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Указания по безопасности 

Это руководство содержит указания , которые вы должны соблюдать для обеспечения собственной 
безопасности , а также защиты продукта и подключенного оборудования . Эти указания выделены в 
показанным ниже символом и подразделяются в соответствии с уровнем опасности : 

 

!  
Опасность 
Указывает, что несоблюдение надлежащих предосторожностей приведет к смерти, тяжким 
телесным повреждениям или существенному повреждению имущества . 

 

!  
Предупреждение 
Указывает, что несоблюдение надлежащих предосторожностей может привести к смерти, 
тяжким телесным повреждениям или существенному повреждению имущества. 

 

!  
Предостережение 
Указывает, что несоблюдение надлежащих предосторожностей может привести к небольшим 
телесным повреждениям или порче имущества. 

 
 Внимание 

Указывает, что несоблюдение надлежащих предосторожностей может привести к 
материальному ущербу  
 

 Замечание 
привлекает внимание к особенно важной информации о продукте , его использовании или к 
конкретной части документации. 

Квалификация персонала 

К установке и работе на данном оборудовании должен допускаться только квалифицированный 
персонал. К квалифицированному персоналу относятся лица , имеющие право пускать в 
эксплуатацию , заземлять и маркировать электрические цепи , оборудование и системы в 
соответствии с установленным порядком и стандартами . 

Правильное использование 

Не забудьте следующее : 
 

!  
Предупреждение 
Это устройство и его компоненты могут использоваться только для приложений , описанных в 
каталоге или технических описаниях , и только в соединении с устройствами или компонентами 
других изготовителей , которые одобрены или рекомендованы Siemens. 
Этот продукт может правильно и успешно функционировать только, если он транспортируется, 
хранится, монтируется и установливается правильно, обслуживается и поддерживается как 
рекомендуется . 

Торговые марки 

SIMATIC®, SIMATIC HMI® и SIMATIC NET® - зарегистрированные торговые марки SIEMENS AG. 

Некоторые другие обозначения использованные в этих документах - также зарегистрированные 
фирменные знаки; права владельца могут нарушаться , если они используются третьими сторонами 
для своих собственных целей. 
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Предисловие 

Цель руководства 
Это руководство дает полный обзор конфигурирования аппаратуры и 
проектирования соединений с помощью программного обеспечения STEP 7. 
Оно разработано для поддержки при отображении структуры аппаратного 
обеспечения в форме проекта STEP 7 и описывает последовательность 
действий для организации обмена данными между системами 
автоматизации.  
Это руководство предназначено для лиц, занимающихся реализацией задач 
управления с помощью STEP 7 на основе систем автоматизации SIMATIC S7. 
Мы рекомендуем вам познакомиться с примерами из руководства для 
начинающих пользователей "Working with STEP 7 V5.3, Getting Started." 
["Работа со STEP 7. Первые шаги "]. Эти упражнения предусматривают 
простое введение в тематику программирования с помощью STEP 7.  

Требуемые основные знания 
Для понимания руководства требуются общие знания в области техники 
автоматизации.  
Кроме того, предполагаются знания о применении компьютеров или РС-
подобных рабочих средств (напр., устройств программирования) под 
управлением операционной системы MS Windows 2000 Professional или MS 
Windows XP Professional. 

Область применения руководства 
Руководство имеет силу для программного пакета STEP 7 V5.3.. 

Самую свежую информацию Вы можете найти в service packs: 

• В файле "readme.wri"  

• В обновленной помощи к STEP 7. 

Раздел "What's new? [Что нового?]" в интерактивнйо помощи дает хорошее 
введение и обзор нововведений STEP 7.
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Пакеты документации для STEP 7 
Данное руководство является составной частью пакета документации  
„STEP 7 Basic Information [STEP 7 Основная информация]“.  

Следующая таблица дает обзор документации для STEP 7: 

 
Руководства Назначение Номер для заказа 

STEP 7 Basic Information [STEP 7 
Основная информация], включающее 
• Working with STEP 7 V5.3, Getting 

Started Manual [Работа со STEP 7 
версии 5.3, Введение] 

• Programming with STEP 7 V5.3 
[Программирование с помощью 
STEP 7 V5.3] 

• Configuring Hardware and 
Communication Connections, STEP 7 
V5.3 [Конфигурирование аппаратуры 
и проектирование соединений с 
помощью STEP 7 V5.3] 

• From S5 to S7, Converter Manual [От 
S5 к S7. Руководство по 
конвертированию] 

Основные знания для 
технического персонала, 
описывающие образ действий 
для реализации задач 
управления с помощью STEP 7 
и программируемых 
контроллеров S7-300/400. 

6ES7810-4CA07-8ВW0

STEP 7 Reference [Справочник по STEP 
7], включающий 
• Руководства по LAD/FBD/STL для 

S7-300/400 
• Стандартные и системные функции 

для S7-300/400 

Справочная информация, 
описывающая языки 
программирования KOP, FUP и 
AWL, а также стандартные и 
системные функции в 
дополнение к основным 
знаниям по STEP 7. 

6ES7810-4CA07-8BW1

 

 
Оперативная помощь в режиме online Назначение Номер для заказа 

Помощь для STEP 7 Основные знания по 
программированию и 
конфигурированию аппаратуры 
с использованием STEP 7 как 
оперативная помощь в режиме 
online 

Составная часть 
программного пакета 
STEP 7 

Справки по STL/LAD/FBD  
Справки по SFB/SFC 
Справки по организационным блокам 

Контекстная справка Составная часть 
программного пакета 
STEP 7 

Помощь в режиме online 
 
В дополнение к руководству вы получите при использовании программного 
обеспечения подробную поддержку через встроенную в программное 
обеспечение оперативную помощь, работающую в режиме online. 
Система помощи встроена в программное обеспечение через несколько 
интерфейсов: 
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• В меню Help [Помощь] имеются в распоряжении несколько команд: 
Contents [Содержание] открывает содержание помощи для STEP 7.  

• Using Help [Использование помощи] дает подробные указания по 
обращению с оперативной помощью. 

• Контекстно-чувствительная помощь предоставляет информацию к 
текущему контексту, напр., к открытому диалоговому окну или к активному 
окну. Ее можно вызвать через экранную кнопку ” Help [Помощь]” или с 
помощью клавиши F1. 

• Еще одну форму контекстно-чувствительной помощи предоставляет 
строка состояния. Для каждой команды меню здесь отображается краткое 
объяснение, как только указатель мыши оказывается на этой команде.  

• Для символов на панели инструментов также высвечивается краткое 
объяснение, когда указатель мыши находится кратковременно над 
символами. 

Если вы хотите прочитать информацию оперативной помощи в напечатанном 
виде, то вы можете распечатать отдельные темы помощи, книги или же всю 
помощь. 

Данное руководство, также как и руководства "Programming with STEP 7", 
"Modifiying the System During Operation via CiR" и "Automation System S7-400H 
- Fault-Tolerant Systems" является фрагментом помощи для STEP 7, 
основанной на HTML. Для получения деталей справьтесь в помощи STEP 7. 
Благодаря почти идентичной структуре деления руководства и оперативной 
помощи вы можете легко переходить от руководства к оперативной помощи и 
обратно. 

Вы можете найти электронное руководство после установки STEP 7 через 
стартовое меню Windows: Start > SIMATIC > Documentation. 

 

Дополнительная поддержка 
Если Вы имеете любые технические вопросы, пожалуйста свяжитесь с Вашим 
представителем Siemens или ответственным агентом. 

You will find your contact person at:  

http://www.siemens.com/automation/partner 

Учебный центр SIMATIC  
Чтобы облегчить вам знакомство с системой автоматизации SIMATIC S7, мы 
предлагаем соответствующие курсы. Обращайтесь, пожалуйста, в свой 
региональный учебный центр или в центральный учебный центр в Нюрнберге 
(D 90327 Nuernberg).  
Телефон:  +49 (911) 895-3200.  
Internet: http://www.sitrain.com 
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Горячая линия поддержки пользователей  
Доступна по всему миру в любое время дня:  
 

 

Beijing 

Nuernberg

Johnson City 

 

 

Всемирная (Нюрнберг) 
Техническая поддержка  
 

Круглосуточно, в любой день 

Тел.: +49 (180) 5050-222 

Факс: +49 (180) 5050-223 

E-Mail: adsupport@
 siemens.com 

GMT: +1:00 

  

Европа и Африка (Нюрнберг) 
Авторизации 
 
Местное время: Пн.-Пт. с 7:00 до 
17:00 

Тел.: +49 (180) 5050-222 

Факс: +49 (180) 5050-223 

E-Mail: adsupport@
 siemens.com 

GMT: +1:00 

США (Джонсон-Сити) 
Техническая поддержка и 
Авторизации  
Местное время: Пн.-Пт. с 8:00 до 
17:00 

Тел.: +1 (423) 262 2522 

Факс: +1 (423) 262 2289 

E-Mail: simatic.hotline@ 

 sea.siemens.com 

GMT: -5:00 

Азия и Австралия (Пекин) 
Техническая поддержка и 
Авторизации  
Местное время: Пн.-Пт. с 8:00 до 
17:00 

Тел.: +86 10 64 75 75 75 

Факс: +86 10 64 74 74 74 

E-Mail: adsupport.asia@ 

 siemens.com 

GMT: +8:00 

Языки горячей линии SIMATIC Hotlines и линии авторизаций немецкий и английский. 
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Серсис и поддержка через Internet 
В дополнение к Нашей документации, мы предоставляем ноу-хау через 
internet: 
http://www.siemens.com/automation/service&support 

Здесь Вы можете найти : 

• Информационные письма постоянно извещающие Вас о изменениях в 
Ваших продуктах. 

• Документы через функции поиска в сервисе и поддержке. 

• Форум, где эксперты и пользователи со всего мира обмениваются 
мненисми. 

• Вашего регионального представителя для Automation & Drives. 

Информацию о полевом обслуживании, ремонте, запасных частях и другое в 
"Services". 

 



 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261405-01 ix 

Содержание 

 

1 Основы конфигурирования аппаратуры с помощью STEP 7 ............................. 1-1 
1.1 Введение в конфигурирование аппаратуры .............................................. 1-1 
1.2 Основной порядок действий при конфигурировании аппаратуры........... 1-2 
1.2.1 Основные шаги при конфигурировании станции....................................... 1-3 
1.2.2 Структура окна станции ............................................................................... 1-3 
1.2.3 Конфигурационная таблица как отображение стойки .............................. 1-4 
1.2.4 Определение свойств компонентов ........................................................... 1-5 
1.2.5 Что следует знать о правилах, относящихся к слотам, и прочих 

правилах?...................................................................................................... 1-6 
1.2.6 Обзор: Последовательность конфигурирования и параметризации ...... 1-7 
1.2.7 Индивидуальная настройка каталога аппаратуры .................................... 1-8 
1.2.8 Поиск в каталоге аппаратуры...................................................................... 1-9 
1.3 Советы по редактированию конфигурации станции ............................... 1-10 
1.3.1 Замена и перемещение модулей.............................................................. 1-11 
1.3.2 Замена стоек, устройств C7 и ведомых DP ............................................. 1-12 
1.3.3 Отображение информации о компонентах в каталоге аппаратуры ...... 1-15 
1.3.4 Обновление установленной аппаратуры ................................................. 1-16 

2 Конфигурирование центральных стоек .................................................................. 2-1 
2.1 Правила размещения модулей (SIMATIC 300).......................................... 2-1 
2.1.1 Правила размещения модулей (SIMATIC 300).......................................... 2-1 
2.1.2 Особые правила для пустого модуля (DM 370 Dummy) ........................... 2-2 
2.1.3 Особые правила для цифрового имитационного модуля                         

SIM 374 IN/OUT 16........................................................................................ 2-3 
2.1.4 Особые правила для M7-300....................................................................... 2-3 
2.2 Правила размещения модулей (SIMATIC-400).......................................... 2-4 
2.2.1 Правила размещения модулей (SIMATIC-400).......................................... 2-4 
2.2.2 Особые правила для резервируемых блоков питания (S7-400).............. 2-5 
2.2.3 Особые правила для M7-400....................................................................... 2-5 
2.2.4 Особые правила для интерфейсного модуля PROFIBUS-DP  (M7-400) . 2-6 
2.3 Как конфигурировать центральные стойки ................................................ 2-7 
2.3.1 Создание станции ........................................................................................ 2-7 
2.3.2 Вызов приложения для конфигурирования аппаратуры .......................... 2-7 
2.3.3 Проектирование центральной стойки......................................................... 2-8 
2.3.4 Размещение модулей в стойке ................................................................... 2-9 
2.3.5 Отображение версии операционной системы CPU в окне 'Hardware 

Catalog' ........................................................................................................ 2-10 
2.3.6 Проектирование управляющих систем C7 (особенности)...................... 2-10 
2.3.7 Параметризация модулей и интерфейсов............................................... 2-11 
2.3.8 Назначение адресов .................................................................................. 2-12 
2.3.9 Назначение адресов входов и выходов ................................................... 2-12 
2.3.10 Назначение символьных имен адресам входов и выходов ................... 2-13 
2.3.11 Наблюдение входов и изменение выходов при конфигурировании 

аппаратуры ................................................................................................. 2-14 
2.3.12 Конфигурирование CP точка-точка........................................................... 2-16 
2.3.13 Конфигурирование модулей S5 ................................................................ 2-17 
2.4 Дополнение центральной стойки стойками расширения ....................... 2-18 



Содержание 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
x A5E00261405-01 

2.4.1 Правила соединения стоек расширения (SIMATIC 400)......................... 2-19 
2.4.2 Размещение стойки расширения (SIMATIC 400)..................................... 2-20 
2.4.3 Особый случай: в центральной стойке - несколько CPU........................ 2-20 

3 Конфигурирование децентрализованной периферии (DP) ................................. 3-1 
3.1 Основная последовательность действий при конфигурировании          

мастер-системы DP...................................................................................... 3-1 
3.2 Где можно найти ведомые DP в окне каталога аппаратуры? .................. 3-4 
3.3 Запись и чтение распределенных консистентных данных (> 4 байт) ..... 3-5 
3.4 Проектирование PROFIBUS-DP.................................................................. 3-6 
3.4.1 Проект с простым (модульным или компактным) ведомым DP (обмен 

данных: Slave <> Master) ............................................................................. 3-6 
3.4.2 Проект с интеллектуальным ведомым DP (Обмен данных: Slave <> 

Master) ........................................................................................................... 3-7 
3.4.3 Проект с интеллектуальными ведомыми DP (Прямой обмен данных: 

Slave > I Slave) .............................................................................................. 3-8 
3.4.4 Проект с двумя мастер-системами DP (Прямой обмен данных: Slave > I 

Slave) ............................................................................................................. 3-9 
3.4.5 Проект с двумя мастер-системами DP (Прямой обмен данных: Slave > 

Master) ......................................................................................................... 3-10 
3.5 Как конфигурировать распределенные системы ввода-вывода ........... 3-11 
3.5.1 Создание мастер-системы DP .................................................................. 3-11 
3.5.2 Обработка мастер-систем интерфейса DP.............................................. 3-12 
3.5.3 Выбор и проектирование ведомых DP..................................................... 3-13 
3.5.4 Копирование нескольких ведомых DP ..................................................... 3-13 
3.5.5 Конфигурирование компактных ведомых DP .......................................... 3-14 
3.5.6 Конфигурирование модульных ведомых DP ........................................... 3-14 
3.5.7 Включение ведомых DP в группу SYNC или FREEZE ............................ 3-15 
3.6 Другие конфигурации ведомых DP........................................................... 3-17 
3.6.1 ET 200L и DP/AS-i Link ............................................................................... 3-17 
3.6.2 ET 200S ....................................................................................................... 3-17 
3.6.3 ET 200S с последующей установкой ........................................................ 3-17 
3.6.4 ET 200S в режиме DPV1............................................................................ 3-21 
3.6.5 ET 200iS....................................................................................................... 3-22 
3.6.6 PROFIBUS PA ............................................................................................. 3-24 
3.6.7 HART- модули ............................................................................................. 3-25 
3.6.8 Конфигурирование программного резервирования ................................ 3-26 
3.7 Интеллектуальные ведомые DP ............................................................... 3-27 
3.7.1 Конфигурирование интеллектуальных ведомых DP............................... 3-27 
3.7.2 Пример конфигурирования S7-400 как интеллектуального ведомого .. 3-32 
3.7.3 Создание аварийных сообщений от интеллектуального ведомого с 

помощью SFB75 'SALRM’ .......................................................................... 3-38 
3.8 Прямой обмен данных (боковые коммуникации) .................................... 3-41 
3.8.1 Проектирование прямого обмена данных между узлами PROFIBUS-DP....   
  ................................................................................................................... 3-41 
3.8.2 Пример конфигурирования прямого обмена данных.............................. 3-43 
3.8.3 Конфигурирование ведомого DP (GSD ревизия 5) как приемника для 

прямой передачи данных .......................................................................... 3-46 
3.9 Работа с GSD-файлами............................................................................. 3-49 
3.9.1 Импорт файла *.GSD ................................................................................. 3-49 
3.9.2 Установка GSD- файла .............................................................................. 3-49 
3.9.3 Что надо знать о ревизиях GSD................................................................ 3-50 
3.10  DPV1............................................................................................................ 3-52 
3.10.1 Что надо знать о PROFIBUS DPV1........................................................... 3-52 
3.10.2 Конфигурирование устройств DPV1......................................................... 3-53 
3.10.3 Программирование устройств DPV1 ........................................................ 3-55 
3.10.4 Модель слотов ведомых DPV1 с интеллектуальными ведомыми......... 3-61 



 Содержание 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261405-01 xi 

3.11  Диагностический повторитель .................................................................. 3-66 
3.11.1 Конфигурирование и ввод в действие диагностического повторителя. 3-66 
3.11.2 Отображение топологии с помощью диагностического повторителя ... 3-69 
3.11.3 Работа с топологическим представлением ............................................. 3-71 
3.12  Установка эквидистантных циклов шины для подсетей PROFIBUS ..... 3-74 
3.12.1 Установка эквидистантных циклов шины для подсетей PROFIBUS ..... 3-74 
3.12.2 Конфигурирование короткого и постоянного времени реакции на сигналы 

для PROFIBUS DP...................................................................................... 3-77 
3.12.3 Параметризация эквидистантного цикла и изохронный режим в HW 

Config ........................................................................................................... 3-82 
3.12.4 Подключение PG/PC к эквидистантной сети PROFIBUS через Industrial 

Ethernet и соединитель IE/PB.................................................................... 3-86 
4 Конфигурирование станции SIMATIC PC................................................................. 4-1 

4.1 Создание и параметризация станций SIMATIC PC................................... 4-1 
4.2 Правила слотов для станции SIMATIC PC................................................. 4-4 
4.3 Сравнение: Станция S7 – Станция PC....................................................... 4-4 
4.4 Добавления конфигурации SIMATIC PC предыдущих версий ................. 4-5 
4.5 Выделение станции SIMATIC PC сконфигурированной в сетевом виде 4-6 

5 Сохранение, импорт и экспорт конфигурации ....................................................... 5-1 
5.1 Сохранение конфигурации и проверка непротиворечивости .................. 5-1 
5.2 Импорт и экспорт конфигурации ................................................................. 5-2 

6 Синхронная работа нескольких CPU ....................................................................... 6-1 
6.1 Что Вы должны знать о многопроцессорной обработке........................... 6-1 
6.1.1 Особенности многопроцессорной обработки ............................................ 6-2 
6.1.2 Когда применять мультипроцессорный режим?........................................ 6-3 
6.2 Конфигурирование мультипроцессорного режима ................................... 6-4 
6.2.1 Конфигурирование модулей для мультипроцессорного режима ............ 6-5 
6.2.2 Отображение назначения CPU ................................................................... 6-5 
6.3 Программирование CPU.............................................................................. 6-7 
6.3.1 Программирование CPU.............................................................................. 6-7 

7 Изменение системы в рабочем режиме (CiR)......................................................... 7-1 

8 Конфигурирование H-систем..................................................................................... 8-1 
8.1 Конфигурирование H-систем ...................................................................... 8-1 

9 Проектирование станций, соединенных в сеть ..................................................... 9-1 
9.1 Соединение в сеть станций в одном проекте ............................................ 9-1 
9.2 Свойства подсетей и коммуникационных узлов........................................ 9-2 
9.3 Правила конфигурирования сетей ............................................................. 9-3 
9.4 Назначение адресов Ethernet...................................................................... 9-4 
9.5 Импорт и экспорт станций в сетевом представлении............................... 9-7 
9.6 Как сконфигурировать и сохранить подсеть ............................................ 9-10 
9.6.1 Последовательность действий при проектировании подсети ............... 9-10 
9.6.2 Создание и параметризация новой подсети ........................................... 9-13 
9.6.3 Создание и параметризация новой станции ........................................... 9-14 
9.6.4 Создание и параметризация сетевых соединений ................................. 9-15 
9.6.5 Создание и параметризация нового ведомого DP.................................. 9-16 
9.6.6 Создание и параметризация PG/PC, 'других станций' и станций S5..... 9-16 
9.6.7 Учет подключений для PG/PC в проекте сети ......................................... 9-20 
9.6.8 Проверка непротиворечивости сети......................................................... 9-23 
9.6.9 Сохранение сетевой конфигурации.......................................................... 9-24 
9.6.10 Советы по редактированию конфигурации сети ..................................... 9-25 
9.7 Сетевые станции, являющиеся шлюзами................................................ 9-28 



Содержание 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
xii A5E00261405-01 

9.7.1 Сетевые станции, являющиеся шлюзами................................................ 9-28 
9.7.2 Программатор/PC, подключенный к подсети через TeleService или WAN .  
  ................................................................................................................... 9-31 
9.8 Подключение к сети станций из различных проектов............................. 9-33 

10 Проектирование соединений................................................................................... 10-1 
10.1 Введение в проектирование соединений ................................................... 10-1 
10.2 Конфигурирование коммуникаций через CP Ethernet ............................... 10-2 
10.3 Конфигурирование коммуникаций через CP PROFIBUS .......................... 10-3 
10.4 Что нужно знать о различных типах соединений?..................................... 10-4 
10.5 Что надо знать о назначении ресурсов соединений ................................. 10-7 
10.6 Использование ресурсов соединений с отказоустойчивыми соединениями 
S7  ................................................................................................................... 10-12 
10.7 Блоки для различных типов соединений .................................................. 10-17 
10.8 Работа с таблицей соединений ................................................................. 10-19 
10.9 Несогласованные соединения................................................................... 10-21 
10.10 Отображение состояния соединений........................................................ 10-22 
10.11 Доступ к идентификаторам соединений при программировании........... 10-23 
10.12 Проектирование соединений для партнеров в одном и том же проекте10-24 
10.12.1 Типы соединений у партнеров в одном и том же проекте.................... 10-24 
10.12.2 Правила создания соединений ............................................................... 10-26 
10.12.3 Проектирование соединений для модулей станции SIMATIC ............. 10-26 
10.12.4 Ввод нового соединения.......................................................................... 10-27 
10.12.5 Изменение партнера ................................................................................ 10-28 
10.12.6 Резервирование соединения .................................................................. 10-29 
10.12.7 Удаление одного или нескольких соединений ...................................... 10-30 
10.12.8 Копирование соединений ........................................................................ 10-30 
10.12.9 Проектирование соединений для станции SIMATIC PC....................... 10-31 
10.12.10 Конфигурирование маршрутизации соединения S7 для станции SIMATIC 

PC .............................................................................................................. 10-33 
10.12.11 Программатор/PC как партнер по соединению ..................................... 10-34 
10.12.12 Соединение S7 c PG/PC .......................................................................... 10-34 
10.12.13 Соединение S7 с PG/PC с WinCC........................................................... 10-35 
10.13 Проектирование соединений с партнерами в других проектах .............. 10-36 
10.13.1 Типы соединений для партнеров из других проектов........................... 10-36 
10.13.2 Основная последовательность действий при проектировании соединений 

между проектами...................................................................................... 10-38 
10.13.3 Создание нового соединения с неопределенным партнером ............. 10-39 
10.13.4 Создание соединения с 'иной станцией', 'PG/PC', 'SIMATIC S5' .......... 10-41 
10.14 Сохранение соединений ............................................................................ 10-41 
10.14.1 Сохранение соединений .......................................................................... 10-41 

11 Проектирование связи через глобальные данные ............................................. 11-1 
11.1 Обзор: связь через глобальные данные..................................................... 11-1 
11.2 Определение производительности коммуникаций исходя из ресурсов GD...   
  ..................................................................................................................... 11-2 

11.2.1 Определение производительности коммуникаций исходя из  ресурсов GD 
................................................................................................................... 11-3 

11.2.2 Необходимое количество GD-пакетов ..................................................... 11-4 
11.2.3 Необходимое количество GD-контуров.................................................... 11-5 
11.2.4 Исключения при расчете GD- контуров.................................................... 11-7 
11.3 Условия передачи и приема ........................................................................ 11-9 
11.3.1 Условия передачи и приема...................................................................... 11-9 
11.3.2 Соотношения между коэффициентом редукции и временем цикла ... 11-10 
11.4 Время реакции ............................................................................................ 11-11 
11.5 Конфигурирование и сохранение GD-связи ............................................. 11-12 
11.5.1 Последовательность действий при конфигурировании  GD- связи .... 11-12 



 Содержание 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261405-01 xiii 

11.5.2 Открытие таблицы глобальных данных ................................................. 11-13 
11.5.3 Советы по работе с таблицами глобальных данных ............................ 11-14 
11.5.4 Заполнение таблицы глобальных данных ............................................. 11-15 
11.5.5 Сохранение и первая компиляция таблицы глобальных данных........ 11-16 
11.5.6 Ввод коэффициентов редукции .............................................................. 11-18 
11.5.7 Ввод строк состояния............................................................................... 11-18 
11.5.8 Вторая компиляция таблицы глобальных данных ................................ 11-20 
11.6 Передача глобальных данных с помощью системных функций ............ 11-20 
11.6.1 Передача глобальных данных с помощью системных функций.......... 11-20 

12 Загрузка и выгрузка ................................................................................................... 12-1 
12.1 Загрузка конфигурации в программируемый контроллер......................... 12-1 
12.2 Первоначальная загрузка сетевой конфигурации ..................................... 12-2 
12.3 Загрузка сетевой конфигурации в программируемый контроллер .......... 12-4 
12.4 Загрузка в станцию PC ................................................................................. 12-4 
12.5 Загрузка изменений сетевой конфигурации............................................... 12-5 
12.6 Загрузка конфигурации глобальных данных .............................................. 12-7 
12.7 Выгрузка конфигурации из станции ............................................................ 12-7 
12.8 Выгрузка сетевой конфигурации ................................................................. 12-8 

13 Проекты, редактируемые несколькими пользователями ................................. 13-1 
13.1 Многопользовательская конфигурация в сети........................................... 13-1 
13.1.1 Установка конфигурации рабочей станции.............................................. 13-3 
13.2 Конфигурация с одним узлом для несетевых рабочих станций............... 13-3 
13.2.1 Слияние нескольких S7 программ в одну ................................................ 13-3 
13.2.2 Копирование программ S7 с атрибутами сообщений ............................. 13-4 

14 Работа с проектами в мультипроекте .................................................................... 14-1 
14.1 Что надо знать о мультипроектах? ............................................................. 14-1 
14.2 Мультипроект – требования и рекомендации ............................................ 14-4 
14.3 Работа с мультипроектами .......................................................................... 14-7 
14.4 Доступ Online к PLC в мультипроекте ....................................................... 14-11 
14.5 Создание межпроектных подсетей ........................................................... 14-13 
14.6 Отображение объединяемых подсетей в сетевом виде ......................... 14-17 
14.7 Конфигурирование межпроектных соединений ....................................... 14-18 
14.8 Возможности слияния межпроектных соединений .................................. 14-22 
14.9 Соединения S7 с незаданным партнером ................................................ 14-23 
14.10 Настройка проектов в мультипроекте ....................................................... 14-23 
14.11 Архивация и разархивация мультипроектов ............................................ 14-24 

15 Ввод в эксплуатацию и обслуживание.................................................................. 15-1 
15.1 Ввод в эксплуатацию и обслуживание........................................................ 15-1 
15.2 Как ввести в действие узлы PROFIBUS...................................................... 15-1 

 

 



 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261404-01 1-1 

1 Основы конфигурирования аппаратуры 
с помощью STEP 7 

1.1 Введение в конфигурирование аппаратуры 

  Конфигурирование 
Под "конфигурированием» мы в дальнейшем будем понимать размещение 
стоек, модулей, устройств децентрализованной периферии и интерфейсных 
модулей в окне станции. Стойки представляются с помощью 
конфигурационной таблицы, которая, как и "реальная» стойка, допускает 
определенное число устанавливаемых модулей. 

В конфигурационной таблице STEP 7 автоматически присваивает каждому 
модулю адрес. Вы можете изменить адреса модулей станции, если CPU 
допускает свободное присвоение адресов (каждому каналу модуля адрес 
может быть назначен свободно, независимо от слота).  

Вы можете, как угодно часто копировать конфигурацию в другие проекты 
STEP 7, при необходимости модифицировать ее и загрузить в одну или 
несколько существующих установок. При запуске системы автоматизации 
CPU сравнивает заданную конфигурацию, созданную с помощью STEP 7, с 
фактической конфигурацией установки. Благодаря этому возможные ошибки 
немедленно распознаются и сигнализируются. 

Параметризация 
Под «параметризацией» мы в дальнейшем будем понимать:  

• Установку свойств параметрируемых модулей для локальной 
конфигурации и для сети. Пример: CPU – это параметрируемый модуль. 
Время контроля цикла - его параметр, который Вы можете устанавливать 

• Установка параметров шины и параметров ведущего и ведомых для 
мастер-системы (PROFIBUS) 

Параметры загружаются в CPU и передаются из CPU в соответствующие 
модули. Модули можно легко заменять, так как параметры, установленные с 
помощью STEP 7, в процессе запуска автоматически загружаются в новый 
модуль. 
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Когда требуется "конфигурирование аппаратуры?"? 
Свойства программируемых контроллеров и модулей S7 устанавливаются по 
умолчанию таким образом, что во многих случаях Вам не нужно их 
конфигурировать  

Конфигурирование требуется обязательно в следующих случаях: 

• если Вы хотите изменить параметры модуля, установленные по 
умолчанию (например, разрешить для модуля прерывания от процесса) 

• если Вы хотите проектировать коммуникационные соединения  

• для станций с децентрализованной периферией (PROFIBUS-DP)  

• для станций S7-400 с несколькими CPU (мультипроцессорная обработка) 
или стойками расширения  

• для систем программируемых контроллеров повышенной надежности (H) 
(дополнительный пакет) 

Обзор: Последовательность конфигурирования и параметризации для 
локальной конфигурации  

Основная процедура для конфигурации оборудования  

Конфигурирование распределенной периферии (DP)  

Редактирование существующей конфигурации предыдущих версий STEP 7  

1.2 Основной порядок действий при 
конфигурировании аппаратуры 

Окна для конфигурирования 
Для конфигурирования системы автоматизации Вы используете два окна:  

• окно станции, в котором Вы помещаете стойки для конструирования 
станции  

• окно "Hardware Catalog [Каталог аппаратуры]"*), из которого Вы выбираете 
необходимые аппаратные компоненты, например, стойки, сигнальные и 
интерфейсные модули  

Отображение каталога аппаратуры  
Если окно "Hardware Catalog [Каталог аппаратуры]» не показано, выберите 
команду меню View > Catalog [Вид > Каталог]. С помощью этой команды Вы 
можете выводить на экран или закрывать каталог аппаратуры. 
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1.2.1 Основные шаги при конфигурировании станции  

Независимо от того, как строится станция, ее конфигурирование содержит 
следующие этапы: 

1 Выделите компонент аппаратуры в окне "Hardware Catalog [Каталог 
аппаратуры]". 

2 Скопируйте выбранные компоненты, используя метод Drag&Drop, в окно 
станции. 

Принцип работы показан на следующем рисунке: 

 

  

1.2.2 Структура окна станции 

Окно станции в своей нижней части содержит подробный обзор вставленной 
и выделенной стойки. Здесь в табличной форме отображаются заказные 
номера и адреса модулей. 

Для центральной стойки, оснащенной модулями, таблица имеет следующую 
структуру (подробное представление): 

  

   

Слот                Модуль              Номер для заказа                     Адрес MPI  Комметарий 
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1.2.3 Конфигурационная таблица как отображение стойки 

Для локальной конфигурации размещайте модули в стойке следом за CPU, а 
затем в стойках расширения. Допустимое количество стоек расширения, 
зависит от применяемого CPU. 

С помощью STEP 7 разместите модули на стойках точно так же, как в вашей 
реальной установке. Отличие: в STEP 7 стойки представляются с помощью 
"конфигурационных таблиц", которые имеют столько строк, сколько модулей 
можно разместить на реальной стойке. 

На следующем рисунке показано на конкретном примере преобразование 
реальной структуры в конфигурационную таблицу. Конфигурационная 
таблица соответствует применяемой стойке; STEP 7 автоматически 
проставляет номера стоек в скобках перед именем. 

Пример: (0) UR соответствует центральной стойке (Universal Rack – 
универсальная стойка) № 0. 

  

Конфигурационная
таблица (стойка)
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1.2.4 Определение свойств компонентов 

После того, как Вы разместили компоненты в окне станции, Вы можете всегда 
следующим образом перейти в диалог для изменения установленных по 
умолчанию свойств (параметров или адресов): 

• дважды щелкните на компоненте или выберите команду меню Edit > 
Object Properties [Редактирование > Свойства объекта]. 

• с помощью правой клавиши мыши: переместите указатель мыши на 
компонент, нажмите правую клавишу мыши и выберите из всплывающего 
меню команду Object Properties [Свойства объекта] 

Свойства CPU 
Для поведения системы особое значение имеют свойства CPU. В диалогах на 
закладках CPU Вы можете, например, установить: характеристики запуска, 
области локальных данных и приоритеты для прерываний, области памяти, 
характеристики реманентности, тактовые меркеры, уровень защиты и пароль 
– здесь перечислены лишь некоторые свойства. STEP 7"знает", что можно 
устанавливать и в каких пределах.  

В закладке "General [Общее]» CPU или через свойства интерфейса CPU Вы 
можете параметрировать интерфейсы (например, MPI или встроенный 
интерфейс PROFIBUS-DP). Через эти диалоги Вы попадаете также в диалог 
свойств соответствующей подсети, к которой должен быть подключен CPU. 

Другие способы параметризации  
Для систем автоматизации S7-300/400 у некоторых модулей Вы имеете 
возможность устанавливать параметры в программе пользователя (напр., у 
аналоговых модулей). Для этого Вы вызываете в прикладной программе 
системные функции (SFC) WR_PARM, WR_DPARM и PARM_MOD. Эти 
настройки, однако, теряются при новом пуске (теплый рестарт). 

Подробную информацию о системных функциях Вы найдете в справочном 
руководстве System Software for S7-300 and S7-400, System and Standard 
Functions [Системное программное обеспечение для S7-300/400, 
Системные и стандартные функции].  

Для систем автоматизации М7-300/400 Вы имеете возможность 
устанавливать параметры сигнальных модулей в программе на языке С. Для 
этого вызовите в программе на языке С функцию прикладного программного 
интерфейса М7 "M7StoreRecord". Эта функция передает параметры 
сигнальному модулю. 

Подробную информацию о функциях прикладного программного интерфейса 
М7 Вы найдете в руководствах по системному программному обеспечению 
М7-300/400. 
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1.2.5 Что следует знать о правилах, относящихся к слотам, и 
прочих правилах? 

STEP 7 поддерживает Вас при конфигурировании станции, так что, как 
правило, Вы непосредственно получаете сообщение о том, что модуль, 
например, не может быть установлен в желаемом слоте. 

Начиная с версии STEP 7 V5.2 Вы можете легко с первого взгляда 
определить слоты, в которые можно установить модуль, для обозначения 
этого отображение использует более 256 цветов. Когда Вы выделяете модуль 
в каталоге аппаратуры, и этот модуль может быть вставлен в проектируемую 
стойку, слоты, в которые можно установить модуль выделяются цветом. Эта 
возможность повышает эффективность проектирования. 

Кроме того, адресные области автоматически проверяются, так что один и 
тот же адрес не может быть занят дважды. 

В связи с этим обращайте внимание на строку состояния на нижнем краю 
окна, а также на сообщения, выводимые на экран, которые объясняют 
причины и следствия команды. Кроме того, Вы имеете возможность получить 
дополнительную информацию к сообщениям через систему помощи. 

Не принимаются во внимание дополнительные, лишь временно действующие 
(для определенной версии) правила, например, ограничения пригодности 
слотов из-за функциональных ограничений у отдельных модулей. Поэтому 
всегда обращайте внимание на документацию или текущую информацию о 
модулях. 
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1.2.6 Обзор: Последовательность конфигурирования и 
параметризации  

Предпосылка 
Вы открыли или создали новый проект в SIMATIC Manager. 

Основная последовательность 
Чтобы сконфигурировать и параметрировать структуру, действуйте 
следующим образом:  

Создание станции

Вызов приложения " Configuring Hardware
[Конфигурирование аппаратуры]"

Определение свойств модулей

Размещение стоек

Сохранение конфигурации

Загрузка конфигурации в систему
автоматизации

Размещение/вставка модулей

  

Резюме 
Как это принято в приложениях Windows, в STEP 7 Вы можете составить всю 
конфигурацию с помощью буксировки (Drag&Drop). Подробную информацию 
о том, как обращаться с вашей реальной установкой и преобразовывать ее, 
например, как конфигурировать подключение стоек расширения или 
специальных компонентов, Вы найдете в оперативной online-помощи для  
STEP 7. 
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1.2.7 Индивидуальная настройка каталога аппаратуры 

Наряду каталогом аппаратуры, поставляемым вместе с пакетом STEP 7, Вы 
сами можете создать "свой» каталог. Таким образом, возникают различные 
профили каталога. Основой для каждого нового профиля каталога является 
известный Вам каталог аппаратуры (Hardware Catalog) со всеми 
модулями/компонентами – этот профиль (Profile) каталога называется 
стандартным (Standard). Имена для создаваемых Вами профилей каталога 
Вы можете назначать произвольно. 

Пример: Вы можете создать себе профиль каталога, который включает в 
себя только используемые Вами сейчас модули 

Начиная с STEP 7 V5.0, Service Pack 3, в дополнение к профилю "Standard» 
предусмотрены следующие профили: 

• Текущие модули (например, версии Ноябрь 1999 или июль 2000) 
В этом профиле, старые модули недоступны (только выпускаемые 
порядковые номера) 

• SIMATIC Outdoor [SIMATIC вне помещения] (например, версии Ноябрь 
1999 или июль) 
Профиль включает только выпускаемые модули, которые могут 
применяться при расширенных условиях эксплуатации (применимы при 
повышенных механических нагрузках и расширенных климатических 
условиях) 

Последовательность действий  
1. Выберите команду меню Options > Edit Catalog Profiles [Возможности > 

Редактирование профилей каталога]. В вызываемом затем приложении 
открываются два профиля каталога: "Standard» и "пустой", который еще 
не содержит компонентов. 

2. Отбуксируйте, используя метод Drag&Drop, необходимые папки и модули 
из окна стандартного профиля каталога в окно "пустого» профиля. Вы 
можете также приспособить структуру каталога к своим потребностям с 
помощью команды меню Insert > Folder [Вставить > Папка]. 

3. Сохраните новый профиль каталога с помощью команды меню File > 
Save as [Файл > Сохранить как]; для нового профиля каталога 
используйте информативное имя. 
После этого имя нового профиля появляется и может быть выбрано в 
поле списка "Profile [Профиль]» окна "Hardware Catalog [Каталог 
аппаратуры]". 

С помощью файлов GSD обновляется только профиль каталога "Standard»  
Ведомые DP, которые устанавливаются позднее с использованием файлов 
GSD, добавляются только в профиль каталога "Standard". Другие папки 
полевых устройств и не включенные в каталог профили Вы создаете сами. 
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1.2.8 Поиск в каталоге аппаратуры 

Вы можете найти компонент в каталоге аппаратуры, если Вы знаете его 
порядковый номер или название функции, которое отображается в 
информационном тексте каталога. 

Верхняя часть каталога аппаратуры содержит окно "Search [Поиск]".  

Последовательность действий 
1. Выделите и раскройте папки в Hardware Catalog [Каталог аппаратуры] 

2. Введите текст для поиска, например, начало порядкового номера       
6ES7 331.  

3. Чтобы начать поиск, нажмите "Search down [Искать ниже]» или "Search up 
[Искать выше]".  

 

  
Искать ниже 

  
Искать выше  

 

STEP 7 обнаруживает первое совпадение с введенным текстом. Если 
искомый компонент находится в другой папке, которая не открыта или 
находится за пределами видимой области, то папка автоматически 
открывается и перемещается в видимую область. 

STEP 7 сохраняет введенный Вами для поиска текст. Вы можете легко 
выбрать его снова из выпадающего списка инструмента поиска.  

Как делать запросы в окне поиска 
В окно поиска Вы можете ввести любой текст, информационный текст, 
название или порядковый номер по каталогу. 

Поиск не чувствителен к регистру. 

Не поддерживаются указания на неопределенные символы (*, ?,...). 

Вы можете ввести часть более длинного полного термина (напр., 331). 

Пробелы, знаки табуляции или дефисы должны быть введены так же, как они 
показаны в каталоге; в противном случае искомый пункт не будет найден (то 
есть необходимо иметь в виду различие между дефисами и пробелами в 
порядковом номере!). 



Основы конфигурирования аппаратуры с помощью STEP 7 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
1-10 A5E00261404-01 

1.3 Советы по редактированию конфигурации станции  

Закрепление окна «Hardware Catalog [Каталог аппаратуры]» на краю окна 
станции 

Во избежание перекрытия окном каталога аппаратуры содержимого окна 
станции Вы можете поместить окно каталога на краю окна приложения и за-
крепить его там. Для этого просто дважды щелкните в области окна "Hardware 
Catalog [Каталог аппаратуры]" над полем списка "Profile [Профиль]". Чтобы 
«открепить» окно, снова щелкните дважды на той же области. 

В «освобожденном» состоянии размер окна «Hardware Catalog [Каталог 
аппаратуры]» можно изменять. 

Определение доступных слотов 
Начиная с версии STEP 7 V5.2 Вы можете легко с первого взгляда 
определить слоты, в которые можно установить модуль для чего 
отображение, использующее более 256 цветов. Когда Вы выделяете модуль 
в каталоге аппаратуры, и этот модуль может быть вставлен в проектируемую 
стойку, слоты, в которые можно установить модуль выделяются цветом. Эта 
возможность ускоряет и облегчает проектирование. 

Выделение нескольких строк в конфигурационной таблице 
Если Вы хотите выделить в конфигурационной таблице несколько строк, 
чтобы, например, скопировать (используя всплывающую команду Copy) или 
удалить (используя всплывающую команду Delete) несколько модулей или 
вставить несколько модулей одного типа, действуйте следующим образом: 
Выделение всех 
строк: 

Выберите команду меню Edit > Select All [Редактировать > 
Выделить все] 

Выделение связной 
области: 

Щелкните на первой строке области, подлежащей выделению 
Удерживайте в нажатом состоянии регистровую клавишу (Shift) 
и щелкните на последней строке области, подлежащей 
выделению 

Выделение 
нескольких строк: 

Нажмите клавишу Ctrl и, удерживая ее в нажатом состоянии, 
щелкайте затем на всех строках, которые Вы хотите выделить 

Вы также можете скопировать модули за пределы станции, если при вставке 
Вы не нарушаете правила слотов.  

Обращение со сложными станциями  
Если станция имеет сложную структуру, напр., содержит несколько стоек, то 
Вы можете настроить конфигурационную таблицу на минимальный размер. 

1. Выделите конфигурационную таблицу. 

2. Нажмите правую клавишу мыши и выберите во всплывающем меню 
команду Minimize [Минимальный размер].  

Это обзорное представление Вы можете также установить командой меню 
Options > Customize [Возможности > Настройка] 
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Автоматическое упорядочение стоек в отображении  
С помощью команды меню View > Arrange Automatically [Вид > Разместить 
автоматически] Вы можете автоматически упорядочить отображение.  

Отображение в каталоге аппаратуры компонентов, установка которых 
возможна  

Чтобы отобразить выделением модули, которые могут быть установлены в 
определенный слот, выделите этот слот в стойке и подайте команду Insert > 
Insert Object [Вставить > Вставить объект] или  Insert > Change Object 
[Вставить > Изменить объект]. Этот способ избавляет Вас от поиска в 
каталоге аппаратуры. Вы можете выбирать из всех модулей, которые 
доступны в текущем профиле каталога. 

1.3.1 Замена и перемещение модулей 

Вы можете настроить существующую конфигурацию, не только путем 
копирования или удаления элементов, но перемещения или замены.  

Перемещение модулей 
Модули или другие компоненты Вы можете перемещать на другие 
допустимые слоты внутри станции просто буксировкой (Drag&Drop). 

Замена модулей 
Если Вы уже создали конфигурацию и хотите заменить уже параметризован-
ный модуль (например, CPU или аналоговый модуль) другим, не "теряя" 
параметризацию или проект соединений, то действуйте следующим образом: 

1. Отбуксируйте новый модуль (например, CPU), используя Drag&Drop, на 
слот CPU, подлежащего замене. 

2. Подтвердите в последующем диалоге замену модуля.  

Если появляется сообщение "The slot is already occupied [Слот уже занят]", Вы 
должны сначала активизировать функцию замены командой меню Options > 
Customize [Возможности > Настройка] и, выбрав затем настройку “Enable 
Module Exchange [Разрешить замену модулей]“.  

Альтернатива: 
После выделения слота в стойке, Вы можете открыть в контекстно-зависимом 
меню (правой кнопкой мыши) Insert Object [Вставить объект] или Replace 
Object [Заменить объект] для отображения модулей, пригодных для 
установки. Эта возможность избавляет Вас от необходимости поиска  в 
каталоге аппаратуры. Вы выбираете из всех модулей, которые доступны в 
текущем профиле каталога аппаратуры. 

Заменять можно только "совместимые» модули. Если модули несовместимы, 
то Вы должны удалить "старый» модуль, установить новый модуль и снова 
его параметрировать. На попытку замены несовместимых модулей STEP 7 
реагирует соответствующим сообщением. 

Пример: Вы можете заменить параметризованный CPU центральным 
процессором с новым заказным номером – вся параметризация (напр., адрес 
MPI) воспринимается новым модулем. 
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1.3.2 Замена стоек, устройств C7 и ведомых DP  

Начиная с STEP 7 V5.1, Service Pack 1, в сконфигурированной станции с 
назначенными адресами и параметрами модулей Вы можете заменить стойку 
в SIMATIC 400, управляющей системе C7 или ведомого DP, сохранив 
размещение и параметры модулей. В этом случае управляющая система C7 
и ведомый DP содержат стойку в себе.  

Замена стойки не применима к системам SIMATIC 300, которые имеют только 
один вид стойки – стандартный профильный рельс.  

В каких случаях имеет смысл заменить стойку? 
Для замены стоек стации SIMATIC 400 всегда необходимо, чтобы 
функциональные возможности только расширялись при замене. 

• Замена стойки, не поддерживающей резервирования системы питания на 
стойку, поддерживающую резервирование. 

• Замена короткой стойки (9 слотов) на длинную (18 слотов) для установки 
дополнительных модулей. Для стоек, сконфигурированных как стойки 
расширения (UR или ER с принимающими IM), принимающие IM автома-
тически перемещаются в последний слот.  

• В станции, первоначально спроектированной с длинной стойкой, стойка 
может быть заменена короткой для сокращения. 
Однако эта замена невозможна для длинных стоек, спроектированных как 
стойки расширения (UR или ER с принимающими IM).  

Замена управляющих систем C7 возможна всегда в следующих случаях: 

• Старая управляющая система C7 может быть всегда заменена на новую 
(порядковый номер с более высокими функциональными возможностями, 
а также версия встроенного программного обеспечения)  

• Функциональные возможности управляющей системы C7 расширяются 
(новая система C7 с дополнительными встроенными модулями).  

Последовательность действий 
Если Вам потребовалось заменить стойку с уже установленными модулями, 
управляющую систему C7, или ведомого в конфигурации станции, действуйте 
следующим образом:  

1. Выделите в конфигурации станции компонент, который Вы хотите 
заменить (например, стойку).  

2. В окне каталога аппаратуры выделите компонент, совместимый с заменя-
емым (см. ниже), который имеет другой порядковый номер. Выделяются 
идентичные компоненты. Для ведомых DP, в окне каталога аппаратуры 
для замены выделяется интерфейсный модуль (например, IM 153-2).  

3. Дважды щелкните на требуемом компоненте в каталоге аппаратуры. Если 
компоненты совместимы, они заменяются, и модули из исходной конфигу-
рации сохраняют настройку адресов и параметров (вплоть до новых 
возможностей).  

Замена также возможна с использованием буксировки методом drag-and-drop 
компонента из каталога аппаратуры на заменяемый элемент.  
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Какие стойки "совместимы"? 
Стойка станции SIMATIC 400 может быть заменена на другую, только при 
соблюдении следующих основных правил. Если одно или несколько основных 
правил не выполняются, то STEP 7 не разрешает замену и прерывает проце-
дуру с сообщением об ошибке, предоставляющим информацию  о причине 
прекращения процедуры.  

• Сегментированная стойка (CR2) не может быть заменена 
несегментированной (например, UR1) и наоборот.  

• Вы должны иметь возможность вставить все модули заменяемой стойки в 
новую стойку, то есть никакие правила слотов не должны нарушаться при 
установке модулей в новую стойку.  

Пример 1: Не разрешается попытка заменить стойку UR1 с установленным 
CPU на стойку расширения ER1. Установка  CPU в ER1 запрещена 
правилами слотов – CPU нельзя установить в ER1.  

Пример 2: Не разрешается попытка заменить сегментированную централь-
ную стойку CR2 станции S7-400 на универсальную стойку (например, UR1). 
Слоты с модулями из двух сегментов не могут быть однозначно сопоставле-
ны слотам в иной, не сегментированной стойке и наоборот. Таким образом, 
стойка CR2 может быть заменена только на стойку CR2 с другим порядковым 
номером, например, чтобы обеспечить установку  модулей с резервирова-
нием питания без того, чтобы проводить все конфигурирование снова.  

Какие управляющие системы C7 "совместимы"? 
Управляющая система C7 содержит встроенные модули (CPU и I/O) и может 
быть замена на другую, если выполняются следующие правила:  

• Для каждого слота (строки в конфигурационной таблице) новой 
управляющей системы C7, соответствующий слот в старой управляющей 
системе C7 удовлетворяет следующим условиям: 

- Нет модуля 

- Есть идентичный или допускающий замену модуль (применимо и к 
CPU) 

• Новая управляющая система C7 имеет столько же подобных или больше 
встроенных модулей в сравнении с заменяемой системой. 

Какие ведомые DP "Совместимы"? 
Если требуется заменить  ведомые DP, то замена возможна только в 
пределах одного семейства, например, внутри семейства ET 200M . Ведомые 
DP могут быть также отображены в NetPro; однако, их замена может быть 
произведена только в приложении Configuring Hardware.  

К модульным ведомым применимы те же самые основные правила замены в 
отношении стоек: все вставленные модули должны разместиться в новом 
ведомом DP и функциональные возможности старого ведомого DP должны 
поддерживаться новым устройством.  

Если сконфигурированы функции, которые используются в более чем одной 
станции, например прямая передача данных между двумя ведомыми DP, Вы 
должны обеспечить эту конфигурацию в новом ведомом DP.  
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Следующая таблица дает информацию о семействах ведомых DP:  

  
Тип ведомого DP  Заменяемость  Условия замены 

Ведомые DP, свойства 
которых заданы файлами 
GSD (дополнительная 
информация...)  

Нет - 

DP-As-i Link Нет - 
DP/PA Link Да Не должна быть превышена максимальная 

конфигурация мастера DP (адресное пространство 
входов и выходов, число слотов) 
Резервировано работающий DP/PA link может быть 
заменено только на DP/PA link, поддерживающий 
резервирование. 

ET 200L SC и IM SC Да Вы должны иметь возможность установить все 
модули в нового ведомого DP. 

ET 200M (IM 153-x) Да Замена невозможна: 
• Если у старых ET 200M, включена функция 

"Change Modules during Operation [замена 
модулей в процессе функционирования]", а 
новые ET 200M не поддерживают эту функцию 

• Для CP/FM с собственным адресом MPI 
(например, FM 353) 

• Если модули, вставленные в старый ET 200M, 
не могут быть вставлены в новый  ET 200M 

• Если старый ET 200M работал зарезервирвано, 
а новый ET 200M не поддерживает 
резервирование  

ET 200S (IM 151-1) Да Замена невозможна для IM 151/CPU 
ET 200S (IM 151/CPU) Да Замена невозможна для IM 151-1 
ET 200X  
(X-BM 141.., X-BM 142..) 

Да Вы должны иметь возможность разместить все 
вставленные модули в нового ведомого DP. 
X-BM 143/DESINA не могут быть заменены на другие 
базовые модули ET 200X  и наоборот. 
Замена невозможна для X-BM 147/CPU 

ET 200X BM 147/CPU Да Замена невозможна для X-BM 141..., X-BM 142... и  
X-BM 143... 

Какие ведомые DP описываются файлами GSD? 
Ведомые DP, свойства которых описываются файлами GSD (файлы базы 
данных устройств), расположены в каталоге аппаратуры в папке "Other Field 
Devices [Прочие полевые устройства]» и далее, например, в папке "CP 342-5 
as DP-Master [CP 342-5 как ведущий DP]". Эти ведомые DP (называемые 
также "Standard Slaves [Стандартные ведомые]") можно идентифицировать, 
указывая файл GSD или печатая файл в строке "Order no. [Порядковый 
номер]»  или в диалоге "DP Slave properties [Свойства ведомого DP]» на 
закладке «General [Общее]». 
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1.3.3 Отображение информации о компонентах в каталоге 
аппаратуры 

Вы имеете доступ из HW Config через Internet к информации о модулях и 
компонентах.  

Предпосылки 
Ваш программатор (PG) подключен к Internet и на нем установлен браузер 
для просмотра страниц Internet. 

Тогда информация о модулях доступна через Internet. (Точный диапазон 
информации зависит от модуля и времени, когда Вы ищете информацию). 

Вы должны разрешить функцию в HW Config (команда меню Options > 
Customize [Возможности > Настройки]) выделить и найти соответствующую 
страницу в Internet.  

Последовательность действий 
1. Выделите компонент, информация о котором необходима Вам, в каталоге 

аппаратуры или в модульной. 

2. Щелкните правой кнопкой мы для отображения контекстного меню: 
Product Support Information [Информационная поддержка продукта] 
FAQs [Часто задаваемые вопросы] 

Если станица Internet доступна, она содержит связи с FAQ или информацией 
о продукте для выбранного модуля 

Другие источники информации 
Страница помощи для выбора свойств компонента или зависимая от модуля 
помощь по сообщениям также предусматривают связь с "More Information and 
FAQ [Более детальная информация и часто задаваемые вопросы]” . STEP 7 
автоматически отыскивает соответствующую информацию в Internet. 
Результат этого поиска отображается в браузере.  
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1.3.4 Обновление установленной аппаратуры 

Начиная с версии STEP 7 V5.2., Вы можете впоследствии инсталлировать 
компоненты в каталог аппаратуры. 

В этом случае Вы можете применять отдельные компоненты, например, 
новые CPU или устройства ввода-вывода, используя текущую версию STEP 7 
без установки нового service pack.  

Основная информация об обновлении аппаратуры 
Обновление каталога аппаратуры выполняется в два этапа: 

• Загрузка и обновление через Internet или копирование с CD 
соответствующей папки.  

• Установка загруженной или скопированной версии аппаратуры.  

Когда это выполнено, эти установленные впоследствии компоненты 
становятся доступны в варианте каталога "Standard". При необходимости, 
эту процедуру можно выполнить так, что можно будет редактировать 
станцию, созданную в старой версии STEP 7.  

Предпосылки 
Вы должны установить адрес Internet и путь к папке хранения "HW Updates". 
Чтобы выполнить эти установки, нажмите кнопку «Customize 
[Пользовательские настройки]» для открытия диалога конфигурирования 
процедуры обновления каталога аппаратуры. 

Вы должны иметь соединение с Internet для загрузки изменений. 

Последовательность действий 
1. Выберите команду меню Options > Install HW Updates. 

3 В появившемся диалоговом окне определите, данные какой аппаратуры 
Вы желаете или загрузить через Internet, или скопировать с CD, или  
Вы хотите установить уже загруженные обновления (выбор доступен)  

4 Выберите элемент для инсталляции и нажмите кнопку "Install 
[Установить]".  
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2 Конфигурирование центральных стоек  

2.1 Правила размещения модулей (SIMATIC 300) 

2.1.1 Правила размещения модулей (SIMATIC 300) 

Основное правило 
Модули должны располагаться друг за другом без пропусков. 

Исключение: В структуре стойки Вы должны оставить свободным один слот в 
конфигурационной таблице (зарезервирован для интерфейсного модуля). У 
S7-300 это слот 3, у М7-300 – слот, следующий за комплектом модулей (слот 
3, 4, 5 или 6). В фактической структуре пропусков нет, так как иначе 
произошел бы разрыв задней шины! 

Слот остается свободным

S7-300
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Правила для слотов (S7-300) 
Стойка 0: 

• Слот 1: Только блок питания (напр., 6ES7 307-...) или пустой 

• Слот 2: Только CPU (напр., 6ES7 314-...) 

• Слот 3: Интерфейсный модуль (напр., 6ES7 360-.../361-...) или пустой 

• Слоты с 4 по 11: Сигнальные или функциональные модули, 
коммуникационные процессоры или пустые 

Стойки с 1 по 3: 

• Слот 1: Только блок питания (напр., 6ES7 307-...) или пустой 

• Слот 2: Пустой 

• Слот 3: Интерфейсный модуль 

• Слоты с 4 по 11: Сигнальные или функциональные модули, 
коммуникационные процессоры (в зависимости от используемого 
интерфейсного модуля) или пустые 

Что следует знать о правилах, относящихся к слотам, и прочих правилах?  

Особые правила для пустого модуля (DM 370 Dummy)  

Особые правила для цифрового имитационного модуля  
SIM 374 IN/OUT 16 

Особые правила для M7-300 

2.1.2 Особые правила для пустого модуля (DM 370 Dummy) 

Пустой модуль (DM 370 Dummy) – это модуль, который Вы можете установить 
вместо модуля, который предполагается использовать в будущем. 

Этот модуль, в зависимости от положения переключателя, сохраняет 
свободным адресное пространство для модуля. Например, резервируется 
адресное пространство для модуля цифрового ввода/вывода или нет для 
интерфейсного модуля. 

  
Положение переклю-
чателя на DM 370 

Dummy 

Значение  Номер для заказа 

A Адресное пространство 
резервируется 

Модуль в модульном 
ведомом DP ET 200M: 
резервируется адресное 
пространство в 0 байтов 

6ES7 370-0AA01-0AA0 

NA Адресное пространство 
не резервируется 

Отсутствует 

(модуль "невидим"; он не 
конфигурируется) 
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2.1.3 Особые правила для цифрового имитационного модуля  
SIM 374 IN/OUT 16 

С помощью цифрового имитационного модуля SIM 374 IN/OUT 16 Вы можете 
имитировать цифровые входы и выходы 

Это модуль Вы не найдете в окне каталога аппаратуры "Hardware Catalog"! 
Вместо SIM 374 Вы должны поместить в конфигурационной таблице модуль, 
подлежащий имитации"!. 

  
Положение переключателя на SIM 374 

IN/OUT 16 
Модуль, который следует 

поместить в таблицу 
16xOutput [16 выходов] 6ES7322-1BH00-0AA0 

8xOutput 8xInput [8 выходов 8 входов] 6ES7323-1BH00-0AA0 

16xInput [16 входов] 6ES7321-1BH00-0AA0 

2.1.4 Особые правила для M7-300 

Когда Вы конфигурируете комплект модулей М7-300, каждый модуль этого 
комплекта занимает один слот. 

Если первым модулем комплекта является CPU М7-300, то следующий слот 
после комплекта модулей может быть занят только одним из интерфейсных 
модулей или остается свободным. 

Комплект модулей (M7-300) 
Комплект модулей М7-300 образуется, если Вы дополняете CPU M7 или FM 
M7 (функциональный модуль) модулями расширения (ЕХМ) или модулем 
массовой памяти (MSM). Все модули в комплекте связаны друг с другом 
шиной AT-ISA и образуют собственно компьютер для решения задач 
автоматизации. 

Разместите в конфигурационной таблице сначала основной модуль (CPU M7 
или FM M7), а затем модули расширения. Иначе модули расширения не 
устанавливаются! 

Размещение модулей внутри комплекта (M7-300) 
Комплект модулей обуславливает новые правила для слотов. 

• CPU M7 или допускающий расширение FM M7 всегда является первым 
модулем комплекта. 

• Модуль массовой памяти (может быть установлен только один!) всегда 
является последним модулем внутри комплекта. 

• CPU M7 или FM M7 может быть дополнен не более чем 3 модулями (MSM 
или EXM).  
Допустимое количество модулей расширения указывается в документации 
на соответствующие FM M7. 
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2.2 Правила размещения модулей (SIMATIC-400) 

2.2.1 Правила размещения модулей (SIMATIC-400) 

Правила размещения модулей в стойке S7-400 зависят от типа применяемой 
стойки. 

Центральная стойка  
Используются следующие правила: 

• устанавливать блоки питания только в слоте 1 (исключение: 
резервируемые блоки питания) 

• устанавливать не более 6 интерфейсных модулей (передающих IM), из 
них не более 2 с передачей питания 

• подключить к центральной стойке через интерфейсные модули не более 
21 стойки расширения  

• подключить к интерфейсу передающего IM (IM 460-1 с IM 461-1) не более 
1 стойки расширения с передачей тока;  

• подключить к интерфейсу передающего IM не более 4 стоек расширения 
без передачи тока (IM 460-0 с IM 461-0 или IM 460-3 с 461-3)  

Стойки расширения  
Используются следующие правила: 

• устанавливать блоки питания только в слоте 1 

• устанавливать интерфейсный модуль (принимающий IM) только в крайнем 
правом слоте (слот 9 или слот 18). 

• устанавливать модули коммуникационной шины (K-шины) только в стойке, 
номер которой не выше 6 (иначе обращение к нему невозможно) 
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2.2.2 Особые правила для резервируемых блоков питания (S7-
400) 

Резервируемые блоки питания могут устанавливаться в одной стойке 
дважды. Эти модули можно определить по информационному тексту в окне 
каталога аппаратуры "Hardware Catalog".  

Следует учитывать следующие правила: 

• установка резервируемых блоков питания возможна только в 
предназначенных для этого стойках (распознаются по большему 
заказному номеру и по информационному тексту в окне каталога 
аппаратуры "Hardware Catalog"); 

• резервируемые блоки питания могут эксплуатироваться только вместе с 
предназначенными для этого CPU; непригодные CPU (напр., более старой 
версии) при конфигурировании отвергаются; 

• резервируемые блоки питания должны устанавливаться в слот 1 и 
следующий свободный слот (пропуски недопустимы!); 

• резервируемые и не резервируемые блоки питания не могут вставляться в 
одну и ту же стойку (т. е. "смешанная эксплуатация» невозможна) 

2.2.3 Особые правила для M7-400 

Комплект модулей М7-400 образуется, если Вы дополняете CPU M7 или FM 
M7 (прикладной модуль) модулями расширения (ЕХМ, АТМ) или модулем 
массовой памяти (MSM).  

Разместите в конфигурационной таблице сначала основной модуль (CPU M7 
или FM M7), а затем модули расширения. Иначе модули расширения не 
устанавливаются! 

Размещение модулей внутри комплекта (M7-400) 
Используются следующие правила: 

• установить не более одного модуля массовой памяти (MSM); 

• дополнить CPU M7 не более чем 3 модулями (EXM, ATM или MSM); 

• размещать модули комплекта справа рядом с CPU M7 только в 
следующей последовательности: 

- модуль (модули) EXM, 

- модуль MSM,  

- модуль ATM. 
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2.2.4 Особые правила для интерфейсного модуля PROFIBUS-DP  
(M7-400) 

Если Вы используете интерфейсный модуль для PROFIBUS-DP в системе 
автоматизации М7-400 (напр., IF 964-DP в качестве ведущего DP), обратите, 
пожалуйста, внимание на то, что: 

• под этим модулем никакой другой интерфейсный модуль не может быть 
установлен в CPU, FM или EXM; 

• интерфейс CPU, FM или EXM, находящийся под этим интерфейсным 
модулем, не может быть использован. 

Причина: Штекер подключения шины PROFIBUS-DP перекрывает 
нижележащее гнездо для вставки модуля / нижележащий интерфейс. 

Рекомендация: Вставляйте интерфейсный модуль для PROFIBUS-DP только 
в самое нижнее или находящееся снизу слева гнездо для модуля CPU, FM 
или EXM. 
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2.3 Как конфигурировать центральные стойки 

2.3.1 Создание станции 

Предпосылка 
Вы открыли SIMATIC Manager и открыли или создали новый проект. 

Последовательность действий 
Станция может создаваться только непосредственно под проектом. 

1. Выделите проект в левой части окна проектов. 

5 Выберите команду меню Insert > Station > SIMATIC 300-Station, 
[Вставить > Станция > Станция SIMATIC 300] или ... > SIMATIC 400-
Station.. 
Станция создается с именем, данным по умолчанию. Вы можете заменить 
имя станции другим, более информативным. 

 

2.3.2 Вызов приложения для конфигурирования аппаратуры 

Предпосылка 
Вы создали станцию (SIMATIC 300, SIMATIC 400). 

Последовательность действий 
1. Выделите в окне проектов объект "Station", так что в правой части окна 

станции становится видимым объект "Hardware [Аппаратура]". 
 

 
Объект "Station" 

6 Дважды щелкните на объекте "Hardware» Дважды щелкните на объекте 
"Hardware". 
 

 
Объект "Hardware" 
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В качестве альтернативы Вы можете также выделить объект «Station 
[Станция]» и выбрать команду меню Edit > Open Object [Редактировать > 
Открыть объект], 

Результат: На экране появляются окно станции и каталог модулей (если 
он был открыт при завершении предыдущего сеанса). В окне станции Вы 
можете поместить стойку и прочие компоненты в соответствии со 
структурой станции; из каталога модулей (окно "Hardware Catalog [Каталог 
аппаратуры]") выберите необходимые для построения станции 
компоненты. 

Открытие других станций 
Командой меню Station > New [Станция > Новая] Вы можете сконфигуриро-
вать в том же проекте еще одну станцию; командой Station > Open [Станция 
> Открыть] – открыть существующую (Offline) конфигурацию станции для 
редактирования. 

2.3.3 Проектирование центральной стойки 

Предпосылка 
Окно станции открыто, и у Вас есть план конфигурации аппаратуры станции.  

Последовательность действий 
1. В окне ”Hardware Catalog [Каталог аппаратуры]” выберите для вашей 

структуры центральную стойку (”Rack”). Для SIMATIC 300 это профильная 
шина (Rail), для SIMATIC 400, например, универсальную стойку (UR1). 

2. Отбуксируйте стойку, используя Drag&Drop, в окно станции. 
Стойка появляется в виде небольшой конфигурационной таблицы в 
верхней части окна станции. В нижней части окна станции появляется 
подробное представление стойки с дополнительными данными, 
например, заказным номером, адресом MPI, адресами входов/выходов.  
В качестве альтернативы шагам 1 и 2 Вы можете также дважды щелкнуть 
на стойке в окне ”Hardware Catalog [Каталог аппаратуры]”. 
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2.3.4 Размещение модулей в стойке 

Предпосылка 
Вы разместили в окне станции стойку, и она представлена не в минимизиро-
ванном виде (видны слоты стойки) 

Для визуального удобства выделения цветом подходящих для выбранного 
модуля слотов, Ваш дисплей должен быть настроен более чем на 256 цветов. 

Последовательность действий 
1. Выберите модуль (например, CPU) из окна ”Hardware Catalog [Каталог 

аппаратуры]”.  
Слоты, в которые можно установить этот модуль выделяются цветом. 

2. Отбуксируйте модуль, используя Drag&Drop, в соответствующую строку 
стойки (конфигурационная таблица). STEP 7 проверяет, не нарушены ли 
правила для слотов (CPU S7-300, напр., может быть установлен только в 
слоте 2). 
  

 
Символ нарушения 
правил для слотов 

7 Повторяйте шаги 1 и 2, пока стойка не будет полностью оснащена 
желаемыми модулями. 

В качестве альтернативы Вы можете также выделить соответствующую 
строку или несколько строк в конфигурационной таблице и дважды щелкнуть 
в окне каталога аппаратуры «Hardware Catalog [Каталог аппаратуры]» на 
желаемом модуле. Если выделено несколько строк, то все выделенные 
строки будут оснащены этим модулем сразу. 

Совет 
Когда Вы выделите слот в стойке модулей, Вы можете увидеть список всех 
возможных для установки модулей, открыв контекстно-зависимое меню 
(правой кнопкой мыши) Insert Object [Вставить объект] или Replace Object 
[Заменить объект]. Эта возможность избавляет Вас от необходимости 
поиска в каталоге аппаратуры. Вы выбираете из всех модулей, которые 
имеются в текущем открытом профиле каталога. 

Отображение интерфейсов и интерфейсных модулей 
Интерфейсы или интерфейсные модули отображаются в конфигурационной 
таблице в собственной строке. Эта строка обозначена также как и коннектор 
интерфейса (напр., Х1), или – если модуль имеет гнезда для установки 
интерфейсных модулей – префиксом "IF» (напр., IF1).  

В случае встроенных интерфейсов имя интерфейса появляется в столбце 
"Module [Модуль]", в случае модулей с гнездами для установки интерфейс-
ных модулей Вы можете перенести подходящий интерфейсный модуль (IF) 
из окна «Hardware Catalog [Каталог аппаратуры]» в соответствующую строку, 
используя Drag&Drop. 
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2.3.5 Отображение версии операционной системы CPU в окне 
'Hardware Catalog'  

Если CPU имеет более одной версии операционной системы, этот CPU 
показан в окне «Hardware Catalog [Каталог аппаратуры]» как папка с 
иконками, имеющими разные порядковые номера. Различные версии 
операционной системы CPU показаны, как порядковый номер иконок. 

Пожалуйста, проверьте версию операционной системы Вашего CPU и 
выберите правильную версию в окне "Hardware Catalog". 

Текущая версия операционной системы

Старая версия операционной системы

 

2.3.6 Проектирование управляющих систем C7 (особенности) 

В управляющей системе C7 (напр., C7-620) в одном корпусе встроены 

• CPU SIMATIC 300  

• входы и выходы (цифровые и аналоговые) 

• интерфейсный модуль IM 360 для подключения других модулей SIMATIC 
300 

• строковая панель оператора с портом для принтера 

Упрощение процесса 
Управляющая система С7 не монтируется на профильной шине, – поэтому 
отпадает необходимость размещения стойки. 

Предпосылка 
Станция должна быть открыта в окне ”Hardware Catalog». 
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Последовательность действий 
1. Выберите управляющую систему С7 из окна "Hardware Catalog". Эту 

систему можно найти под SIMATIC 300. 

2. Отбуксируйте управляющую систему С7, используя Drag&Drop, в окно 
станции. 

3. Если Вы хотите расширить управляющую систему С7: 

- Выберите в окне «Hardware Catalog [Каталог аппаратуры]» в качестве 
стоек профильные шины. 

- Отбуксируйте стойки друг за другом, используя Drag&Drop, в окно 
станции. 

- Разместите в стойках модули. Важно: Интерфейсные модули должны 
быть установлены во всех стойках, чтобы было возможно соединение! 

2.3.7  Параметризация модулей и интерфейсов 

Введение 
Свойствами таких компонентов, как модули или интерфейсы, являются 
адреса и параметры. Прочитайте следующие разделы только в том случае, 
если Вы хотите изменить значения, установленные по умолчанию. 

Предпосылка 
Вы разместили компоненты, свойства которых хотите изменить, в 
конфигурационной таблице. 

Последовательность действий 
Каждый компонент (модуль, интерфейс или интерфейсный модуль) имеет 
свойства, установленные по умолчанию, напр., заранее установленные виды 
и диапазоны измерений в случае аналоговых модулей. 

Если Вы хотите изменить эти настройки, то действуйте следующим образом: 

1. Дважды щелкните в конфигурационной таблице на компоненте, 
подлежащем параметризации (напр., на модуле или интерфейсном 
модуле) или выделите строку и выберите команду меню Edit > Object 
Properties [Редактировать > Свойства объекта]. 
Правой клавишей мыши: Переместите указатель мыши на компонент, 
щелкните правой клавишей мыши и выберите из всплывающего меню 
команду Object Properties [Свойства объекта]. 

2. Используя появившееся диалоговое окно, установите свойства 
компонента.  
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2.3.8 Назначение адресов 

При назначении адресов мы различаем назначение адресов узлам и 
назначение адресов входам/выходам.  

Адреса узлов – это адреса программируемых модулей (адреса MPI, 
PROFIBUS, Industrial Ethernet); они необходимы, чтобы иметь возможность 
обращаться к различным узлам подсети – например, чтобы загрузить 
программу пользователя в CPU. Информацию о задании адресов абонентов в 
подсети Вы найдете в главе о соединении станций в сеть. 

Адреса входов/выходов (I/O) необходимы для того, чтобы в программе 
пользователя считывать входы или устанавливать выходы. 

Особенность: адреса MPI функциональных модулей и коммуникационных 
процессоров в S7-300 

CP и FM с их собственными адресами MPI имеют особенность: их адреса MPI 
автоматически определяются центральным процессором по следующему 
образцу: 

• первый CP / первый FM после CPU: MPI-адрес CPU + 1 

• второй CP / второй FM после CPU: MPI- адрес CPU + 2 

Более новые CPU S7-300 (см. руководство или информацию о продукте) 
разрешают для таких CP и FM свободное задание адреса MPI 
(устанавливается через закладку "General [Общие (свойства)]» модуля).. 

2.3.9 Назначение адресов входов и выходов 

Адреса входов/выходов STEP 7 задает уже при размещении модулей в 
конфигурационной таблице. Благодаря этому каждый модуль имеет свой 
начальный адрес (адрес первого канала); адреса остальных каналов 
получаются из этого начального адреса 

Предпосылки 
• Модуль установлен в центральной стойке или стойке расширения, и CPU 

допускает свободное назначение адресов  

• Модуль установлен в ведомом DP или сам является ведомым DP 
(компактный ведомый DP) 

Последовательность действий 
1. Щелкните дважды на строке стойки с модулем, начальный адрес которого 

Вы хотите установить, или выделите соответствующий модуль и 
выберите команду меню Edit > Object Properties [Редактировать > 
Свойства объекта].  

2. Выберите закладку ”Addresses [Адреса]”. 

3. Измените начальный адрес, установленный по умолчанию. 
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 Указание 
Для модулей внутри локального сегмента шины, образованного функциона-
льным модулем (S7-300), или для специальных функциональных модулей 
(S7-400) задайте последующий начальный адрес. Наряду с начальным 
адресом для CPU модуль в этом случае имеет и начальный адрес для FM. В 
этом случае в общем отображении конфигурационной таблицы начальный 
адрес всегда представляется с точки зрения FM! 

Обзор адресов  

Уже использованные адреса входов и выходов и пропуски адресов Вы 
можете отобразить следующим образом: 

1. Откройте станцию, адреса которой Вы хотите просмотреть. 

2. Выберите команду меню View > Address Overview [Вид > Обзор адресов]. 

3. Выделите в диалоговом окне « Address Overview» модуль, назначенные 
которому входы и выходы должны быть отображены (напр., CPU). 

4. Если необходимо, Вы можете отфильтровать отображение по видам 
адресов (напр., только адреса входов) 

Отображаются адресные области входов и выходов с указанием размещения 
для модулей (номер мастер-системы DP, адрес PROFIBUS, стойка, слот, 
гнездо для интерфейсного субмодуля). Адреса входов, имеющие нулевую 
длину (напр., адреса интерфейсных модулей), обозначены звездочкой (*). 

2.3.10 Назначение символьных имен адресам входов и выходов 

Введение 
Уже при конфигурировании модулей Вы можете назначить входам и выходам 
символьные имена, не открывая для этого таблицу символов. 

При конфигурировании аппаратуры Вы можете назначать символьные имена 
только входам и выходам цифровых или аналоговых модулей. Для встроен-
ных входов/выходов (напр., CPU 312 IFM), для СР, FM и модулей S5 (напр., 
сконфигурированных через адаптационный модуль) Вы должны назначать 
символьные имена через таблицу символов. 

Присвоенные символьные имена при загрузке конфигурации в станцию 
(команда меню PLC > Download [ПЛК > Загрузить]) вместе с ней не 
загружаются. Следствие: если Вы выгружаете конфигурацию станции 
обратно в устройство программирования (команда меню PLC > Upload [ПЛК 
> Выгрузить]), то символика не отображается! 

Последовательность действий 
1. Выделите цифровой или аналоговый модуль, адресам которого Вы 

хотите присвоить символьные имена. 

2. Выберите команду меню Edit > Symbols [Редактировать > Символы] 
или нажмите правую клавишу мыши и выберите из контекстного меню 
команду Symbols [Символы]. В появившемся диалоговом окне Вы 
можете ввести требуемые символьные имена. 
Если Вы щелкнете на имеющейся в диалоговом окне кнопке "Add Symbol 
[Добавить символ]", то имя операнда вносится в качестве символа. 
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2.3.11 Наблюдение входов и изменение выходов при 
конфигурировании аппаратуры 

Введение 
Если с CPU установлено соединение online, и Вы загрузили конфигурацию 
оборудования в CPU, Вы может подключаться к адресам входов и выходов 
непосредственно, не изменяя пользовательскую программу. 

Выполните следующее: 

1. Выделите модуль, входы и выходы которого Вы будете наблюдать или 
изменять. 

2. Выберите команду меню PLC > Monitor/Modify. 
Команда меню может быть активирована только в том случае, если 
модуль может быть наблюдаем, или его выходы могут изменяться (напри-
мер, для модулей типа DI, DO, AI, или AO). Откроется диалоговое окно, 
отображающее в таблице входы и выходы модуля (колонка адресов). 
Входы и выходы будут отображаться в бинарном формате для цифровых 
модулей и в формате слова для аналоговых модулей. 

Наблюдение 
1. Активируйте бокс выбора Monitor [Наблюдение]. 

2. Нажмите на кнопку Trigger [Точка включения], чтобы изменить точку 
наблюдения и модификации переменных, а также частоту включения. Вы 
получите информацию об установках в помощи к диалоговому окну 
Trigger, которое открывается после нажатия кнопки. 

3. Если Вы хотите наблюдать периферийные входы непосредственно, 
активируйте бокс выбора I/O Display [Отображение входов и выходов]; 
если бокс выбора не активирован, будет наблюдаться область 
отображения входов. 

4. Если Вы выбрали однократную точку включения, Вы можете обновить 
отображение в колонке Status Value [Состояние переменной] нажав 
кнопку Status Values [Состояние переменной]. Значения остаются 
"замороженными» пока Вы не нажмете эту кнопку. 

Изменение 
При определенной точке включения: 

1. Введите в таблицу изменяемую переменную 

2. Нажмите кнопку "Trigger[Точки включения]", чтобы проверить или 
изменить точку или условия включения. Вы получите информацию об 
этих установках в помощи к диалоговому окну Trigger [Точки включения], 
которое открывается после нажатия кнопки. 

3. Активируйте бокс выбора "Modify [Изменение]". Изменяются все видимые 
переменные с изменяемыми. 



 Конфигурирование центральных стоек 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261404-01 2-15 

Однократное изменение переменных:  
Независимо от точки включения или установленных условий триггера Вы 
можете однократно присваивать значение переменным в отдельных 
операциях. Когда эта функция установлена, выполнимы действия типа 
"Trigger immediately [Немедленное включение]", без ссылки на определенную 
точку пользовательской программы. 

1. Введите в таблицу желаемое значение переменной. 

2. Нажмите кнопку "Modify values [Изменить величину]". 

Если Вы хотите непосредственно изменить периферийные выходы, 
активируйте бокс выбора I/O Display [Отображение входов и выходов]; если 
бокс выбора не активирован, управляет область отображения процесса. 

Если Вы также желаете изменять выходы непосредственно в режиме STOP, 
Вы должны активировать бокс выбора Enable PQ [Разрешение периферийных 
выходов]. В противном случае, выходы остаются в режиме STOP, и 
установлены в сконфигурированное подстановочное значение. 

Наблюдение изменяемых адресов 
Помните, что отображение в колонке "Status Value [Значение переменной]» 
зависит от заданной точки включения и от процесса в CPU (например, 
времени обновления области отображения). 

Вы должны установить точку включения для наблюдения. Вы должны 
установить точку включения для наблюдения в "Cycle Start [Начало цикла]» и 
точку включения для наблюдения в "Cycle End [Конец цикла]", чтобы 
модифицированная величина могла отображаться в колонке "Status Value 
[Значение переменной]"! 

Наблюдение и изменение вход-выходных модулей  
При наблюдении сигналов во вход-выходных модулях (например, 8DI/8DO), 
учтите, что точка наблюдения применима к модулю в целом. 

Если, например, Вы установили точку наблюдения в "Cycle Start [Начало 
цикла]", входы и выходы будут изменяться в этот. В этом случае, управление 
переменных для входов активировано, поскольку перезапись входных 
сигналов выполняется после обновления области отображения входов; то 
есть непосредственно перед выполнением циклической программы 
процессора. В этом случае, значения выходов будут переписаны 
пользовательской программой. 

Наблюдение и изменение распределенных входов и выходов 
Распределенные входы и выходы консистентно читаются функцией SFC 14 
"DPRD_DAT» и консистентно записываются функцией SFC 15 "DPWR_DAT". 
Чтобы получить доступ к действительным значениям при мониторинге, 
необходимо выполнить следующее: 

Должен быть предусмотрен входной параметр SFC "RECORD [ЗАПИСЬ]» с 
"I» (вход) или "O» (выход). Он должен точно соответствовать 
сконфигурированной области адресов, которая отображается в 
конфигурационной таблице ведомого DP в колонках e "I address [входные 
адреса]» или "O address [выходные адреса]". 
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Если для сохранения согласованных во времени данных выбираются 
различные области, нерелевантные области образа процесса отображаются 
в таблице для мониторинга. 

2.3.12 Конфигурирование CP точка-точка 

Введение в конфигурирование CP точка-точка (PtP)  
Как и для любого модуля, Вы перетаскиваете коммуникационный процессор 
из каталога аппаратуры в стойку и параметризируете его в конфигурационной 
таблице (Общие установки, адресация и основные параметры).  

Находясь на закладке Basic Parameters, Вы можете запустить дополнительно 
программное обеспечение для установки параметров интерфейса. 

Для CP PtP станций SIMATIC 400, Вы можете сконфигурировать соединения 
PtP. Следующий раздел описывает процедуру кратко. Более детальное 
описание имеется в руководстве по CP PtP. 

Конфигурирование соединений CP PtP для S7-400  
Для соединения между  CPU S7 и партнером с помощью интерфейса точка-
точка, связь представляет CP PtP.  

Вы должны сконфигурировать связь между CPU S7-400 и CP PtP.  

Действуйте следующим образом: 

1. Сконфигурируйте в HW Config CP PtP и, если коммуникационный партнер 
также CP PtP станции S7-400, сконфигурируйте и партнера.  

2. Запустите NetPro (из HW Config: команда меню Options > Configure 
Network [Дополнительные возможности > Конфигурирование сети]). 

3. Если подсеть PtP уже создана при конфигурировании CP PtP и CP 
подключен к сети, продолжите с шага 4;  
в ином случае, вставьте a PtP подсеть и свяжите с ней CP. 

4. Выберите партнера по соединению 

- Если партер по соединению CP 34x (CP PtP в станции S7-300), или CP 
PtP S5, принтер, или устройство другого производителя: 
сконфигурируйте в качестве коммуникационного партнера "Other 
Station [Прочую станцию]". Для "Other Station [Прочей станции]» 
сконфигурируйте интерфейс PtP и соедините этот интерфейс с 
созданной подсетью  PtP.  

- Партнер по соединению CP PtP для станции SIMATIC 400: 
Вы уже сконфигурировали партнера по соединению на шаге 1 и 
должны продолжить с шага 5. 

8 Загрузите данные конфигурации и соединения  в соответствующие 
станции.  
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2.3.13 Конфигурирование модулей S5 

Вы имеете возможность вставлять в станцию SIMATIC 400 модули S5. Эти 
модули подключаются через:  

• адаптационный модуль S5 (IM 470) или  

• IM 463-2 для подключения устройств расширения S5 с IM 314 

Эти модули Вы найдете в окне каталога аппаратуры "Hardware Catalog” в 
разделе "IM-400”. 
 

 Указание 
Для каждого соединения Вы должны сконфигурировать области входов или 
выходов модулей S5 (двойной щелчок на адаптационном модуле или IM463-
2, а затем выбрать закладку "Input Addresses [Адреса входов]» или "Output 
Addresses [Адреса выходов]”)! 

Если адресные области не сконфигурированы, то вышеназванные модули не 
сохраняются в системном блоке данных. Следствие: Конфигурация, 
загруженная в CPU, не содержит информации об этих модулях. Когда эта 
конфигурация загружается в PG, эти модули отсутствуют в 
конфигурационной таблице! 
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2.4 Дополнение центральной стойки стойками 
расширения 

Конфигурирование стоек расширения для SIMATIC 300 
Для станций SIMATIC 300 как в качестве центральной стойки, так и в качестве 
стоек расширения используются только профильные шины; т. е. Вы 
размещаете столько профильных шин (не более 4), сколько имеется в 
наличии в реальной конструкции. 

Стойки расширения соединяются в STEP 7 путем установки в каждой стойке 
соответствующих интерфейсных модулей в слот 3. 

• Для расширения только на одну стойку:  
в стойках 0 и 1: IM 365  

• Для подключения до трех стоек расширения: 
стойка 0: IM 360; стойки с 1 по 3: IM 361 

Конфигурирование стоек расширения для SIMATIC 400 
У SIMATIC 400 возможности расширения из-за наличия различных стоек и 
интерфейсных модулей реализуются сложнее. 

Все стойки расширения, которые подключены к одному интерфейсу 
передающего IM центральной стойки, образуют каскад. 

На следующем рисунке к каждому интерфейсу передающего IM подключены 
по три стойки расширения. 

 

1

Центральная стойка

1 2 31 2 3

Стойки расширения

4 5 6

C1

C2
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2.4.1 Правила соединения стоек расширения (SIMATIC 400) 

Если Вы соединяете стойки расширения (SIMATIC 400) с интерфейсным 
модулем (передающим IM) центральной стойки, то должны быть согласованы 
следующие свойства передающего и принимающего IM:  

• Передача тока (с/без) 

• Вид соединения (централизованное/децентрализованное) 

• Передача по коммуникационной шине (с передачей или без передачи 
прерывания) 

2.4.2 Размещение стойки расширения (SIMATIC 400) 

Последовательность действий 
1. Выберите подходящие стойки (расширения) из каталога аппаратуры 

”Hardware Catalog”. 

2. Отбуксируйте эти стойки друг за другом, используя Drag&Drop, в окно 
станции. 

3. Если Вы хотите изменить номер стойки:  
Щелкните дважды на 2-й строке стойки в верхней части окна станции. В 
закладке "General [Общие (свойства)]» стойки Вы можете изменить номер. 

4. Разместите в стойках модули. 
Важно: Интерфейсные модули должны быть установлены во всех 
стойках, чтобы Вы могли соединить стойки друг с другом! 

5. Только для S7-400: Сделайте соединения между интерфейсными 
модулями в стойках: 

• Щелкните дважды на передающем IM 

• Выберите закладку ”Connect [Соединение]”. 
В этой закладке отображены все несоединенные стойки (стойки с 
установленными принимающими IM). 

• Выделяйте стойки по отдельности и подключайте с помощью 
экранной кнопки ”Connect [Соединить]” к желаемому интерфейсу 
передающего IM (C1 или C2). 
После этого соединительные линии покажут размещение стоек друг 
под другом. 
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2.4.3 Особый случай: в центральной стойке - несколько CPU 

Если Вы хотите дополнить стойками конфигурацию, состоящую из 
сегментированной стойки CR2 (S7-400), или многопроцессорную 
конфигурацию, то Вы должны соблюдать следующую последовательность: 

1. Сконфигурируйте центральную стойку (напр., CR2) с передающим IM. 

2. Вставьте в стойку расширения только принимающий IM. 

3. Установите соединения между интерфейсными модулями (IM), как 
описано выше. 

Только тогда Вы можете устанавливать модули в стойку расширения. 
Причина: Так как при наличии нескольких CPU адресное пространство не 
единственно, то стойка расширения сначала должна быть приписана 
некоторому адресному пространству (=CPU).  
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3 Конфигурирование 
децентрализованной периферии (DP) 

Введение 
Децентрализованной периферией мы называем мастер-системы, состоящие 
и ведущего и ведомых DP, связанных шинным кабелем и обменивающиеся 
между собой информацией через протокол PROFIBUS-DP. 

Так как в качестве ведущих и ведомых DP может быть использовано 
различное оборудование, то здесь объясняется только принципиальная 
последовательность действий при конфигурировании. 
Частности, относящиеся к набору функций, к методам доступа и т. д., Вы 
найдете в руководствах к соответствующим устройствам или в online-помощи 
к конкретным FC (напр., DP-SEND и DP-RECEIVE для CP 342-5). 

3.1 Основная последовательность действий при 
конфигурировании мастер-системы DP 

Если Вы знаете, как в принципе конфигурируется централизованная 
структура, то Вы знаете также и то, как сконфигурировать 
децентрализованную периферию – последовательность действий в 
значительной степени одинакова. 

Окно станции как отображение реальной мастер-системы DP 
Когда Вы размещаете ведущего DP (напр., CPU 315-2DP), то STEP 7 
автоматически рисует линию, представляющую мастер-систему. В конце 
линии Вы помещаете ведомые DP, соответствующие этому ведущему, 
перетаскивая их из окна каталога аппаратуры "Hardware Catalog", раздел 
"PROFIBUS-DP". 

Так как мастер-система DP всегда связана с подсетью PROFIBUS, то STEP 7 
при размещении компонентов DP автоматически выводит на экран диалоги 
для определения свойств подсети (напр., скорости передачи) и адреса 
PROFIBUS.  
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Ведомый DP отсутствует в окне каталога аппаратуры 
Если ведомый DP отсутствует в окне каталога аппаратуры , то после запуска 
STEP 7 Вы должны установить соответствующий GSD-файл с помощью 
команды меню Options > Install New *.GSE Files [Возможности > Установка 
нового GSD]. Последующий диалог позволит Вам установить GSD-файл. 
После этого установленный ведомый DP появляется в окне «Hardware 
Catalog [Каталог аппаратуры]» в разделе "PROFIBUS-DP – Other Field Devices 
[PROFIBUS-DP – Прочие полевые устройства]". 

Подробное представление выделенного ведомого DP
  

Конфигурация ведомого в детальном представлении 
Когда Вы выделяете ведомого DP, то его структура (идентификаторы DP и 
модули/субмодули) и адреса входов/выходов отображаются в подробном 
представлении окна станции. 

Переход в детальном представлении окна станции между мастер-системой 
и ведомым DP 

Когда Вы выделяете символ для мастер-системы DP ( ), то в 
нижней части окна станции отображаются все ведомые DP этой мастер-
системы DP. Когда Вы выделяете символ ведомого DP, то в нижней части 
окна станции отображается структура выделенного ведомого DP. Вы можете 

просто переключать эти отображения, используя экранные кнопки  и  .  
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Нумерация слотов в устройствах децентрализованной периферии 
В зависимости от того, какой тип ведомого DP Вы конфигурируете, слоты в 
подробном представлении ведомого DP начинаются с «0» или с "4". 

У ведомых DP, которые конфигурируются с помощью GSD-файлов, GSD-
файл указывает, с какого слота начинаются периферийные адреса; слоты до 
него - "пустые". 

Нумерация слотов таких ведомых DP, как ET 200M, которые полностью 
встроены в STEP 7, выводится из структуры станции S7-300 по следующей 
схеме: 

  

PS CPU IM I/O ...S7-300
(центральное
устройство)

"PS" Интер-
фейс-
ный

модуль
DP

IM I/O ...

Слот 1 2 3 4

Децентрализован-
ное периферийное
устройство

  

  

Примечания к слотам ведомого DP, структура которого аналогична структуре 
станции S7-300: 

• Собственная» периферия (входы/выходы) всегда начинается со слота 4. 

• Независимо от того, стоит ли блок питания (PS) в реальной структуре или 
нет: слот 1 всегда резервируется для "PS". 

• Слот 2 всегда резервируется для интерфейсного модуля DP.  

• Слот 3 всегда резервируется для интерфейсного модуля расширения (IM), 
независимо от того, является "реальное» периферийное устройство 
расширяемым или нет. 

Эта схема применима ко всем типам ведомых DP, как к модульным, так и к 
компактным. Назначение слотов важно для анализа диагностических 
сообщений ("слот, запускающий диагностику"). 
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3.2 Где можно найти ведомые DP в окне каталога 
аппаратуры? 

Все ведомые DP Вы найдете в окне каталога аппаратуры "Hardware Catalog” в 
разделе "PROFIBUS-DP”. 

Здесь имеют силу следующие особенности: 

Ведущий DP – это … 
• ... CPU SIMATIC 300 или SIMATIC 400 со встроенным интерфейсом 

PROFIBUS-DP или CP PROFIBUS (кроме CP 342-5DA00): 
Ведомые DP Вы найдете по названию их семейства (напр., ЕТ 200В). 

• ...CP 342-5DA00 с интерфейсом PROFIBUS-DP: 
Ведомые DP Вы найдете в папке "DP V0 Slaves” и далее по названию их 
семейства. 

Папка "DP V0 Slaves» содержит ведомых DP, представленных их файлами 
GSD или файлами типа (смотрите "Стандартные ведомые").  

Папки, обозначенные именами семейств (например, ET 200B), содержат 
Ведомые DP, свойства которых представлены внутренней информацией 
STEP 7 (названные "S7 Slaves").  

Ведомый DP приобретенный отдельно (с новым файлом *.GSD) 
После того как Вы установили GSD-файл, Вы найдете ведомого DP в папке 
"Other Field Devices [Прочие полевые устройства]”. 

Интеллектуальный ведомый DP  
Примеры: В качестве ведомого DP Вы можете запроектировать станцию с 

• CP 342-5 DP 

•  CPU 315-2 DP, CPU 316-2 DP, CPU 318-2 DP 

•  Базовые субмодули ET 200X (BM 147/CPU) 

• IM 151/CPU (ET 200S) 

После конфигурирования станции Вы найдете ведомого DP в папке 
"Configured Stations [Спроектированные станции]”. Последовательность 
действий (как станция попадает в эту папку?) подробно описана в разделе об 
интеллектуальных ведомых DP. 

 



 Конфигурирование децентрализованной периферии (DP) 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261404-01 3-5 

3.3 Запись и чтение распределенных консистентных 
данных (> 4 байт) 

Ранее, Вы использование консистентных данных (> 4 байт) ведомых DP 
выполнялось с использованием SFC 14 и SFC 15.  

Начиная с версии 3.0 CPU 318-2 и CPU 41x, Вы имеете возможность 
использовать консистентные данные обращением к области отображения 
(например, L IW).  

Проектирование консистентных областей данных > 4 байт 
1. В аппаратной конфигурации выберите закладку "Addresses[Адрес]» для 

ведомого DP. 
В зависимости от типа ведомого DP, может быть или определена как 
стандартная настройка по умолчанию, которая не может быть изменена 
(определена в файле GSD), или Вы можете определить область 
консистентных данных в полях "Length [Длина]", "Unit [Модуль]» и 
"Consistency via [Консистентность через]". 

2. При необходимости, определите длину консистентной области и введите 
эту область в отображение процесса. Далее действуйте так: В поле 
"Process image partition", выберите OB1-PI или, в случае S7-400, выберите 
другую область отображения периферии (PIP), например, PIP 3. Если Вы 
не хотите помещать данные в область отображения процесса, Вы должны 
использовать SFC 14 или SFC 15 для обмена данных.  

  

При обновлении области отображения операционная система передает 
данные консистентно, и Вы можете использовать команды загрузки и 
передачи для доступа к данным в области отображения. Это обеспечивает 
Вам более простой и эффективный (более быстрое выполнение загрузки) 
способ использования консистентных данных. 
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3.4 Проектирование PROFIBUS-DP 

В следующих разделах приведены примеры проектирования систем с 
PROFIBUS-DP, созданных в STEP 7. 

• Проект с простым ведомым DP (модульным или компактным) (Обмен 
данных: Slave <> Master)  

• Проект с интеллектуальным ведомым DP (Обмен данных: Slave <> Master)  

• Проект с интеллектуальными ведомыми DP (Прямой обмен данных: Slave 
> I Slave)  

• Проект с двумя мастер-системами DP (Прямой обмен данных: Slave > 
Master)  

• Проект с двумя мастер-системами DP (Прямой обмен данных: Slave > I 
Slave)  

• Пример конфигурирования прямого обмена данных (Побочные 
соединения)  

3.4.1 Проект с простым (модульным или компактным) ведомым 
DP (обмен данных: Slave <> Master) 

В этой конфигурации обмен данными между DP и простым ведомым DP, 
например, модулями ввода-вывода, происходит под управлением мастера 
DP. Мастер DP один за другим опрашивает ведомые DP, 
сконфигурированные в списке опроса мастер-системы DP и передает 
выходные данные или принимает входные данные от ведомых DP. Адреса 
входов и выходов назначаются автоматически при конфигурировании 
системы. 

Эта конфигурация известна также как мономастер-система, так как к одной 
физической подсети PROFIBUS DP подключен один мастер со своей 
системой ведомых DP. 

ВедущийDP

Ведомый DP

Мастер-система DP

Ведомый DP Ведомый DP
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3.4.2 Проект с интеллектуальным ведомым DP (Обмен данных: 
Slave <> Master) 

Вы можете разделить задачу автоматизации на частные подзадачи, которые 
управляются программируемыми логическими контроллерами верхнего 
уровня. Эти задачи управления, которые могут быть завершены независимо и 
эффективно, выполняются на отдельных CPU. Эти CPU могут быть 
реализованы в форме интеллектуальных ведомых DP. 

Для конфигурирования интеллектуальных ведомых DP (I-slaves), таких как 
CPU 315-2DP, мастеру DP не назначаются входные и выходные модули на 
интеллектуальном ведомом DP; вместо этого назначается только область 
адресного пространства CPU интеллектуальному ведомому. Эта адресная 
область не может назначаться реальным входным и выходным модулям 
интеллектуальных ведомых DP. Это назначение производится при 
конфигурировании ведомого. 

Примеры  интеллектуальных ведомых DP (= ведомых DP с предобработкой): 
станции с CPU 315-2DP, CPU 316-2DP, CPU 318-2DP 

Мастер-система DP

Ведущий-ведомый (MS)

Ведущий DP

Ведомый DP Интеллектуальный
ведомыйВедомый DP Ведомый DP
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3.4.3 Проект с интеллектуальными ведомыми DP (Прямой обмен 
данных: Slave > I Slave) 

В этой конфигурации, входные данные из ведомых DP могут быть очень 
быстро переданы интеллектуальным ведомым DP в подсети PROFIBUS-DP. 

Этим способом, все простые ведомые DP (в зависимости от выпуска) или 
другие интеллектуальные ведомые DP могут, в принципе, обеспечить прямую 
передачу (DX) отдельных входных данных между  ведомыми. Только 
интеллектуальные ведомые DP, такие как CPU 315-2DP, могут 
использоваться для приема таких данных.  

Примеры станций, которые могут использоваться как интеллектуальные 
ведомые DP: CPU 315-2DP, CPU 316-2DP, CPU 318-2DP 

Мастер-система DP

DX

Ведущий DP

Ведомый DP Интеллектуальный
ведомыйВедомый DP Ведомый DP
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3.4.4 Проект с двумя мастер-системами DP (Прямой обмен 
данных: Slave > I Slave) 

Различные мастера DP на одной физической подсети PROFIBUS-DP можно 
также назвать мультимастерной системой.. В этой конфигурации, входные 
данные из ведомых DP могут быть очень быстро прочитаны 
интеллектуальным ведомым DP, находящимся в той же физической 
PROFIBUS-DP. Интеллектуальное ведомое DP может относиться к той же или 
другой мастер-системе DP. 

Этим способом, интеллектуальные ведомые DP, такие как CPU 315-2DP 
предусматривают прямую передачу в свою область входных данных из 
ведомого DP, даже из других мастер-систем DP (это - мультимастерная 
система).  

В принципе, все ведомые DP (по текущим данным) могут обеспечить прямой 
обмен (DX) отдельных входных данных между ведомыми DP. Эти входные 
данные, в свою очередь, могут быть использованы только 
интеллектуальными ведомыми DP, такими как CPU 315-2DP.  

 

Ведущий DP1

Ведомый DP
11 12

Ведущий DP2

Прямой обмен данных DX

2213 21
Интеллектуальный

ведомый 23

Мастер-система DP 1 Мастер-система DP 2

Ведомый DP Ведомый DP Ведомый DP Ведомый DP
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3.4.5 Проект с двумя мастер-системами DP (Прямой обмен 
данных: Slave > Master) 

Различные мастер-системы DP на одной физической подсети PROFIBUS-DP 
называются также мультимастерными системами. В этой конфигурации, 
входные данные из интеллектуального или простого ведомого DP могут быть 
непосредственно прочитаны ведущим другой мастер системы той же 
физической подсети PROFIBUS-DP. Этот механизм называется также  
"общий вход» поскольку входные данные используются за границами мастер-
систем DP. 

 

Ведущий DP
1

Ведомый DP
11 12

2

22
Интеллектуальный

ведомый 21

Мастер-система DP 1 Мастер-система DP 2

Прямой обмен данных DX
Ведущий DP

Ведомый DP Ведомый DP
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3.5 Как конфигурировать распределенные системы 
ввода-вывода 

3.5.1 Создание мастер-системы DP 

Предпосылка 
Вы разместили в окне станции стойку, и она отображается в раскрытом виде 
(видны слоты стойки). 

Ведущий DP 
Как ведущего DP Вы можете использовать: 

• CPU с жестко встроенным или вставляемым интерфейсом ведущего DP 
(жестко встроен, напр., в CPU 315-2 DP) 

• интерфейсный субмодуль, поставленный в соответствие CPU/FM  
(напр., IF 964-DP в CPU 488-4) 

• CP в соединении с CPU (напр., CP 342-5, CP 443-5) 

• Интерфейсный модуль с интерфейсом ведущего DP (например, IM 467) 

Последовательность действий 
1. Выберите ведущего DP из окна каталога аппаратуры "Hardware Catalog” 

(напр., CPU 315-2 DP) 

2. Отбуксируйте этот модуль, используя Drag&Drop, в допустимую строку 
стойки. Откроется диалоговое окно ”Properties – PROFIBUS Node 
[Свойства – Узел PROFIBUS]”.  
Здесь Вы можете  

• создать новую подсеть PROFIBUS или выбрать существующую  

• установить свойства подсети PROFIBUS (скорость передачи и т. д.)  

• установить адрес PROFIBUS для ведущего DP 

Подтвердите установки, щелкнув на ”OK” 
Появится следующий символ:  
Этот символ является «якорем» для ведомых мастер-системы DP.  

Совет: Если Вы не можете сразу найти этот символ, то он, возможно, закрыт 
конфигурационной таблицей. Сузьте конфигурационную таблицу, в которой 
установлен ведущий DP. Если символ для мастер-системы DP еще не виден, 
выберите команду меню Insert > DP Master System [Вставить > Мастер-
система DP]. 
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3.5.2 Обработка мастер-систем интерфейса DP 

Отделение мастер-систем DP  
Если Вы вставляете в станцию CPU со встроенным интерфейсом PROFIBUS-
DP или CP PROFIBUS (которую можно сконфигурировать как интеллектуаль-
ное ведомое DP) и Вы хотите сконфигурировать CPU или CP как ведущий с 
мастер-системой DP, Вы можете отделить мастер-систему DP от мастера: 

1. Выберите интерфейс мастера DP  

2. Выберите команду меню Edit > Master System > Separate 
[Редактировать > Мастер-система > Отделить].  
Вариант: По щелчку правой кнопкой мыши, выберите команду меню 
Master System > Separate [Мастер-система > Отделить].  

Мастер-система поддерживается как "осиротевшая» и видима в станции. 
Поддерживается конфигурирование прямого обмена данных.  

Если к мастер-системе не подключено ведомых, мастер-система удаляется.  

Вставка мастер-системы DP 
Если Вы спроектировали одну или более мастер-систем DP и отделили их от 
мастер-интерфейса DP, Вы можете снова вставить одну из отключенных 
мастер систем к выделенному интерфейсу мастер-системы DP командой 
меню Edit > Master System > Insert [Редактировать > Мастер-система > 
Вставить].  

Возможность использования интерфейса PROFIBUS-DP для подключения 
Online  

Если Вы желаете, чтобы встроенный в CPU интерфейс PROFIBUS-DP был 
активным узлом PROFIBUS-DP (чтобы программатор выполнял свои функции 
через этот интерфейс), убедитесь, что выполнены следующие условия:  

1. Интерфейс PROFIBUS-DP должен быть подключен к сети, то есть когда 
по команде Edit > Object Properties выбирается интерфейс PROFIBUS-
DP, должна быть выбрана или вновь создана подсеть PROFIBUS.  

2. Эта конфигурация должна быть загружена в CPU. 
После этого такие функции, как мониторинг с использованием 
программатора становятся доступны через интерфейс  PROFIBUS-DP. 

Изменение свойств мастер-системы 
С версии  STEP 7 V5.0, Service Pack 3 и далее Вы можете изменить свойства 
мастер-системы (имя и номер): 

1. В открытой конфигурации станции щелкните дважды на линии, 
представляющей мастер-систему. 

2. Выберите закладку "General [Общее]", измените имя и номер системы, как 
это требуется Вам. 
Вы можете также редактировать соответствующую подсеть, используя 
кнопку "Properties [Свойства]".  
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3.5.3 Выбор и проектирование ведомых DP 

Типы ведомых DP 
При проектировании ведомых DP мы различаем: 

• Компактные ведомые DP  
(модули с встроенными цифровыми/аналоговыми входами и выходами, 
напр., ET 200B) 

• Модульные ведомые DP 
(интерфейсные модули с соответствующими модулями S5 или S7, напр., 
ET 200M) 

• Интеллектуальные ведомые (I-Slaves) 
(станции S7-300, напр., с CP 342-5, CPU 315-2DP или ET 200X с BM 
147/CPU) 

  
 Указание 

При проектировании мастер-системы обратите внимание на технические 
данные ведущего DP (макс. количество узлов, макс. количество слотов, макс. 
количество данных пользователя). Возможно, что из-за ограничений на 
количество слотов или данных пользователя Вы не сможете запроектировать 
максимальное количество узлов! 

Предпосылка 
Мастер-система DP существует и видна в окне станции. 

Символ для мастер-системы DP:   

Если это символ отсутствует (напр., был удален), то Вы можете его создать, 
выделив строку для интерфейса DP и выбрав команду меню Insert > DP 
Master System [Вставить > Мастер-система DP]. 

3.5.4 Копирование нескольких ведомых DP 

1. Удерживайте в нажатом состоянии клавишу Ctrl и щелкните указателем 
мыши последовательно на ведомых DP, подлежащих копированию. 
Результат: Ведомые DP выделены. 

2. Выберите команду меню Edit > Copy [Редактировать > Копировать]. 

3. Выделите мастер-систему DP, к которой должны быть добавлены 
копируемые ведомые DP. 

4. Выберите команду меню Edit > Paste [Редактировать > Вставить] 
("обычное» копирование) или Edit > Redundant Paste [Редактировать > 
Вставить для резервирования] (копирование для программного 
резервирования) 
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3.5.5 Конфигурирование компактных ведомых DP 

Последовательность действий 
1. Выберите компактного ведомого (напр., ET 200B) в окне каталога 

аппаратуры ”Hardware Catalog”. 

2. Отбуксируйте ведомого DP на следующий символ мастер-системы DP: 
  

Откроется диалоговое окно ”Properties – PROFIBUS Node [Свойства – 
Узел PROFIBUS]”. Здесь Вы можете установить  

- свойства подсети PROFIBUS (скорость передачи и т. д.) 

- адрес PROFIBUS для ведомого DP 

3. Подтвердите установки щелчком на ”OK” 
Результат: Символ добавляется к мастер-системе DP, представляя 
компактный ведомый DP. Структура входов/выходов компактного 
ведомого DP отображается в нижней части окна станции (подробное 
представление) 

3.5.6 Конфигурирование модульных ведомых DP  

Последовательность действий 
1. Выберите интерфейсный модуль для модульного ведомого DP (напр., IM 

153 для ET 200M) из окна каталога аппаратуры ”Hardware Catalog”. 

2. Отбуксируйте интерфейсный модуль, используя Drag&Drop, на 
следующий символ для мастер-системы DP:   
Результат: Откроется диалоговое окно ”Properties – PROFIBUS Node 
[Свойства – Узел PROFIBUS]”. Здесь Вы можете установить 

- свойства подсети PROFIBUS (скорость передачи и т. д.) 

- адрес PROFIBUS для ведомого DP 

3. Подтвердите установки щелчком на ”OK”. 
Символ для ведомого DP добавляется к мастер-системе DP. В нижней 
части окна станции появляется подробное представление ведомого DP с 
его возможными слотами и идентификаторами DP. 

4. Разместите модули для модульного ведомого DP в нижней части окна 
станции.  
У модульных ведомых DP возможные для установки модули размещены в 
окне каталога аппаратуры «Hardware Catalog [Каталог аппаратуры]» в 
соответствующим разделе ведомых DP! 
Сюда относятся: 

- терминальные блоки (TB...SC) для интеллектуального соединения 
Smart Connect (семейство ET 200L SC) 

- SC-модули (семейство ET 200L SC) 

- ведомые AS-i (семейство DP/AS-i Link) 

- модули S7-300 (семейство ET 200M) 
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3.5.7 Включение ведомых DP в группу SYNC или FREEZE 

Ведущий DP с соответствующими функциональными возможностями может 
послать команды управления SYNC и/или FREEZE для синхронизации 
ведомых DP одновременно группе таких устройств. Для этого Вы должны 
включить ведомые DP в группы SYNC и FREEZE. 

Предпосылка 
Вы должны были создать мастер-систему DP. 

Последовательность действий 
1. Выделите символ мастер-системы, в которой находится ведомый, 

который Вы хотите включить в группу. 

2. Выберите команду меню Edit > Object Properties [Редактировать > 
Свойства объекта]. 
Результат: Появляется закладка "Group Assignment [Назначение группы]» 
с таблицей, в которой Вы можете назначить ведомого DP в группу SYNC и 
FREEZE. 

  
 Указание 

Каждого ведомого DP Вы можете включить в одну SYNC и одну FREEZE 
группу.  
Исключение: Если Вы в качестве ведущего DP используете CP 3425, то Вы 
можете каждому ведомому DP поставить в соответствие до 8 групп (SYNC- 
и/или FREEZE-групп). 

Что нужно знать о командах управления SYNC и FREEZE? 
С помощью команд управления SYNC и FREEZE можно синхронизировать 
ведомые DP в зависимости от событий. Ведущий посылает команды 
управления одновременно на группу ведомых DP своей мастер-системы. Не 
принимаются во внимание ведомые, вышедшие из строя или передающие в 
данный момент диагностические сообщения. 

Предпосылкой для синхронизации через команды управления является 
предварительное включение Вами ведомых DP в SYNC- и/или FREEZE-
группы. 
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Команда управления SYNC 
С помощью команды SYNC ведущий DP заставляет группу ведомых DP 
«заморозить» состояния своих выходов на текущих значениях. 

При последующих кадрах ведомые DP сохраняют выходные данные 
ведущего DP; однако, состояния выходов ведомых DP не меняются. 

После каждой новой команды управления SYNC ведомые устанавливает свои 
выходы в значения, которые он сохранил в качестве выходных данных 
ведущего DP. 

Выходы только тогда снова начинают обновляться циклически, когда 
Ведущий DP посылает команду управления UNSYNC. 

Команда управления FREEZE 
После получения от ведущего DP команды FREEZE ведомые DP, входящие в 
группу, замораживают текущее состояние своих входов и передают его 
циклически ведущему DP.  

После каждой новой команды управления FREEZE ведомые DP снова 
замораживают состояние своих входов. 

Входные данные только тогда снова циклически передаются от ведомого 
ведущему DP, когда ведущий посылает команду управления UNFREEZE. 
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3.6 Другие конфигурации ведомых DP  

3.6.1 ET 200L и DP/AS-i Link 

При конфигурировании ведомых ET 200L и DP/AS-i Link(распределенный 
интерфейс исполнительных устройств и датчиков) имеют место следующие 
особенности: 

• ET 200L может расширяться поканально с помощью Smart Connect (SC)  

• DP/AS-i Link конфигурируется с ведомыми AS-i; см. следующий абзац  

При размещении устройств DP/AS-i Link в нижней части окна станции 
автоматически отображается конфигурационная таблица, в которую Вы 
можете поместить ведомые AS-i из окна каталога аппаратуры "Hardware 
Catalog". 

3.6.2 ET 200S 

Введение  
Ведомые DP семейства ET 200S конфигурируются подобно другим 
модульным ведомым.  

Особенность: Цифровые электронные модули с адресным пространством 2 
бита вначале при вставке в конфигурационную таблицу занимают 1 байт 
(детальный вид). Однако, занятое адресное пространство может быть сжато 
после конфигурации с помощью кнопки Pack Addresses [Упаковка адресов].  

Пример: 

 
 До упаковки После упаковки 

Модуль i - адреса i – адреса 
DI_1_Module От 10.0 до 10.1 От 10.0 до 10.1 
DI_2_Module От 11.0 до 11.1 От 10.2 до 10.3 
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Последовательность действий:  Совместная "упаковка» адресного 
пространства  

1. Выберите один непрерывный диапазон модулей, адреса которых должны 
быть упакованы. Если диапазон не обозначен, функция применима ко 
всем модулям в конфигурационной таблице. 

2. В детальном представлении конфигурационной таблицы, нажмите кнопку 
Pack Addresses [Упаковка адресов]. 

Адресное пространство для входов, выходов и запуска моторов 
упаковываются отдельно.  

- Начало адресного пространства определяется по адресу того модуля, 
который выбран первым и имеет вид X.0.  

- Если адрес бита не равен 0, автоматически используется следующий 
доступный байт адреса из выбранной области, например, (X+1).0.  

- Если нет непрерывного диапазона, упаковка производится 
автоматически в доступном адресном пространстве.  

Особенности для модулей с упакованными адресами  
Когда модуль имеет упакованный адрес, то, с точки зрения CPU, он более не 
может быть назначен в слот. По этой причине SFC 5 (GADR_LGC) выдает 
сообщение об ошибке W#16#8099 (слот не сконфигурирован) для 
действительного слота модуля.  

SFC 49 (LGC_GADR) и SZL-ID W#16#xy91 (информация о состоянии модуля) 
также неспособны оценить состояние модуля с упакованными адресами.  

С точки зрения CPU, прерывания также не могут быть назначены для 
модулей с упакованными адресами. Вследствие этого, дополнительный 
диагностический адрес автоматически присваивается модулю в режиме 
DPV1.  

Установки "Pack addresses [Упаковка адресов]» и "Plug/remove interrupt 
[Прерывания вставки и удаления]» – взаимно исключающие.  

Правила конфигурирования ET 200S 
• Слот 1: Только модуль питания (PM-E или PM-D) 

• Слева от электронного модуля (EM): только другой EM или модуль 
питания (PM-E или PM-D) 

• Слева от стартера мотора (MS): только другой MS или PM-D или другой 
модуль питания (PM-D Fx (1..x..4) или PM-X) 

• Слева от PM-X: только стартер мотора или PM-D 

• Вы должны обратить внимание на назначение диапазонов напряжений 
для PM-E и для EM. 

• Можно установить максимум 63 модуля и один интерфейсный модуль. 
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Особенности параметризации для термокомпенсации  
Запомните следующую последовательность: 

1. В конфигурационной таблице (детальное представление) ET 200S: 
установите аналоговый электронный модуль и установите канал для 
термокомпесации для диапазона измерений "RTD-4L Pt 100 Cl.»  

9 Дважды щелкните на ET 200S (свойства интерфейса ведомого DP): 
определите Reference Junctions [канал термокомпенсации], слот и канал 
для модуля RTD  

10 Установите аналоговый электронный модуль для измерения температуры 
через термопару  (модульTC) и назначьте как параметр номер канала 
термокомпенсации (модуля RTD). 

3.6.3 ET 200S с последующей установкой  

Предпосылки для последующей установки  
• Модуль питания: PM E-DC24..48V или PM EDC24..48V/AC24..230V с 

возможностью последующей установки  

• Интерфейсный модуль: IM 151-1 STANDARD (6ES7 151-1AA03-0AB0) или 
IM 151-1 FO STANDARD (6ES7 151-1AB02-0AB0)  

Обзор последовательности действий 
Возможность последующей установки позволяет Вам подготовить ET 200S 
для дальнейшего расширения (возможность).  

Следующий раздел дает обзор функций и процедур (для детального 
описания, см. руководство ET 200S Distributed I/O):  

1. Установите, подключите, сконфигурируйте и запрограммируйте 
максимальную планируемую конфигурацию для ET 200S.  

11 Вместо использования электронных субмодулей, которые могут 
потребоваться позже, используйте для первой установки экономичные 
модули RESERVE (138-4AA00 или 138-4AA10). ET 200S может быть 
полностью «предподключен» (”мастер подключение”) поскольку модули 
RESERVE не подключаются к оконечным устройствам и не включаются в 
процесс. 

12 Для тех слотов, где сначала вместо электронных модулей будут 
установлены модули RESERVE, разрешите возможность обработки (в 
свойствах IM 151-1 STANDARD, откройте закладку "Option Handling").  

13 На листе свойств для силового модуля зарезервируйте необходимое 
адресное пространство в области отображения выходов (PIQ) и области 
отображения входов (PII) для управления и интерфейса обратной связи 
для разрешения последующей установки.   

14 Позже Вы можете заменить модули RESERVE сконфигурированными 
модулями без повторения процедуры конфигурации. 
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Правило 
Возможность последующей установки допустима только для одного силового 
модуля PM E-DC24..48V или PM EDC24..48V/AC24...  

Функциональность: Возможность последующей установки при рестарте 
Если запрещен "Startup when defined and actual configuration differ [Запуск в 
случае различия спроектированной и реальной конфигурации]", то ET 200S 
все равно стартует, если вместо сконфигурированного электронного модуля 
вставлен модуль RESERVE и для слота разрешена последующая установка 
обработка . 

Функциональность: Последующая установка в процессе работы 
• В слот может быть вставлен модуль RESERVE (возможность) или 

сконфигурированный электронный модуль. Если в этом слоте обнаружен 
другой модуль, включается диагностическое сообщение (нет модуля, 
неправильный модуль).  

• Последующая установка запрещена для слота:  
В слот может быть вставлен только сконфигурированный модуль. Если в 
слоте обнаружен другой модуль, включается диагностическое сообщение 
(нет модуля, неправильный модуль). 

Подстановочные значения для модуля RESERVE 
Подстановочное значение для цифровых входов: 0 

Подстановочное значение для аналоговых входов: 0x7FFF  

Изменение и опрос в программе пользователя 
ET 200S имеет управление и интерфейс обратной связи для последующей 
установки.  

Изменение интерфейса выполняется через область отображения выходов 
(PIQ). Каждый бит в этой области адресов управляет одним из слотов от 2 до 
63:  

• Значение бита = 0: Возможна последующая установка. Модули RESERVE 
разрешены.  

• Значение бита = 1: Последующая установка не разрешена. Модули 
RESERVE не могут быть установлены в слот: 

Интерфейс обратной связи расположен в области отображении входов (PII). 
Каждый бит в этой области данных предоставляют информацию о том, какой 
модуль реально вставлен в слоты со 2 по 63:  

• Значение бита = 0: Слот содержит модуль RESERVE, неправильный 
модуль или модуль отсутствует. 

• Значение бита = 1: Слот содержит сконфигурированный модуль.  

Адреса этих интерфейсов зарезервированы как только последующая 
установка разрешена в силовом модуле (Закладка "Addresses [Адреса]"). 
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Возможность последующей установки также должна  быть разрешена на ве-
домом DP (модуль IM 151-1 STANDARD). Если разрешения нет, адреса, заре-
зервированные для интерфейса управления и обратной связи освобождают-
ся! Повторение разрешения и блокировка возможности последующей уста-
новки могут изменить адреса интерфейса управления и обратной связи .  

Для более детальной информации о назначении и использовании байт в 
области отображения процесса смотрите руководство ET 200S Distributed I/O.  

3.6.4 ET 200S в режиме DPV1  

Режим DPV1 предоставляет Вам расширенные функции, например, 
прерывания. Вы можете параметрировать эти функции с соответствующим 
интерфейсным модулем DP IM 151. 

Чтобы установить режим DPV1, у ведущего DP тоже должен быть установлен  
режим DPV1. 

Последовательность действий 
1. Сконфигурируйте станцию с ведущим DP,  который поддерживает DPV1 

(например, CPU S7-41x DP с версией встроенного программного 
обеспечения 3.0) и соответствующим ET 200S (IM 151). 
Интерфейс DP для ведущего DP установите в режим DPV1. 

2. Дважды щелкните на иконке ведомого DP (IM 151). 

3. Нажмите закладку "Operating Parameters [Рабочие параметры]". 
Эта страница содержит дополнительные параметры, такие как режим 
прерываний DP и прерывания DPV1. 

4. Установите параметры. 

Особенности:  
Определенные взаимозависимости между параметрами показаны в 
следующей таблице:  

 
Параметр Режим DPV0  Режим DPV1  

Функционирование с конфигу-
рацией ожидаемой <> реальной  

Никаких действующих 
ограничений 

Никаких действующих ограничений 

Диагностическое прерывание Не действует, не 
установлено 

Никаких действующих ограничений 

Аппаратное прерывание Не действует, не 
установлено 

Никаких действующих ограничений 

Прерывание вставки/удаления Не действует, не 
установлено 

Никаких действующих ограничений  
Если прерывание вставки/ удаления 
активировано, автоматически активи-
руется настройка 'Start-up with expected 
<> actual configuration [Стартовать при 
различиях предполагаемой и реальной 
конфигурации]'.  

  Функционирует только для 
неупакованных адресов 
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Прерывания для модулей с упакованными адресами 
Если модули могут включать прерывания и их адреса «распакованы» (то 
есть, среди них нет таких, битовый адрес которых не равен 0), тогда Вы 
можете использовать диалог адресов ET 200S для назначения 
диагностических адресов.  

Диагностический адрес существенен для назначения прерываний DPV1 
модулям, вызывающим эти прерывания. Только когда модуль имеют эти 
«распакованные адреса» CPU может назначить прерывания и сохранить 
информацию о прерывании в стартовой информации OB прерываний или в 
диагностическом буфере. CPU не может использовать для этого 
«упакованные» адреса. 

Диагностический адрес, назначенный модулю, нужен только для обработки 
прерываний (OB прерываний). Для обработки входных и выходных данных в 
программе пользователя, модуль может иметь упакованные адреса. 

 Заметьте 
Если адреса модуля упакованы, прерывание удаления/вставки для ET 200S 
также запрещено! 

3.6.5 ET 200iS 

Вы можете также сконфигурировать ET 200iS и его электронные модули в HW 
Config или более удобно сделать это с применением дополнительного пакета 
SIMATIC PDM. Соответствующие системные требования и процедуры 
описаны ниже:  

Системная предпосылка 
STEP 7 начиная с версии 5.1, SP 2, Hotfix 1 или PCS7 с версии 5.2. 

В этом случае, ET 200iS имеется в каталоге аппаратуры STEP 7. 
Поддерживаются прерывания диагностики, процесса, вставки и удаления и 
временных меток. 

Конфигурирование ET 200iS  
1. Запустите SIMATIC Manager. 

2. Сконфигурируйте в HW Config ET 200iS. 

- Создайте новый проект. 

- Перетащите модуль из каталога аппаратуры в конфигурационную 
таблицу. 

15 Сконфигурируйте временные метки (дополнительная возможность). 

16 Сохраните и загрузите конфигурацию в ведущее DP. 

Системная предпосылка 
STEP 7 начиная с версии 5.1, SP 2, Hotfix 1 и дополнительный пакет SIMATIC 
PDM начиная с версии 5.1, SP 2 или PCS7 начиная с версии 5.2. 
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Чтобы работать с PDM online, Вам требуется интерфейс PROFIBUS DP, 
например, CP5611 (6GK1 561-1AA00). CP должен быть установлен на интер-
фейс PROFIBUS DP (в SIMATIC Manager через: Extras > Setting the PG/PC 
Interface [Добавочные возможности > Установка интерфейса PG/PC]). 

Параметризация электронного модуля 
1. В HW Config, дважды щелкните на электронном модуле в 

конфигурационной таблице. 

2. Выберите "Specialist [Специалист]» в качестве пользователя в 
последующем диалоговом окне и подтвердите "OK"; чтобы 
параметризировать это модуль. 

3. SIMATIC PDM запускается с текущими параметрами и 
идентификационными данными модуля.  

4. Установите параметры электронного модуля используя SIMATIC PDM, 
сохраните параметры (командой меню File > Save) и загрузите ее 
командой Device > Load Into Device [Устройство > Загрузить в 
устройство] в электронный модуль; покиньте SIMATIC PDM. 

5. Дважды щелкните на следующем электронном модуле в 
конфигурационной таблице и повторите шаги 2 и 3 для всех остальных 
сконфигурированных модулей. 

Параметризация интерфейсного модуля 
1. В HW Config, дважды щелкните на ведомом DP "IM 151-2» (в верхней 

части окна станции). Выберите "Specialist [Специалист]» в следующем 
окне; SIMATIC PDM запущен.  

2. Установите параметры интерфейсного модуля IM 151-2, сохраните 
параметры (командой File > Save [Файл > Сохранить]) и загрузите 
параметры в интерфейсный модуль командой Device > Load Into Device 
Device [Устройство > Загрузить в устройство]; покиньте SIMATIC PDM.  

Параметризация всех модулей ET 200iS 
1. В HW Config дважды щелкните на ведомом DP "IM 151-2» (в верхней 

части окна станции). Выберите "Specialist [Специалист]» в следующем 
окне; SIMATIC PDM запущен и все модули ET 200iS загружены. 

2. Загрузите параметры всех модулей (командой File > Load into 
Programming Device/PC [Файл > Загрузить в программатор/PC]). 

3. Параметризируйте все необходимые модули. Вы можете перемещаться 
между всеми модулями ET 200iS в левой панели SIMATIC PDM. 

4. Сохраните изменения (командой File > Save [Файл > Сохранить]). 

5. Загрузите параметры в модули (командой Device > Load Into Device 
Device [Устройство > Загрузить в устройство]); покиньте SIMATIC 
PDM. 

Вы можете, таким образом, параметризовать ET 200iS только в SIMATIC PDM 
(Для более подробной информации, смотрите интерактивную помощь по 
SIMATIC PDM)  
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3.6.6 PROFIBUS PA  

Чтобы сконфигурировать полевые устройства для PROFIBUS-PA (PROFIBUS 
для автоматизации процессов), необходимо учесть следующее: 

Соединитель DP/PA  
Вам не нужно конфигурировать соединитель DP/PA в утилите HW Config; он 
"невидим» конфигурации станции. Вы должны только через свойства 
интерфейса PROFIBUS ведущего или ведомого DP установить скорость 
передачи сети PROFIBUS равной 45,45 Кбод. Соединитель уменьшает 
скорость передачи до 31,25 Кбод для полевых устройств РА. 

DP/PA Link 
DP/PA-Link - это шлюз между PROFIBUS-DP и PROFIBUS-PA. DP/PA-Link - 
это ведомое DP, которое в свою очередь (действуя почти как "мастер") 
"открывает» PROFIBUS-PA для подключения устройств PROFIBUS PA.  

Это устройство может быть добавлено в качестве ведомого DP из окна 
каталога аппаратуры "Hardware Catalog” к мастер-системе DP.  

Отображение DP/PA-Link включает в себя наряду с символом для самого 
устройства также и символ для системы DP/PA – подобно мастер-системе 
DP. На этот символ назначаются полевые устройства РА. 

Для подключения устройств РА PROFIBUS-PA должен работать со скоростью 
передачи 45,45 Кбит/с. 

Последовательность действий для конфигурирования DP/PA-Link 
1 Установите дополнительный программный пакет SIMATIC PDM 

(PDM=Process Device Manager [Администратор устройств процесса]), 
чтобы иметь впоследствии возможность конфигурировать ведомые PA из 
окна каталога аппаратуры ”Hardware Catalog”. 

2 Сконфигурируйте мастер-систему DP. 

3 Отбуксируйте DP/PA-Link (IM 157) из окна каталога аппаратуры на мастер-
систему DP. 

4 Выделите DP/PA-Link, чтобы иметь возможность видеть в нижней части 
окна станции структуру ведомого DP. 

5 Слот 2 представляет "ведущее» для оборудования PA; поэтому щелкните 
дважды на слоте 2, чтобы иметь возможность конфигурировать подсеть 
РА. 

6 Щелкните в закладке "General [Общие (свойства)]» на экранной кнопке ” 
Properties [Свойства]” (в разделе « Interface [Интерфейс]") и затем 
выберите подсеть со скоростью передачи 45,45 Кбит/с. 

7 Затем сконфигурируйте оборудование PA. 
Оборудование РА вы найдете в окне "Hardware Catalog" под позицией 
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"PROFIBUS-PA". Эта позиция видна только тогда, когда установлен 
дополнительный программный пакет SIMATIC PDM.  

3.6.7 HART- модули 

HART- модули – это аналоговые модули, к которым могут быть подключены 
измерительные преобразователи типа HART (HART=Highway Adressable 
Remote Transducer [магистральный адресуемый дистанционный 
преобразователь]). 

HART- модули предназначены для децентрализованного использования с IM 
153-2 (ET 200M).  

Для параметризации преобразователей типа HART следует запустить 
инструментальное средство параметризации SIMATIC PDM. 

Предпосылка:  
На PG/PC установлен SIMATIC PDM. 

Представление измерительных преобразователей типа HART 
Измерительные преобразователи для модулей типа HART представляются в 
конфигурационной таблице как интерфейсные субмодули. 

Пример: Модуль установлен в слоте 4. Тогда измерительный 
преобразователь для первого канала представлен как слот 4.1. 

Запуск SIMATIC PDM 
• Щелкните дважды на одном из "слотов» для измерительного 

преобразователя типа HART.  

Так как инструментальное средство для параметризации SIMATIC PDM может 
быть также использовано для назначения параметров полевым устройствам 
PROFIBUS-PA, то Вы можете запустить его также следующим образом: 

• Поместите полевое устройство PA, используя Drag&Drop, из окна каталога 
аппаратуры "Hardware Catalog” на мастер-системе DP и дважды щелкните 
затем на этом полевом устройстве. 
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3.6.8 Конфигурирование программного резервирования  

Структура системы "горячего резерва» состоит из:  

• двух станций S7 с интерфейсом ведущего PROFIBUS-DP на каждой 
(каждый из этих интерфейсов образует собственную подсеть!) 

• один или несколько ET 200M с IM 153-3, которые подключены к обеим 
подсетям  

Эта конфигурация гарантирует, что при выходе из строя одной станции (т. е. 
одного из двух ведущих DP) "резервная станция» возьмет на себя обработку 
программы пользователя.  

Последовательность действий 
1. Сконфигурируйте полностью 1-ю станцию со всеми ET 200M (IM 153-3). 

2. Сконфигурируйте 2-ю станцию без ET 200M. 

3. Скопируйте все ET 200M 1-й станции и вставьте эти ведомые DP в 
мастер-систему DP 2-й станции (команда меню Edit > Redundant Paste 
[Редактировать > Вставить для резервирования]). 

  
 Указание 

Ведомые DP должны быть сконфигурированы в каждой из станций,  
т. е. они появляются как два раздельно управляемых объекта, хотя 
физически речь идет об одном и том же ведомом DP! Если Вы меняете 
настройку у одного из ведомых ЕТ 200М, то Вы поэтому должны этого 
измененного ведомого DP снова скопировать в другую станцию, чтобы 
гарантировать непротиворечивость! 
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3.7 Интеллектуальные ведомые DP  

3.7.1 Конфигурирование интеллектуальных ведомых DP 

Признаком интеллектуального ведомого DP является то, что входные/ 
выходные данные предоставляются в распоряжение ведущему DP не 
непосредственно от реального входа/выхода, а от выполняющего 
предварительную обработку CPU, который вместе с СР образует ведомого 
DP. 

CPU
CPU 315-2DP

Область
операндов
(I, Q, M, ..)

PROFIBUS-CP

PROFIBUS

I/O

Интеллектуальный DP-SlaveВедущий DP

  

Различие: «Обычный» – интеллектуальный ведомый  
В "обычном» ведомом DP, например, в компактном (ЕТ 200В) или модульном 
(ЕТ 200М) ведущий DP обращается к децентрализованным входам/выходам. 

В интеллектуальном ведомом DP ведущий обращается не к входам/выходам 
интеллектуального ведомого DP, а к области операндов CPU, выполняющего 
предварительную обработку. Об обмене данными между областью 
операндов и входами/выходами должна заботиться программа пользователя 
CPU, выполняющего предварительную обработку.  

 Указание 
Области входов/выходов, запроектированные для обмена данными между ведущим и 
ведомым, не должны «заниматься» модулями ввода/вывода. 

Применение 
Конфигурации с интеллектуальным ведомым DP: 

• Обмен данных интеллектуальный ведомый <> ведущий  

• Прямой обмен данных ведомый > интеллектуальный ведомый  
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Основная последовательность действий 
Для включения интеллектуального ведомого DP в мастер-систему DP 
необходимо два шага: 

1. Конфигурирование станции, в которой модуль интерфейсом PROFIBUS-
DP включен в режим работы ведомого DP (напр., CPU 316-2 DP).  

 Закладка "Operating Mode [Режим работы]" 
Установите режим DP-Slave. Теперь 
Вы можете использовать станцию как. 

Закладка "Configuration [Конфигурация]" 
Все следующие установки установки  воз- 
можны только если станция уже рабоатет 
как ведомый DP.
1. Адрес, который использует CPU ведо- 
мый DP для доступа к ведущему DP 
Назначается в колонке с именем ведомо-f 
го DP.
2. Адрес который использует CPU веду- 
oий DP для доступа к ведомому DP  наз- 
начается в колонке PROFIBUS-DP Partner 
[партнер PROFIBUS-DP].
3. Вы можете диагностировать ошибки 
dедущего DP, используя локальный 
диагностический адрес.

интеллектуального ведомого. 

 
8 Сконфигурируйте еще одну станцию, которой как ведущему будет 

назначен (то есть подключен) этот ведомый DP (интеллектуальный).  

Закладка "Connection"
Назначение станции, сконфигурированной
как ведомый DP, этому интеллектуальному
ведомому
Закладка "Configuration"
1. Адрес, который CPU ведомого DP
использует для доступа к ведущему,
назначен в колонке с именем ведомого DP

2. Адрес, который  CPU ведущего DP
использует для доступа ведомого
назначен в колонке PROFIBUS-DP partner

 

 

 

Конфигурирование CP 342-5 как ведомого DP 
CP 342-5 может быть сконфигурирован для режима работы "DP-Slave". 
Станция, в которой был сконфигурирован этот СР, становится тогда 
"интеллектуальным ведомым". 
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Последовательность действий 
1. Сконфигурируйте станцию с CP 342-5 DP в качестве ведомого DP 

(выберите опцию "DP-Slave» в закладке "Operating Mode [Режим работы]» 
свойств CP). 

2. Сконфигурируйте в одной из других станций ведущее DP (CPU со 
встроенным интерфейсом PROFIBUS-DP или СР с интерфейсом 
PROFIBUS-DP). 

3. Отбуксируйте CP 342-5, используя Drag&Drop, из окна каталога 
аппаратуры «Hardware Catalog [Каталог аппаратуры]» (папка Configured 
Stations [Спроектированные станции]) на символ мастер-системы DP 
( ). 

Открывается диалоговое окно, в котором Вы можете выбрать 
проектируемые интеллектуальные ведомые DP. 

4. Подтвердите выбор, щелкнув на "OK". 

5. В появляющейся затем конфигурационной таблице сконфигурируйте для 
ведомого DP идентификаторы DP и адреса для областей входов/выходов: 
Для этого отбуксируйте, используя Drag&Drop, «универсальный модуль» 
из окна каталога аппаратуры «Hardware Catalog [Каталог аппаратуры]» 
(папка Configured Stations [Спроектированные станции]) в 
конфигурационную таблицу (нижняя часть окна станции), а затем дважды 
щелкните на соответствующей строке. 

  
 Указание 

Обмен данными между CPU, выполняющим предварительную обработку, и 
CP 342-5 DP внутри ведомого DP описан в пакете руководств NCM S7 для 
PROFIBUS (особенно том 1). 

Конфигурирование CPU 31X-2 DP или CPU 41X-..DP как ведомого DP  
CPU с встроенным интерфейсом DP (такое как CPU 315-2 DP) может быть 
сконфигурировано для режима работы "DP-Slave". Станция, в которой 
сконфигурирован этот CPU, в таком случае является "интеллектуальным 
ведомым". 

Ниже описан порядок действий на примере CPU 315-2 DP. Порядок действий 
всегда тот же, за исключением выбора типа CPU (смотрите также пример 
конфигурации S7-400 как интеллектуального ведомого).  
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Последовательность действий 
1. Сконфигурируйте станцию, например с CPU 315-2 DP, в качестве 

ведомого DP (дважды щелкните на строке 2.1 (интерфейс) в 
конфигурационной таблице и выберите вариант «DP Slave» в закладке 
"Operating Mode [Режим работы]"). 

Локальные адреса входов и выходов и диагностический адрес Вы можете 
задать в закладке "Configuration [Конфигурация]".  

2. Сконфигурируйте в другой станции ведущего DP (CPU со встроенным 
интерфейсом PROFIBUS-DP или СР с интерфейсом PROFIBUS-DP). 

3. Отбуксируйте, используя Drag&Drop, CPU 315-2 DP из окна каталога 
аппаратуры «Hardware Catalog [Каталог аппаратуры]» (папка Configured 
Stations [Спроектированные станции]) на символ для мастер-системы 
DP ( ). 

4. Дважды щелкните на символе для интеллектуального ведомого DP и 
выберите закладку  «Connection [Соединение]". В этой закладке Вы 
определите, какая станция должна представлять здесь 
интеллектуального ведомого. 

5. Выделите интеллектуального ведомого и щелкните на кнопке "Connect 
[Соединить]". 

6. Выберите закладку "Slave-Configuration [Конфигурация ведомого]» и 
назначьте друг другу адреса ведущего и ведомого. 

- Выберите режим «MS» (ведущий-ведомый) для обмена данных с 
ведущим DP через область входов-выходов. 

- Для прямого обмена данными с ведомым или с ведущим DP, 
выберите режим «DX» (прямой обмен данными).   

7. Подтвердите настройку, щелкнув на "OK". 

Конфигурирование ET 200X (BM 147/CPU) как ведомого DP  
Базовый субмодуль BM 147/CPU конфигурируется как интеллектуальный 
ведомый DP. В противоположность другим интеллектуальным ведомым DP 
базовый субмодуль следует искать в окне каталога аппаратуры «Hardware 
Catalog [Каталог аппаратуры]» под "PROFIBUS-DP/ET 200X/BM147/CPU"! 

Последовательность действий 
1. Сконфигурируйте ведомого DP ET 200X (с BM 147/CPU) как станцию S7-

300 

- Создайте новую станцию типа S7-300 (команда меню Station > New 
[Станция > Новая])  

- Выберите в окне каталога аппаратуры «Hardware Catalog [Каталог 
аппаратуры]» папку PROFIBUS-DP/ET 200X/BM147/CPU 

- Перетащите объект "BM 147/CPU» в пустое окно станции  

- Сконфигурируйте ведомого DP с желаемыми субмодулями 
расширения входов/выходов 

- Сохраните станцию (т. е. интеллектуальный ведомый DP) 
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2. Сконфигурируйте ведущего DP в другой станции (CPU с встроенным 
интерфейсом PROFIBUS-DP или CP с интерфейсом PROFIBUS-DP). 

3. Отбуксируйте, используя Drag&Drop, ведомого DP ET 200X (с BM 
147/CPU) из окна каталога аппаратуры «Hardware Catalog [Каталог 
аппаратуры]» (папка Configured Stations [Спроектированные станции]) 
на символ для мастер-системы DP ( ). 

4. Щелкните дважды на символе для интеллектуального ведомого DP и 
выберите закладку "Connection [Соединение]". В этой закладке укажите, 
какая станция должна здесь представлять интеллектуальный ведомый 
DP. 

5. Выделите интеллектуальный ведомый DP и щелкните на кнопке "Connect 
[Соединить]". 

6. Выберите закладку "Slave-Configuration [Конфигурация ведомого]» и 
поставьте в соответствие друг другу адреса ведущего и ведомого 

7. Подтвердите настройку, щелкнув на "OK". 

Конфигурирование ET 200S (IM 151/CPU) как ведомого DP  
IM 1151/CPU конфигурируется подобно интеллектуальному ведомому DP. В 
от других , это ведомый DP находится в каталоге аппаратуры  в разделе 
PROFIBUS DP/ET 200S/IM 151/CPU. 

Последовательность действий 
1. Сконфигурируйте ET 200S как ведомого DP (с IM 151/CPU) аналогично 

станции S7-300. 

- Создайте новую станцию типа S7-300 (команда меню Station > New 
[Станция > Новая]).  

- Выберите раздел PROFIBUS-DP/ET 200S/IM151/CPU в каталоге 
аппаратуры. 

- Перетащите IM 151/CPU в пустое окно станции. 

- Сконфигурируйте ведомого DP с требуемыми модулями входов и 
выходов. 

- Сохраните станцию (интеллектуального ведомого DP). 

2. Сконфигурируйте ведущего DP (CPU с встроенным интерфейсом 
PROFIBUS DP или CP с интерфейсом PROFIBUS DP) в другой станции. 

3. Перетащите ведомого DP ET 200S (с IM 151/CPU) из окна ”Hardware 
Catalog” (папка Configured Stations) на символ мастер системы DP 
( ). 

4. Дважды щелкните на символе для интеллектуального ведомого DP и 
выберите закладку Connection [Подключение]. В этой закладке, Вы 
можете назначить станцию, которую Вы выбираете в качестве 
интеллектуального ведомого DP. 

5. Выберите интеллектуального ведомого DP и нажмите кнопку 
Connect[Подключить]. 
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6. Выберите закладку Configuration [Конфигурация] и назначьте адреса в 
соответствие друг другу.  

7. Подтвердите Ваши настройки OK. 

3.7.2 Пример конфигурирования S7-400 как интеллектуального 
ведомого 

Ниже мы должны создать следующую конфигурацию:  

• Ведущая станция (Имя "DP Master") с CPU 417-4 в качестве ведущего DP  

• (DPV1).  
CPU S7-400  с встроенным интерфейсом DP может быть сконфигурирован 
как ведущий DPV1 только с версией встроенного программного 
обеспечения 3.0.  

• Ведомую станцию (Имя "DP Slave") с CPU 414-3 DP в качестве 
интеллектуального ведомого DP 

Как обычно, для конфигурирования интеллектуального ведомого DP 
выполните следующие шаги:  

 
Шаг Действия Разъяснение 

1 Создайте ведущую станцию с CPU 417-4. 
Имя: DP Master 

Адрес PROFIBUS должен быть 2.  

2 Создайте ведомую станцию с CPU 414-3 
DP. Имя: DP Slave. 

Режим работы интерфейса DP для CPU 414-
3 DP должен быть установлен в  "DP Slave". 
Адрес PROFIBUS должен быть 3.  

3 Заполните первую строчку на закладке 
"Configuration [Конфигурация]» ведомой 
станции. Для создания новой строки, 
нажмите кнопку "New [Новая]»  

Если эта строка не заполнена, данные 
некомплектны. В диалоге свойств, выберите 
режим "MS» (Ведущий-ведомый) и 
примените установки по умолчанию. 

4 Вставьте интеллектуального ведомого DP 
в ведущую станцию из папки "Configured 
Stations [Сконфигурированные станции]". 

Выберите CPU 41x в каталоге аппаратуры 
PROFIBUS DP в папке "Configured Stations 
[Сконфигурированные станции]» и 
перетащите этот "представляющий» 
ведомого DP символ на мастер-систему DP. 

4 Соедините вставленный интеллектуальный 
ведомый DP с конфигурированной 
ведомой станцией.  

Соединение это предпосылка для 
связывания "представляющего» символа с 
сконфигурированной станцией или для 
связывания входов ведомого DP с выходами 
ведущего и наоборот.  
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Расположите ведущую и ведомую станцию, чтобы видеть их рядом. 
Результат показан ниже:  

 

 
  

Как назначать адреса 
 

Шаг Процедура Разъяснение 

 
Дважды щелкнув 
на интерфейсе DP 
ведущей станции 
откройте диалог с 
несколькими 
закладками  
 

Закладка «General [Общее]»:  
Имя интерфейса и адрес PROFIBUS с сетевыми назначениями. The 
Адрес PROFIBUS должен быть установлен в 2.  
Закладка "Address [Адрес]":  
Логический адрес интерфейса DP (системные сообщения 
идентифицируют интерфейс по этому). 
Закладка "Operating mode [Рабочий режим]":  
Следует выбрать "DP Master".  
Также, должен быть установлен режим DP "DPV1".  
Содержание других настроек несущественно для этого примера. 
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Шаг Процедура Разъяснение 

 

Дважды щелкнув 
на символе 
ведомого DP в 
представлении 
ведущей станции 
отройте диалог с 
несколькими 
закладками 

Закладка «General [Общее]»:  
Редактируемое обозначение символа ведомого DP и диагностичес-
ких адресов. Здесь назначаются два диагностических адреса для 
ведущего DPV1:  
Первый диагностический адрес назначается виртуальному слоту 0 
ведомого DP. Через этот адрес ведущий DP принимает 
диагностические данные и/или прерывания, которые не назначены 
слоту ведомого. В нашем примере это адрес 16381. 
Второй диагностический адрес назначается виртуальному слоту 2 
ведомого DP. Через этот адрес ведущий DP принимает диагностику 
или прерывания, которые назначены интерфейсу DP. В нашем 
примере это адрес 16380.  
(Также смотрите раздел "Ведомый DP с точки зрения ведущего").  
Закладка "Coupling [Соединение]":  
Назначение символу ведомого DP в представлении ведущей стан-
ции сконфигурированной ведомой станции. Когда назначение сдела-
но, обозначение сконфигурированной станции появляется в нижней 
части закладки в поле  "Active Coupling [Активные соединения]".  
Закладка "Configuration [Конфигурация]":  
Назначение областей входов и выходов для обмена данными между 
ведущей и ведомой станциями. Дважды щелкните в первой строке и 
полностью заполните поля в появившемся диалоге. 

 
Дважды щелкните 
на интерфейсе 
ведомого DP в 
представлении 
ведомой станции, 
чтобы открыть 
диалог 
содержащий 
несколько 
закладок  
 

Закладка «General [Общее]»:  
Имя интерфейса и адрес PROFIBUS с привязкой к сети. Адрес 
PROFIBUS должен быть установлен равным 3.  
Закладка "Address [Адрес]":  
Логический адрес интерфейса DP (системные сообщения ссылаются 
на интерфейс через этот адрес). 
Закладка "Operating mode [Рабочий режим]":  
Следует выбрать "DP-Slave". Активируйте бокс выбора "Programming 
and Status/Control...[Программирование и контроль состояния…]» 
если PG/PC подключается через этот же  PROFIBUS и если, 
например, Вы хотите загружать программы используя этот путь.  
Отображается Diagnostic address [Диагностический адрес]. Этот 
адрес может использоваться интеллектуальным ведомым для 
диагностики условий, например, ошибок на ведущем  DP. 
"Address for the virtual slot 2 [Адрес для виртуального слота 2]» 
видим только для ведущего DP поддерживающего режим "DPV1» и 
если этот режим установлен. Этот адрес может использоваться 
пользовательской программой ведомого DP для генерации 
программных прерываний на ведущем DP (см. также раздел 
"Ведущий DP с точки зрения ведомого"). 
DP mode [Режим DP]: Здесь следует выбрать "DPV1", если этот же 
режим установлен на ведущем DP. В другом случае, "Address for 
the virtual slot 2» не может быть выбран.  
Закладка "Configuration [Конфигурация]":  

Значения этой закладки смотрите в   
Отличие: Колонка "Local: ...» может быть отредактирована, даже 
если бы интеллектуальный ведомый  DP не был назначен ведущему 
DP (см. закладку "Coupling").  
Для нашего примера все остальные настройки закладок не имеют 
значения. 
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Ведомый с точки зрения ведущего DP  
Вы можете использовать программу пользователя ведущего DP, чтобы 
получить информацию о состоянии ведущего DP, используя 
сконфигурированный диагностический адрес 16381, который назначен 
виртуальному слоту 0 (Slot 0) ведомого DP. Слот 0, относящийся к DPV1, 
представляет ведомую станцию в целом. Например, SFB 54 "RALRM 
использует выходной параметр ID, как указатель на этот адрес, если этим 
ведомым включается прерывание  и если это прерывание не назначено 
какому-либо слоту. Если прерывание включается виртуальным слотом 2 
этого ведомого DP (то есть, секцией CPU) оно идентифицируется 
диагностическим адресом 16380. 

Ведомый DP
(режим
DPV1)

Слот
2

Ведущий DP (режим DPV1)

Слот
0

Диагностический адрес 16381
(для ошибки станции)
виртуальный слот  0

Диагностический адрес 16380
(для диагностических прерываний
переключения режимов и для
аппаратных прерываний)
Виртуальный слот 2

PROFIBUS

Программа
пользователя
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Ведущий с точки зрения ведомогоDP  
Вы можете, например, использовать программу пользователя ведомого DP, 
для чтения из ведущего DP информации об ошибках через 
сконфигурированный диагностический адрес 8189.  

Если Вы установили ведомого DP в режим DPV1, Вы можете, например,  
включать аппаратные прерывания. В пользовательской программе ведомого 
DP Вы можете использовать SFC 7 "DP_PRAL» для включения прерывания 
на ведущем, используя конфигурируемый адрес для виртуального слота 2 
(Slot 2). В нашем примере это адрес 8188. Приведенный ниже пример 
показывает фрагмент пользовательской программы ведомого DP, который 
включает аппаратные прерывания и фрагмент пользовательской программы 
ведущего  DP, который обрабатывает прерывание. 

  

Ведомый DP

DPV1)
(Режим

Ведущий DP (режим DPV1)

Программа
пользова-

теля

Адрес виртуального слота 2
8188
аппаратные и
диагностические
прерывания

Диагностический адрес 8189
(для ошибки станции)

адрес виртуального слота 0

PROFIBUS

2
Слот

0
Slot
35

Вы можете инициировать аппаратное прерывание от
назначенного сконфигурированного слота (0 – 35)
интеллектуального ведомого, поскольку каждый виртуальный
слот доступен для мастера через некоторый адрес.

1
Своб.

3
Слот Слот Слот

Своб.
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Программа ведомого DP (в CPU I-Slave) для включения аппаратных 
прерываний 

// 

// ... 

L DW#16#F0F0 //Константа для идентификации события I-Slave, которое 
//включает аппаратное прерывание  

 T MD 100 

//... 

 CALL "DP_PRAL" 

 REQ :=M1.0 //Аппаратное прерывание включается если REQ=1 

 IOID :=B#16#54 //Входная  область (сконфигурированный адрес = E 8188) 

 LADDR :=W#16#8189 //Адрес (сконфигурированный адрес = E 8188) 

 AL_INFO:=MD100 //MD 100 информация прерывания, непосредственно 
//направляемая ведущему (может быть прочитана в стартовой информации 
//OB 40 на ведущем, как OB40_POINT_ADDR) 

 RET_VAL:=MW10 //Возвращаемая величина (0000, если нет ошибок) 

 BUSY :=M1.1 //Если BUSY =1 аппаратное прерывание еще не квитировано 
//ведущим  

// ... 

Программа ведущего DP ( в CPU ведущей станции) для обработки 
аппаратного прерывания  

// ... 

 L #OB40_POINT_ADDR //Загрузка информации прерывания 

 L DW#16#F0F0 //сравнение с константой, с которой ведомый посылает 
прерывание при его генерации  

 ==I // Информация о прерывании от I-Slave? 

 

 SPB m001 //если да, переход к соответствующему сегменту программы  

 BEB  

 

m001: CALL FC 100 //Сегмент программы для обработки прерывания  

// от I-Slave 

// ...  

 

 



Конфигурирование децентрализованной периферии (DP) 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
3-38 A5E00261404-01 

3.7.3 Создание аварийных сообщений от интеллектуального 
ведомого с помощью SFB75 'SALRM’ 

Интеллектуальные ведомые DP, используя SFB 75 'SALRM', могут запускать 
прерывания на своих мастер-устройствах DP. Следующая таблица 
показывает доступные типы прерываний в зависимости от установок режима 
DP: 

  
Тип прерывания Режим DP: S7-

совместимый? 
Режим DP: DPV1 

Диагностическое прерывание (OB 82) Да  Да 
Аппаратное прерывание (OB 40 .. 47) да  Да 
Вставка и удаление модуля 
(OB 83) 

Да (Если интеллектуаль-
ный ведомый поддержи-
вает это прерывание ) 

Да  

Прерывание статуса (OB 55) Нет Да  
Прерывание обновления (OB 56) Нет Да  
Прерывание, зависящее от 
производителя (OB 57) 

Нет Да  

Адреса для включения прерываний 
Вы можете использовать для включения прерываний с применением  SFB 75 
любой адрес, заданный на закладке "Configuration [Конфигурация]» в диалоге 
конфигурирования интеллектуального ведомого. Эти адреса не могут 
назначаться реальным модулям, а только виртуальным "слотам". 

Адреса для «слота 0» (диагностический адрес) и "Слота» 2 (адреса для 
"Слота» 2) не могут использоваться для включения прерываний.  
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Основной порядок действий создания прерываний 
Основной порядок действий при создании прерываний будет показан на 
примере диагностического прерывания.  

• На интеллектуальном ведомом выходной адрес 0 назначен виртуальному 
слоту на закладке "Configuration [Конфигурация]".  

• В этом примере выходной адрес 0 используется для включения на 
ведущем DP диагностического прерывания (OB 82).  

Для каждого диагностического прерывания, в программе пользователя 
должны также вводиться данные (AINFO). Эти данные должны 
переписываться в базовую структуру для дополнительной информации 
прерываний. 
Например, Вы можете использовать следующую простейшую структуру 
(детальное описание можно найти в руководстве "System and Standard 
Functions for S7-300/400» в главе "Diagnostic Data"):  

Бит

Бит

Бит

Бит

1: Неисправный модуль

Идентификатор модуля 0:Дополнительные
диагностические данные

не доступны

  

  
 Указание 

Дополнительная информация прерываний влияет на состояние модуля и 
светодиод ошибок "SF» на интеллектуальном ведомом. Аналогично, 
прерывание также влияет на данные состояния модуля и светодиоды ошибок 
ведущего DP. По этой причине, Вы должны убедиться в значении множеств 
диагностических данных (множество данных 0 и множество данных 1) при 
обеспечении данных для дополнительной информации о прерывании. 
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Процесс создания прерываний показан на следующем рисунке: 

Вызов SFB 75

Ведущий DP (DPV1)

Интеллектуальный
ведомый с SFB 75

Начальный адрес  0
Диагностическое прерывание
Наступающее прерывание, сбой модуля
Длина дополн. информации 4 байта

Область для дополн. инф.

Конфигурация:
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3.8 Прямой обмен данных (боковые коммуникации) 

3.8.1 Проектирование прямого обмена данных между узлами 
PROFIBUS-DP 

Введение 
В конфигурации для прямого обмена данных (lateral communication), 
локальная область входных адресов интеллектуального ведомого DP или 
мастер-устройства DP ставятся в соответствие области входных адресов 
партнера PROFIBUS-DP. 

Интеллектуальный ведомыйDP или мастер-устройство DP используют эту 
область входных адресов, чтобы принимать входные данные, которые 
партнер PROFIBUS-DP посылает своему мастеру DP. 

Число партнеров PROFIBUS-DP, которые могут быть подключены 
Тип интерфейса ограничивает общее число партнеров PROFIBUS-DP, 
которые подключаются непосредственно к интерфейсу DP или адресуются 
через этот интерфейс посредством прямого обмена данных. Максимум 32 
партнера PROFIBUS-DP могут адресоваться через интерфейсы MPI/DP.  

Приложения 
Для прямого обмена данных возможны следующие приложения:  

• Конфигурация с интеллектуальным ведомым DP (прямой обмен данных: 
ведомый -> интеллектуальный ведомый)  

• Конфигурация с двумя мастер-системами DP (обмен данных: ведомый -> 
ведущий)  

• Конфигурация с двумя мастер-системами DP (прямой обмен данных: 
ведомый -> интеллектуальный ведомый)  
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Начало проектирования 
1. Щелкните дважды на интерфейсе DP сконфигурированного приемника 

(ведущем или уже сконфигурированном интеллектуальном ведомом). 

2. Выберите закладку "Configuration [Проектирование]". 

3. Для создания новой строки при конфигурировании прямого обмена 
данных, нажмите кнопку "New [Новая]". 

4. В появившемся диалоге, выберите  режим "DX» и назначьте друг другу 
области входных адресов (Вы найдете больше информации в 
интерактивной справке к этому диалогу). 

Свойства

Ведущий DP

CPU 316-2DPПартнер PROFIBUS-DP

Закладка “Configuration"

PROFIBUS

Ведомый DP

Прямой обмен данных (DX)

Интеллектуальный
ведомый или
ведущий DP

 

Содержание закладки "Configuration [Конфигурация]»  

 
• Mode [Режим]: "DX» для прямого обмена данных, ("MS» для ведущий-

ведомый)  

• Partner DP Addr [Адрес партнера DP]: Адрес PROFIBUS партнера DP 

• Partner Addr. [Адрес партнера]: Логически назначенный адрес области 
(передатчик)  

• Local Addr. [Локальный адрес]: Логически назначенный адрес области 
(приемник) 

Для дополнительной информации, смотрите интерактивную помощь по этой 
закладке 
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3.8.2 Пример конфигурирования прямого обмена данных 

Конфигурация для примера: 
• CPU 417-4 как мастер DP  

• CPU 316-2 DP как приемник 

• CPU 318-2 DP как издатель  

Абонент
(CPU 316-2 DP)

Издатель
(CPU 318-2 DP)

 

Задача 
CPU 318-2 DP посылает мастеру 8 слов консистентных данных.  

CPU 316-2 DP принимает первые два байта этих данных. 

Последовательность действий 
1. Сконфигурируйте три станции, каждая с указанным CPU. Затем, дайте 

имен содержательные имена, например, "DP Master station [Ведущая 
станция]", "receiver station [Принимающая станция]", и "publisher station 
[Выпускающая станция]". 

2. Сконфигурируйте выпускающую и принимающую станции как 
интеллектуальные ведомые: 

- Дважды щелкните в строке «DP Master [Ведущий DP]». 

- Выберите закладку Operating Mode [Рабочий режим]  

- Установите режим  «DP Slave [Ведомый DP]». 

3. На ведущей станции: 

- Перетащите иконку CPU 31x 2-DP из окна "Catalog [Каталог]", 
(PROFIBUS-DP, папка "Already Configured Stations [Уже 
сконфигурированные станции]") на символ мастер-системы DP. 
Появится диалог свойств ведомых DP с закладкой "Connection 
[Подключение]»  

- Выберите ведомого в окне «Configured Slave Controllers [Контроллеры, 
сконфигурированные как ведомые]» и нажмите кнопку "Connect 
[Подключить]". Подтвердите, нажав "OK". 

- Повторите процедуру подключения к мастер системе для второй 
сконфигурированной в качестве интеллектуального ведомого станции.  
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4. Сконфигурируйте область адресов выпускающей станции, чтобы DP 
читал данные из CPU 318-2 DP через адрес I 200: 

- Дважды щелкните на строке ведомого DP станции CPU 318-2 DP. 

- Выберите закладку "Configuration [Конфигурация]» и нажмите кнопку 
"New [Новая]". Заполните поля в диалоге свойств следующим 
образом: 

 
Publisher Station 
(local) 
[Выпускающая 
станция] 

Mode  [Режим]  = MS (Master-slave) [Ведущий-ведомый] 
Address type [Тип адреса] = Output 
Address [Адрес]   = 100 

PROFIBUS- 
DP Partner [Партнер 
PROFIBUS- 
DP] 

PROFIBUS address [Адрес PROFIBUS] = 2 (фиксированный 
адрес PROFIBUS ведущего DP) 
Address type[Тип адреса] = Input [Вход] 
Address [Адрес]   = 200 

Length [Длина], Unit 
[Модуль], 
Consistency 
[Консистентность] 

Length [Длина]   = 8 
Unit[Модуль]    = Word 
Consistency [Консистентность]= Entire length [Вся длина] 

 

9 Сконфигурируйте область адресов приемника: 

- Дважды щелкните на строке «DP slave» в станции CPU 316-2-DP. 

- Выберите закладку "Configuration [Конфигурация]» и нажмите кнопку  
"New [Новая]". Заполните поля в диалоге свойств, так чтобы CPU 316-
2 использовало адрес I 120 для доступа к данным, которые CPU 318-2 
посылает своему ведущему: 

 
Receiver Station 
(local) 
[Принимающая 
станция] 

Mode [Режим]   = DX (прямой обмен данных) 
Address type [Тип адреса] = Input [Вход](зафиксировано) 
Address [Адрес]   = 120 

PROFIBUS- 
DP Partner [Партнер 
PROFIBUS- 
DP] 

PROFIBUS address [Адрес PROFIBUS]= 3 (по выбору) 
Address type [Тип адреса] = Input (фиксировано) 
Address [Адрес]  = 200 (по выбору) 

Length [Длина], Unit 
[Модуль], 
Consistency 
[Консистентность] 

Берется автоматически из установок станции издателя. 
Измените длину на 1 слово,  поскольку только первые два 
байта должны быть прочитаны. 
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Особенность: 
В принципе Вы можете установить адрес, который больше чем I 200, 
например, I 202.  
STEP 7 автоматически настраивает длину консистентных данных. Вы можете 
также длину меньше. Вы можете также установить длину меньшую, чем та, 
которую задает издатель (например, 1 байт). 

  
 Указание 

Если установка для консистентной издателя 3 байта или больше чем 4 байта 
и данные передаются с помощью функции SFC15 (DPWR_DAT), приемник 
должен всегда использовать SFC14 (DPRD_DAT), даже если он читает 
только 1 байт. 

В этом случае, если Вы используете операцию загрузки (L IB…), читается «0» 
(неправильная величина). 

Вызов SFC15 на издателе (CPU 318-2 DP) 
CALL "DPWR_DAT" 

 LADDR :=W#16#64 //начальный адрес Q 100 

 RECORD :=P#M 10.0 BYTE 16 //исходная область пользовательских данных 

 RET_VAL:=MW100 //возвращаемая величина 

Вызов SFC14 на абоненте (CPU 316-2 DP) 
CALL "DPRD_DAT" 

 LADDR :=W#16#78 //начальный адрес I 120 

 RET_VAL:=MW100 // возвращаемая величина  

 RECORD :=P#M 10.0 BYTE 2 //целевая область пользовательских данных  
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3.8.3 Конфигурирование ведомого DP (GSD ревизия 5) как 
приемника для прямой передачи данных  

Начиная со STEP 7 Version 5.3, Вы можете сконфигурировать ведомого DP  
как приемник для прямого обмена данных, используя файлы GSD  
("стандартные ведомые") 

Конфигурация прямого обмена данных (боковые коммуникации) возможна 
для файлов GSD ревизии 5. 

Ключевые слова в файле GSD  
Ведомый  DP с записью в GSD "Subscriber_supp =1» может быть 
сконфигурирован как приемник (абонент). В STEP 7 эта запись означает, что 
окно свойств ведомого DP, будет содержать закладку "Address Configuration 
[Конфигурация адресов]» в которой Вы можете назначить адреса входов и 
выходов. 

Ведомый DP с записью "Publisher_supp =1» может использоваться как 
передатчик (издатель) для прямого обмена данных. Входная область такого 
ведомого DP может быть выбрана ("subscribed to") в закладке "Address 
Configuration [Конфигурация адресов]» ведомого DP, а без этого ввода, как и 
без "publishing capability", даже не предлагается в качестве источника для 
прямого обмена данных. 

Другие записи в файле GSD автоматически применяются STEP 7. Например, 
при проверке консистентности принимается во внимание максимальное число 
ссылок для прямого обмена данных. Если это число превышено, будет 
выведено сообщение о том, что превышено заданное число. 

Описание 
В случае прямого обмена данных, например между передающим ведомым DP 
(издателем)  и принимающим интеллектуальным ведомым DP (абонентом), 
данные передаются непосредственно между ведомыми через ведущего.  

В отличие от принимающего данные интеллектуального ведомого, который 
“наблюдает” входные данные, с передающего ведомого в собственной 
локальной области адресов, принимающий стандартный ведомый создает 
изображение входных данных передающего ведомого непосредственно в 
выходной области принимающего ведомого.  

Это означает, что параметры назначенные приемником определяют какой 
выходной байт поступает от ведущего, а какой от передающего ведомого.  
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Следующий рисунок показывает пример этой ситуации.  

Ведущий 1 Ведущий 2

Ведомый 1 (Абонент)Ведомый 2 (Абонент) Ведомый 3 (Издатель)

  
Здесь показаны две мастер-системы, сконфигурированные для прямого 
обмена данных.  

Ведомый 1 сконфигурирован как абонент для прямого обмена данных. 
Показывается обмен данных между ведущим и ведомым.  

Ведомый 1 выдает входные данные от ведомого 2 в свою выходную область 
Q2. Обе области имеют одинаковую длину (по крайней мере 1 байт).  

Ведомый 1 также выдает входные данные от ведомого 3 в свою выходную 
область Q3. Обе области также имеют одинаковую длину  

Для ведущего 1, ведомый 1 (абонент) имеет только выходную область Q1. 
Области выходных данных Q2 и Q3 не доступны для него.  

Правила и указания 
Прямой обмен данных между издателем и абонентом ограничен ведомыми 
DP (коммуникации ведомый-ведомый). 

Возможен прямой обмен данных между ведомыми в различных мастер-
системах. В этом случае оба ведущих должны быть подключены к одной 
подсети PROFIBUS. 

Как правило, выходная область абонента назначается ведущему и может 
быть при конфигурировании назначена передатчику. Возможно также не 
назначить выходную область ни ведущему, ни передатчику. В этом случае 
выходной области назначается значение "0". При проверке консистентности 
появляется для этой области выдается предупреждение. 

Прямой обмен данных не ограничивается стандартными ведомыми. Могут 
использоваться любые ведомые из каталога аппаратуры (папки "PROFIBUS 
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DP"), которые описаны, как передатчики или приемники для прямого обмена 
данных (смотри информационный текст в каталоге).  

Последовательность действий 
1. Импортируйте требуемые файлы GSD для ведомых, которые 

сконфигурированы как передатчики или абоненты.  

2. Сконфигурируйте мастер систему с ее ведомыми. 

3. Для ведомых, конфигурируемых как абоненты, выполните следующие 
шаги. Сделайте это для каждого подключенного ID (модуля). 

- Дважды щелкните на DP-ID. 

- Выберите закладку "Address Configuration [Конфигурация адресов]»  

- Назначьте соответствующие области адресов: либо от ведущего (по 
умолчанию), к издателю либо без узлов.  

Если Вы устанавливаете область адресов для ID DP в режим "DX", 
тогда область адресов невидима с точки зрения CPU ведущего DP. 
Это означает, что нет логической адресации для ведущего CPU в этой 
области адресов. Пользовательский диалог показывает область 
передатчика (партнера DP), которая изменяет выходы абонента.  
На приведенном выше рисунке это область адреса Q2 для ведомого 
1. С точки зрения ведущего 1, Q2 невидим. В процессе конфигурации 
показаны имя, адрес PROFIBUS и логический адрес для I1 ведомого 
3 (издателя) (например, I 100).  
Если Вы установили область адресов для DP ID в режим "MS", то эта 
область адресов видима с точки зрения ведущего CPU. Это означает, 
что при конфигурировании эта область адресов отражается в 
логических адресах  выходов (например, Q 100).  
Если Вы установили DP ID для абонента в режим "--» , то эта область 
адресов невидима с точки зрения ведущего CPU и эта область не 
изменяема каким либо другим узлом. При конфигурировании эта 
область адресов не отражается в адресах логических выходов.  
Интерактивная помощь к закладке "Address Configuration 
[Конфигурация адресов]» содержит информацию об выборе области 
адресов и примеры применения.  

- Подтвердите установки "OK" 

4. Сконфигурируйте остальных ведомых и ведущего со всеми модулями.  

5. Сохраните и скомпилируйте конфигурацию. 

6. Загрузите аппаратную конфигурацию в станцию.  
Если для прямого обмена данных используются различные мастер 
системы, все задействованные станции тоже должны быть загружены. 
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3.9 Работа с GSD-файлами 

Файл базы данных об устройстве 
В GSD-файле (файле базы данных об устройстве) хранятся все свойства 
ведомого DP. STEP 7 требует GSD-файл для каждого ведомого DP, чтобы это 
устройство можно было выбрать в каталоге модулей. Для устройств других 
фирм, которые используются в качестве ведомых DP, GSD-файл 
поставляется изготовителем вместе с устройством. 

3.9.1 Импорт файла *.GSD  

Файлы *.GSD в STEP 7, начиная с версии V4.02, хранятся не только в 
каталоге приложения ”Configuring Hardware [Конфигурирование аппаратуры]”, 
но и в проекте, т. е. вся информация, необходимая для отображения ведомых 
DP (в том числе символы этих устройств), доступна в сохраненном проекте. 
Если станция должна обратиться к файлам *.GSD, сохраненным в проекте, то 
мы будем называть это импортом станции *.GSD. 

При конфигурировании аппаратуры Вы можете командой меню Options > 
Import Station *.GSE Files [Возможности > Импорт GSD станции] импорти-
ровать доступные (только) в проекте GSD-файлы и символы ведомых DP в 
каталог GSD STEP 7 и, таким образом, использовать их для других проектов. 

3.9.2 Установка GSD- файла 

Если ведомый DP не появляется в окне каталога аппаратуры, Вы должны 
установить соответствующий GSD-файл, поставляемый изготовителем. 

1. Выберите команду меню Options > Install New *.GSE Files [Возможности 
> Установить новый GSD]. 

2. В появившемся затем диалоговом окне откройте дисковод/каталог с 
соответствующим GSD-файлом. 
Результат: Ведомый DP вносится в окно каталога аппаратуры «Hardware 
Catalog [Каталог аппаратуры]» в раздел "PROFIBUS-DP\Other Field 
Devices [PROFIBUS-DP\Прочие полевые устройства]» и доступны там для 
использования при конфигурировании. 

Перезапись файлов *.GSD 
Для отображения ведомых DP STEP 7 использует GSD-файлы и символы, 
установленные в STEP 7, т. е. 

• автоматически установленные STEP 7  

• установленные в STEP 7 командой меню Options > Install New *.GSE Files 
[Возможности > Установка нового GSD] или Options > Import Station *.GSE 
Files [Возможности > Импорт GSD станции].  

При последующей установке или импортировании уже имеющиеся в наличии 
GSD-файлы/символы не удаляются полностью, а сохраняются в следующем 
резервном каталоге: 



Конфигурирование децентрализованной периферии (DP) 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
3-50 A5E00261404-01 

\\Step7\S7data\Gsd\Bkp[No.], 

где [No.] – текущий номер, автоматически задаваемый STEP 7.  

Восстановление перезаписанных файлов *.GSD 
Для восстановления случайно перезаписанных файлов *.GSD или символов 
действуйте следующим образом:  

1. Выберите команду меню Options > Install New *.GSE Files, [Возможности > 
Установка нового GSE] 

2. В появившемся диалоговом окне перейдите в каталог 
\\Step7\S7data\Gsd\Bkp[Nr]. Убедитесь, что Вы выбираете желаемый 
резервный каталог (используйте Explorer, чтобы найти каталог с 
требуемой датой и временем). 

3. Щелкните на кнопке "Open [Открыть]".  

3.9.3 Что надо знать о ревизиях GSD  

Свойства ведомых DP предусматривают инструменты конфигурирования с 
помощью файлов GSD. 

Любые расширения функций устройств распределенного ввода-вывода  
приводят к изменениям в файлах GSD, например, к новым ключевым словам. 

Чтобы обеспечить интерпретацию средствами конфигурирования файлов 
GSD, содержащие  новые ключевые слова, спецификации GSD расширяются. 
Это приводит к появлению различных версий спецификаций. Версии 
спецификации файлов GSD выпускаются м названием "GSD-Revision 
[Ревизии GSD]".  

Ревизии GSD содержат в файле GSD обязательное ключевое слово 
"GSD_Revision", начиная с ревизии 1. Файлы GSD где отсутствует это 
ключевое слово интерпретируются средствами конфигурирования как GSD 
ревизии "0". 

STEP 7 V5.1, Service Pack 3 
Эта версия STEP 7 может интерпретировать файлы GSD до ревизии 4 
включительно. Это означает, что Вы можете использовать следующие новые 
функции ведомых DP, если у Вас установлены соответствующие файлы GSD 
(ревизия 4):  

• Назначение модулям F-параметров  

• Диагностические сообщения для блоков прерываний 

• Изохронный режим   
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Особенность:  
Пожалуйста заметьте, что для редактирования F-параметров должен быть 
установлен дополнительный пакет COM PROFISafe. Если этот пакет не 
установлен, параметры будут не видимы и их нельзя будет изменить. F-
параметры, тем не менее, остаются (значения по умолчанию берутся из 
файла GSD или их значения изменены с использованием COM PROFISafe) и 
будут учтены при генерировании конфигурации (Для дополнительной 
информации, см. документацию по F-системам). 

Не поддерживаются следующие функции, предусмотренные ревизией 4 GSD:  

• Второй кадр параметров (расширенная параметризация) 

• Функции абонента  (возможность приема для прямого обмена данными 
/боковые коммуникации)  

• Ключевые слова для назначения параметров HART  

STEP 7 V5.3 
Эта версия STEP 7 может интерпретировать файлы GSD вплоть до версии 
GSD Revision 5. Это позволяет использовать новые свойства ведомых DP при 
установке соответствующих GSD (ревизия 5):  

• Использовать ведомого DP как приемника (абонента) для прямого обмена 
данных (побочные коммуникации). 

• Резервированные конфигурации ведомых DP в H-станциях.  
Ведомый DP может быть сконфигурирован как резервированный, если  в 
GSD присутствует запись  "Slave_Redundancy_supp = 8“. 

• Синхронизация времени для ведомых DP.  
Ведомый DP с записью GSD "Time_Sync_supp = 1“ для конфигурирования 
этой функции снабжен закладкой "Clock Synchronization [Синхронизация 
часов]". 
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3.10 DPV1 

3.10.1 Что надо знать о PROFIBUS DPV1 

Приведенная ниже информация относится к следующим темам: 

• Механизмы ведущий/ведомый вновь введенные DPV1  

• Изменения, которые встретятся Вам при конфигурировании и 
программировании этих компонентов  

Дополнительная информация 
Страница поддержки пользователя Интернет содержит публикации FAQ 
относительно этой темы под идентификатором ID 7027576. (Заголовок: 
"Changing over to DPV1 [Замена на DPV1]"; справьтесь в Automation Systems > 
SIMATIC Decentralized Peripherals > PROFIBUS > General [Системы 
автоматизации > Распределенная периферия > PROFIBUS > Общее])  

Какие ведущие/ведомые поддерживают DPV1? 
CPU семейства S7-400, с встроенным интерфейсом DP, поддерживают 
функции ведущего DPV1, начиная с версии встроенного программного 
обеспечения 3.0. 

Функции ведущего DPV1 выполняет новый CP 443-5 (DX03).  

Ведомые DP перечисленные в каталоге аппаратуры Step 7 под именем своих 
семейств определяются в информационном тексте как ведомые DPV1.  

Ведомые DP, подключаемые к STEP 7 через файлы GSD поддерживают 
функции DPV1, если это GSD Revision 3 [Ревизия 3].  

Дополнительные возможности устройств DPV1 (Ведущий/ведомые)  
Ведущие и ведомые DP, которые поддерживают DPV1, в отличие от «старых» 
устройств (часто называемых "Стандартный ведущий» или "Стандартный 
ведомы"), снабжены следующими дополнительными функциями:  

• Поддерживается ациклический обмен данных между ведущим и ведомым  
(чтение/запись записей для реконфигурации работающего). Записи 
данных модуля и их структура раскрыта в документации на 
соответствующие модули.  

• Ведомый DPV1 обеспечивает прерывания, чтобы предохранить работу 
ведущего CPU при событиях, вызывающих прерывания. Данные 
прерывания оцениваются также в режиме STOP CPU (обновление 
диагностического буфера и состояния модуля); однако OB, не 
выполняются в режиме STOP. 
В дополнение к прерываниям, известным в SIMATIC (например, 
диагностическому прерыванию от ET 200M), поддерживаются новые 
прерывания, названные Состояния/Обновления/Производителя. 

Примечание: Ведомые DP, которые до сих пор были полностью встроены в 
STEP 7 (то есть ведомые, которые конфигурировались не через файлы GSD, 
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а через внутреннюю информацию о модулях STEP 7) также поддерживают 
часть из этих функций, однако, с специфическим для S7 значением, 
например, содержанием записей данных. Новым является то, что теперь эти 
функции доступны независимым производителям (например, для ведомых 
DP с файлами GSD ревизии 3).  

3.10.2 Конфигурирование устройств DPV1  

Изменение интерфейса мастера DP и конфигурирование ведомых DP 
Рабочий режим DPV1 устанавливается по умолчанию при конфигурировании 
аппаратуры в STEP 7, если Вы используете ведущее с возможностями DPV1 
в стойке ведущего. Для изменения рабочего режима выполните следующее: 

1. Дважды щелкните на строке "DP Master» в конфигурационной таблице 
CPU. Эта строка представляет интерфейс DP. 

2. В диалоге свойств, щелкните в выпадающем меню "DP-Mode» и выберите 
желаемый рабочий режим:  

- "S7 compatible [Совместимый с S7]", если Вы не хотите использовать 
функции DPV1  

- "DPV1", если Вы используете функции DPV1. 

3. Реализуйте всех ведомых DP в мастер-системе DP.  
Допустимо:  

- Через интерфейс DP с рабочим режимом DPV1 Вы можете также 
работать с ведомыми DP, которые не поддерживают этих функций, 
(например, ведомый DP с файлами GSD ревизии < 3).  

- Вы также можете, в принципе, работать с ведомыми DPV1 через 
интерфейс DP в режиме "S7 compatible [Совместимый с S7]". В этом 
случае функции DPV1 автоматически отключаются. Однако, правила 
конфигурации, определяемые производителем для отдельных 
ведомых DP вынуждают использовать режим DPV1, что не позволяет 
подключить их к мастер-системе DP (это автоматически проверяется 
при конфигурировании)! 

Последствия переключения интерфейса ведущего DP  
Случай 1:  Интерфейс ведущего DP должен быть изменен на "DPV1": 

Этот интерфейс может поддерживать функционирование уже подключенных 
ведомых, которые не поддерживают работу DPV1. 

Случай 2: Интерфейс ведущего DP должен быть изменен "DPV1» в "S7 
compatible [Совместимый с S7]": 

STEP 7 проверяет какие ведомые DP могут быть переключены в этот рабочий 
режим. Если ведомый DP вынужден использовать DPV1 по причине своего 
функционирования, например, если должны активироваться прерывания, Вы 
не можете использовать этого ведомого DP с этим ведущим DP в режиме "S7 
compatible [Совместимый с S7]".  
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Изменения в структуре ведомого DPV1 
Ведомые DPV1 снабжены моделью слотов, которая является новой по 
сравнению с известными. Однако, связанные с этим сложности для Вас, как 
пользователей STEP 7, являются временными.  

Как правило, Вы адресуетесь к распределенным входам и выходам через 
логический адрес тем же способом, который Вы применяли до сих пор. 
Преобразование адреса слота в логический адрес выполняется 
автоматически или управляется диалогом, когда конфигурируется ведомый 
DP. Итак, назначение слотов и адресов при конфигурации переписываются 
назначением, которое Вы можете сделать через преобразование адресов в 
пользовательской программе (преобразование физического адреса в 
логический адрес и наоборот - через SFC 5 и SFC 49).  

Начиная с STEP 7 V5.1, Service Pack 2, слоты в детальном представлении 
ведомого DP1 всегда начинаются с номера 1. Это имеет следствием, что при 
использовании ведомых DP, сконфигурированных не через файл GSD, 
подключение к DP (например на IM 153) представлено через слот 2.  

Диагностические адреса 
Диагностический адрес ведомого DP не изменяется переключением. Для 
ведомого DPV1 он автоматически назначается виртуальному слоту номер 0, 
представляющему станцию.  

В общем, применимо следующее назначение: 

• Диагностические данные и прерывания, которые могут быть назначены 
только глобально ведомому DP, назначаются виртуальному слоту 0 и его 
диагностическому адресу: например, прерывания от модулей, 
вставленных в слоты, которые еще не сконфигурированы, возвращают 
ошибку станции (OB 86) 

• Остальные слоты и соответствующие им начальные адреса 
конфигурируются  с диагностическими и аппаратными прерываниями, 
включаемыми модулями (например, подключенным к DP модулем IM 153-
2 в слоте 2).  
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3.10.3 Программирование устройств DPV1  

 Новые OB для событий DPV1 
Ведомые DPV1 могут вызывать прерывания. Вы можете использовать 
соответствующие OB операционной системы CPU S7 в том числе и новые 
обеспечивающие  прерывания для Диагностики/Системы/Удаления/Вставки.  

Вновь вводятся следующие OB: 

 
Прерывание DPV1  OB Объяснение 

Прерывание состояния  OB 55 Прерывание состояния может включаться при 
изменении рабочего состояния модуля, 
например из RUN в STOP. 
Справьтесь в соответствующей документации 
производителя по ведомому DPV1 о деталях  
событий, которые вызывают прерывание 
состояния.  

Прерывание обновления  OB 56 Прерывание обновления может включаться 
после реконфигурации слота. Например, это 
может произойти в результате локального или 
удаленного доступа к параметрам.  
Справьтесь в соответствующей документации 
производителя по ведомому DPV1 о деталях  
событий, которые вызывают прерывание 
обновления 

Прерывание, заданное 
производителем 

OB 57 События, вызывающие прерывание, заданное 
производителем, может быть задано 
производителем ведомого DPV1 
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Новые SFB и SFC для доступа к Ведомым DPV1  
Чтобы сделать этот раздел исчерпывающим, приведенная ниже таблица 
показывает, по возможности, новые интерфейсы и их функции в сравнении с 
предыдущими интерфейсами. Вы можете найти более детальную 
информацию в описаниях SFB/SFC и новых OB. Преобразование 
существующих конфигураций к новым SFB/SFC не обязательно. Однако, Вы 
должны использовать новые SFC/SFB при создании новых проектов с 
конфигурацией DPV1, чтобы использовать все возможности DPV1. 

 
Функция Предыдущий 

интерфейс  
Новый интерфейс (DPV1) Комментарий 

Чтение записи данных SFC 59 RD_REC SFB 52 RDREC - 
Запись записи данных SFC 58 WR_REC SFB 53 WRREC - 
Прием прерывания от 
ведомого DP 

- SFB 54 RALRM SFB должен 
вызываться в OB 
который 
включается 
прерыванием.  

Контрольный список для проверки существующих пользовательских 
программ 

Следующие разделы в Вашей пользовательской программе должны быть 
проверены, если Вы редактировали конфигурацию в STEP 7 V5.1, Service 
Pack 2 и если Вы хотите перейти к "DPV1":  

  
Функция Что надо проверить? 

Преобразование адресов Для ведомых DP, сконфигурированных через файлы GSD,  Вы  должны 
проверить назначение слотам логических начальных адресов, если Вы 
хотите использовать преобразование адресов в пользовательской 
программе (SFC 5, SFC 49, SFC 50). Слот 0 имеет дополнительный 
адрес.  
• Ведомый DP применяется через файл GSD:  

Прежде первый вход-выходной модуль ведомого DP был назначен в 
слот 4. Однако, теперь первый вход-выходной модуль назначается в 
слот (как Вы видите в конфигурации аппаратуры).  

• Ведомый DP интегрирован в  STEP 7 (например, ET 200M):  
интерфейсный модуль (слот 2) имеет собственный адрес.  

Чтение диагностики 
посредством SFC 13  

Продолжает действовать первоначально назначенный диагностический 
адрес. STEP 7 внутренне присваивает этот адрес слоту 0.  
Однако, запись диагностических данных ведомого DPV1 имеет другую 
структуру (смотрите описание ведомых DP. Например, для ET 200M 
найдите ключевое слово "Extended Diagnostics [Расширенная 
диагностика]"). 
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Функция Что надо проверить? 

Чтение/Запись записей 
данных 

Если Вы передаете записи данных в ведомого DPV1 с использованием  
SFC58 "WR_REC» или если Вы вызываете записи данных из ведомых 
DPV1 с использованием SFC59 "RD_REC» и если этот ведомый DPV1 
работает в режиме DPV1, ведущий DP оценивает информацию об 
ошибках, которая принимается от ведомого, следующим образом: Если 
информация об ошибках лежит в пределах от W#16#8000 до W#16#80FF 
или от W#16#F000 до W#16#FFFF ведущий DP предает информацию об 
ошибке SFC. Если лежит вне этих пределов, CPU передает SFC 
значение W#16#80A2 и останавливает ведомого. Описание информации 
об ошибках, принятой от ведомых DPV1, смотри Получение прерывания 
от ведомого DP с помощью SFB 54 "RALRM» STATUS [3]. 
See also: Jumps to Language Descriptions and Help on Blocks and System 
Attributes  

Чтение списка состояний 
системы  

Если Вы используете SFC 51 (RDSYSST), например, для чтения 
выходной информации о состоянии модуля или состоянии 
стойки/станции, Вы должны принимать во внимание изменение значений 
слотов и дополнительного слота 0 (смотри выше).  

Пример 1: Оценка информации прерывания OB 40 посредством SFB 54 
"RALRM" 

Распределенный цифровой входной модуль S7 (Начальный адрес 288) 
включает аппаратные прерывания. Дополнительная информация  
прерывания от этого модуля может быть  прочитана в OB 40 через вызов SFB 
54 "DP_ALRM". Проверяется, был ли первым канал, который включил 
аппаратное прерывание.  

Вы также можете получить дополнительную информацию прерывания из 
модулей S7 непосредственно из стартовой информации OB 40. Однако, 
стандарт DPV1 обычно предусматривает до 59 байт дополнительной 
информации о прерывании – слишком много для стартовой информации OB 
40.  

Для информации о SFB 54 и структуре дополнительной информации о 
прерывании для различных типов прерываний справьтесь в руководстве 
"System Software for S7-300/400 System and Standard functions [Системное 
программное обеспечение для S7-300/400. Системные и стандартные 
функции]» или к соответствующей интерактивной помощи.  
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// ... 

// ... 

//Ключ адреса, который включает прерывание (288) 

 L DW#16#120 

 T "MD10" 

 

 CALL "RALRM» , "DB54" 

 MODE :=1 //режим функции: 1 = установка всех выходных параметров   

          //(то есть, F_ID не имеет эффекта) 

 F_ID :="MD10» //начальный адрес слота которым включается прерывание  

 MLEN :=8 //макс. длина дополнительной информации прерывания  

          //байт (например, для состояния канала модуля) 

 NEW :="Alarm_neu» //прием прерывания ? (да = 1) 

 STATUS:="DP_RALRM_STATUS» //Возвр. величина с результатом функции/сообщением об ошибке 

 ID :="Slotadresse_Alarm» //начальный адрес слота от которого принято прерывание 

 LEN :="Laenge_Alarminfo» //длина дополнительной информации препывания (4 байта  

                          //информация заголовка + ,например, 4 байта с вход-выходными 

                          //модулями S7 ) 

 TINFO :=P#M 100.0 BYTE 28 //указатель для стартовой информации OB + информации   

                           //управления 28 байт, начиная с MB 100 

 AINFO :=P#M 130.0 BYTE 8 //указатель на целевую область информации заголовка + 

                          //дополнительной информации прерывания (макс. 59 байт) 

 A M 124.0 //прерывание включил вход 1 (бит 0)?  

 JC Alrm 

 BEU  

Alrm: S Q 0.0 // обработка прерывания 

// ... 
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Пример 2: Оценка диагностических данных в OB 82 посредством    
Целевая область диагностических данных должна быть достаточно большой, 
чтобы вместить стандартную диагностику (6 байт), идентификатор 
специфической диагностики (3 байта для 12 сотов) и оценке диагностики, 
специфической для устройства (только состояние модуля, которое требует 
более 7 байт).  

Расширенная оценка (диагностика зависящая от канала) должна требовать 
резервирование дополнительных байт, предусматривающих поддержку этих 
функции ведомого DP.  

// ... 

// ... 

 L 120  //стартовый адрес для   

 //модуля/станции,  

 T "Slotadresse_Diag»  //из которого читается диагностика  

 

 

 CALL "RALRM» , "DB54" 

 MODE :="Alle_Params»  // 1 = все выходные параметры устанволены 

 F_ID :="Slotadresse_Diag»  //начальный адрес слота из которого  

 //читается диагностика 

 MLEN :=20  //макс. Длина диагностических данных в байтах 

 NEW :="neu»  //не имеет значения  

 STATUS:="RET_VAL»  //результат функции, сообщение об ошибке 

 ID :="Slotadresse_Alarm»  //начальный адрес слота от которого  

 //принято прерывание  

 LEN :="Laenge_Alarminfo»  //длина дополнительной информации прерывания 

 //(4 байта заголовок + 16 байт  

 //диагностические данные  

 TINFO :=P#M 100.0 BYTE 28  //указатель для стартовой информации OB + 

management //информации: 28 байт, начиная с MB 100 

 AINFO :=P#M 130.0 BYTE 20  //указатель на целевую область, в которой  

 //хранятся диагностические данные 

 

// ... 

//Структура хранящихся диагностических данных:  

// MB 130 .. MB 133: информация заголовка (длина, идентификатор, слот) 

// MB 134 .. MB 139: Стандартная диагностика (6 байт) 

// MB 140 to MB 142: идентификатор специфической диагностики (3 байта) 

// MB 143 to MB 149: состояние модуля (7 байт) 

// ... 

 U M 141.0 //ошибка слота 1? 
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 SPB stp1 

 BE  

 

stp1: L MB 147 //чтение слотов состояния модуля 1 .. 4 

 UW W#16#3 //фильтр слота 1 

 L W#16#2 //2-бит состояние 'вставлен неправильный модуль' 

 ==I  

 S A 0.1 //реакция на неправильный модуль 

 

 L MB 147 //чтение слотов состояния модулей 1 .. 4 

 UW W#16#3 //фильтрация слота 1 

 L W#16#1 //2-бит состояние 'неправильные данные пользователя',  

 ==I  

 S A 0.2 //реакция на неправильные данные пользователя 

//.. 
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3.10.4 Модель слотов ведомых DPV1 с интеллектуальными 
ведомыми 

В следующей статье рассмотрена визуализация назначения адресов (вход-
выходные и диагностические адреса) слотам в модели DPV1. Мы должны 
обратить пристальное внимание на адреса, которые не передают 
пользовательских данных и особенно конфигурацию этих адресов. 

Модель слотов для DPV1 
При использовании DPV1 (IEC 61158) ведомый состоит из слотов так же, как 
для DP (EN 50 170). Слоты нумеруются 0, 1, ...n. Новый слот 0 наиболее 
значим, поскольку от представляет ведомого DP в целом. 

Представление означает, например, что прерывания, включаемые через 0, 
назначены ведомому скорее глобально, чем отдельному слоту в составе 
ведомого DP. Диагностический выход этого слота назначен ведомому DP 
глобально, а не какому-либо конкретному слоту или модулю.  

Экскурсия: Адреса интерфейса DP  
С точки зрения CPU, отдельный логический адрес доступен для каждого из 
интерфейсов.  

Вы можете найти этот адрес на закладке "Addresses [Адрес]» интерфейсов 
ведущего и ведомого (двойной щелчок на строке «DP» в таблице 
конфигурации). 

Этот адрес необходим в общем для модели слотов ведомого DP. Скорее, он 
используется CPU внутренне, например, для идентификации ошибок 
интерфейса. Этот адрес имеет небольшое значение в программе 
потребителя.  
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Слоты и адреса для пользовательских данных 
Вообще говоря, производитель ведомого DP может свободно выбрать, какой 
тип данных он назначает в любой слот.  

Первый вход-выходной модуль ведомого DP (часто называемый "S7 Slaves"), 
сконфигурированный в Step 7 через внутреннюю базу данных модулей STEP 
7 всегда располагается в слоте 4. В отличие от этого, ведомые, которые 
установлены в Step 7 через файлы GSD, могут содержать пользовательские 
данные в слоте 1.  

Распределенные периферийные данные обычно адресуются через их 
адреса, также как и центральные периферийные данные. Поэтому 
пользовательские данные ведомого S7 всегда адресуются через начальный 
адрес слота 4.  

Это применимо и для интеллектуальных ведомых DP. Интеллектуальным 
ведомым DP Вы можете назначить область памяти входов-выходов через 
таблицу (закладка "Configuration [Конфигурация]") области памяти входов-
выходов ведущего. В рабочем режиме (циклический обмен данных) данные, 
которые Вы направляете в программе пользователя интеллектуального 
ведомого в эту область памяти, передаются в назначенную  область памяти 
ведущего.  

Впрочем, когда Вы конфигурируете этот адрес, номер слота не отображается, 
поскольку пределы слотов не формируется реальными модулями (например, 
как для ET 200M). При этом формируется относительно свободно 
конфигурируемая длина соответствующей вход-выходной области. В этом 
случае мы также говорим о “виртуальных” слотах.  

Важно для назначения адресов:  

• В дополнение к “реальным” слотам область памяти интеллектуального 
ведомого также имеет “виртуальные” слоты.  

• Виртуальные слоты адресуются также как и реальные, а именно через их 
логический адрес. Для “стандартных” ведомых DP, таких как ET 200M это 
осуществляется через начальный адрес, и для интеллектуального 
ведомого через адрес, сконфигурированный на закладке "Configuration 
[Конфигурация]» (вход-выходная область).  

• Адреса виртуальных слотов отличаются с точки зрения ведущего и 
ведомого. Назначение конфигурируемо. Следовательно, ведущий и 
ведомый  DP как правило используют различные адреса для одного и того 
же слота.  
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Пример назначения адресов для пользовательских данных  

 
Предшествующее назначение “виртуальных” слотов было таким. 

  
Пример 
адреса с 
точки зрения 
ведомого  

Значение  
(для ведомого DP ) 

Слот  
(не видим при 
конфигурации)  

Значение  
(для ведущего DP) 

Пример адре-
са с точки 
зрения 
ведущего 

  0   
  1   
  2   
  3   
i 2 Чтение через входной 

байт 2, который… 
4 ... который ведущий 

записал через 
выходной байт 4.  

Q 4 

Q 5 Запись ведомым в 
выходной байт 5, 
которая ... 

5 ... которая прочитана 
ведущим , как 
входной байт 6. 

I 6 

I 8 ...  6 ...  Q 8 
  ...   
  35   

  

Совет: назначение слотов отображается в обзоре адресов ведущего или 
ведомого CPU. 

Слоты и адреса для системной информации  
Адреса для системной информации используются, например, для обработки 
диагностической информации или информации об изменении рабочего 
состояния.  

Адреса ведомого DP  
Системная информация ведомых DP также назначается в слотах. Для 
рабочего режима DPV1 в этом контексте существенны следующие слоты: 

• Слот 0 (Представляет станцию):  
Через адрес этого виртуального слота, видимых в представлении 
ведущего DP, ведущий DP диагностирует ошибки или отвечает 
интеллектуальному ведомому DP. 
Через адрес этого виртуального слота, видимого в представлении 
ведомого DP, интеллектуальный ведомый DP диагностирует ошибки или 
отвечает ведущему DP.  
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• Слот 2 (для интерфейса DP стандартного ведомого DP): 
Через адрес этого виртуального слота, видимых в представлении 
ведущего DP, ведущий DP может определить переход рабочего состояния 
ведомого DP. Ведущий DP может также использовать этот адрес для 
включения аппаратного прерывания  на интеллектуальном ведомом DP 
(SFC 7).  
Через адрес этого виртуального слота, видимый в представлении 
ведомого DP, ведомый DP может определить переход рабочего 
состояния ведущего DP.  

• Слоты 1 и 3 не существенны для интеллектуальных ведомых DP.  

В приведенной ниже таблице Вы можете найти назначения для слотов от 0 
до 3 ("виртуальные» слоты). Значения в таблице, существенные для 
конфигурации ведущей и ведомой станций, описаны ниже таблицы. 

В STEP 7 адреса автоматически назначаются “снизу вверх” в порядке, 
исключающем конфликт адресов. Вы должны применять рекомендованные 
адреса, даже если Вы можете отредактировать их. Проверьте соответствует 
ли размер адресуемой области “наименьшему” CPU в случае, если 
пользовательская программа выполняется в различных CPU.  

  
Пример 
адреса с 
точки зрения 
ведомого  

Значение  
(для ведомого DP ) 

Слот  
(не видим при 
конфигурации

)  

Значение  
(для ведущего DP) 

Пример адре-
са с точки 
зрения 
ведущего 

8189 Ошибка станции / 
станция возвращает 
ведущему DP (см. 1) 

0 Ошибка станции / 
станция возвращает 
ведомому DP (см. 3) 

16381 

- Не существенно 1 Не существенно - 
8188 Изменение рабочего 

состояния ведущего DP  
(см. 2) 

2 Изменение рабочего 
состояния ведомого DP 
(см. 4)  

16380 

- Не существенно 3 Не существенно - 
 Данные пользователя 

(см. выше) 
4 ... 35 Данные пользователя 

(см. выше) 
 

(1) В ведомой станции дважды щелкните на интерфейсе DP интеллектуального ведомого 
(например, CPU 414-3 DP), закладка "Configuration [Конфигурация]"; возможен ввод в 
таблице, поле "Diagnostics [Диагностика]".  

(2) В ведомой станции дважды щелкните на интерфейсе DP интеллектуального ведомого 
(например, CPU 414-3 DP), закладка "Operating Mode [Рабочий режим]"; в случае "DP 
Slave» возможен ввод в поле "Address for virtual slot 2 [Адрес виртуального слота 2]".  

(3) В ведущей станции дважды щелкните на иконке ведомого, закладка «General 
[Общее]»; возможен ввод в "Addresses [Адрес]» в поле "Diagnostic address 
[Диагностический адрес]". 

(4) В ведущей станции дважды щелкните на иконке ведомого, закладка, «General 
[Общее]»; возможен ввод в "Addresses [Адрес]» в поле "Address for virtual slot 2 [Адрес 
виртуального слота 2]". 
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Итог 
С явно представленными виртуальными слотами конфигурация 
интеллектуального ведомого DP показана ниже: 

Ведущий DP (режим DPV1)

PROFIBUS

0

Адреса в представлении ведущего 16381

8189

Виртуальные слоты 1 2

16380

8188

3 4

Q 4

I 2

5

I 6

Q 5

...

...

...

35

...

...

Ведомые DP (режим DPV1)

Адреса в представлении ведомого

Адреса для системной информации Адреса для пользовательских данных

Н
е 
за
ня
т

Н
е 
за
ня
т

 

Включение аппаратных прерываний с помощью SFC 7 
Используя SFC 7, Вы можете включить аппаратные прерывания для любых 
сконфигурированных адресов из пользовательской программы 
интеллектуального ведомого CPU. Это также применимо для адресов 
пользовательских данных диапазона входов-выходов, например, адресов 
виртуального слота 2.  

В пользовательской программе интеллектуального ведомого используйте, 
например, для SFC 7входные и выходные адреса сконфигурированные в 
колонке "Local...". 

При этом в пользовательской программе ведущего включается аппаратное 
прерывание. В стартовой информации OB аппаратных прерываний 
(например, OB 40) как адреса вызвавшие прерывание указываются адреса, 
сконфигурированные в колонке "PROFIBUS-DP-Partner". 
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3.11 Диагностический повторитель 

3.11.1 Конфигурирование и ввод в действие диагностического 
повторителя 

Диагностический повторитель обеспечивает мониторинг сегмента подсети  
RS485 PROFIBUS (медный провод) в рабочем режиме и сообщает о 
дефектах кабеля  через диагностические телеграммы DP. Используя HMI, Вы 
можете отобразить место и причину ошибки незашифрованным текстом. 

Диагностический повторитель с возможностью диагностики линии 
предоставляет возможность определить и локализовать ошибки линии на 
раннем этапе и в рабочем состоянии с сниженными характеристиками.  

Конфигурирование диагностического повторителя 
Вы может найти диагностический повторитель в каталоге аппаратуры в 
разделе "PROFIBUS DP\Network components\Diagnostic Repeater". 
Диагностический повторитель должен быть сконфигурирован подобно 
стандартному ведомому (он подключается к мастер-системе ведущего DP).  

Функции диагностического повторителя  
Чтобы обнаружить нарушения функционирования , диагностический 
повторитель должен знать топологию подсети PROFIBUS, к которой он 
подключен. Диагностический повторитель измеряет расстояние до всех 
партнеров с использованием функции "Prepare line diagnostics [Подготовить 
диагностику линии] ".  

Диагностический повторитель измеряет расстояние до партнеров т хранит их 
в своей таблице. Диагностический повторитель также запоминает в каком из 
сегментов был обнаружен партнер. 

После измерения расстояния до дефекта сегмента в процессе работы, вводы 
в таблице могут использоваться, чтобы определить между какими 
партнерами находится дефект сегмента.  

Диагностический повторитель соединяет 3 сегмента. В процессе работы он 
может определить, топологию и локализовать ошибку сегмента только в 
сегментах DP2 и DP3, поскольку только они обеспечивают измерение 
расстояния. Рисунок ниже показывает диагностический повторитель (DR) и 
его соединения. 

 

Схема измерения с 
согласующим 
сопротивлением  

DR

 DP1

 DP3 DP2

PG 
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Предварительные условия для ввода в эксплуатацию 
Должны быть выполнены следующие предварительные условия:  

• Чтобы иметь возможность запустить считывание топологии, PG должен 
быть подключен к сети PROFIBUS. 

• Структура сети PROFIBUS с подключенным диагностическим 
повторителем соответствует спецификациям и правилам документации 
диагностического повторителя.  

Ввод в действие диагностического повторителя с помощью STEP 7 
Для того, чтобы обнаружить место дефекта в процессе функционирования, 
диагностический повторитель должен знать топологию сети PROFIBUS, к 
которой он подключен. Диагностический повторитель измеряет расстояние до 
всех партнеров через функцию "Prepare line diagnostics [Подготовить 
диагностику линии] ".  

Диагностический повторитель измеряет расстояние до партнеров и хранит 
его во внутренней таблице. Диагностический повторитель также запоминает, 
в каком сегменте расположен партнер.  

После того, как в процессе функционирования измерено расстояние до 
дефекта, данные таблицы могут использоваться для определения, между 
какими партнерами произошел дефект.  

Вы можете явно указать диагностический повторитель для определения 
расстояния между партнерами PROFIBUS при конфигурировании аппаратуры 
или сети:  

1. Выделите диагностический повторитель или мастер-систему, к которой он 
подключен (конфигурация аппаратуры), или выделите подсеть PROFIBUS 
к которой подключен диагностический повторитель (конфигурация сети)  

2. Выберите команду меню PLC > Prepare line diagnostics [PLC > 
Подготовить диагностику линии]. 

3. Запустить измерения через открывающийся диалог.  

Обнаружение ошибок функционирования 
В процессе функционирования диагностический повторитель сообщает 
ведущему CPU о событии "Found Error [Найдена ошибка]".  

ВЫ можете увидеть подробную информацию о задержанных диагностических 
событиях в диалоге для состояния модуля диагностического повторителя. 
Ошибка отображается визуально в диалоге с дополнительной информацией, 
например, показана причина ошибки (если она может обнаруживаться 
диагностическим повторителем).  
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Пример визуального представления в диалоге "Module Status [Состояние 
модуля]»  

Если функционирование всех сегментов, к которым подключен 
диагностический повторитель не имеет ошибок, соответствующие закладки в 
диалоге "Module Status [Состояние модуля]» выглядят следующим образом:  

 
Если сегмент отключен, (значит его невозможно диагностировать), 
появляется следующий символ сбоку от названия закладки:  

 Символ для отключенного сегмента  

Ошибка в сегменте "DP2» вызывает символ ошибки сбоку от надписи на 
закладке "DP2". Остальные сегменты не имеют ошибок:  

 
Закладка "DP2» tможет показать дефект следующим образом: 
Диагностический повторитель имеет адрес PROFIBUS 4, ошибка 
расположена между партнерами, имеющими адреса PROFIBUS 16 и 21. 
Дополнительно показано расстояние до соседних ведомых.  

 
На картинке ниже Вы видите пример, упрощенно представляющий детали 
размещения, представленного Выше.  

Расстояние до
дефекта

Узел 16Узел 21Узел 13

DP3DP2

Следует включить
согласующее соединение

Схема измерения
с согласующим
сопротивлением

DR (Узел 4)

DP1

PGPG
Узел 1
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Если STEP 7 не может локализовать ошибку в сегменте "DP2» или если, 
например, этот сегмент содержит более 32 партнеров и диагностический 
повторитель не может работать правильно, Вы увидите следующее 
изображение: 

 
 

Все символы 
Символы регистров имеют следующий вид:  

 

  Нет ошибок в сегменте 

  Ошибка в сегменте 

  Сегмент отключен 

  Информация из сегмента не может быть получена 

3.11.2 Отображение топологии с помощью диагностического 
повторителя 

Начиная со STEP 7 V5.2, при конфигурации PROFIBUS с диагностическим 
повторителем класса 2  972-0AB01 возможно выполнить не только линейную 
диагностику, но и отобразить топологию сети PROFIBUS DP. 

В отличие от представления сети в NetPro, эта функция дает не “логический” 
вид подсети PROFIBUS, а скорее физическое расположение узлов PROFIBUS 
в их действительном порядке в соответствии с расстоянием до узлов – 
предполагается, что диагностический повторитель обеспечил получение этих 
данных. Действующие узлы отображаются также, как в NetPro. 
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Функционирование 
До отображения топологии после каждого изменения структуры оборудования 
должна быть выполнена функция "Prepare line diagnostics [Подготовить диаг-
ностику линии]", с тем, чтобы диагностический повторитель провел измере-
ния в подсети PROFIBUS и сгенерировал внутреннюю таблицу расстояний.  

Функция «Display the PROFIBUS Network Topology [Отобразить топологию 
сети PROFIBUS]» использует эти данные для визуализации.  

В дополнение к визуализации, могут читаться и отображаться записи в 
диагностическом буфере диагностического повторителя, а также данные 
статистики.  

Вы можете записать эти данные в файл и распечатать.  

Предпосылки 
Диагностический повторитель должен поддерживать функцию «Display the 
PROFIBUS Network Topology [Отобразить топологию сети PROFIBUS]» (то 
есть иметь номер 6ES7 972-0AB01).  

Для правильного определения расстояний, структура сети PROFIBUS должна 
соответствовать основным принципам руководства по диагностическому 
повторителю. Каскадированные диагностических повторители, например, 
могут быть подключены к ведущему диагностическому повторителю только 
через интерфейс DP1.  

Для вызова функции «Prepare line diagnostics [Подготовить диагностику 
линии]» программатор должен быть подключен к той же сети PROFIBUS, что 
и диагностический повторитель. Функция «Prepare line diagnostics [Подгото-
вить диагностику линии]» может быть также вызвана без открытого проекта.  

Чтобы разрешить функцию «Display the PROFIBUS Network Topology 
[Отобразить топологию сети PROFIBUS]», Вы, таким образом, подключить 
сеть PROFIBUS с диагностическими повторителями к программатору через 
"Data record router [Маршрутизатор записей данных]» (например, CP 443-5 Ext 
V3.2). Программатор также должен быть включен в проект STEP 7 (В NetPro, 
используя команду меню PLC > Assign PG/PC [ПЛК > Назначить PG/PC] для 
конфигурирования объекта "PG/PC»). Чтобы разрешить отображение сетевой 
топологии через маршрутизацию диагностического повторителя , Вы должны 
открыть соответствующий проект и выбрать соответствующую подсеть 
PROFIBUS.  

Последовательность действий 
Выполните одно из следующего: 

1. В NetPro или в HW Config, выберите команду меню PLC > Prepare Line 
Diagnostics [ПЛК > Подготовить диагностику линии ]. 

2. В SIMATIC Manager выберите команду меню PLC > PROFIBUS > Display 
Network Topology [ПЛК > PROFIBUS > Отобразить сетевую 
топологию]; или в NetPro, выберите команду меню PLC > Display 
PROFIBUS Topology [ПЛК > Отобразить сетевую топологию]. 

Альтернатива. Используйте SFC 103 ("DP_TOPOL") в программе 
пользователя для определения топологии.  
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3.11.3 Работа с топологическим представлением 

Отображение узлов 
Верхняя часть окна "Topology display PROFIBUS DP [Топологическое 
представление PROFIBUS DP]» показывает узлы, которые не могут быть 
назначены.  

 
Представление Значение 

  

Узлы не могут быть назначены. 
Возможные причины приводятся в окне 
сообщения:  
Узлы добавлены, адреса узлов изменены, 
после чего функция «Prepare line diagnostics
[Подготовить диагностику линии]» не 
выполнялась. Если подключен 
диагностический повторитель, то чтение 
топологических данных не поддерживается, 
Об этом также сообщается в нижней части 
окна. 
Неизвестный узел обозначается рядом 
знаков вопроса.  

 

Нижняя часть окна показывает узлы, которые могут быть назначены как 
сетевые узлы вместе с информацией о расстоянии и, если необходимо, 
дополнительной информацией. 

 
Представление Значение 

  

Узлы должны быть назначены и 
представлены в топологии PROFIBUS. 
Другая информация, например, ошибки 
конфигурации (например, когда 
непосредственно связаны измеряемые 
сегменты двух диагностических 
повторителей) доводится в виде 
сообщений. 
Представление длины кабелей (на 
примере):  
Длина кабеля между ведомым DP с 
адресом PROFIBUS 2 и диагностическим 
повторителем (адрес PROFIBUS 16) - 4 
метра. Ведомый DP подключен как сегмент  
DP2. 
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Как найти узлы в топологическом представлении 
В большой конфигурации Вы можете обнаружить требуемый узел используя 
команду меню Options > Go To [Возможности > Перейти]. Следующее 
диалоговое окно "Go To [Перейти]» все узлы сети PROFIBUS:  

1. Выберите требуемый модуль (например, ведомого DP) 

10 Нажмите кнопку "Node [Узел]» для отображения узла в центе окна.  
Нажмите кнопку "Diagnostic repeater [Диагностический повторитель]» для 
отображения назначенного в центре окна.  

Отображение топологии  в таблице 
Если Вы предпочитаете отображать топологию таблично, а не графически, 
вызовите команду меню View > Table > Topology [Вид > Таблица > 
Топология].  

Подготовить диагностику линии 
Используйте эту процедуру в HW Config или в NetPro. В топологическом 
представлении, вызовите команду меню PLC > Prepare Line Diagnostics 
[PLC > Подготовить диагностику линии].  

Вызов состояния модуля 
Используйте эту процедуру в HW Config или в NetPro В топологическом 
представлении, вызовите команду меню PLC > Module Status [PLC > 
Состояние модуля].  

Как сохранить и открыть топологические данные 
Выберите команду меню File > Save [Файл > Сохранить] или File > Save As 
Save [Файл > Сохранить как ] для сохранения текущего представления. Эта 
функция позволяет сохранить полученные online данные для последующего 
анализа и диагностики.  

Как экспортировать топологические данные 
Вы можете использовать следующие виды для экспорта топологических 
данных: 

• Вид "Table [Таблица]» (после вызова команды меню View > Table [Вид 
>Таблица]) 

• Диалоговое окно "Statistics [Статистика]» (после вызова команды меню 
PLC > Statistics [PLC > Статистика]) 

• Диалоговое окно "Diagnostics buffer [Диагностический буфер]» (после 
вызова команды меню PLC > Diagnostics Buffer [PLC > Диагностический 
буфер]) 

Формат экспорта CSV (ASCII) может читаться и редактироваться другими 
приложениями.  

Отображение топологии не может читать экспортированные данные. 
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Как находить данные об дефектах отражения и ошибки кадров сообщений 
(статистические данные) 

Дефекты отражения (интерференции) возникают в таких случаях, как обрыв 
линии или дефекте из-за неподключенного терминального резистора или из-
за подключения нескольких терминальных резисторов.  

Ошибка кадров возникают в таких случаях, когда, например, по крайней мере 
один бит искажен из-за аппаратных ошибок (контроль четности). 

Вы можете зарегистрировать ошибки интерференции и кадров сообщений 
обнаруженных диагностическим повторителем. Вы можете, например, 
распечатать или экспортировать зарегистрированные данные.  

1. В топологическом представлении, выберите диагностический 
повторитель, данные которого Вы хотите прочитать.  

2. Запустите эту функцию командой меню PLC > Statistics.  

Величины будут отображаться в течение 60 сек.,  начиная со времени 
открытия диалога. Последующие величины будут накоплены 
непосредственно через этот интервал. Вы можете нажать кнопку «Export 
[Экспорт]» для экспорта этих переменных в формате CSV.  

Цветная кодировка также помогает Вам в определении степени серьезности 
ошибки. Цветная кодировка отображения определена оценкой статистических 
данных.  

Нажмите на  «Print [Печатать]» для распечатки видимого графического 
объекта.  

Получение данных из диагностического буфера 
Подобно функции диагностического буфера CPU, Вы можете использовать 
эту функцию для записи последовательности ошибок и событий в сети 
PROFIBUS. Выберите команду меню PLC > Diagnostics Buffer [ПЛК > 
Диагностический буфер] для запуска этой функции. Следующий диалог 
отображает последние 10 событий. Щелкните на событии для отображения 
деталей в нижней части диалогового окна.  

Если закладка "DPx» (например, закладка "DP2») в диалоговом окне 
«Diagnostic Buffer [Диагностический буфер]» показывает, какой сегмент 
неисправен, затем следует возникшая ошибка. При определенных условиях 
эта ошибка не содержится в диагностическом буфере. 

Для отображения текущего состояния, выберите команду меню PLC > Module 
Status [PLC > Состояние модуля].  

Распечатка топологического представления 
Выберите File > Print [Файл >Печатать] для распечатки топологических 
данных. Вы должны задать принтер и диапазон печати в следующем 
диалоговом окне. 
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3.12 Установка эквидистантных циклов шины для 
подсетей PROFIBUS 

3.12.1 Установка эквидистантных циклов шины для подсетей 
PROFIBUS 

 Введение 
Для подсетей PROFIBUS Вы можете запараметрировать в STEP 7 циклы 
шины одинаковой длины (эквидистантные). 

Эквидистантность - свойство PROFIBUS-DP, которое обеспечивает постоян-
ную длительность цикла шины. Это означает, что ведущий DP всегда начина-
ет цикл шины DP через один и тот же временной интервал. С точки зрения 
подключенных ведомых, это означает, что они также получают свои данные 
от ведущего во временные интервалы точно одинаковой длительности.  

Получено
следующее
разрешение
на передачу

t

Получено
разрешение
на передачу

Получено
очередное
разрешение
на передачу

Эквидистантный цикл DP
  

Время цикла шины  
На следующем рисунке показано, как формируется время цикла шины. 

Получено разрешение
на передачу

Получено следующее
разрешение на передачу

Передача данных
пользователя между
master-устройством и
slave-устройствами
DP

Ацикличес-
кое обслу-
живание,
другие актив-
ные абоненты
(PG/OP)

переменная
пауза

Эквидистантный цикл DP

t
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Показанная на рисунке "переменная пауза» минимальна в тех случаях, когда 
задания на выполнение связи, напр., для других активных абонентов, стоят в 
очереди. Мастер (называемый также мастером эквидистанты) управляет 
долей цикла, отводимой на коммуникации, так, чтобы всегда обеспечивалась 
одинаковая продолжительность цикла шины. 

Предпосылки 
• Мастер эквидистанты должен быть ведущим DP класса 1, т. е. PG/PC не 

может быть мастером эквидистанты. 

• Мастер эквидистанты – единственная активная станция в PROFIBUS-DP. 
Также могут быть подключены программаторы и PC.  

• Эквидистантный режим возможен только для профилей шины «DP» и 
«User-Defined [Определяемый пользователем]».  

Время эквидистантного цикла DP  
STEP 7 вычисляет рекомендуемое время для "DP constant bus cycle time(ms) 
[эквидистантного цикла DP]» на основе: 

• Конфигурации PROFIBUS (число сконфигурированных узлов, числа 
программаторов и т.д.)  

• Другая информация для вычисления, которая может быть задан 
дополнительно (например, дополнительные не сконфигурированные 
программаторы, которые следует принять во внимание)  

Вы можете исправить это время, но не менее, чем вычисленная минимальная 
величина. 

Влияние подключенных активных абонентов (PG/PC и интеллектуальных 
ведомых DP) 

PG/PC должен учитываться только тогда, когда он своим интерфейсом 
PROFIBUS подключен непосредственно к шине PROFIBUS. Его не нужно 
принимать во внимание, если он подключен через интерфейс MPI CPU, как 
показано на следующем рисунке! 

  

PG CPU DP
Ведомый

MPI PROFIBUS
  

Если подключены интеллектуальные ведомые DP (напр., CPU 315-2DP), то 
время для эквидистантного цикла DP следует выделять более щедро. 
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Эквидистантность 
Вычислив время, STEP 7 предлагает величину эквидистантного цикла шины. 
Эта величина основана на обсуждаемой конфигурации. Однако, Вы можете 
изменить эту величину. 

Когда STEP 7 вычисляет эту величину для эквидистантного цикла шины, в 
выселение включается пользовательский трафик мастера DP, а также запас 
для нескольких сообщений об ошибках, которые могут произойти.  

STEP 7 также вычисляет минимальное значение для эквидистантного цикла 
шины DP. Время цикла не может быть меньше этой величины. Когда STEP 7 
вычисляет минимальное значение, учитывается только обычные кадры 
сообщений для каждого цикла шины. Если возникает ошибка, постоянное 
время цикла может быть нарушено.  

Время, большее рекомендованного, может быть назначено без каких либо 
проблем.  

  

!  
Предупреждение 
Если Вы выбираете время, которое меньше чем рекомендованное системой , 
при определенных обстоятельствах связь с дополнительными активными 
узлами, которые подключаются к подсети PROFIBUS, будет задержана, или, 
в худшем случае, останавливается. Если Вы установили величину, близкую к 
показанному  Вам минимальному допустимому циклу шины, ошибки шины 
могут в определенных случаях отключить всю подсеть PROFIBUS.  

Взаимосвязь: Эквидистантность и SYNC/FREEZE 
Если Вы для PROFIBUS-DP проектируете как "Эквидистантность", так и 
группы SYNC-/FREEZE, то следует принять во внимание следующее: 

• Группа 8 не может быть использована (зарезервирована для шага 
эквидистантности). Если Вы сначала проектируете назначение групп и 
назначили группу 8, то эквидистантность после этого настроить 
невозможно.  

• Если Вы проектируете группу 7, то Ведущий DP автоматически запускает 
команду SYNC или FREEZE в каждом цикле шины. Эти команды не могут 
быть запущены для группы 7 в программе пользователя. 

Последовательность действий  
1. Спроектируйте подсеть PROFIBUS с ведущим, поддерживающим 

функцию "Equidistancy [Эквидистантность]» (см. информационный текст в 
окне «Hardware Catalog» при конфигурировании аппаратуры). 

2. Дважды щелкните в отображении сети на подсети PROFIBUS. 

3. Выберите в диалоге для установки свойств (закладка "Network settings  
[Настройка сети]") профиль «DP» и щелкните на кнопке "Options 
[Возможности]". 

4. Установите в закладке "Equidistancy [Эквидистантность]» эквидистантный 
режим, подходящий для вашего приложения, и адаптируйте его с учетом 
времен, которые следует принимать во внимание, и подключенных 
PG/OP. Подробную информацию о возможностях настройки Вы получите 
через кнопку "Help [Помощь]» в этом диалоговом окне. 
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Дополнительная информация 
Вы можете найти более детальную информацию о установке эквидистантного 
времени цикла шины в интерактивной помощи по закладкам диалога.  

3.12.2 Конфигурирование короткого и постоянного времени 
реакции на сигналы для PROFIBUS DP 

 Время реакции на сигналы без эквидистантного цикла шины и изохронного 
режима  

Если управление приводом или другие приложения требуют короткого и 
постоянного времени реакции на входные сигналы, тогда отдельные 
свободные циклы компонентов отрицательно влияют на общее время 
реакции системы. 

  
В предшествующем примере, изображено поведение без постоянного цикла и 
синхронизации шины, использующее модельную структуру с ведущим DP, 
двумя ведомыми DP, программатором (PG) и OP. Эта конфигурация 
порождает следующие подциклы со своими собственными циклическими и 
ациклическими частями: 

• Свободный цикл пользовательской программы OB 1. Ветвления в 
циклической программе могут вызвать изменения длительности цикла. 

• Свободный, изменяемый цикл DP на шине PROFIBUS, состоящий из: 

- Циклического обмена данных ведущий-ведомый, ведомый 1 DP. 

- Циклического обмена данных ведущий-ведомый, ведомый 2 DP 

- Ациклическая часть для прерываний, приемки шины или 
диагностических служб.  

- Пересылка токена к программатору (PG), с его последующей 
обработкой. 

- Пересылка токена к OP, с его последующей обработкой. 
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• Свободный фоновый цикл ведомого DP. 

• Свободный цикл подготовки сигналов и преобразований в электронных 
модулях ведомых DP. 

Если время реакции должно быть особенно коротким и жестким, то 
свободные циклы с различной длительностью имеют определенное влияние 
на время реакции процесса.  

Программа
пользователя OB1

Цикл DP

Цикл
распределенных
входов –выходов DP

  
При рассмотрении индивидуальных циклов входных электронных модулей 
следует учесть, что сигналы или обмен данных может происходить через 
заднюю шину ведомого DP, обмен данных ведущий-ведомый по подсети 
PROFIBUS в OB 1 пользовательской программы CPU. Реакция системы 
определяется OB 1 пользовательской программы и затем возвращается тем 
же путем в выходной электронный модуль. Различная длина и случайная 
позиция отдельного цикла имеют заметное влияние на время реакции 
системы . В зависимости от позиции в отдельных циклах, передача 
информации может произойти или немедленно или через два цикла. 
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Время реакции системы с эквидистантным циклом шины и временной 
синхронизацией  

SIMATIC обеспечивает репродуктивное (то есть, повторяемое, постоянной 
длины) время реакции посредством эквидистантного (изохронного) цикла 
шины DP и синхронизации отдельных перечисленных выше циклов. 

  
В этом случае ситуация соответствует приведенному выше примеру с тем 
отличием, что все циклы (вплоть до цикла OB 1) имеют постоянную длину и 
синхронизованы. Генератор синхроимпульсов охватывается синхронизацией 
эквидистантного цикла шины, который направляет глобальный управляющий 
кадр ведомым DP. Прерывание синхронного цикла OB 61 (или OB 61 …OB 
64) обеспечивают синхронизацию с пользовательской программой. 

OB61 программы
пользователя    

Цикл DP    

Цикл
распределенных
входов-выходов DP
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При эквидистантных циклах шины и циклической синхронизации, все 
связанные циклы имеют один общий период и длину. Это поддерживает 
постоянное время реакции системы и, поскольку не происходит скачков 
циклов они также короче. Это означает что ранее описанный случай, в 
котором информация могла передаваться в первом или во втором циклах, в 
зависимости от  соотношения циклов, теперь не возникнет. 

Процесс Процесс

Программа пользователя
(OB61)

Программа
пользователя (OB61)

Программа
пользователя

Т (эквидистантный цикл DP)

Задняя шина
распределенной

периферии

Модули рас-
пределенной
периферии

ацикл.
порт

ацикл.
порт

  

В предыдущем примере ведущий DP, обеспечивал циклический обмен 
ведущий-ведомый с ведомыми 1 и 2. За этим следовала обработка 
ациклической части для прерываний, шина доступна для диагностических 
служб. Ведущий DP сохраняет этот резерв времени вплоть до истечения  
сконфигурированного времени эквидистантного цикла в целях компенсации 
возможных сетевых сбоев и повторных поисков кадров сообщений. С этого 
момента начинается новый цикл DP с глобальным кадром (GC). 

Чтобы обеспечить чтение в начале нового цикла DP консистентной 
информации о состоянии для входов DP, процесс чтения должен быть 
смещен вперед на определенное время Ti. Это время Ti включает время для 
подготовки сигнала и преобразования в электронных модулях и время 
обработки входов по задней шине ведомого DP.  

При использовании SIMATIC WinAC RTX (начиная с V3.1) применимо 
следующее: После того, как входные данные всех ведомых DP уже будут 
прочитаны ведущим DP, циклическая синхронная пользовательская 
программа запускается автоматически (OB 6x). 
При использовании SIMATIC S7-400 применимо следующее: Запуск 
циклической синхронной пользовательской программы за висит от 
сконфигурированного "времени задержки". 
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Время To обеспечивает, что реакции процесса для пользовательской 
программы посылаются согласованно и через равные интервалы  времени к 
оконечным устройствам вход-выходных устройств DP. Это время To время 
для циклического обмена данных ведущий-ведомый со всеми ведомыми DP, 
время для подготовки сигнала и преобразования в электронных модулях, а 
также время обработки выходов в шине заднего плана ведомого DP.  

Период, начиная с момента, когда вход обнаружен на электронном модуле до 
реакции на выходном модуле при постоянном времени обработки: Ti + TDP + 
To. Это условие позволяет записать постоянное время реакции системы как: 
TDP + Ti + TDP + To. 

Предпосылки и общие условия 
• H-системы (резервированные отказоустойчивые) не поддерживают 

синхронизацию циклов.  

• В F-системах, синхронизация циклов не может использоваться для не 
отказоустойчивых периферийных устройств ввода и вывода.  

• Циклическая синхронизация не может использоваться  в оптических сетях 
PROFIBUS. 

• Эквидистантное время цикла шины и синхронизация циклов возможно 
только при применении шинных профилей «DP» и «User-Defined 
[Определяемый пользователем]». Однако, использование профиля «User-
Defined [Определяемый пользователем]» не рекомендуется. 

• Синхронизация циклов возможна только для интерфейса DP, встроенного 
в CPU. 

• В шине PROFIBUS-DP с синхронизацией циклов , активной станцией 
может быть только ведущий эквидистантного цикла. OP и программаторы 
(PG) (или PC в качестве PG) влияют на время эквидистантного цикла DP. 
Поэтому мы рекомендуем. 

• Синхронизация циклов между цепями в настоящее время невозможна. 

• Устройства входа-выхода с синхронизацией циклов могут работать только 
с сегментом отображения процесса (часть отображения процесса). 
Сегмент отображения требуется для обеспечения консистентной, 
синхронизованной с циклами передачи данных. Без этого консистентная, 
синхронизованная с циклами передача данных не возможна. Чтобы 
гарантировать, что сегмент отображения процесса является 
консистентным,  STEP 7 обеспечивает мониторинг количества данных 
(число ведомых и число байт в сегменте отображения процесса для 
мастер-системы DP ограничено). Дополнительно, пожалуйста, обратите 
внимание на следующие моменты: 

- В пределах станции, входной адрес не должен назначаться разным 
сегментам отображения процесса. 

- В пределах станции, выходной адрес не должен назначаться разным 
сегментам отображения процесса. 

- Общая часть сегмента отображения процесса может использоваться 
как для входных, так и для выходных адресов. 
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• В HW Config, адреса аналоговых вход-выходных устройств с циклической 
синхронизацией должны располагаться в области адресов сегмента 
отображения процесса.  

• Синхронизация циклов возможна только для устройств ET 200M и ET 
200S; синхронизация с централизованными вход-выходными 
устройствами невозможна. 

• Полный цикл синхронизации "от терминала до терминалаl» возможен 
только тогда, когда все компоненты в цепи поддерживают системное 
свойство «Isochrone mode [Изохронный режим]». При выборе элементов в 
каталоге аппаратуры, обратите внимание на информационное поле, 
которое должно содержать запись «Isochrone mode [Изохронный режим]». 
Последний список обновлений доступен через Internet по ссылке 
http:/www.siemens.de/taktsynchronitaet.  

3.12.3 Параметризация эквидистантного цикла и изохронный 
режим в HW Config 

Введение 
Станция состоит их следующих изохронных компонентов, которые Вы должны 
установить в HW Config:  

• CPU с встроенным интерфейсом DP (например, CPU 414-3 DP, V3.1)  

• Интерфейсные модули DP (например, интерфейсный модуль ET 200S IM 
151-1 High Feature) 

• Распределенных вход-выходных модулей (например, DI 2xDC24V, High 
Feature [131-4BB00], DO 2xDC24V/2A, High Feature [132-4BB30])  

Последний список обновлений доступен через Internet по ссылке 
http:/www.siemens.de/taktsynchronitaet. 

Следующий раздел содержит информацию об особенностях 
конфигурирования этих компонентов для изохронного режима.  

Настройка свойств CPU  
1. Выберите закладку «Synchronous Cycle Interrupt [Прерывание синхронного 

цикла]»  

2. Для каждого OB  циклических синхронных прерываний должны быть 
сделаны следующие установки:  

- Задайте используемую мастер-систему DP. 

- Задайте  нужный сегмент(ы) отображения процесса 

- Для CPU S7-400: интервал времени. Этот временной интервал – 
время между глобальным управляющим кадром и запуском OB 6x. 
Это интервал времени, в который ведущий DP выполняет 
циклический обмен данных с ведомыми. 
Совет: После параметризации устройств распределенных вход-
выходов, не забудьте позволить STEP 7 вычислить величину по 
умолчанию. 
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Настройка мастер-системы DP  
Для активации эквидистантного цикла в мастер-ситеме DP:  

1. Дважды щелкните  на Double-click the Мастер-система DP. 

2. В закладке «General [Общее]», нажмите кнопку «Properties [Свойства]».  

3. В диалоговом окне "Properties – PROFIBUS [Свойства - PROFIBUS]», 
выберите закладку «Network Settings [Настройка сети]»  

4. Выберите подходящий профиль (например, "DP")  

5. Нажмите кнопку «Options [Возможности]». 

6. В диалоговом окне «Options [Возможности]», выберите закладку «Constant 
Bus Cycle Time [Время эквидистантного цикла шины]»  и сделайте 
следующие установки: 

- Отметьте бокс выбора «Activate constant bus cycle [Активировать 
эквидистантный цикл шины]». Этот шаг активирует эквидистантный 
цикл шины как основу для применения изохронного режима .  

- Отметьте бокс выбора "Times Ti and To same for all slaves [Время Ti и 
To – одно для всех ведомых]».  

- Оставьте пока остальные настройки по умолчанию. 

7. Закройте это диалоговое окно и все другие открытые диалоговые окна 
нажав в каждом случае «OK».  

Установки для модулей на ведомом DP 
Адресное пространство каждого модуля, который включен в изохронный 
процесс должно быть связано с часть образа процесса. Изохронное чтение 
входов и вывод могут быть сделаны только через часть образа процесса.  

1. Дважды щелкните на модуле.  

2. Выберите закладку "Addresses [Адрес]»  

3. В выпавшем списке выберите сегмент области отображения, которая 
связана с OB синхронных циклических прерываний, при назначении 
параметров CPU. 
Если адреса модулей выходят за пределы диапазона адресов (например, 
для аналоговых модулей), тогда Вы можете либо выбрать меньший 
адрес, который лежит внутри заданного диапазона сегмента отображения 
процесса или изменить размеры сегмента отображения, так чтобы 
адресное пространство модуля попало в сегмент области отображения. 
Если Вы выбираете последнее, откройте закладку "Cycle/Clock Memory 
[Циклы и синхромеркер]» и измените параметр "Size of the Process Image 
[Размер области отображения]». Значение, которое Вы вводите здесь 
применимо ко всем сегментам отображения процесса. 

4. В пределах разумного, установите параметр «Input delay [Задержка 
входов]» для цифровых входов по возможности малым. Дело в том, что 
малое время задержки входов приводит к сокращению времени Ti и 
следовательно к сокращению общего времени реакции. Критическая 
установка здесь – наибольшее время задержки входов ведомых. 



Конфигурирование децентрализованной периферии (DP) 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
3-84 A5E00261404-01 

Настройка ведомого DP (Интерфейсный модуль DP) 
Изохронные входные и выходные модули должны быть известны как 
изохронные компоненты интерфейсным модулям DP (например, IM 151-1 
High Feature). Для этого продолжите следующим образом  

1. Дважды щелкните на иконке для ведомого DP (например,  IM 151-1 High 
Feature). 

2. В диалоговом окне «Properties - DP Slave [Свойства - ведомый DP]»  
выберите закладку «Isochrone mode [Изохронный режим]» и сделайте 
следующие настройки: 

- Выберите бокс выбора "Synchronize DP slave to constant bus cycle time 
for DP cycle…[Синхронизировать ведомого DP для эквидистантного 
цикла …]». 

- Выберите модули, предназначенные для изохронной работы. Модули, 
которые не поддерживают изохронный режим, или для которых эта 
опция не выбрана, не должны включаться в вычисление времен Ti 
(чтение переменных процесса) и To (выход переменных процесса). 

3. Подтвердите Ваши настройки и закройте диалоговое окно, нажав "OK".  

После этого появится сообщение, напоминающее Вам, что времена Ti и To в 
конфигурации мастер-системы DP еще не обновлены. 

Обновление времен (Ti, To и времени задержки) 
Для обновления времен Ti и To, перейдите к диалоговому окну «Options 
[Возможности]» и выберите закладку «Constant Bus Cycle Time [Время 
эквидистантного цикла шины]», описанную ранее в разделе "Настройки 
мастер-системы DP". После этого нажмите кнопку «Recalculate 
[Пересчитать]». 

Результат вычисления выводится в поле «Constant DP Cycle [Эквидистантный 
цикл DP]». Это время, гарантирующее постоянное значение времени цикла в 
случае сложной интерференции (например, ошибок связанных с ЭМС). При 
весьма стабильных условиях, это время можно уменьшить до минимального 
значения. Система требует, чтобы новые значения изменялись в пределах 
заданных интервалов. По этой причине, используйте ступенчатое 
переключение для изменения этих величин. Наибольшее время цикла DP 
необходимо, чтобы обеспечить для OB6x достаточное время вычислений.  

В процессе автоматического вычисления, значения Ti и To устанавливаются в 
их минимальыне значения. Эти переменные могут быть также изменены и 
установлены в показанных пределах. Максимальные значения Ti и To могут 
увеличиваться установкой большего значения эксидистантного цикла DP. 

Для обновления времени задержки между глобальным управляющим кадром 
и вызовом OB синхронных циклических прерываний OB, откройте свойства 
CPU, выберите закладку «Synchronous Cycle Interrupts [Прерывания 
синхронного цикла]» и нажмите кнопку «Default [По умолчанию]» чтобы 
получить вычисленную величину. В некоторых отдельных случаях 
необходимо перенести запуск OB6x. В этом случае, измените вычисленную 
величину вручную. Вычисленная величина представлена в миллисекундах. 
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Оптимизация конфигурации 
Для помощи в оптимизации конфигурации, диалоговое окно «Isochrone mode 
[Изохронный режим]» предоставляет обзор всех относящихся к 
синхронизации параметров. Чтобы открыть их в диалоговом окне, перейдите 
в HW Config и выберите команду меню Edit > Isochrone Mode 
[Редактировать > Изохронный режим]. 

Диалоговое окно разделено на содержащие иерархию области отображения: 
"PROFIBUS", «Slave [Ведомые]» и «Module [Модули]». Когда Вы выберите  
мастер-систему в области «PROFIBUS», область «Slave [Ведомые]» 
автоматически отобразит назначенных ведомых. Аналогично, если Вы 
выберите ведомого DP, область «Module [Модули]» должна автоматически 
отобразить связанные модули. Для детального описания колонок 
отображаемых в диалоговом окне, смотрите соответствующие разделы 
интерактивной справки. 

Создание программы пользователя 
Создайте требуемые OB синхронных циклических прерываний (например, OB 
61).  

Для запуска OB синхронных циклических прерываний должна быть вызвана 
SFC 126 'SYNC_PI' для обновления частей области отображения входов 
процесса, и для завершения OB 61, должна вызываться SFC 127 'SYNC_PO' 
для обновления частей области отображения выходов. Часть области 
отображения процесса, используемая здесь, должна быть сконфигурирована 
CPU (закладка «Synchronous Cycle Interrupts [Прерывания синхронного 
цикла]»). 

  
 Замечание 

Время выполнения отдельных OB можно определить для различных 
периодов времени,  используя SFC 78 'OB_RT' (только WinAC RTX). 
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3.12.4 Подключение PG/PC к эквидистантной сети PROFIBUS через 
Industrial Ethernet и соединитель IE/PB  

Соединитель IE/PB link (Вервия 1.3) может быть подключен через интерфейс 
DP к эквидистантной сети PROFIBUS-DP. 

Конфигурация позволяет Вам использовать программатор /PC подключенный  
к Industrial Ethernet для доступа к станциям в эквидистантной сети PROFIBUS-
DP (маршрутизация).  

  

Конфигурирование соединителей IE/PB маршрутизатора S7  
Для конфигурирования связи IE/PB, действуйте так:  

1. Создайте станцию типа SIMATIC 300.  

2. Используя drag & drop, добавьте в станцию элемент IE/PB-Link(V1.3).  

  
3. Добавляя соединитель, отредактируйте диалоговое окно:  

- Установите свойства интерфейса Industrial Ethernet interface, и 
– Установите свойства интерфейса PROFIBUS.  
После добавления соединителя IE/PB, установите его в рабочий режим 
"DP Master [Ведущий DP]». 

4. Дважды щелкните в строке "PROFIBUS/DP» соединителя IE/PB. 

5. Выберите закладку "Operating mode [Рабочий режим]»  

6. Выберите вариант "No DP [Не DP]». 
В этом рабочем режиме соединитель IE/PB на шине PROFIBUS 
функционирует подобно программатору/PC.  
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4 Конфигурирование станции SIMATIC PC 

4.1 Создание и параметризация станций SIMATIC PC 

Введение 
Станция SIMATIC PC (в дальнейшем сокращенно "Станция РС") 
представляет РС или станцию OS, приложение которой (напр., WinCC) 
является конечным пунктом соединения. Станция SIMATIC PC (в дальнейшем 
сокращенно "Станция РС") представляет РС или операторскую станцию, 
которая включает в качестве приложений компоненты SIMATIC (напр., 
WinCC), слоты PLC или программные PLC для решения задач автоматизации 
Эти компоненты конфигурируются в составе станции PC, или могут быть 
конечными точками соединений they can be the end point of a connection.  

Обзор: Конфигурирование станции SIMATIC PC и подключение к ней   
Полностью конфигурация станции PC выполняется через тип станции 
"SIMATIC PC Station". Компоненты сконфигурированные в ней доступны 
далее для конфигурирования соединений. В станции SIMATIC PC Вы можете 
сконфигурировать следующие компоненты: 

• Программный PLC WinLC (Версия V3.0 и выше) 

• Слот PLC CPU 41x-2 PCI (WinAC Slot 412 и WinAC Slot 416)  

• Коммуникационный процессор SIMATIC для PC 

• SIMATIC HMI: WinCC и ProTool Pro 

• Приложения (например, приложения пользователя, основанные на SAPI) 

• Сервер OPC  

Для компонентов, основанных на  PC, таких как WinLC (< V2.x) или CPU 416-2 
DP ISA, Вы должны продолжить для использования станций типа SIMATIC 
300 или SIMATIC 400. Вы может найти компоненты в окне "Hardware Catalog 
[Каталог аппаратуры]»  в разделе SIMATIC PC Based Control 300/400. 
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Следующий рисунок показывает структуру каталога аппаратуры для станций 
SIMATIC PC: 

Станция SIMATIC PC

Конечная точка
сконфигурированного соединения

Контроллеры

Коммуникационные модули для PC

Элементы HMI

 

Последовательность действий 
1. В SIMATIC Manager вставьте в Ваш проект станцию SIMATIC PC 

(командой Insert > SIMATIC PC Station [Вставить > Станция SIMATIC 
PC]). 

2. Измените имя станции SIMATIC PC, как Вы считаете нужным. Если 
компьютер, который Вы хотите использовать для конфигурирования и 
загрузки станций, идентичен станции SIMATIC PC, вставленной в SIMATIC 
Manager, тогда имя этой станции должно быть идентично имени, 
заданному в Component Configuration Editor [Редактор конфигурации 
компонентов]. Только в этом случае свойства станции SIMATIC PC могут 
быть назначены в проекте; другими словами, она признается SIMATIC 
Manager и сетевым представлением как назначенная станция SIMATIC 
PC. 

3. Дважды щелкните на станции SIMATIC PC, а затем на объекте 
Configuration . 
HW Config opens открывает для редактирования конфигурацию станции. 
Строка 125 в конфигурационной таблице занята менеджером станции (не 
удаляется). 

4. Используйте операцию перетаскивания, чтобы вставить эти компоненты в 
конфигурационную таблицу станции SIMATIC PC, которая представляет 
конфигурацию реального PC. Компоненты расположены в окне «Hardware 
Catalog [Каталог аппаратуры]» в разделе “SIMATIC PC Station”:  

- Программный PLC WinLC в слот 2 (для информации о 
дополнительных возможностях конфигурирования смотрите правила 
слотов для контроллеров SIMATIC на базе PC) 

- Слот PLC CPU 41x-2 PCI (Слот WinAC 412 и Слот WinAC 416) в слот 3 
(для информации о дополнительных возможностях конфигурирования 
смотрите правила слотов для контроллеров SIMATIC на базе PC) 

- CP в любой из слотов с 1 по 32 (если необходимо, просмотрите 
ограничения в информации о продукте для Вашего слот-CP!) 

- Заменитель программного обеспечения для конфигурирования 
соединений, например, «User Application [Приложение пользователя]» 
или компонент HMI (если установлен) также в слоты с 1 по 32 
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- Сервер OPC для клиентов OPC обеспечивающий доступ к 
переменным удаленной автоматической системы через 
конфигурируемые соединения, также в слоты с 1 по 32.  

11 Вызовите диалог свойств станции PC (команда меню Station > Properties 
[Станция > Свойства]), выберите закладку Configuration [Конфигурация] , 
и введите здесь путь для хранения конфигурационного файла (файл 
*.XDB).  
Данные соединения, адреса CP и приложений хранятся в этом файле (см. 
шаг 6).  

12 Выберите команду меню PLC > Save and Compile [ПЛК > Сохранить и 
скомпилировать]. 
Когда сохраняется и компилируется конфигурация станции SIMATIC PC, 
создаются системные данные и файл конфигурации (файл *.XDB). Эти 
системные данные и файл конфигурации должны быть загружены в 
программируемый логический контроллер или инсталлированы (смотри 
Загрузка в станцию PC). 
Вы задаете расположение файла конфигурации на станции PC используя  
программу «Set PG/PC Interface [Установка интерфейса PG/PC]» 
(закладка «Configuring STEP 7 [Конфигурирование STEP 7]»).  
Вы можете найти больше информации о установке программатора /PC в 
описании "SIMATIC NET, S7 Programming Interface [Интерфейсы 
программирования S7]» и в интерактивной справке, закладка «Configuring 
STEP 7 [Конфигурирование STEP 7]».  

13 Если Вам необходимо сконфигурировать соединение для станции 
SIMATIC PC: 

- Выберите команду меню Options Configure Network [Возможности > 
Конфигурирование сети]. В NetPro Вы можете сконфигурировать 
соединение S7 для управляющих компонентов и приложений. Вы 
также можете сконфигурировать резервированные соединения S7 с 
сервером OPC . Если Вы хотите редактировать конфигурацию 
SIMATIC PC из NetPro, дважды щелкните на объекте “Станция 
SIMATIC PC” (как Вы это делаете для станций SIMATIC 300/400). 

- Если Вы хотите загрузить конфигурацию: 
Выберите команду меню PLC > Download [ПЛК > Загрузить]. Для 
загрузки предлагается только управление на базе PC (смотри 
Загрузка в станцию PC).  

Особенность конфигурирования WinLC V3.0 и приложений 
Интерфейс PROFIBUS-DP для WinLC всегда включается в WinLC, как 
встроенный интерфейс WinLC (ведущий DP в слоте 2.1). Соответственно, 
карта, требующая для этой функции (CP 5412/A2 ил CP 5613) не включается 
в явном виде в HW Config. Конфигурация выполняется посредством входа 
ведущего DP в слоте 2.1. 

Конфигурация с приложениями и CP PROFIBUS  
Приложения могут иметь доступ к распределенным входам и выходам с 
использованием конфигурации PROFIBUS-DP. Чтобы создать конфигурацию 
действуйте так: 
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1. Разместите в конфигурационной таблице станции SIMATIC PC Application 
[Приложение] и  CP PROFIBUS-DP . 

2. Дважды щелкните на CP для вызова диалога Properties [Свойства]. 

3. Свяжите приложение с CP в диалоге Properties [Свойства]. 

 
4.2 Правила слотов для станции SIMATIC PC  

Такие компоненты, как  CP, пользовательские программы для PC для 
конфигурирования соединений и сервер OPC можно вставить в слоты 
(индекс) с 1 по 32.  

SoftPLC [Программная реализация контроллера] 
Вплоть до STEP 7 V 5.2 Service Pack 1, программный PLC WinLC можно было 
вставить только в индекс 2. Начиная с STEP 7 V 5.3, поддерживается WinLC 
версия V 4.1. Они может быть вставлен в любой слот и возможна работа до 
четырех SlotPLC (CPU 41x-2 PCI, начиная с V 3.4).  

SlotPLC [Аппаратная реализация контроллера] 
Вплоть до STEP 7 V 5.2 Service Pack 1, SlotPLC CPU 41x-2 PCI (Слот WinAC 
412 и слот WinAC 416) можно было вставить только в индекс 3.  

Начиная с STEP 7 V 5.3, поддерживается CPU 41x-2 PCI V 3.4. Его можно 
вставить во все слоты. Можно вставить даже вместе до 4 этих CPU с новым 
LoftPLC WinLC V 4.1.  

Области адресов 
Если в станцию PC вставляется несколько различных контроллеров WinAC, 
каждый из них имеет собственное пространство входов и выходов. 

4.3 Сравнение: Станция S7 – Станция PC  

Конфигурация станции S7 представлена в SIMATIC Manager через объект 
Hardware [Оборудование]; при двойном щелчке на объекте Hardware 
запускается приложение для конфигурирования станции S7. Конечная точка 
соединений – модули, включенные в реальную станцию. Интерфейсы с 
подсетями образуют конфигурируемые CPU, CP, или интерфейсные модули. 

Конфигурация станций PC представлена в SIMATIC Manager объектом 
Configuration [Конфигурация]; при двойном щелчке на Configuration 
запускается приложение для конфигурирования станции PC (начиная с STEP 
7 V5.0 Service Pack 3). 
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4.4 Добавления конфигурации SIMATIC PC 
предыдущих версий 

Конфигурации PC проектов STEP 7 V5.1 (до SP 1) 
Начиная с STEP 7 V5.1, Service Pack 2 Вы можете загрузить коммуникации в 
станцию PC тем же способом, что и в станции S7-300 или S7-400 (без 
необходимости использовать окольный путь через файл конфигурации). Тем 
не менее, файл конфигурации всегда генерируется  при сохранении или 
компиляции, чтобы разрешить загрузку конфигурации в целевой PC, 
используя этот метод. 

Это имеет следствием, что “старые” станции PC не могут интерпретировать 
некоторую информацию, включенную во вновь сгенерированные файлы 
конфигурации. STEP 7 автоматически приспосабливается к этому 
обстоятельству:  

• Если Вы создали новую станцию SIMATIC PC в STEP 7 V5.1, Service Pack 
2, STEP 7 допускает, что целевая станция PC была сконфигурирована с 
помощью CD SIMATIC NET начиная с 7/2001, то есть предполагается, что 
установлен S7RTM (Runtime Manager). Конфигурационные файлы 
генерируются  таким образом, что они могут интерпретироваться “новой” 
станцией PC . 

• Если Вы добавляете конфигурацию станции SIMATIC PC предыдущей 
версии (например, станция  PC сконфигурирована в STEP 7 V5.1, Service 
Pack 1), STEP 7 не предполагает, что целевая станция PC 
сконфигурирована с помощью CD SIMATIC NET начиная с 7/2001. Те 
файлы конфигурации, которые сгенерированы этим способом могут 
интерпретироваться как “старые” станции PC.  

Если такое поведение по умолчанию не соответствует Вашим требованиям, 
Вы можете изменить его, как описано ниже.  

Установки в контекстном меню "Configuring Hardware [Конфигурирование 
аппаратуры]:  

1. Откройте аппаратную конфигурацию станции PC 

2. Щелкните правой кнопкой мыши в окне станции (белое поле) 

3. Выберите в контекстном меню "Station Properties [Свойства станции]»  

4. Отметьте или очистите бокс выбора "Compatibility".. 

Установки в контекстном меню "Configuring Networks [Конфигурирование 
сетей]" 

1. Откройте конфигурацию сети. 

2. Выделите станцию PC  

3. Выберите команду меню Edit > Object properties  

4. Выберите закладку «Configuration » в появившемся диалоге 

5. Отметьте или очистите бокс выбора "Compatibility [Совместимость]". 
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Конфигурации PC в проектах STEP 7 V5.0  
Если Вы сконфигурировали станцию в STEP 7 V5.0, Service Pack 3, то ее надо 
преобразовать, если Вы хотите использовать новые компоненты, которые 
поддерживаются только Service Pack 3 и выше. 

1. В SIMATIC Manager, выделите станцию SIMATIC PC и вызовите команду 
меню Edit > Object properties [Редактировать > Свойства объекта]. 

2. В закладке "Functions [Функции]» диалога свойств, нажмите кнопку 
"Expand [Расширить]". 
Станция SIMATIC PC при этом  преобразуется. Теперь, она может 
редактироваться только в STEP 7 V5.0, Service Pack 3 и более поздних 
версиях.  

4.5 Выделение станции SIMATIC PC 
сконфигурированной в сетевом виде 

Если станция SIMATIC PC, которую Вы используете для создания проекта  
STEP 7 выделена в сетевом виде и в проекте SIMATIC manager, должны быть 
выполнены следующие предварительные условия:  

• Не был назначен программатор (PG)/PC  

• Интерфейс PG/PC должен быть установлен в "PC internal (local) 
[Встроенный в PC]" 

• Станция PC должна быть сконфигурирована с использованием Component 
Configurator [Конфигуратор компонент], который поставляется на  CD 
SIMATIC NET с 7/2001. 

• Введенной имя станции PC должно быть идентичным, в Component 
Configurator и в STEP 7 (свойства станции SIMATIC PC).  

Поскольку это имя идентично повсюду, STEP 7 может затем установить 
правильную ассоциацию и выделить назначенную станцию PC. Если хотя бы 
одно из указанных Выше условий не выполняется, станция будет показана 
обычной иконкой. 

  
Иконка  Значение  

Выделенная станция SIMATIC PC  

  
Не выделенная станция SIMATIC PC 
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5 Сохранение, импорт и экспорт 
конфигурации 

5.1 Сохранение конфигурации и проверка 
непротиворечивости 

Чтобы сохранить конфигурацию со всеми установленными параметрами и 
адресами, выберите команду меню Station > Save [Станция > Сохранить] 
или команду меню Station > Save and Compile [Станция > Сохранить и 
компилировать]. 

При использовании Station > Save and Compile [Станция > Сохранить и 
компилировать] конфигурация сохраняется в активном проекте (как объект 
"STATION"), и если могут быть созданы подходящие системные блоки данных 
(SDB), то они сохраняются в папке "Blocks [Блоки]» соответствующих модулей 
("носителей SDB", напр., CPU). Системные блоки данных представляются 
папкой символом “System Data [Системные данные]". 
 

 

Символ для системных 
данных 

 
Чтобы получить возможность сохранения незаконченной конфигурации, 
выберите команду меню Station > Save [Станция > Сохранить]. При 
сохранении системные блоки данных не генерируются. Процесс сохранения 
быстрее, чем при сохранении с компиляцией, однако, Вы должны обратить 
внимание на то, что затем может возникнуть несоответствие между 
конфигурацией, хранящейся в объекте "Station", и конфигурацией, 
хранящейся в системных данных!  

Перед загрузкой Вам следует проверить правильность конфигурации вашей 
станции с помощью команды меню Station > Consistency Check [Станция > 
Проверка непротиворечивости]. 
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5.2 Импорт и экспорт конфигурации 

Введение 
Начиная с версии V5 пакета STEP 7, Вы можете манипулировать с 
конфигурацией станции не только вместе со всем проектом (напр., сохранять 
или открывать ее), но и независимо от проекта экспортировать ее в текстовый 
файл (ASCII-файл) и импортировать ее оттуда.  

Применения  
• Распространение через электронные средства (напр., E-Mail)  

• Сохранение для использования в будущих версиях STEP 7  

• Файл с экспортом может быть распечатан системами обработки текстов 
или далее переработан для целей документирования 

Что экспортируется/импортируется? 
При конфигурировании аппаратуры могут экспортироваться/импортироваться 
только данные, которые необходимы для конфигурирования и 
параметризации модулей. Начиная со STEP 7 V5.1, Service Pack 1, возможны 
также экспорт и импорт данных подсети. 

Не регистрируются: 

• данные, управляемые другими приложениями (напр., программы, 
соединения, глобальные данные) 

• пароль параметризованного CPU 

• данные, относящиеся не к одной только станции (напр., соединения 
интеллектуальных ведомых DP или параметры для прямого обмена 
данными) 

 
 

Указание 
Если ваша конфигурация содержит модули из старых дополнительных 
пакетов, то может случиться, что не все данные модуля воспринимаются 
функцией "Export Station [Экспорт станции]". В таком случае проверьте 
полноту данных модуля при последующем импорте. 
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Экспортированный файл  
Что и в какой форме хранится в экспортируемом текстовом файле, Вы 
можете установить при экспорте (команда меню Station > Export [Станция > 
Экспортировать]): 

• легко читаемая или компактная форма 

Важно: Если Вы экспортируете конфигурацию станции, для чтения в 
других версиях STEP 7, выберите вариант "Compact [Компактный]». 

• свободно выбираемое имя файла(*.cfg) 

• с символикой или без  

• с подсетями или без 

• значения по умолчанию для параметров модулей могут быть при желании 
пропущены (STEP 7 "знает» значения по умолчанию и дополняет их при 
импортировании из внутренних данных модуля) 

 

!  
Предупреждение 
Если Вы используете экспорт конфигурации станции с символикой, Вы более 
не сможете импортировать эти файлы в STEP 7 V5, SP 1 и более старые 
версии STEP 7.  

Последовательность действий (экспорт) 
1. Откройте конфигурацию станции или сохраните только что 

отредактированную конфигурацию (команда меню Station >Save, 
[Станция > Сохранить]). 

2. Выберите при открытой конфигурации станции команду меню Station > 
Export [Станция > Экспортировать]. 

3. В появившемся после этого диалоговом окне введите путь и имя 
экспортируемого файла, формат и другие параметры. 

4. Подтвердите установки, щелкнув на "OK". 

Последовательность действий (импорт) 
Рекомендация: Не импортируйте экспортированную из того же проекта 
конфигурацию станции. В этом случае, STEP 7 не может принять решение о 
сетевых назначениях. Используйте для импорта другой или новый проект.  

1. При открытой пустой конфигурации станции выберите команду меню 
Station > Import [Станция > Импортировать]. 
Если нет открытой конфигурации станции, появляется диалоговое окно 
для выбора проекта. В этом случае, найдите проект, в который Вы хотите 
импортировать конфигурацию станции.  

2. В появившемся после этого диалоговом окне перейдите к текстовому 
файлу, который Вы хотите импортировать. 

3. Подтвердите установки, щелкнув на "OK". 
При импорте STEP 7 проверяет импортируемый файл на наличие ошибок 
и непротиворечивость и выдает сообщения. 
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Импорт в существующую станцию  
В открытую конфигурацию станции Вы также можете импортировать станцию. 
При импорте STEP 7 спрашивает, должны ли быть переписаны уже 
сконфигурированные модули/интерфейсные субмодули. Для каждого 
компонента Вы можете решить, нужно ли сохранить его в существующем 
виде или переписать. 

Если компонент переписывается, то действуют все настройки (параметры) 
содержащиеся в импортируемом файле. Параметры, которые в 
импортируемом файле отсутствуют, остаются в конфигурации станции 
неизменными.  
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6 Синхронная работа нескольких CPU 

6.1 Что Вы должны знать о многопроцессорной 
обработке 

Что такое многопроцессорная обработка? 
Мультипроцессорный режим – это одновременная работа нескольких (не 
более 4) центральных процессоров в одной центральной стойке 
(центральном устройстве) S7-400. 

Участвующие CPU автоматически синхронно меняют свои рабочие 
состояния, т. е. CPU вместе запускаются и вместе переходят в состояние 
STOP. На каждом CPU исполняется пользовательская программа независимо 
от программ пользователя в других CPU. Это делает возможным 
запараллеливание задач управления. 

Пример 
На следующем рисунке представлена система автоматизации, работающая в 
мультипроцессорном режиме. Каждый CPU может обратиться к приписанным 
ему модулям (FM, CP, SM).  
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Разница между мультипроцессорным режимом и работой в 
сегментированной стойке  

Одновременная несинхронизированная работа нескольких CPU также 
возможна в сегментированной стойке CR2 (сегментирована физически, не с 
помощью настраиваемой параметризации). Однако здесь речь не идет о 
мультипроцессорном режиме. CPU в сегментированной стойке образуют 
каждый свою независимую подсистему и ведут себя как отдельные 
процессоры. Совместное логическое адресное пространство отсутствует. 

"Мультипроцессорный режим" и "несинхронизированная работа в 
сегментированной стойке" одновременно невозможны. 

6.1.1 Особенности многопроцессорной обработки 

 Правила для слотов 
В мультипроцессорном режиме одновременно до четырех CPU могут быть 
установлены в центральной стойке в произвольной последовательности. 

Если Вы используете CPU, которые могут управлять только при начальном 
адресе модуля кратном 4 (в общем, CPU до 10/98), Вы должны следовать 
этому правилу назначения адресов для всех сконфигурирвоанных CPU. 
Правило применимо к случаю, когда Вы используете CPU, которые 
поддерживают побайтовое назначение начальных адресов модулей в режиме 
с одним процессором.  

Связь через шину 
CPU соединены друг с другом через коммуникационную шину, это 
соответствует связи через MPI. 

Поведение при запуске и во время работы 
При запуске CPU, участвующие в мультипроцессорной обработке, 
автоматически проверяют, могут ли они синхронизироваться. Синхронизация 
возможна только тогда 

• когда все сконфигурированные CPU (и только они) установлены и 
исправны 

• когда для всех установленных CPU были созданы и загружены 
правильные конфигурационные данные (SDB). 
Если одна из этих предпосылок не удовлетворяется, то в диагностический 
буфер вносится событие с идентификатором 0x49A4. Объяснения к 
идентификаторам (ID) событий вы найдете в оперативной online-помощи к 
стандартными и системным функциям (SFB/SFC). 

При выходе из состояния STOP проводится сравнение видов запуска 
(холодный, теплый,горячий). Этим гарантируется, что все CPU  системы 
автоматизации выполняют одинаковый вид запуска, и все CPU имеют 
одинаковый рабочий режим. 
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Назначение адресов и прерываний 
В мультипроцессорном режиме отдельные CPU могут обращаться к модулям, 
которые были им назначены при конфигурировании с помощью STEP 7. 
Адресная область модуля всегда назначается "эксклюзивно" одному CPU. 

Все CPU имеют общее адресное пространтсво; то есть логический адрес 
модуля должен быть представлен только однократно в многопроцессорной 
станции. 

Каждому CPU назначается вход прерываний. Прерывания, которые 
достигают этого входа, не могут быть приняты другими CPU. Назначение 
линии прерываний происходит автоматически при параметризации модулей. 

К обработке прерываний применимы следующие правила: 

• Аппаратные и диагностические прерывания посылаются только одному 
CPU.  

• При выходе из строя модуля прерывание обрабатывается тем CPU, 
который был назначен модулю при параметризации с помощью STEP 7. 

• При выходе из строя стойки ОВ 86 вызывается на каждом CPU. 

Более подробную информацию об ОВ 86 вы найдете в оперативной online-
помощи к организационным блокам. 

6.1.2 Когда применять мультипроцессорный режим? 

Применение мультипроцессорного режима имеет преимущество в 
следующих случаях: 

• Если ваша прикладная программа слишком велика для одного CPU, и не 
хватает места в памяти, распределите свою программу между 
несколькими CPU. 

• Если определенная часть вашей установки должна обрабатываться 
быстро, отделите соответствующую часть программы от программы в 
целом и передайте ее на обработку собственному "быстрому" CPU. 

• Если ваша установка состоит из нескольких частей, которые необходимо 
четко разграничить, чтобы относительно автономно ими управлять, 
передайте обработку каждой из этих частей своему CPU. 
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6.2 Конфигурирование мультипроцессорного режима 

 Установка мультипроцессорного режима 
Мультипроцессорный режим получается неявно при установке второго 
(третьего или четвертого) CPU, способного к многопроцессорной работе, в 
стойку, пригодную для реализации этого режима (напр., в стойку UR1). Может 
ли CPU работать в мультипроцессорном режиме, следует из 
информационного текста в окне каталога аппаратуры "Hardware Catalog", 
который отображается для каждого выделенного модуля. 

Предпосылки 
Прежде чем вы сможете сконфигурировать модули в своей системе 
автоматизации для работы в мультипроцессорном режиме, должны быть 
выполнены следующие предпосылки: 

• Вы установили свою систему автоматизации, как описано в руководстве 
по инсталляции "S7-400, M7-400 Programmable Controllers, Hardware and 
Installation". 

• Вы открыли в окне проекта конфигурационную таблицу двойным щелчком 
на объекте “Hardware [Аппаратура]”. 

• Вы разместили в окне станции стойку, и она отображается в открытом 
виде (видны слоты стойки). 

Принципиальная последовательность действий 
   

Вставьте CPU, которые должны работать в
мультипроцессорном режиме

Определите при параметризации модулей
их назначение соответствующим CPU

  

Особенности при загрузке и выгрузке 
Конфигурация станции должна загружаться во все CPU только полностью. 
Благодаря этому удается избежать противоречивости в конфигурациях. 

При выгрузке в PG конфигурация станции передается всеми 
программируемыми модулями последовательно (т. е. ”CPU за CPU"). 
Благодаря этому у вас есть возможность прервать процесс выгрузки, хотя 
выгружены и не все конфигурационные данные (SDB). Однако в этом случае 
данные параметризации теряются! 
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6.2.1 Конфигурирование модулей для мультипроцессорного 
режима 

Для конфигурирования системы автоматизации в мультипроцессорном 
режиме действуйте следующим образом: 

1. Используя Drag&Drop, отбуксируйте CPU, которые должны работать в 
мультипроцессорном режиме, из окна каталога аппаратуры “Hardware 
Catalog” в соответствующие строки стойки. 

2. Дважды щелкните на CPU и установите его номер в закладке 
“Multicomputing [Мультипроцессорный режим]” (когда вы вставляете CPU, 
их номера задаются автоматически в возрастающем порядке). 

3. Для всех модулей, которые должны быть назначены CPU 1, действуйте 
следующим образом: 

- Разместите модули на предусмотренных местах в стойке. 

- Дважды щелкните на модуле и выберите закладку “Addresses 
[Адреса]”. 

- В поле “CPU No. [№ CPU]” выберите CPU 1. 
  
Указание: Назначение CPU для модулей, которые могут запускать 
прерывания, отображается в закладке "Inputs [Входы]" или "Outputs 
[Выходы]" как "Target CPU for interrupt [Целевое CPU (для 
прерывания)]". 

4. Повторите шаги, перечисленные в пункте 3, для модулей, которые 
должны быть назначены остальным CPU. 

6.2.2 Отображение назначения CPU 

Если вы хотите выделить подсветкой модули, которые относятся к 
определенному CPU, то у вас есть для этого две возможности: 

• Выберите команду меню View > Filter > CPU No. x - Modules [Вид > 
Фильтровать > CPU № х] (x = номер CPU).  
  
Все модули, которые не относятся к CPU x, отображаются затененными 
(исключение: модули децентрализованной периферии, интерфейсные 
модули и источники питания). 

• Выделите соответствующий CPU и выберите во всплывающем меню 
команду Filter Assigned Modules [Фильтровать назначенные модули]. 

  
 Указание 

Установленный фильтр не действует на функцию печати и диалоговое окно 
"Address Overview [Обзор адресов]". 

Вы можете изменить назначение CPU через закладку ”Addresses [Адреса]" 
(исключение: интерфейсные модули и источники питания). 
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Изменение номера CPU 

Если вы установили несколько CPU и хотите изменить номер CPU, 
действуйте следующим образом:  

1. Если установлены четыре CPU:  удалите один из уже установленных 
CPU. 
Если установлены три или два CPU: продолжайте со следующего шага. 

2. Дважды щелкните на CPU, номер которого вы хотите изменить. 

3. Выберите закладку ”Multicomputing [Мультипроцессорный режим]”. 

4. Выберите желаемый номер CPU.   
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6.3 Программирование CPU 

6.3.1 Программирование CPU 

Программирование  
Программирование для мультипроцессорного режима в принципе не 
отличается от программирования для отдельного CPU. 

Однако требуются дополнительные шаги, если вы хотите синхронизировать 
CPU, чтобы они совместно реагировали на события. 

Вызов SFC 35 
Чтобы в мультипроцессорном режиме все CPU могли целенаправленно 
реагировать на события (напр., прерывания), то в вашем распоряжении 
имеется SFC 35 ”MP_ALM”. Вызов SFC 35 запускает мультипроцессорное 
прерывание, которое ведет к синхронному запросу на запуск ОВ 60 на всех 
установленных CPU. В этом ОВ имеются локальные переменные, которые 
точнее устанавливают запускающее событие. 

При вызове SFC 35 на все CPU передается информация о событиях в 
идентификаторе заданий. Идентификатор заданий позволяет различить до 16 
событий. 

При обработке мультипроцессорного прерывания как посылающая программа 
пользователя, так и пользовательские программы, исполняющиеся на других 
CPU, проверяют, могут ли они распознать задание, и затем реагируют в 
соответствии с программой.  

Вы можете вызывать SFC 35 в любом месте своей программы. Но так как 
этот вызов имеет смысл только в режиме RUN, то при  вызове в режиме 
запуска (RESTART) мультипроцессорное прерывание подавляется. 

Другой вызов мультипроцессорного прерывания может произойти только 
после завершения обработки (квитирования) текущего мультипроцессорного 
прерывания. 

Более подробную информацию о SFC 35 вы найдете в оперативной online-
помощи для SFB/SFC. 

Программирование OB 60 
В каждый CPU, принимающий участие в мультипроцессорной обработке, вы 
можете загрузить ОВ 60, запрограммированный специально для этого CPU. 
Тем самым вы можете задать времена обработки различной длины. Это 
ведет к следующему результату: 

• Прерванные классы приоритета продолжают обрабатываться с разных 
моментов времени. 

• Мультипроцессорное прерывание не выполняется, если оно наступает во 
время обработки ОВ 60 любого CPU. Однако при этом генерируется 
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сообщение, которое вы можете опросить и соответствующим образом на 
него отреагировать. 

Если ОВ 60 не загружен на установленном CPU, то соответствующий CPU 
немедленно возвращается в класс приоритета, обрабатывавшийся 
последним, и продолжает там обработку программы. 

Более подробную информацию об ОВ 60 вы найдете в оперативной online-
помощи для ОВ  
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7 Изменение системы в рабочем режиме 
(CiR) 

CiR (Конфигурация в RUN) – это метод изменения систем, работающих со 
стандартными CPU S7-400 или  S7-400-H-CPU в обычном режиме. Изменения 
выполняются во время работы системы, за исключением небольшого 
промежутка не более 2.5 секунд, Ваш CPU остается в режиме RUN. 

Для большей информации, справьтесь в руководстве "Modifying the System 
During Operation via CiR".Оно доступно в электронном виде, как файл PDF. 
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8 Конфигурирование H-систем 

8.1 Конфигурирование H-систем 

H-системы (системы высокой готовности) – отказоустойчивая автоматическая 
система, которая применяется, чтобы увеличить системную готовность и тем 
самым сократить остановы производства и простои. 

Для более детальной информации, справьтесь в руководстве "Automation 
System S7-400H - Fault-tolerant Systems". 
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9 Проектирование станций, соединенных 
в сеть 

9.1 Соединение в сеть станций в одном проекте 

 Взаимосвязь: Проектирование сетей и проекты STEP 7 
В иерархии объектов подсети входят непосредственно в проект и поэтому 
могут управляться только в проекте. Подсети могут управляться только 
внутри одного проекта. Но у Вас есть возможность соединять между собой в 
сеть абонентов, которые были сконфигурированы в различных проектах.  

Если возможно, Вам следует создавать и проектировать узлы, которые Вы 
хотите объединить в сеть в одном проекте. 

Подсети и станции  
Вы можете создавать подсети и станции в одном проекте STEP 7, это 
упрощает проектирование станций для целей коммуникации.  

Из-за различия задач, решаемых станциями, или из-за протяженности 
установки может оказаться необходимым работать с несколькими подсетями. 
Этими подсетями можно также управлять в одном проекте. Станция может 
быть включена в несколько подсетей путем соответствующего назначения 
сетевых узлов (напр., СР). 

C
P

C
P

Все в одном проекте STEP 7

Установка
"Уровень производства
и управления"

S7-400/1

S7-300/1 S7-300/2

S7-400/2
PROFIBUS-CP

Ethernet-CPEthernet (1)

PROFIBUS (1)
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9.2 Свойства подсетей и коммуникационных узлов 

 Установка свойств подсетей и абонентов коммуникаций в проекте 
Не имеет значения, хотите ли Вы осуществлять связь через глобальные 
данные или через коммуникационные соединения: основой для коммуникаций 
всегда является предварительно сконфигурированная сеть.  
С помощью STEP 7: 

• Создайте графическое изображение своей сети (состоящей из одной или 
нескольких подсетей). 

• Установите для каждой подсети свойства/параметры подсети. 

• Установите свойства для каждого включаемого в сеть узла. 

• Задокументируйте конфигурацию своей сети. 

В следующей таблице показано, каким образом STEP 7 поддерживает Вас 
при проектировании вашей коммуникационной задачи 

 

  
Способ связи Как проектируется? Примечания 

PROFIBUS-DP Конфигурирование 
аппаратуры 

Возможно также через NetPro  

Интерфейс исполни-
тельных устройств и 
датчиков (AS-i)  

Конфигурирование 
аппаратуры 

Подключение к станциям S7 через 
DP/AS-i Link 

Связь через 
неспроектированные 
соединения 

Конфигурирование 
аппаратуры 

Установите свойства подсети и 
абонентов MPI. 

В программе пользователя 
доступны специальные системные 
функции для неспроектированных 
соединений. 

Связь через 
спроектированные 
соединения 

NetPro (Проектирование 
сети и соединений)  

Соединения S7 и "точка-точка» 
могут быть спроектированы с 
помощью базового пакета STEP 7. 
Для других типов соединений 
требуются дополнительные пакеты 
(напр., FMS для PROFIBUS). 

Связь через глобальные 
данные 

Определение 
глобальных данных 

Установите свойства подсети и 
абонентов MPI и спроектируйте в 
таблице глобальных данных 
области операндов для обмена 
данными 
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9.3 Правила конфигурирования сетей 

Обратите, пожалуйста, внимание на следующие правила конфигурирования 
сетей: 

Все абоненты подсети должны иметь уникальные адреса.  

CPU поставляются с адресом по умолчанию "2". Так как это адрес можно 
использовать только один раз, то Вы должны во всех остальных CPU 
изменить адрес, установленный по умолчанию. 

Для станций S7-300: При планировании адресов MPI для нескольких CPU Вы 
должны предусмотреть "пропуски адресов MPI» для FM и CP, имеющих 
собственные адреса MPI, во избежание двойного назначения адресов. 

Загружать установки через сеть Вам следует только тогда, когда все модули 
подсети имеют уникальные адреса и ваша фактическая конфигурация 
совпадает с созданной Вами конфигурацией сети. 

Назначение адресов MPI 
• Задавайте адреса MPI в возрастающей последовательности. 

• Зарезервируйте адрес MPI «0» для программатора. 

• Вы можете соединить друг с другом в одной подсети MPI до 126 
(адресуемых) узлов; до 8 узлов при скорости передачи 19.2 кбит/с. 

• Все адреса MPI подсети MPI должны быть уникальными. 

Другие правила формирования сети Вы найдете в руководствах по 
инсталляции SIMATIC 300 или SIMATIC 400. 

Назначение адресов PROFIBUS 
• Задайте для каждого ведущего и каждого ведомого в сети PROFIBUS 

уникальный адрес PROFIBUS в диапазоне от 0 до 125.  

• Задавайте адреса PROFIBUS в возрастающей последовательности. 

• Зарезервируйте адрес PROFIBUS «0» для устройства программирования, 
которое в дальнейшем Вы будете подключать к сети PROFIBUS в целях 
обслуживания. 

 



Проектирование станций, соединенных в сеть 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
9-4 A5E00261404-01 

9.4 Назначение адресов Ethernet 

Чтобы сконфигурировать CP Ethernet, Вы должны назначить интерфейсу 
Ethernet адрес MAC или IP.  

Вы найдете обширную информацию о CP Ethernet в документации по 
SIMATIC NCM. В этой документации Вы найдете принципиальную 
информацию о конфигурировании в STEP 7 партнеров Ethernet .  

Конфигурирование партнеров и настройка свойств интерфейса 
1. В отрытой аппаратной конфигурации, выделите в каталоге аппаратуры 

CP Ethernet. Перетащите его в подходящую строку конфигурационной 
таблицы.  

2. Дважды щелкните на символе CP в конфигурационной таблице. 

3. В закладке «General [Общее]», нажмите кнопку «Properties [Свойства]» 
(эта кнопка расположена в области интерфейсных параметров).  

4. Назначьте CP подсеть, для чего в поле "Subnet [Подсеть]”, выделите одну 
из существующих подсетей Ethernet или создайте новую, нажав на кнопку 
"New [Новая]".  

5. Введите адрес MAC или IP на странице "Parameter [Параметры]".  
Появление этой части таблицы зависит от типа CP.  

Адрес MAC  
Каждый CP Ethernet имеет уникальный адрес MAC, который вводится при 
конфигурировании CP. Как правило, производитель «записывает» этот адрес 
в модуле.  

Приведенный ниже бокс требует введения адреса MAC для CP: 

  
Ниже приведен бокс для нового CP, который оснащен фиксированным 
адресом MAC, установленным при производстве – и, следовательно, не 
требует ввода этого адреса:  

  
Вы должны отметить бокс выбора и ввести адрес MAC модуля только в том 
случае, если Вы хотите использовать протокол ISO (например, для 
независимых от сети транспортных соединений ISO), или если Вы 
используете протоколы как ISO, так и TCP/IP.  

Вы не должны активировать бокс выбора, если Вы конфигурируете только 
типы соединений, использующие протокол TCP/IP (соединения TCP, ISO-on-
TCP, UDP). В этом случае нет необходимости вводить адрес MAC и 
поддерживается адрес записанный в модуле. 
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Адрес IP  
Параметры IP представлены только для CP Ethernet, поддерживающих 
протокол TCP/IP.  

Адрес IP состоит из 4 десятичных чисел, в диапазоне от 0 до 255. Десятичные 
числа разделяются точками.  

  
Адрес IP состоит из  

• Адреса (под)сети  

• Адреса партнера (обычно называемый хост или сетевой узел)  

Маска подсети разделяет эти два адреса. Она определяет части адреса IP, 
используемые для адресации сети и узла IP.  

Множество бит в маске подсети определяют сетевую часть адреса IP . 

В предыдущем примере: 

Маска подсети : 255.255.0.0 = 11111111.11111111.00000000.00000000 

Значение: первые 2 байта адреса IP определяют подсеть - например, 140.80. 
Последние два байте определяют узел – например, 2.  

В общем, справедливо:  

• Адрес подсети это результат логической операции И между адресом IP и 
маской подсети.  

• Адрес узла результат логической операции И между адресом IP и 
инверсией  маски подсети. 

Взаимосвязь между адресом IP и маской подсети, принятой по умолчанию 
Существует определенная взаимосвязь между областью адресов IP и так 
называемой "Маской подсети по умолчанию". Первое (слева направо) 
десятичное число или, иначе, первые символы в бинарном представлении 
адреса определяют используемую маску, как показано ниже: 
  
Адрес IP (дес.) Адрес IP  (бинарный) Класс адресов Маска подсети по 

умолчанию 

От 0 до 126 0xxxxxxx.xxxxxxxx....  A 255.0.0.0 
От 128 до 191 10xxxxxx.xxxxxxxx...  B 255.255.0.0 
От 192 до 223 110xxxxx.xxxxxxxx...  C 255.255.255.0 

  
 Замечание 

Первый десятичный номер адреса IP может также иметь значение 224 до 255 
(адреса класса D и т. д.). Однако мы не рекомендуем использовать эти 
значения,  так как STEP 7 не может их проверить. 
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Формирование расширенной маски подсети  
Маска подсети позволяет Вам расширить структуру подсети, связанную с 
назначением адресов классов A, B или C для создания "частных» nодсетей 
путем выбора последнего единичного бита в маске. Число “частных” подсетей 
удваивается с каждым битом, устанавливаемым в «1» и сокращает число 
улов в сети вдвое. Со стороны, эта сеть выглядит как простая сеть  

Пример:  

В сети с адресом класса B (например, адрес IP 129.80.xxx.xxx) Вы можете 
изменить маску подсети следующим образом:  

  
Маски Десятичные Двоичные 

Маска подсети по 
умолчанию 

255.255.0.0 11111111.11111111.00000000.00000000 

Маска подсети  255.255.128.0 11111111.11111111.10000000.00000000 

Результат:  

Все узлы с адресами от 129.80.001.xxx до 129.80.127.xxx относятся к данной 
подсети, а все узлы с адресами от 129.80.128.xxx до 129.80.255.xxx к другой 
подсети.  

Сетевой шлюз (Маршрутизатор) 

Сетевой шлюз (Маршрутизатор) осуществляет внешнее подключение сети. 
Дейтаграмма IP, посылаемая в другую сеть, начала попадает в 
маршрутизатор. Чтобы разрешить это, Вы должны для каждого сетевого узла 
определить адрес маршрутизатора.  

Адрес IP узла подсети и маршрутизатора (сетевого шлюза) могут отличаться 
только нулевыми битами маски подсети . 
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9.5 Импорт и экспорт станций в сетевом 
представлении  

Введение 
Начиная с STEP 7 V5.1, Service Pack 1, в сетевом представлении, Вы можете 
экспортировать и импортировать в текстовые файлы (ASCII) те конфигурации 
станций, которые имеют сетевые данные, но не имеют данных соединений.  

Если Вы экспортируете различные станции проекта STEP 7, которые 
работают в сети друг с другом, а затем импортируете их в дугой проект, эти 
станции сохранят сетевое взаимодействие, которое было  в оригинальном 
проекте.  

Применения  
• Можно распространять с помощью электронных средств (например, e-

mail) 

• Можно будет прочитать в последующих версиях STEP 7 

• Файл экспорта можно распечатать в текстовом редакторе или 
использовать для создания документации. 

Какие сетевые объекты можно экспортировать или импортировать? 
Вы можете экспортировать и импортировать станции SIMATIC 300, SIMATIC 
400, SIMATIC 400H, и SIMATIC PC.  

Что экспортируется и импортируется? 
В процессе импорта и экспорта в сетевом представлении экспортируются и 
импортируются данные, которые необходимы для параметризации модулей, 
а также сетевой конфигурации.  

Сетевая конфигурация включает: 

• Параметры интерфейса (например, экран подсети и установки 
маршрутизатора Industrial Ethernet interface, шинные параметры 
интерфейса PROFIBUS)  

• Привязка к подсетям 

• Соединения  

Не включено: 

• Данные, которые управляются посредством других приложений 
(например, программы, глобальные данные) 

• Соединения  

• Пароль CPU, назначенный как параметр 

• Данные, которые применимы к более, чем одной станции (например, связь 
интеллектуального ведомого DP или конфигурация для прямого обмена 
данных) 
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 Замечание 
Если Ваша конфигурация содержит модули из старых дополнительных 
пакетов, возможно, что не все данные модуля будут включены в функцию 
экспорта. В этом случае проверьте полноту данных модуля после импорта. 

Файлы экспорта 
Для каждой экспортируемой станции создается текстовый файл (*.cfg). По 
умолчанию его имя "[station name].cfg". 

В процессе экспорта Вы можете отдельно для каждой станции определить, 
что сохранять в файле экспорта и в какой форме хранить информацию 
(команда меню Edit > Export [Редактировать >Экспорт]): 

• Читаемая или компактная форма 

Важно: Если Вы экспортируете конфигурацию станции для того , читать 
ее в других версиях STEP 7, выберите вариант "Compact"! 

• Имя файла (*.cfg) для каждой отдельной станции может быть любым по 
Вашему желанию 

• С или без символики  

• Предустановленные значения параметров модулей могут быть пожеланию 
пропущены, (STEP 7 "знает” предустановленные значения параметров и 
дополняет ими данные при импорте из своей внутренней базы данных) 

• Опция «Export Subnets [Экспорт подсетей]» - Вы можете выбрать эту 
возможность для загрузки конфигурации станций с использованием 
старых версий STEP 7 (STEP 7 => V5.0). 

• Опция "Export Connections [Экспорт соединений]» - Вы можете выбрать эту 
возможность для загрузки конфигурации станций с использованием 
старых версий STEP 7 (STEP 7 => V5.0). 

Чтобы упростить процедуру импорта уже при экспорте, Вы можете импорти-
ровать все экспортированные станции вместе с опцией "With Reference File 
[С файлом ссылок]». Чтобы сделать это, Вы должны выбрать имя для этого 
файла ссылок (например, как файла *.cfg) который содержит ссылки на все 
экспортируемые станции, которые будут экспортированы вместе. Когда Вы 
выберите этот файл позднее при импорте, все станции которые были 
экспортированы вместе будут автоматически вместе импортированы.  

!  
Предупреждение 
Если Вы экспортировали конфигурацию станции с символикой, Вы не 
сможете импортировать этот файл в STEP 7 V5, SP 1, и более старых 
версиях STEP 7.  
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Последовательность действий (Экспорт) 
1. Откройте сетевое представление или сохраните конфигурацию сети, 

которую Вы редактировали (команда меню Network  Save [Сеть > 
Сохранить]). 

2. Выберите одну или более станций, которые Вы хотите экспортировать.  

3. Выберите команду меню Edit > Export [Редактировать >Экспорт]. 
Открывается диалоговое окно «Export [Экспорт]”. В этом в диалоговом 
окне, Вы можете выбрать из списка станции проекта для экспорта 

4. В открывшемся диалоговом окне, введите путь и имя файла экспорта, 
формат, и другие настройки.  

5. Формат и опции можно настроить для каждой станции отдельно.  
Выберите формат "Compact [Компакт]»,  если Вы собираетесь 
использовать файл экспорта для других версий STEP 7.  

6. Подтвердите установки, нажав «OK». 

Последовательность действий (Импорт) 
1. В открытом сетевом представлении, выберите команду меню Edit > 

Import [Редактировать > Импорт]. 

2. В возникшем  диалоговом окне, найдите текстовый файл, который Вы 
хотите импортировать. 
Если Вы экспортировали различные станции совместно с использованием 
опции "With Reference File [С файлом ссылок]» выберите только этот 
файл ссылок для импорта вместе всех станций с их сетевыми 
назначениями.  

3. Подтвердите установки, нажав «OK». 
В процессе импорта STEP 7 проверяет ошибки импортируемых файлов и 
согласованность с выводом сообщений. 

Если оба партнера по соединению импортированы в проект, STEP 7 затем 
делает попытку восстановить соединение между этими партнерами. 
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9.6 Как сконфигурировать и сохранить подсеть 

9.6.1 Последовательность действий при проектировании подсети 

 Возможность 1: Конфигурирование аппаратуры 
Уже при конфигурировании станции у Вас есть возможность создавать 
подсети и соединять с подсетью модули (точнее: их интерфейсы). 

Разместить модуль с интерфейсом или
интерфейсный модуль

Двойной щелчок на модуле/интерфейсе

При необходимости вставить в SIMATIC
Manager'е  другие объекты и определить

их свойства
(станции S7, PG/PC, станции S5,

"Другие станции", станцию SIMATIC PC)

Определение свойств:
- подсети (напр., имени,

скорости передачи)
- итерфейса (соединение с подсетью и

определение адреса MPI, PROFIBUS,
Industrial Ethernet)

Сохранить конфигурацию

Загрузить конфигурацию во все станции
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Возможность 1: Конфигурирование сети 
Для сложных сетевых установок предпочтительнее работать в сетевом 
представлении. 

В SIMATIC Manager создать под
проектом:

- станции (S7-300, S7-400, SIMATIC
PC и т. д.)

- подсети (PROFIBUS, Industrial Ether-
net и т. д.)

- "замещающие объекты" как PG/PC,
"Другая станция", станция S5

Запустить NetPro (графическое
представление сети)

Конфигурируйте станции так, чтобы все
модули с интерфейсами были назначены

одной подсети (CPU, CP, FM)

Определить свойства интерфейсов и
подсетей

Графически связать в сеть интерфейсы

Загрузить конфигурацию во все станции
  

  

Расширение конфигурации сети в NetPro 
В NetPro у Вас имеется возможность вставлять все сетевые объекты, напр., 
подсети или станции, с помощью буксировки (Drag&Drop) из каталога в 
представление сети. 

Что еще нужно сделать после вставки объектов: 

• Двойным щелчком на объекте установить его свойства 

• При вставке станции: Двойным щелчком на станции запустить 
конфигурирование аппаратуры и разместить модули 
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Открытие графического представления сети (запуск NetPro) 
У Вас есть следующие возможности для запуска отображения конфигурации 
сети: 

  
Из SIMATIC Manager'а Из конфигурирования 

аппаратуры 

1-й Открыть проект 
2-й Двойной щелчок на символе подсети (при 

необходимости создать подсеть командой меню 
Insert > Subnet > …[Вставить > Подсеть >…]) 

  
В качестве альтернативы Вы можете также дважды 
щелкнуть на объекте "Connections [Соединения]» 
(пиктограмму можно, напр., найти под модулем, 
который является точкой соединения; напр., CPU). В 
этом случае при запуске NetPro открывается для 
редактирования таблица соединений модуля. 

1. Команда меню Options > 
Configure Network 
[Возможности > 
Конфигурирование сети] 

Пример графического представления сети 
При открытии экрана для сетевой конфигурации отображается окно с 
графическим представлением сети. При первом выборе: 

• все созданные до сих пор в проекте подсети 

• все сконфигурированные до сих пор в проекте станции 

  

MPI(1)
MPI

Символ для подключения к сети
Символ для подсети

Символ для станции

Символ для
интерфейса
абонента

SIMATIC 300-Station(1)
CPU
314

SIMATIC 300-Station(2)
CPU
314 Символ для модуля
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Редактирование станции в NetPro  
Двойным щелчком на области символа станции Вы можете продолжить 
редактирование станции: 

SIMATIC 300-Station(1)
CPU
314

Двойной щелчок: запуск приложения для
Конфигурирования станции (напр.,вставка
модулей)

Двойной щелчок: определение
свойств модуля

Двойной щелчок: определение
свойств интерфейса

SIMATIC 300-Station(1)
CPU
314

Двойной щелчок: запуск приложения для
Конфигурирования станции (напр.,вставка
модулей)

Двойной щелчок: определение
свойств модуля

Двойной щелчок: определение
свойств интерфейса

  

9.6.2 Создание и параметризация новой подсети 

Предпосылка 
NetPro открыт.  

  
 Указание 

Свойства подсети, например, скорость передачи, автоматически 
централизованно и непротиворечиво устанавливаются в пакете STEP 7 для 
всех абонентов подсети. 

Если Вы устанавливаете или изменяете свойства подсети с помощью  
STEP 7, Вы должны позаботиться о том, чтобы каждый абонент подсети 
воспринял эти установки (загрузка конфигурации в контроллер)! 
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Последовательность действий 
1. Если окно «Catalog [Каталог]» не видно:  

Откройте окно «Catalog [Каталог]» командой меню View > Catalog [Вид > 
Каталог]. 

2. Щелкните в окне «Catalog [Каталог]» на "Subnets [Подсети]". 

3. Щелкните на желаемой подсети, удерживайте клавишу мыши нажатой и 
отбуксируйте подсеть, используя Drag&Drop, в окно для графического 
представления сети. 
Недопустимые положения подсети в окне графического представления 
отображаются запрещающим знаком  на курсоре мыши. 
Результат: Подсеть представляется на экране горизонтальной линией. 

4. Щелкните дважды на символе подсети. 
Результат: Отображается диалоговое окно для определения свойств 
подсети. 

5. Выполните параметризацию подсети. 

Совет: 
Удерживая мышь на символе подсети, Вы можете запросить 
информационное окно с данными о свойствах подсети. 

Советы по редактированию конфигурации сети 

Учет подключений для PG/PC в проекте сети 

Установка эквидистантных циклов шины для подсетей PROFIBUS 

9.6.3 Создание и параметризация новой станции 

Предпосылка 
NetPro открыт.  

Последовательность действий 
1. Если окно «Catalog [Каталог]» не видно:  

Откройте окно «Catalog» командой меню View > Catalog [Вид > Каталог]. 

2. Щелкните в окне «Catalog [Каталог]» на "Stations [Станции]". 

3. Щелкните на желаемом типе станции, удерживайте клавишу мыши 
нажатой и отбуксируйте станцию, используя Drag&Drop, в окно для 
графического представления сети. 
Недопустимые положения станции в окне графического представления 
отображаются запрещающим знаком  на указателе мыши. 

4. Щелкните дважды на станции (символе станции или имени станции). 
Теперь Вы можете вводить и параметрировать всю аппаратную 
конфигурацию станции, но должны в любом случае разместить CPU, а 
также при необходимости функциональные модули и коммуникационные 
процессоры в надлежащих слотах. Только эти модули могут быть 
соединены в сеть и появляются в графическом отображении сети. 
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5. Сохраните конфигурацию аппаратуры. 

6. Снова перейдите через панель задач (в Windows 95) к NetPro. 
Результат: Доступные интерфейсы абонентов отображаются в станции. 

Важно: 
Перед переходом из конфигурации станции в NetPro и обратно Вы должны 
сохранить введенные данные, так как иначе база данных не обновляется. 

Совет 
Удерживая мышь на символе станции, Вы можете запросить 
информационное окно с данными о свойствах станции. 

9.6.4 Создание и параметризация сетевых соединений 

Предпосылка 
NetPro открыт, уже сконфигурированные станции видны. 

Последовательность действий 
1. Щелкните на символе интерфейса абонента ( ), удерживайте клавишу 

мыши нажатой и переведите указатель мыши на подсеть. 
Недопустимые варианты подключения (напр., подключение интерфейса 
MPI к подсети типа Ethernet) отображаются в окне графического 
изображения запрещающим знаком  на указателе мыши. 
Результат: Подключение к сети отображается в виде вертикальной линии 
между станцией/ведомым DP и подсетью. Если была выбрана команда 
меню View > Reduced Subnet Lengths [Вид > Сокращенная длина 
сети], при подключении новой станции длина подсети автоматически 
увеличивается таким образом, что сетевые соединения всегда 
расположены вертикально над интерфейсом. 

2. Щелкните дважды на символе подключения к сети или на символе 
интерфейса.  
Результат: На экран выводится диалоговое окно для определения 
свойств абонента подсети. 

3. Установите свойства абонента (напр., его имя и адрес). 

Следующая иллюстрация показывает, куда надо перемещать курсор мыши, 
если выбрана опция  View > Reduced Subnet Lengths [Вид > Сокращенная 
длина сети],. 
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Советы 
Удерживая мышь на символе интерфейса, Вы можете запросить 
информационное окно с данными о свойствах интерфейса (имя модуля, тип 
подсети и, если есть соединение с сетью, адрес абонента). 

Вы можете показать или скрыть эту краткую информацию. Для этого 
выберите команду меню Options > Customize [Возможности 
>Пользовательские настройки]. В появившемся диалоговом окне 
«Customize [Пользовательские настройки]», перейдите на закладку «Editor 
[Редактор]» и, по желанию, отметьте или очистите бокс выбора "Display brief 
information [Показать краткую информацию]». 

9.6.5 Создание и параметризация нового ведомого DP 

Предпосылка: 
• При конфигурировании аппаратуры в конфигурационной таблице Вы 

назначили станции ведущего DP 

• Ведомые DP отображаются в графическом представлении сети (если нет: 
выберите команду меню View > DP Slaves [Вид > Ведомые DP]) 
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Последовательность действий 
1. Если окно «Catalog [Каталог]» не видно:  

Откройте окно «Catalog [Каталог]» командой меню View > Catalog [Вид > 
Каталог]. 

2. Выделите в графическом представлении сети внутри станции ведущего 
DP, которому должен быть поставлен в соответствие ведомый DP.  

3. Выделите в окне «Catalog [Каталог]» желаемого ведомого DP (под 
"PROFIBUS-DP"), удерживайте нажатой клавишу мыши и, используя 
Drag&Drop, отбуксируйте его в окно графического представления сети. 
Недопустимые положения ведомых отображаются запрещающим знаком 

 на указателе мыши. 
В качестве альтернативы Вы можете дважды щелкнуть на желаемом 
ведомом DP в окне "Catalog"! 

4. Задайте адрес абонента для ведомого DP в появившемся на экране 
диалоговом окне для определения свойств. 
Результат: В графическом представлении сети появляется ведомый DP 
со своим подключением к сети. 

5. Для параметризации/установки адресов: дважды щелкните на ведомом 
DP. 
Результат: Запускается конфигурирование аппаратуры, и выделяется 
ведомый DP. 

6.  Установите свойства ведомого DP. 

Советы 
Удерживая мышь на символе ведомого DP, Вы можете запросить 
информационное окно с данными о свойствах этого ведомого. 

Для быстрого поиска в каталоге NetPro, используйте окно каталога «Find 
[Найти]». Эта функция поиска работает подобно такой же в аппаратном 
каталоге HW Config.  
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9.6.6 Создание и параметризация PG/PC, 'других станций' и 
станций S5 

Обзор 
Что делать с абонентами сети, которые не могут быть сконфигурированы в 
текущем проекте STEP 7, напр., с устройствами программирования (PG), 
станциями оператора (OS), устройствами других изготовителей, имеющими 
собственные инструменты для проектирования, или устройствами S5? 

Эти устройства в NetPro представляются такими объектами, как PG/PC, 
"Other Station [Иная станция]» и станция S5.  

Выбор правильного объекта 
В следующей таблице показано, какой объект и в каком случае следует 
вставлять: 

  
Объект Для чего? Примечания 

PG/PC Чтобы отобразить в 
графическом 
представлении сети свое 
'собственное' устройство 
программирования, из 
которого можно получить 
доступ в режиме online к 
любому абоненту подсети. 

Через закладку " Assignment 
[Назначение]» Вы можете 
назначить свой PG/PC (систему 
разработки) вставленному в 
NetPro объекту "PG/PC". В NetPro 
символ для системы 
разработки−PG/PC особо 
выделен подсветкой. 

 Для PG/PC, которые 
являются целью 
соединения S7. 

Для PG/PC с интерфейсом S7-
SAPI  

Станция SIMATIC 
PC  

Для станций РС, 
являющихся конечным 
пунктом (двустороннего) 
соединения S7; пригодно 
также для соединений S7 с 
резервированием. 
Для WinLC с версии V3.0 

Конечным пунктом соединения у 
станций SIMATIC PC является 
такое приложение, как, напр., S7-
SAPI ** или WinCC. Для станции 
SIMATIC PC можно 
спроектировать ных пунктов 
соединения.  

Станция S5 Для станций S5 в подсети  -  
Other Station [Иная 
станция] 

Для устройств других 
фирм, подключенных к 
подсети  

-  

 * SIMATIC NET на CD произведенных до 10/98.  
 ** SIMATIC NET на CD произведенных начиная с 10/98, также справьтесь в информации о 
продукту на этом CD или S7-REDCONNECT 
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Последовательность действий 
1. Если окно «Catalog [Каталог]» не видно:  

Откройте окно «Catalog [Каталог]» командой меню View > Catalog [Вид > 
Каталог]. 

2. Выделите в окне «Catalog [Каталог]» желаемый объект (под "Stations 
[Станции]"), удерживайте нажатой клавишу мыши и отбуксируйте его, 
используя Drag&Drop, в окно для графического отображения сети. 
Недопустимые положения отображаются запрещающим знаком  на 
указателе мыши. 
В качестве альтернативы Вы можете дважды щелкнуть на желаемом 
объекте в окне "Catalog"! 

3. Дважды щелкните на объекте. 
Результат: Появляется диалоговое окно с закладками для установки 
свойств. 

4. Установите свойства: 

- Для всех объектов, кроме станций SIMATIC PC: Через закладку 
"Interfaces [Интерфейсы]» создайте тип интерфейса, который имеет 
реальный объект (напр., PROFIBUS). Через кнопку "Properties 
[Свойства]» установите свойства абонента и подсети.  
Результат: Объект получает для каждого вновь созданного 
интерфейса символ интерфейса.  

- Для объекта "PG/PC": Определите при необходимости в закладке 
"Assignment [Назначение]» назначение для существующей 
параметризации модуля (плата PC). Этим назначением Вы 
связываете объект «PG/PC» в графическом представлении сети с 
фактической параметризацией модуля вашего PG/PC.  
Преимущество: Когда Вы меняете, например, скорость передачи 
подсети, автоматически меняется параметризация модуля вашей 
платы PG/PC! 
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9.6.7 Учет подключений для PG/PC в проекте сети 

Если у Вас есть сетевой проект с несколькими, в том числе различными 
подсетями, Вы можете предусмотреть в проекте сети несколько 
"местодержателей» wildcards для PG (PC), который Вы хотите подключить 
позднее. Функцию "местодержателя» берет на себя в графическом 
представлении сети объект "PG/PC". 

Таким образом, Вы можете отключить PG от одной подсети и подключить к 
другой. Вы "информируете» STEP 7 об изменении местоположения PG 
командой меню PLC > Assign PG/PC [ПЛК > Назначение PG/PC] 

Следующий рисунок объясняет эту настройку: 

PROFIBUS 2

PROFIBUS 1

MPI
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А так выглядят точки подключения в графическом представлении сети 
("PG/PC(1))» и ("PG/PC(2))": 

 

  

Теперь Вы можете поставить свой PG в соответствие символам «PG/PC» 
(для определения устройства, с помощью которого Вы хотите получать 
доступ к станциям в режиме online). Благодаря этому назначению 
интерфейсы в вашей системе разработки настраиваются в соответствии с 
запроектированными параметрами. При изменении спроектированных 
настроек (напр., изменяется свойство скорость передачи) автоматически 
обновляется интерфейс в Вашем PG или PC. 

Последовательность действий 
1. Если PG/PC уже назначен: отмените это назначение, выделив «PG/PC» и 

выбрав команду меню PLC > Remove PG/PC Assignment [Контроллер > 
Отменить назначение PG/PC]. Символ назначенного PG/PC отличается 
от символа для неназначенных PG/PC. 

2. Выделите в графическом представлении сети символ "PG/PC", который 
должен представлять подключенное Вами устройство программирования. 

3. Выберите команду меню PLC > Assign PG/PC [Контроллер > 
Назначение PG/PC]. 

4. Используйте закладку "Assignment [Назначение]» для назначения набора 
параметров интерфейса в вашей системе разработки (Ваш PG/PC) 
интерфейсу символа "PG/PC". 
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STEP 7 на станции SIMATIC PC  
Станция SIMATIC PC, начиная с STEP 7 V5.1, Servicepack 2 имеет 
возможность маршрутизации.  

Из STEP 7 на станции SIMATIC PC Вы можете соединиться online со всеми 
узлами, которые подключены к этой станции. В этом случае, Вам не 
требуется назначать PG/PC для достижения узлов в различных подсетях.   

Условия, необходимые для маршрутизации станции SIMATIC PC:  

• Для конфигурации станции SIMATIC PC:  

- STEP 7, версия 5.1, Servicepack 2 или  

- SIMATIC NCM PC, версия 5.1 включая Servicepack 2 (с CD SIMATIC 
NET начиная с 7/2001)  

• Для функционирования станции PC   

- Установленные драйверы для CP: CD SIMATIC NET, начиная с 7/2001 

- Установленные компоненты для слота WinAC: WinAC Слот 41x, 
версия 3.2  
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9.6.8 Проверка непротиворечивости сети 

Перед сохранением следует проверить конфигурацию сети на непротиворе-
чивость. При этом появляются, например, следующие сообщения: 

• Узлы, не подключенные ни к какой подсети  
(исключение: не соединенные в сеть узлы MPI) 

• Подсети, имеющие только один узел 

• Несовместимые соединения  

Предпосылка 
NetPro открыт. 

Последовательность действий 
• Выберите команду меню Network > Consistency Check [Сеть > Проверка 

непротиворечивости]. 
Результат: Появляется окно "Outputs for Consistency Check [Результаты 
проверки непротиворечивости]» с указаниями по проектированию 
непротиворечивых сетевых конфигураций и соединений. 

Совет  
Окно с результатами последней проверки на непротиворечивость Вы можете 
выбрать в любое время командой меню View > Errors and Warnings [Вид > 
Ошибки и предупреждения)] 

Альтернативная последовательность действий 
1. Выберите команду меню Network > Save and Compile [Сеть > 

Сохранить и скомпилировать]. 

2. Выберите в следующем диалоговом окне опцию "Check and compile all 
[Скомпилировать и проверить все]". 

Окно «Outputs for Consistency Check [Вывод проверки согласованности]»  
Если проверка согласованности находит ошибки в конфигурации проекта, 
сообщения и предупреждения выводятся в это окно (возможна ссылка на 
конфигурацию аппаратуры, планирование сети или соединений). Проверка 
согласованности выполняется при следующих действиях: 

• Команда меню Network > Check Consistency [Сеть >Проверить 
согласованность] 

• Команда меню Network > Network > Check Interproject Consistency 
[Сеть > Сеть >Проверить межпроектную согласованность] 

• Команда меню Network > Save and Compile [Сеть >Сохранить и 
скомпилировать] 

• Загрузка в PLC (проверка согласованности станций или соединений, в 
которые выполняется загрузка) 
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Сообщения в окне «Outputs for Consistency Check [Отображение проверки 
согласованности]» отображаются как ошибки, если при сохранении и 
компиляции или перед загрузкой в PLC не созданы системные данные (SDB). 
Без сгенерированных системных данных невозможна загрузка в PLC 
конфигурации аппаратуры, сети и соединений.  

Сообщения в окне «Outputs for Consistency Check [Отображение проверки 
согласованности]» отображаются как warnings [предупреждения], если 
данное состояние позволяет сгенерировать системные данные (SDB).  

Если Вы выберите строку в верхней части окна выводa, эта строка 
повторяется в нижней части окна. Вам не требуется использовать прокрутку 
чтобы просмотреть весь текст..  

Выделение ошибочных и не согласованных объектов  
Дважды щелкните на соответствующем сообщении или предупреждении в 
окне "Outputs for Consistency Check [Вывод проверки согласованности]", или 
выберите команду меню Edit > Go to Error Location [Редактировать > 
Перейти к месту ошибки] в этом окне.  

Помощь по сообщениям и предупреждениям 
Выберите сообщение или предупреждение и нажмите F1, или выберите 
команду меню Edit > Show Help on Message.[Редактировать > Показать 
помощь по сообщению]. 

Сохранение сообщений и предупреждений 
Выберите команду меню File > Save Messages [Файл >Сохранить 
сообщения] в окне сообщений. 

9.6.9 Сохранение сетевой конфигурации 

Введение 
Для сохранения таблицы соединений, Вы должны выбрать одну из команд 
меню Network > Save [Сеть > Сохранить] или Network > Save and Compile 
[Сеть > Сохранить и скомпилировать]. 

Сохранение 
Если Вы в NetPro создали новые сетевые объекты или изменили их свойства, 
NetPro при применении команды меню Network > Save [Сеть > Сохранить 
сохраняет следующее: 

• Адреса узлов  

• Свойства подсети (такие как скорость передачи) 

• Соединения 

• Измененные параметры модулей (например, CPU) 
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Сохранение и компиляция 
Если Вы выберите команду меню Network > Save and Compile [Сеть > 
Сохранить и скомпилировать], Вы в появившемся диалоговом окне должны 
определить хотите ли Вы скомпилировать все или только изменения: 

Независимо от выбранного варианта, NetPro проверяет согласованность 
данных конфигурации в проекте; сообщения отображаются в отдельном окне.  

• Вариант "Check and compile all [Проверить и откомпилировать все]»  
Создаются загружаемые системные блоки данных (SDB) для всей сетевой 
конфигурации; которые содержат все соединения, адреса узлов, свойства 
подсетей, адреса входов и выходов и параметры модулей. 

• Вариант "Compile changes only [Компилировать только изменения]» 
Создаются загружаемые системные блоки данных (SDB) для измененных 
соединений, адресов узлов, свойств подсетей, адресов входов и выходов 
и параметров модулей. 

9.6.10 Советы по редактированию конфигурации сети 

 Запуск проектирования глобальных данных 
1. Выделите в отображении сети подсеть MPI, для которой Вы хотите 

спроектировать глобальные данные. 

2. Выберите команду меню Options > Define Global Data [Возможности > 
Определение глобальных данных]. 

Результат: Открывается таблица глобальных данных для подсети MPI. 

Проектирование соединений 
Если Вы в графическом представлении сети выделите компонент, который 
может быть конечным пунктом соединения (напр., CPU), то на экран 
автоматически выводится таблица соединений, в которой Вы можете 
проектировать соединения. 

Выделение подсветкой коммуникационного партнера модуля 
Если Вы уже спроектировали соединения: 

1. Выделите в NetPro сети программируемый модуль (CPU, FM). 

2. Выберите команду меню View > Highlight > Connections [Вид > Подсветить 
> Соединения].  

Замечание: одновременно могут быть выделены подсветкой 
коммуникационные партнеры только одного программируемого модуля! 

Отображение/изменение свойств компонентов 
Для отображения или изменения свойств станций или модулей действуйте 
следующим образом: 

1. Выделите компонент (символ станции или модуль) 
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2. Выберите команду меню Edit > Object Properties [Редактировать > 
Свойства объекта]. 

Копирование подсетей и станций  
1. Выделите подлежащий копированию объект сети, щелкнув левой 

клавишей мыши. Если Вы хотите скопировать одновременно несколько 
объектов, то другие объекты выделяйте, нажав SHIFT + левая клавиша 
мыши. 

2. Выберите команду меню Edit > Copy [Редактировать > Копировать]. 

3. Щелкните на том месте в отображении сети, куда должна быть помещена 
копия, и выберите команду меню Edit > Paste [Редактировать > 
Вставить]. 
 
Указание: Вы можете копировать отдельные объекты сети или целые 
подсети с подключениями к сети, станциями и ведомыми DP. При 
копировании не забывайте о том, что все абоненты подсети должны 
иметь различные адреса. Поэтому при необходимости Вам следует 
изменить адреса абонентов.  

Удаление подключений к сети, станций и подсетей 
1. Выделите символ подключения к сети, станцию, ведомого или подсеть. 

2. Выберите команду меню Edit > Delete [Редактировать > Удалить]. 
При удалении подсети ранее связанные с ней станции сохраняются и 
могут быть при необходимости подключены к другой подсети. 

Позиционирование станций и подсетей 
Вы можете произвольно перемещать в окне графического представления 
подсети, станции и ведомые DP (с подсоединением или без подсоединения к 
сети). Благодаря этому Вы можете также визуально копировать структуру 
вашего аппаратного обеспечения. 

• Щелкните на подсети или станции/ведомом DP, удерживайте нажатой 
клавишу мыши и, используя Drag&Drop, отбуксируйте подсеть или 
станцию/ведомый в желаемое положение. 
Недопустимые положения подсети или станции/ведомого DP в окне 
графического представления отображаются запрещающим знаком  на 
курсоре. 

Вы можете перемещать также уже подключенные к подсети станции/ведомые 
DP. Подключения к сети станций/ведомых DP при этом сохраняются. 

Сокращение длины подсетей 
В NetPro подсети отображаются “бесконечной” горизонтальной линией. 
Сократив длину подсети станции, можно сгруппировать по их подсетям и 
расположить в ясном и более понятном порядке. Для этого выберите команду 
меню View > Reduced Subnet Lengths [Вид > Сокращенная длина 
подсетей]. Отображаемая длина определяется расстоянием между 
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сетевыми интерфейсами и настраивается автоматически. Подсеть 
продляется немного за сетевыми модулями.  

Если подсеть еще не содержит подключенных узлов, как, например, после 
вставки новой подсети, длина показана “бесконечной” и зависит от установки, 
выбранной  в меню View [Вид]. 

 
 Замечание 

Если Вы изменили вид, подключение станций к подсети или расположение 
подсетей и станций, может случиться, что некоторые подсети будут перекры-
вать друг друга. В этом случае, Вы должны разместить станции и подсети по 
другому.  

Планирование вида сети  - Назначение ведомых DP их ведущим 
В графическом представлении сети, чтобы перестроить сетевую 
конфигурацию, которая стала запутанной, Вы можете графически назначить 
ведомых DP их мастерам:  

Предпосылка: Активирован вид "с ведомыми DP» (команда меню: View > With 
DP Slaves [Вид > C ведомыми DP]). 

Выберите команду меню View > Rearrange  
(начиная с STEP 7 V5.1, Service Pack 1).  

Выделение мастер-системы  
Вы можете выделить мастер-систему, например, чтобы скопировать ее 
целиком: 

1. Выделите ведущего или ведомого в графическом представлении сети. 

2. Выберите команду меню Edit > Select > Master System [Редактировать 
> Выделить > Мастер-система]. 

Выделение Master-системы DP подсветкой 
1. Выделите ведущего или ведомого в графическом представлении сети. 

2. Выберите команду меню View > Highlight > Master System [Вид > 
Подсветить > Мастер-система]. 

Доступ к модулям в режиме online 
Через меню PLC [Контроллер] у Вас имеется доступ к следующим функциям: 

• Отображение состояния модуля 

• Изменение рабочего режима модуля 

• Полное стирание модуля 

• Установка даты и времени для модуля 

• Загрузка и выгрузка 
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9.7 Сетевые станции, являющиеся шлюзами  

9.7.1 Сетевые станции, являющиеся шлюзами 

Обзор 
Для большинства систем программируемых логических контроллеров Вы 
можете работать с устройством программирования исключительно с 
помощью шинного кабеля (подсети), который подключен непосредственно к 
программируемому логическому контроллеру. Для относительно больших 
сетевых систем, эта ситуация требует, чтобы устройство программирования 
подключалось к различным шинным кабелям (подсетям) до того, как 
программируемый логический контроллер будет доступен online.  

Начиная с STEP 7 V5, возможен online доступ от устройства 
программирования/PC к программируемому логическому контроллеру за 
пределами подсети, например, для того, чтобы загрузить пользовательскую 
программу, конфигурацию аппаратуры или выполнить диагностику.  

Функция «PG Routing [Маршрутизация PG]» делает возможным доступ к 
программируемому логическому контроллеру из фиксированной точки 
системы через различные сети без переключения шинных соединений. Для 
этих целей в процессе конфигурации сети в STEP 7 автоматически 
генерируется специальная "таблица маршрутизации» для сетевых шлюзов. 
Эта таблица маршрутизации представляет собой специальные системные 
данные и должна быть загружена в отдельные сетевые шлюзы , то есть, CPU 
S7 или коммуникационные процессоры (CP). Впоследствии, когда 
программатор переходит в online, путь к выбранному программируемому 
логическому контроллеру может быть найден через сетевые шлюзы.  

Сетевой шлюз 
Шлюз от подсети к одной или нескольким подсетям это станция SIMATIC, 
которая имеет интерфейсы с соответствующими подсетями. 

Подсеть
типа 1

Интерфейс
типа 2

Подсеть
типа 2

Интерфейс
типа 1

Станция S7
PG/PC

Станция S7
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Предпосылки 
• STEP 7 начиная с версии 5 

• Модули с возможностью коммуникаций (CPU или CP), поддерживающие 
установку сетевых шлюзов между подсетями должны иметь возможность 
маршрутизации (информационный текст к соответствующему компоненту 
можно найти в каталоге аппаратуры). 
Начиная со STEP 7 Version 5.1, Servicepack 2, станции SIMATIC PC также 
поддерживают маршрутизацию.  

• Все достижимые программируемые логические контроллеры или 
коммуникационные партнеры в сети системы должны быть 
сконфигурированы и загружены в проекте S7.  

• Желаемая станция S7 – сетевая и может действительно достигаться 
через сетевые шлюзы .  

• В модули должна быть загружена конфигурационная информация, которая 
содержит текущие сведения о всей сетевой конфигурации проекта. 
Причина: Все модули, включенные в сетевой шлюз, должны получить 
информацию о том, какие подсети могут быть достигнуты, через какие 
маршруты (таблица маршрутизации).  

• Устройство программирования/PC с которого Вы хотите установить online 
соединение через шлюзы должно быть сконфигурировано и назначено 
программатору в сетевой конфигурации. 

Дополнительная информация для сетевых шлюзов 
В дополнение к адресу узла, свойствам подсети и соединениям  STEP 7 V5 
также генерирует информацию маршрутизации, которая может быть 
загружена в соответствующие модули.  

Информация маршрутизации включает: 

• Интерфейсы модулей 

• Назначения к подключенным подсетям 

• Следующие сетевые шлюзы, чтобы иметь доступ к удаленной подсети из 
одной из подключенных подсетей. 

Эта информация генерируется STEP 7 автоматически, когда компилируется 
конфигурация сети или станции (команда меню: ... > Save and Compile [… > 
Сохранить и скомпилировать]).  
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Какие модули или станции должны быть загружены после изменения 
сетевой конфигурации? 

  
Если Вы изменили конфигурацию 
следующим образом ... 

... Вы должны перегрузить 

Удаление или добавление сетевых 
соединений со станцией (станция эквивалента 
сетевому шлюзу) 

Все сетевые шлюзы 

Изменение адреса интерфейса в подсети 
(станция эквивалента сетевому шлюзу) или  
Подключение модуля с собственным адресом 
MPI в станцию S7-300, таким образом, что 
адрес MPI сетевого шлюза изменился 
(вставлен следующий модуль)  

Сетевые шлюзы в данной подсети  

Добавление и удаление сетевого шлюза Все сетевые шлюзы  
Вставка модуля с сетевым соединением  в 
другой слот (станция эквивалента сетевому 
шлюзу) 

Все модули этой станции 

Добавление подсети - 
Удаление подсети (в которой сконфигурирован 
сетевой шлюз) 

Все сетевые шлюзы  

Изменение ID подсети Если любой сетевой шлюз 
подключен к этой подсети: Все 
сетевые шлюзы  

Идентификатор подсети S7 для соединения Online через сетевые шлюзы  
Если сетевая конфигурации вместе с информацией маршрутизации 
загружена во все связанные станции, Вы можете также задать ID подсети S7 
для доступа к удаленной станции.  

ID подсети S7, который требуется STEP 7 используется в диалоговом окне 
состоит из двух чисел: 

• Номер проекта  

• Номер подсети 

Оба числа можно определить в диалоговом окне свойств подсети в 
существующей сетевой конфигурации. Если Вы хотите перейти в online с 
программатора без существующего проекта, Вы должны знать ID подсети. ID 
подсети распечатывается с сетевой конфигурацией. 

Учет подключений для PG/PC в проекте сети 
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9.7.2 Программатор/PC, подключенный к подсети через 
TeleService или WAN 

Устройство программирования или PC, как узлы удаленной сети доступные 
через TeleService или WAN (Wide Area Network) обрабатываются следующим 
образом в сетевой конфигурации: 

Объект «PG/PC» подключается непосредственно к удаленной подсети в 
сетевой конфигурации STEP 7. Сетевой шлюз через адаптер или 
маршрутизатор в конфигурации не видим.  

Пример: Подключение программатора через TeleService 

PROFIBUS

Модем

PG CPU

MPI

S7-300

CPU

S7-300

CPCP

Модем

CPU

MPI

S7-300

CPU

S7-300

CPCP

PROFIBUS

PG

Реальная конфигурация

Сетевая конфигурация в  STEP
7

  

  



Проектирование станций, соединенных в сеть 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
9-32 A5E00261404-01 

Пример: Подключение программатора через WAN  

Реальная конфигурация

Сетевая конфигурация в STEP 7

PG CPU

MPI

S7-300

CPU

S7-300

CPCP

EthernetМаршру-
тизатор WAN

PG CPU

MPI

S7-300

CPU

S7-300

CPCP

Ethernet

Маршру-
тизатор
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9.8 Подключение к сети станций из различных 
проектов 

Введение 
В сложных сетевых системах, управление станцией в более чем одном 
проекте может иметь преимущества.  

Начиная со STEP 7 V5.2, Вы можете конфигурировать отдельные проекты в 
составе мультипроекта. Эта процедура рекомендуется для новых проектов. 

На рисунке внизу, сетевая система разделена на две части (проекты) 
"Manuf1» и "Manuf2." 

Без мультипроекта, возникает следующая проблема: в проекте "Manuf1,» 
неизвестны станции, которые сконфигурированы в проекте "Manuf2».  

Конфигурирование без мультипроекта 
• Вы должны вставить в проект "Manuf1» символ «Other Station [Иная 

станция]», чтобы представить станцию из проекта "Manuf2.». «Other Station 
[Иная станция]» как a "stand-in object» ограничен свойствами, которые 
существенны для сетевого вида. 

• Вы должны запрограммировать подсеть, к которой подключены обе части 
системы, дважды в идентичной форме: как в проекте "Manuf1» так и в 
проекте "Manuf2". 

Ответственность за согласованность сетевых данных различных проектов в 
этом случае лежит на Вас, STEP 7 не может проверить согласованность "за 
границами проекта". 

S7 400/1

C
P

S7 - 300/3

Часть системы

"Manuf1"

C
P

S7 300/1

C
P

S7 - 300/2

S7 - 400/2

Часть системы

"Manuf2"

Ethernet (1)

Два проекта STEP 7
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10 Проектирование соединений 

10.1 Введение в проектирование соединений 

Введение 
Коммуникационные соединения или, кратко, соединения требуются во всех 
случаях, когда Вы хотите выполнить в своей прикладной программе обмен 
данными через специальные коммуникационные блоки (SFB, FB или FC). 

В этой главе Вы прочитаете, как определить соединения с помощью STEP 7, 
какие особенности Вы должны принять во внимание и какие 
коммуникационные блоки Вы можете использовать в прикладной программе. 

Что такое соединение? 
Соединение это логическое назначение друг другу двух коммуникационных 
партнеров для выполнения коммуникаций. Соединение определяет: 

• участников коммуникации (коммуникационных партнеров) 

• тип соединения (напр., транспортное соединение S7, "точка-точка", FDL 
или ISO) 

• специальные свойства (напр., действует ли оно постоянно, или 
динамически устанавливается и разъединяется в программе 
пользователя; должны ли посылаться сообщения о режиме работы). 

Что происходит при проектировании соединений? 
При проектировании соединений каждому соединению дается уникальный 
локальный идентификатор, "локальный ID". При параметризации 
коммуникационных блоков нужен только этот локальный ID. Для любого 
программируемого модуля, который может быть конечным пунктом 
соединения, существует своя собственная таблица соединений. 

 



Проектирование соединений 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
10-2 A5E00261404-01 

10.2 Конфигурирование коммуникаций через CP Ethernet  

Типы коммуникаций  
CP Ethernet поддерживают, в зависимости от типа CP, следующие типы 
коммуникаций: 

• Коммуникации S7 
Коммуникации S7 образуют простой и эффективный интерфейс между 
станциями SIMATIC S7 и PG/PC, используя коммуникационные 
функциональные блоки. 
CP работают как ”коммуникационные реле S7”, то есть передают 
коммуникационные блоки через Industrial Ethernet. 

• Коммуникации, совместимые с S5  

- Интерфейс SEND-RECEIVE  
В зависимости от типа CP, интерфейс SEND-RECEIVE допускают 
программно управляемую связь через сконфигурированные 
соединения между PLC SIMATIC S7 и другими PLC SIMATIC S7, 
SIMATIC S5, PC/PG и любыми другими станциями. 

- Службы FETCH/WRITE () 
Службы FETCH/WRITE (сервер) предоставляют прямой доступ к 
областям системной памяти CPU SIMATIC S7 из систем SIMATIC S5 
или устройств других производителей.  

• Управление процессом с использованием HTML  
С применением IT-CP, Вы можете использовать встроенные функции 
страницы HTML для запроса о важных системных данных через браузер 
browser (смотри руководство по IT-CP). 

• Управление файлами и доступ через FTP 
IT-CP предусматривает Возможности для сервисов FTP.  

Коммуникационные службы интерфейса SEND/RECEIVE  
В зависимости от типа CP, доступны следующие коммуникационные сервисы: 

• ISO Transport 
оптимизирован для наивысшей производительности в замкнутой 
производственной сети  

• TCP/IP для коммуникаций  Internet с  
– Соединениями ISO-on-TCP  (RFC 1006) и 
– Службой дейтаграмм UDP. 

• Посылка E-Mail 
Контроллер может посылать сообщения в зависимости от событий 
процесса (смотри руководство по IT-CP).  
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10.3 Конфигурирование коммуникаций через CP 
PROFIBUS  

 Типы коммуникаций 
CP PROFIBUS поддерживает следующие типы коммуникаций (в зависимости 
от используемого CP): 

S7-300/S7-400  с CP PROFIBUS

Функции S7

Возможные типы коммуникаций

Интерфейс
SEND/RECEIV

Интерфейс
FMS

Режим DP

Ведомый DPВедущий DP
Только одно из двух!

 

• Коммуникации PG/OP 
Коммуникации PG/OP используются для загрузки программ и 
конфигурации, выполнения тестирования и диагностики, а также для 
операторского контроля и управления системой через OP.  

• Коммуникации S7  
Коммуникации S7 создают простой и эффективный интерфейс между 
станциями SIMATIC S7 и PG/PC с использованием коммуникационных 
функциональных блоков. CP работает как ”коммуникационное реле S7”, 
передавая коммуникации через PROFIBUS. 

• Коммуникации, совместимые с S5 (интерфейс SEND-RECEIVE) 
Интерфейс SEND-RECEIVE предоставляет программно управляемые 
коммуникации через сконфигурированные соединения между PLC 
SIMATIC S7 и другими PLC SIMATIC S7, SIMATIC S5 и PC/PG. 

• Стандартные коммуникации (Интерфейс FMS) 
(совместимо с EN 50170 Vol. 2; функции клиента и сервера FMS) 
Интерфейс FMS предоставляет программно управляемые коммуникации 
нейтральной передачи структурированных данных через сконфигуриро-
ванные соединения между PLC SIMATIC S7 с устройствами 
поддерживающими протокол FMS. 

• PROFIBUS DP  
(совместимо с EN 50170 Vol. 2, ведущий или ведомый DP) 
Распределенная периферия (DP) позволяет Вам использовать большое 
число модулей аналоговых и цифровых входов и выходов  в 
непосредственной окрестности процесса в распределенной конфигурации. 
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10.4 Что нужно знать о различных типах соединений? 

Введение 
В следующих разделах дается краткий обзор типов соединений, которые Вы 
можете проектировать с помощью STEP 7. Для получения более полного 
обзора возможностей связи в SIMATIC мы рекомендуем руководство 
"Communicating with SIMATIC [Связь с помощью SIMATIC]. 

Соединения S7  
Соединения S7 обладают, среди прочего, следующими характеристиками: 

• тип соединения может быть спроектирован во всех устройствах S7/M7 

• применимы во всех типах подсетей (MPI, PROFIBUS, Industrial Ethernet) 

• при применении системных функциональных блоков BSEND/BRCV: 
надежная передача данных между станциями SIMATIC S7/M7-400; напр., 
обмен содержимым блоков данных (до 64 КБайт) 

• при применении системных функциональных блоков USEND/URCV: 
быстрая незащищенная передача данных независимо от затрат времени 
на обработку коммуникационных партнеров; напр., для сообщений о 
событиях и необходимости обслуживания 

• квитирование передачи данных от коммуникационных партнеров на 
уровне 7 эталонной модели ISO 

Соединения S7 с резервированием 
• свойства, как у соединений S7; за исключением CPU S7 H, сервера OPC 

для станции SIMATIC PC и подсетей MPI 

• в зависимости от топологии сети при использовании соединений S7 с 
резервированием между двумя конечными пунктами соединения 
возможны, по крайней мере, два пути для связи. 

Соединение "точка-точка" 
Для связи между CPU S7-400 и коммуникационным партнером, 
подключенным через соединение "точка-точка", связующим звеном является 
локальный СР 441. На этом СР происходит преобразование, связанное с 
переходом на механизмы адресации выбранной процедуры передачи. 
Поэтому соединение "точка-точка» заканчивается уже на СР 441, а не на 
коммуникационном партнере, как при других соединениях.  

Количество соединений с СР зависит от установленной процедуры. 
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Соединение FMS 
PROFIBUS-FMS (Fieldbus Message Specification [Спецификация сообщений 
полевой шины]) характеризуется следующими свойствами: 

• применимо для передачи структурированных данных (переменных FMS) 

• соответствует европейскому стандарту EN 50170, т. 2, PROFIBUS 

• применимо для открытой связи с устройствами других фирм на PROFIBUS 

• приложение удаленного коммуникационного партнера подтверждает 
прием данных 

• соответствует уровню 7 эталонной модели ISO  

• сервисы FMS на РС предоставляются в распоряжение как функции на 
языке С 

Соединение FDL 
PROFIBUS-FDL (Fieldbus Data Link[связь по данным полевой шины]) 
характеризуется следующими свойствами: 

• применимо для передачи данных коммуникационному партнеру (напр., 
SIMATIC S5 или PC), который поддерживает передачу и прием в 
соответствии с функцией SDA (Send Data with Acknowledge [Передача 
данных с подтверждением])  

• прием данных подтверждается службой FDL коммуникационного партнера 
путем квитирования  

• только для подсети PROFIBUS 

• соответствует стандарту EN 50170, т. 2, PROFIBUS 

• соответствует уровню 2 эталонной модели ISO 

• сервисы FDL на РС предоставляются в распоряжение в виде функций на 
языке С 

Транспортное соединение ISO 
Транспортное соединение ISO характеризуется следующими свойствами:  

• благодаря "упаковке данных» пригодно для больших объемов данных 

• делает возможной связь с партнером (напр., SIMATIC S5 или PC), который 
поддерживает передачу и прием данных в соответствии с требованиями 
транспортировки ISO 

• только для Industrial Ethernet 

• прием данных подтверждается службой транспортировки ISO 
коммуникационного партнера путем квитирования  

• служба транспортировки ISO (ISO 8073 class 4) соответствует уровню 4 
эталонной модели ISO 

• на РС транспортные услуги ISO предоставляются в распоряжение в виде 
функций на языке С 
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Соединение ISO-on-TCP  
Соединение ISO-on-TCP характеризуется следующими свойствами: 

• соответствует стандарту TCP/IP (Transmission Control Protocol/Internet 
Protocol [Протокол управления передачей данных/Протокол Интернет]) с 
расширением RFC 1006 в соответствии с уровнем 4 эталонной модели 
ISO. RFC 1006 описывает, как услуги уровня 4 ISO могут быть отображены 
на TCP. 

• делает возможной связь с партнером (напр., PC или системой другой 
фирмы), который поддерживает передачу и прием данных в соответствии 
с ISO-on-TCP  

• прием данных подтверждается квитированием  

• только для Industrial Ethernet 

• на РС услуги ISO-on-TCP предоставляются в распоряжение в виде 
функций на языке C 

Соединение TCP  
TCP имеет следующие особенности: 

• Совместимость с стандартом TCP/IP (Transmission Control Protocol/Internet 
Protocol)  

• Разрешает соединение с партнером (таким, как PC или устройство не 
Siemens), который поддерживает отправку и прием данных в соответствии 
TCP/IP.  

• Вы можете передавать данные, используя утилиты Send/Receive или 
Fetch и Write.  

• Только для Industrial Ethernet  

• Как правило, Вы можете использовать реализацию TCP/IP в операционной 
системе PC.  

Соединение UDP 
Соединение UDP (User Datagramm Protocol [Протокол дейтаграмм 
пользователя]) характеризуется следующими свойствами: 

• применимо для Industrial Ethernet (протокол TCP/IP) 

• дает возможность незащищенной передачи связных блоков данных между 
двумя узлами  

Соединение E-Mail характеризуется следующими свойствами:  

• применимо для Industrial Ethernet (протокол TCP/IP) 

• дает возможность передачи, например, данных процесса из блоков 
данных по E-Mail через IT-CP 

• с помощью соединения E-Mail определяется сервер электронной почты, 
через который доставляются все посылаемые коммуникационными 
процессорами IT электронные сообщения  
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10.5 Что надо знать о назначении ресурсов соединений 

Введение 
На подключенной станции, каждое соединение требует ресурс соединения 
для своей конечной точки и точки перехода (например, CP). Реальное число 
доступных ресурсов соединений зависит от используемых CPU и CP. 

Если заняты все ресурсы соединений коммуникационного партнера, то новое 
соединение не может быть. Следующее обсуждение относится конкретно к 
каждому виду связи. В пределах, наложенных количеством доступных 
ресурсов, возможны комбинации любых типов. 

Соединения S7  
Соединения S7, устанавливаемые через встроенный  интерфейс MPI-
/PROFIBUS DP, используют на CPU для каждого соединения S7 один ресурс 
соединений для конечной точки. Это применимо ко всем CPU S7/M7-300/400 
и C7-600. 

  
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) MPI или PROFIBUS DP 

Соединения S7, устанавливаемые через внешний интерфейс CP, 
используют один ресурс соединений на CPU (конечная точка) и на CP (точка 
передачи) для каждого соединения S7. Это применимо ко всем CPU S7/M7-
300/400 и C7-600.  

  
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) Industrial Ethernet, PROFIBUS  
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 Замечание 
Для выполнения функций программатора на CP для S7-400 через MPI или 
встроенный интерфейс DP необходимо два ресурса соединений на CPU (для 
двух точек перехода). Это требование должно быть принято во внимание при 
определении общего числа сконфигурированных соединений STEP 7. 

Интерфейс SEND/RECEIVE  
Коммуникации через интерфейс SEND-RECEIVE осуществляются только 
через CP. Каждое соединение (например, соединения FDL, ISO-transport, ISO-
on-TCP, UDP и TCP) требует одного ресурса соединений на CP для каждой 
конечной точки. 

На CPU S7-300 и C7-600 не требуется ресурсов соединений.  

  
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) Industrial Ethernet, PROFIBUS  

На CPU S7-400 CPU не требуется ресурсов соединений для соединений 
SEND/RECEIVE (например, соединения FDL, ISO-transport, ISO-on-TCP). 

  
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) Industrial Ethernet, PROFIBUS  

 
 Замечание 

Для выполнения функций программатора на CP для S7-400 через MPI или 
встроенный интерфейс DP необходимо два ресурса соединений на CPU (для 
двух точек перехода). Это требование должно быть принято во внимание при 
определении общего числа сконфигурированных соединений STEP 7. 
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Интерфейс FMS  
Связь через интерфейс FMS осуществляется только через CP. Каждое 
соединение FMS использует один ресурс на CP конечной точки. На CPU 
каждый CP использует один коммуникационный ресурс для связи с ним. 

 
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) PROFIBUS 

  
 Замечание 

Для выполнения функций программатора на CP для S7-400 через MPI или 
встроенный интерфейс DP необходимо два ресурса соединений на CPU (для 
двух точек перехода). Это требование должно быть принято во внимание при 
определении общего числа сконфигурированных соединений STEP 7. 

  

Соединения S7 через S7/M7-300 и C7-600 
Соединения S7, устанавливаемые через интерфейс MPI, используют только 
один ресурс соединений для конечной точки на FM для S7/M7-300 (только для 
CPU 312-316) и C7-600. 

 
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений 
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Соединения S7, устанавливаемые через встроенный  интерфейс MPI-
/PROFIBUS DP, используют на CPU два ресурса соединений (для двух точек 
перехода); на FM в любом случае требуется один ресурс (для конечной 
точки).  

 
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) PROFIBUS DP  

Соединения S7 через S7/M7-400 
Соединения S7, устанавливаемые через внутренний  интерфейс MPI-
/PROFIBUS DP, используют на CPU два ресурса соединений (для двух точек 
перехода); на FM в любом случае требуется один ресурс (для конечной 
точки). Это также применимо для каждого дополнительного CPU 
(многопроцессорная система) в пределах той же станции, поскольку этот узел 
находится на MPI. 

 
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) MPI или MPI/PROFIBUS DP  
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Соединения S7 через FM M7  
Соединения S7, устанавливаемые через внутренний интерфейс 
MPI/PROFIBUS DP, используют на FM два ресурса соединений (для двух 
точек перехода); на CPU S7/M7 или C7-600 в любом случае требуется один 
ресурс (для конечной точки). 

 
(1) Доступные ресурсы соединений 

(2) Используемые ресурсы соединений  

(3) PROFIBUS DP 
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10.6 Использование ресурсов соединений с 
отказоустойчивыми соединениями S7 

Для H-систем имеется множество возможных конфигураций, которые 
отличаются числом используемых H-CPU, CP подсетей. В зависимости от 
конфигурации, возможно два или четыре отдельных соединений для каждого 
отказоустойчивого соединения S7. Эти соединения обеспечивают 
соединения, поддеживаемые даже при отказе одного из компонентов. 

Следующий разделы описывают большинство общих конфигураций 
отказоустойчивых соединений и использование ими ресурсов соединений. 

Основная информация 
Для каждого H-CPU, ресурс соединений используется для каждой конечной 
точки отказоустойчивого соединения S7 (то есть, для резервированных 
соединений на обоих используемых H-CPU).  

Для каждого отказоустойчивого соединения S7 STEP 7 устанавливает два 
частичных соединения, как альтернативные пути коммуникаций. Чтобы 
обеспечить доступность обоих путей, для каждого пути резервируются 
ресурсы. Если оба частичных соединения работают через один 
промежуточный CP, на этом CP все равно резервируется два ресурса 
соединений. 

Следующие разделы раскрывают эту ситуацию в деталях.  

Заметки к иллюстрациям 
В резервированных H-станциях, два CPU обозначены "H-CPU 0» и "H-CPU 1".  

CP нумеруются последовательно  (CP 0, CP1, ...).  
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Случай 1: Конфигурация с резервированными H-станциями (локальной и 
удаленной), возможны два частных соединения 

Как показано на следующей иллюстрации, каждый из двух CPU имеет один 
назначенный ему ресурс, и каждый используемый CP также имеет один 
назначенный ресурс. 

  

  
(1) Частичное соединение 

(2) Отказоустойчивое соединение S7 
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Случай 2: Конфигурация с нерезервированной H-станцией (локальной) и 
резервированной H-станцией (удаленной), возможны два частных 
соединения  

В этом случае есть различие в том, оснащена ли резервированная станция 
партнер двумя или четырьмя CP.  

Если станция партнер оснащена двумя CP, один ресурс соединения 
резервируется на локальном H-CPU и два ресурса соединения резервируется 
на локальном CP.  

Если станция партнер оснащена четырьмя CP и выбрана опция «Enable max. 
CP redundancy [Разрешить максимальное резервирование CP]», тогда в 
общем возможно четыре пути соединений. И все-таки, один ресурс 
соединения резервируется на локальном H-CPU, и два ресурса соединения 
резервируется на локальном CP. Причина этого в том, что максимум два 
частичных соединения могут быть активны. 

  
(1) Частичное соединение 

(2) Отказоустойчивое соединение S7 
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Случай 3: Конфигурация с резервированными H-станциями (локальной и 
удаленной), возможны четыре частных соединения  

Если резервированные H-станции соединены в подсеть, возможно максимум 
четыре частичных соединения. Один ресурс соединения резервируется для 
каждого H-CPU, и два ресурса соединений резервируется для каждого 
используемого CP  

Возможны следующие частичные соединения:  

От H-CPU0/CP0 (локальная станция) к CP0 /H-CPU0 (станция партнер) 

От H-CPU1/CP1 (локальная станция) к CP1 /H-CPU1 (станция партнер) 

От H-CPU0/CP0 (локальная станция) к CP1 /H-CPU1 (станция партнер) 

От H-CPU1/CP1 (локальная станция) к CP0 /H-CPU0 (станция партнер) 

  
(1) Частичное соединение 

(2) Отказоустойчивое соединение S7 

Случай 4: Конфигурация с нерезервированной H-станцией и двумя CP 
(локальные) и резервированной H-станцией (удаленной)  

Если локальная станция оснащена всего двумя CP, один ресурс соединения 
зарезервирован на локальном H-CPU и по одному ресурсу соединения 
зарезервировано на каждом локальном CP.  

  
(1) Частичное соединение 

(2) Отказоустойчивое соединение S7 
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Случай 5: Конфигурация с нерезервированной H-станцией (локальные) и 
резервированной H-станцией (удаленной) с максимальным 
резервированием CP 

Если локальная станция и станция партнер оснащены в сумме четырьмя CP 
и включена опция «Enable max. CP redundancy [Разрешить максимальное 
резервирование CP]», тогда возможно четыре пути соединения. STEP 7 
резервирует один ресурс соединения для локального H-CPU и ресурс 
соединения для каждого локального CP. 

Возможны следующие частные пути соединения:  

От H-CPU0/CP0 (локальная станция) к CP0 /H-CPU0 (станция партнер) 

От H-CPU1/CP2 (локальная станция) к CP2 /H-CPU1 (станция партнер) 

От H-CPU0/CP1 (локальная станция) к CP1 /H-CPU0 (станция партнер) 

От H-CPU1/CP3 (локальная станция) к CP3 /H-CPU1 (станция партнер) 

  

(1) Частичное соединение 

(2) Отказоустойчивое соединение S7 
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10.7 Блоки для различных типов соединений 

Блоки, используемые для соединений S7 
Системные функциональные блоки встроены в  CPU S7-400.  

Для S7-300, с новыми CPU и CP, Вы можете активно использовать 
коммуникации S7 (то есть, как клиента) через интерфейс CP. Блоки (FB) 
имеют те же номера и обозначения как и соответствующие SFB для S7-400; 
однако, они должны вызываться циклически в пользовательской программе 
CPU S7-300. Вы можете найти блоки в библиотеке SIMATIC_NET_CP.  

CP должен поддерживать функции клиента для S7.  

CPU 317-2 PN/DP с интерфейсом PROFInet может также быть 
сконфигурирован как клиент для коммуникаций S7. В этом случае, 
используются те же блоки, что и упомянутые выше для S7-300 с CP. Эти 
блоки также находятся в Standard Library [Стандартной библиотеке] 
(Communication Blocks/CPU_300). С интерфейсом PROFInet возможны только 
функции клиента. 

 

SFB/FB/FC Обозначение Краткое описание 

SFB8/FB8 
SFB9/FB9 

USEND 
URCV 

Нескоординированный обмен данными через SFB для 
передачи и приема  
Макс. длина SFB 8/9: 440 байт, разбито 4x100 байт. 
Макс. длина FB 8/9: 160 байт 

SFB12/FB12 
SFB13/FB13 

BSEND 
BRCV 

Обмен блоками данных переменной длины между одним 
передающим и одним принимающим SFB  
Макс. длина SFB 12/13: 64 KB 
Макс. длина FB 12/13: 32 KB 

SFB14/FB14 GET Чтение данных из удаленного устройства 
Макс. длина SFB 14: 400 байт, разбито 4x100 байт 
Макс. длина FB 14: 160 

SFB15/FB15 PUT Запись данных в удаленное устройство 
Макс. длина SFB 15: 400 байт, разбито  4x100 байт 
Макс. длина FB 15: 160 

SFB19 START Выполнение теплого рестарта в удаленном устройстве 
SFB20 STOP Перевод удаленного устройства в состояние STOP 
SFB21 RESUME Выполнение горячего рестарта в удаленном устройстве 
SFB22 STATUS Запрос состояния удаленного устройства 
SFB23 USTATUS Прием сообщений о состоянии удаленного устройства 
SFC62 CONTROL Запрос состояния связи относящейся к экземпляру SFB  
FC62 C_CNTRL Опрос состояния соединения (для CPU S7- 300) 
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Блоки, используемые для соединений «точка-точка»  
Для соединений типа «точка-точка» Вы можете использовать SFB BSEND, 
BRCV, GET, PUT и STATUS (см. вышеприведенную таблицу). 

Кроме того, можно использовать SFB PRINT: 

  
SFB Обозначение Краткое описание 

SFB16 PRINT Передача данных на принтер 

Блоки для соединений FMS  
  

FB Обозначение  Краткое описание 

FB 2 IDENTIFY  Идентифицирует удаленное устройство для пользователя 
FB 3 READ  Чтение переменной из удаленного устройства 
FB 4 REPORT Сообщение о переменной на удаленное устройство 
FB 5 STATUS Предоставляет данные о состоянии удаленного устройства по 

запросу пользователя 
FB 6 WRITE Запись переменной в удаленное устройство 

Блоки для соединений FDL, ISO-on-TCP и транспортного соединения ISO, а 
также Email  

 
FC Обозначение Краткое описание 

FC 5 AG_SEND Передает данные через спроектированное соединение 
коммуникационному партнеру (<= 240 байт).  

FC 6 AG_RECV Принимает данные через спроектированное соединение от 
коммуникационного партнера (<= 240 байт, not email).  

FC 50 AG_LSEND Передает данные через спроектированное соединение 
коммуникационному партнеру.  

FC 60 AG_LRECV Принимает данные через спроектированное соединение от 
коммуникационного партнера (не email).  

FC 7 AG_LOCK Блокирует внешний доступ к данным через FETCH/WRITE (не для 
UDP, email). 

FC 8 AG_UNLOCK Разблокирует внешний доступ к данным через FETCH/WRITE (не 
для UDP, email). 
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10.8 Работа с таблицей соединений 

Отображение и сокрытие колонок таблицы соединений  
1. Разместите указатель в таблице соединений и нажмите на правую кнопку 

мыши, чтобы появилось выпадающее меню  

2. В выпадающем меню, выберите Show/Hide Columns >…. 
[Показать/Скрыть >…]. В следующем выпадающем меню, выберите имя 
колонки, которую Вы хотите показать или скрыть. 

Имя видимой колонки отмечено “галочкой”. Если Вы выберите видимую 
колонку, отметка снимается и колонка скрывается.  

Оптимизация ширины колонок 
Чтобы настроить ширину колонки по ее содержанию, так чтобы весь текст в 
строках был разборчив, поступают следующим образом: 

1. Разместите указатель курсора в заголовке таблицы соединений, справа 
от колонки которую Вы хотите оптимизировать так, чтобы указатель 
принял вид двух параллельных линий (как, если бы Вы хотели изменить 
ширину колонки перетаскиванием указателя). 

2. Дважды щелкните на этой позиции. 

Совет: В колонках, которые расположены слишком плотно, Вы можете 
отобразить полное содержание, если Вы установите курсор на некоторое 
время на нужном поле. 

Сортировка в таблице соединений 
Чтобы отсортировать таблицу соединений по колонке в возрастающем или 
убывающем порядке, щелкните в заголовке колонки. 

Следующий щелчок в заголовке сортирует таблицу в противоположном 
направлении.  

  
 Указание 

Ширина колонок и то, какие колонки видимы, сохраняется для каждого 
проекта при его закрытии. По этой причине, когда Вы открываете проект на 
другом компьютере, установки действуют и на нем. 

Дополнительная информация 
Для дополнительной информации о колонках таблицы соединений 
справьтесь в контекстной справке (например, о команде меню View > 
Display/Hide Columns ...[Скрыть/Показать колонки… ]). 
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Перемещение с клавишами курсора и вызов диалога редактирования  
Вы можете использовать клавиши СТРЕЛКА ВВЕРХ и СТРЕЛКА ВНИЗ для 
выбора соединения  в таблице соединений.. Выбранное соединение 
подсвечивается. 

Если Вы используете клавиши СТРЕЛКА ВПРАВО или СТРЕЛКА ВЛЕВО для 
перемещения по полям и в колонке «Partner [Партнер]» нажмете ENTER, 
возникает диалог изменения партнера по соединению. Если Вы 
переместитесь в другое поле (например, Local ID) и нажмете ENTER, 
открывается диалог свойств соединения.  

Если Вы выбираете несколько соединений, или Вы подсветили несколько  
отдельных колонок (удерживая клавишу CTRL м выбирая одну колонку за 
другой) и вызываете при этом соответствующий диалог (изменение партнера 
по соединению или свойства соединений), диалоги выделенных соединений 
возникают один за другим.  

Изменение свойств соединения 
Если Вы хотите изменить уже созданное соединение, например, установить 
другой путь соединения (интерфейс), выполните следующее:  

1. Выберите соединение, которое Вы хотите изменить.  

2. Выберите команду меню Edit > Object Properties [Редактировать > 
Свойства объекта].  
В возникшем диалоговом окне, Вы можете изменить свойства, которые 
Вам надо отредактировать.  

Изменение только локальных данных: Начиная со STEP 7 V5.1, Service 
Pack 1, Вы можете изменить локальный ID непосредственно в колонке 
таблицы соединений Local ID .  

Переход к станции-партнеру 
Начиная со STEP 7 V5.2 при редактировании таблицы соединений Вы можете 
легко переключиться к таблице соединений партнера по соединению:  

1. Выберите соединение  в таблице соединений. 

2. Выберите команду меню Edit > Go To Partner Connection 
[Редактировать > Перейти к партнеру по соединению]. 

Эта функция доступна и при межпроектных соединений в мультипроекте. 
Проект, содержащий партнера по соединению, должен быть открыт.  
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10.9 Несогласованные соединения 

Если соединения несогласованны, структура данных соединения нарушена 
или соединение не может быть установлено в контексте данного проекта. 

Несогласованные соединения не могут быть скомпилированы и загружены – с 
такой связью невозможны никакие операции. 

Несогласованные соединения в таблице соединений обозначаются красным 
цветом и курсивом. 

Возможные причины несогласованности соединений  
• Удаление или изменение аппаратной конфигурации  

• Пропуски сетей или интерфейсов в проекте, которые необходимы для 
соединения  

• Превышение ресурсов соединений 

• Ошибка в сохранении данных из-за недостатка памяти  

• Соединение с незаданным партнером без определения адреса партнера  

• Соединение с партнером в неизвестном проекте, которые пока имеют  
сконфигурированные соединения  

Детальная информация о причинах несогласованности соединений 
перечислена в окне Outputs on Consistency Check [Результат проверки 
согласованности] (после проверки согласованности, команды меню Network > 
Check Consistency [Сеть > Проверка согласованности] или Network > 
Check Interproject Consistency [Сеть > Проверка межпроектной 
согласованности]). 

Детальная информация о причинах несогласованности можно получить при 
редактировании свойств соединений (выделив соединение и выбрав команду 
меню Edit > Object Properties [Редактировать > Свойства объекта]). 

Исправления 
Во многих случаях для восстановления согласованности достаточно 
редактирования свойств соединений, то есть исправления данных 
соединения. Несогласованность соединений может быть исправлена при 
назначении свойств. 

Если соединение не может быть исправлено при редактировании свойств 
соединений, изменении или переделке конфигурации, может появиться 
необходимость удаления и создания нового соединения. 
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10.10 Отображение состояния соединений 

Состояние соединения 
Чтобы отобразить системные или диагностические ошибки, Вы можете 
отобразить состояние коммуникационных соединений модуля в таблице 
соединений.  

Возможные состояния соединения: 

• Установлено 

• Не установлено 

• Устанавливается в настоящий момент  

• Не доступно 

  
 Указание 

Колонка «Connection Status [Состояние соединения]» имеет желтый фон, 
если соединение доступно только online, но не доступно offline в project. 
Причина этого может быть в том, что соединение было загружено в модули 
без предварительного сохранения в проекте. 

Предпосылки 
• Отображение состояния соединений возможно только для локальной 

конечной точки соединения, например, для CPU, выбранном в сетевом 
представлении.  

• Модуль должен поддерживать состояние соединения. 

(Возможно с 10/99, эта характеристика документирована в списке команд 
CPU. CPU должен поддерживать SSL ID 0x36 "Connection-Specific 
Diagnostics [Диагностика соединений]") 

• Есть соединение online с конечной точкой соединений. 

• Если имеются связи, сконфигурированные с применением 
дополнительного пакета, Вам требуется иметь этот дополнительный пакет 
для отображения состояния.  

• На программаторе есть проект для сетевой конфигурации или Вы 
выгрузили станции в программатор (команда меню PLC > Upload [ПЛК > 
Выгрузить]). 



 Проектирование соединений 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261404-01 10-23 

Последовательность действий 
1. Выберите модуль, для которого Вы хотите отобразить состояние 

соединений. 

2. Выберите команду меню PLC > Activate Connection Status [ПЛК > 
Активировать состояние соединений].  

Окно переключается в ONLINE и в начале таблицы соединений 
появляется колонка Connection Status [состояние соединений].  

В этой колонке отображается информация о состоянии каждого 
соединения. 

Текст выполняемой команды меню изменяется на "Deactivate Connection 
Status.[Деактивировать состояние соединения]» Вы используете эту 
команду, для возврата в представление таблицы соединений offline, так, 
что Вы можете снова конфигурировать соединения.  

3. Чтобы получить, более летальную информацию о текущем состоянии 
связи, дважды щелкните  на соответствующей строке в таблице 
соединений или выберите команду меню Edit > Object Properties 
(альтернативно, щелкните правой кнопкой мыши, чтобы получить 
выпадающее меню и выберите Object Properties [Свойства объекта] или 
Status Information [Информация о состоянии]). 

Появляется таблица Status Information [Информация о состоянии] с 
дополнительной информацией о состоянии соединений.  

Завершение состояния соединений 
Используйте команду меню PLC > Deactivate Connection Status [ПЛК > 
Деактивировать состояние соединений] для завершения функции и 
возврата к представлению таблицы соединений offline .  

10.11 Доступ к идентификаторам соединений при 
программировании 

При программировании (например, в Statement List Editor), Вы можете 
выполнить следующие функции, предусмотренные диалогами: 

• Доступ уже сконфигурированных соединений  

• Создать новое соединение  

• Изменить партнера по соединению  

Чтобы вызвать диалог, выполните следующее: 

1. Запрограммируйте вызов блока (например, SFB12, BSEND) 

2. Установите курсор мыши на параметре блока (например, "ID") 

3. Щелкните правой кнопкой мыши, чтобы получить выпадающее меню. В 
Выпадающем меню, выберите "Connections [Соединения]" 
Появляется диалог со всеми соединениями, которые применимы  в 
данном контексте (зависит от назначенных станций, сконфигурированных 
соединений) 
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10.12 Проектирование соединений для партнеров в 
одном и том же проекте 

10.12.1 Типы соединений у партнеров в одном и том же проекте 

 Выбор типа соединения у партнеров в одном и том же проекте 
Тип соединения зависит от подсети и протокола передачи, через который 
устанавливается соединение, и от семейства устройств автоматизации, к 
которому принадлежат коммуникационные партнеры. 

Какие блоки Вы можете использовать (SFC, FB, FC), зависит от типа 
соединения. 

Следующая таблица должна Вам облегчить выбор типа для соединения, 
которое Вы хотите создать. 

 
Тип соединения Тип подсети Соединение между SIMATIC ... SFB/FB/FC 

Соединение S7 MPI,  
PROFIBUS,  
Industrial Ethernet 

S7 - S7, S7 - PG/PC, 
S7 - PG/PC с WinCC 
для MPI дополнительно:  
M7 - M7, M7 - S7, M7 – PG/PC 
S7 – партнер в другом проекте 
(S7, PG/PC с WinCC) 

SFB: USEND, 
URCV, BSEND, 
BRCV, GET, 
PUT, START, 
STOP, RESUME, 
STATUS, 
USTATUS 

Соединение S7 с 
резервированием  

PROFIBUS,  
Industrial Ethernet 

S7(H) – S7(H), S7(H)– Станция PC 
(H) 

SFB: USEND, 
URCV, BSEND, 
BRCV, START, 
STOP, RESUME, 
STATUS, 
USTATUS 

Соединение "точка-
точка" 

«точка-точка» 
(протокол 
компьютера  
RK 512/3964(R)) 

S7 - S7, S7 - S5,  
S7 – устройство другой фирмы 
S7 – партнер в другом проекте 
(S7, устройство другой фирмы) 

SFB: BSEND, 
BRCV, GET, 
PUT, STATUS, 
PRINT 

Соединение FMS PROFIBUS 
(протокол FMS) 

S7 - S7, S7 - S5, S7 - PC/PG, S7 - 
устройство другой фирмы, S7 – 
пересылка всем абонентам 
(broadcast) 
S7 – партнер в другом проекте 
(S7, S5, PG/PC, устройство другой 
фирмы) 

FB: READ, 
WRITE, 
IDENTIFY, 
OSTATUS, 
REPORT 

Соединение FDL  
 

PROFIBUS 
(протокол FDL) 

S7 - S7, S7 - S5, S7 - PC/PG, S7 - 
устройство не Siemens, 
S7 - проект (S7, S5, PG/PC, 
устройство не.Siemens) 

FCs AG_SEND, 
AG_RECV, 
AG_LSEND,  
AG_LRECV  

Транспортное 
соединение ISO  
 
 

Industrial Ethernet
(Транспортный 
протокол ISO) 

S7 - S7, S7 - S5, S7 – партнер в 
другом PC/PG, S7 - устройство не 
Siemens, S7 - незаданное 
S7 – партнер в дугом проекте (S7, 
S5, PG/PC, устройство не 
Siemens, незаданное) 

FCs AG-SEND,  
AG-RECEIVE 
AG_LSEND,  
AG_LRECV, 
AG_LOCK, 
AG_UNLOCK; 
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Тип соединения Тип подсети Соединение между SIMATIC... SFB/FB/FC 

Соединение ISO-on-
TCP  
 

Industrial Ethernet
(протокол TCP/IP) 

S7 - S7, S7 - S5,  
S7 - PC/PG,  
S7 – устройство не Siemens,  
S7 - незаданное  
S7 - партнер  в другом проекте 
(S7, S5, PG/PC, non-Siemens 
device, незаданное) 

FCs AG-SEND,  
AG-RECEIVE 
AG_LSEND,  
AG_LRECV, 
AG_LOCK, 
AG_UNLOCK 

Cоединение TCP  Industrial Ethernet 
(протокол TCP/IP) 

S7 - S7, S7 - S5,  
S7 - PC/PG,  
S7 - устройство не.Siemens,  
S7 - незаданное  
S7 - партнер  в другом проекте 
(S7, S5, PG/PC, устройство 
не.Siemens, незаданное) 

FCs AG_SEND*, 
AG_RECV*, 
AG_LSEND**,  
AG_LRECV** 
AG_LOCK 
AG_UNLOCK 

Cоединение UDP  
 

Industrial Ethernet
(протокол TCP/IP) 

S7 - S7, S7 - S5, S7 - PG/PC, S7 - 
устройство не.Siemens, S7 - 
незаданное  
S7 – партнер  в другом проекте 
(S7, S5, PG/PC, устройство 
не.Siemens, незаданное) 

FCs AG-SEND,  
AG-RECEIVE 
AG_LSEND,  
AG_LRECV 

Cоединение E-mail  Industrial Ethernet
(протокол TCP/IP) 

S7 - незаданное (S7 – почтовый 
сервер) 

FCs AG-SEND,  
AG_LSEND 

* Функции AG_SEND и AG_RECV здесь могут использоваться только для S7-
300 (это зависит от номера версии CP, сотри документацию CP). 

** FC AG_LSEND и AG_LRECV здесь могут в общем использоваться в S7-400, 
и дополнительно в S7-300 (это зависит от номера версии CP, смотри 
документацию к CP). 

Особенность: Соединение с широковещательными (Broadcast) и 
групповыми (Multicast) партнерами  

Для специальных типов соединений имеется возможность выбирать не 
только одного партнера, но и нескольких (широковещательные посылки и 
групповые партнеры). Эти возможности описаны в руководствах по SIMATIC 
NET (NCM S7). Партнеры "all broadcast … [Ко всем широковещательным …]» 
или "… multicast nodes, ... [… групповым абонентам]» предлагаются в 
диалоговом окне для ввода нового соединения. 

• Вы можете создать соединение с "широковещательными (broadcast) 
посылками» (одновременная передача всем широковещательным 
приемникам) для соединений типа FMS, FDL и UDP. 

• Вы можете создать соединение со "всеми групповыми (multicast) 
партнерами» (одновременная передача нескольким узлам) для 
соединений типа FDL и UDP.  

 



Проектирование соединений 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
10-26 A5E00261404-01 

10.12.2 Правила создания соединений 

Выбор пути соединения при нескольких подсетях в проекте 
Если станции связаны с несколькими подсетями, то STEP 7 выбирает путь 
соединения через одну из подсетей. Этот путь STEP 7 посчитал более 
эффективным, чем другой. Последовательность, в которой STEP 7оказывает 
предпочтение: Industrial Ethernet перед Industrial Ethernet/TCP/IP перед MPI  

Пример: Две станции соединены друг с другом через MPI и Industrial Ethernet. 
STEP 7 выбирает путь через Industrial Ethernet. 

Учтите, что путь, установленный STEP 7, сохраняется и при неисправности 
подсети. Альтернативный путь через другую подсеть STEP 7 не выбирает 
(исключение: соединения S7 с резервированием). 

В случае соединения S7 путь, автоматически установленный пакетом STEP 7, 
может быть изменен пользователем в диалоговом окне для установки 
свойств соединения, напр., от MPI на PROFIBUS. 

Количество возможных соединений 
Количество возможных соединений, которые могут быть внесены в таблицу 
соединений, зависит от ресурсов выбранного модуля и контролируется  
STEP 7. 

Информация о ресурсах соединений модуля доступна в диалоговом окне 
«Module state [Состояние модуля]», закладка «Communication 
[Коммуникации]».  

10.12.3 Проектирование соединений для модулей станции SIMATIC 

Ниже показано, как создавать соединения в отображении сети для конечного 
пункта соединения (напр., CPU). 

Особенность 
STEP 7 автоматически задает для обоих конечных пунктов соединения 
локальный ID, 

• если оба коммуникационных партнера являются станциями S7-400 или  

• если один коммуникационный партнер является станцией S7-400, а другой 
– станцией SIMATIC PC 

В этом случае Вы проектируете соединение в таблице соединений только для 
одного партнера; другой коммуникационный партнер автоматически имеет 
после этого соответствующую запись в своей таблице соединений. 
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10.12.4 Ввод нового соединения 

Соединение определяет отношение связи между двумя узлами. В нем 
устанавливаются: 

• оба коммуникационных партнера 

• тип соединения (напр., S7, "точка-точка", FMS, ISO-on-TCP, FDL или 
транспортное соединение ISO) 

• специальные свойства, зависящие от типа соединения (напр., 
устанавливается ли соединение постоянно или оно динамически 
устанавливается и разъединяется в программе пользователя) 

Предпосылка 
Вы находитесь в графическом представлении сети (NetPro). 

Последовательность действий 
1. Выделите в изображении сети модуль, для которого должно быть создано 

соединение. 
Результат: В нижней части графического представления сети 
отображается таблица соединений выделенного модуля.  

2. Дважды щелкните на пустой строке таблицы соединений или выделите 
строку и выберите команду меню Insert > Connection [Вставить > 
Соединение].  

3. Выберите в диалоговом окне "New Connection [Новое соединение]» 
желаемого партнера по соединению. Помощь для выбора партнера Вы 
найдете в оперативной справке в режиме online к этому диалоговому 
окну. 

4. Определите тип соединения.  

5. Активизируйте бокс выбора "Show Properties dialog box [Показать 
диалоговое окно свойств]", если после щелчка на «OK» или "Add 
[Добавить]» Вы хотите просмотреть или изменить свойства соединения: 
Содержимое диалогового окна "Properties… [Свойства…]» зависит от 
выбранного соединения; помощь для заполнения Вы найдете в 
оперативной справке к этому диалоговому окну. 
Результат: STEP 7 вносит соединение в таблицу соединений локального 
(т. е. выделенного) абонента и назначает этому соединению локальный ID 
и, при необходимости, ID партнера, которые Вам необходимы при 
программировании коммуникационных функциональных блоков (значение 
параметра блока "ID"). 
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10.12.5 Изменение партнера 

Для уже спроектированного соединения Вы можете изменить партнера. 
Локальный ID и тип соединения при этом сохраняются.  

Предпосылка 
Вы находитесь в графическом представлении сети (NetPro) 

Последовательность действий 
1. Выделите в изображении сети модуль, для которого должно быть 

изменено соединение. 

2. Выделите в таблице соединений строку с соединением, которое Вы 
хотите изменить. 

3. Дважды щелкните на выделенной области столбца таблицы «Partner 
[Партнер]» или выберите команду меню Edit > Connection Partner 
[Редактировать > Партнер по соединению] 
Результат: Открывается диалоговое окно "Modify Connection [Изменение 
соединения]". 

4. В окне «Connection Partner [Партнер по соединению]», выберите конечную 
точку (то есть модуль в открытом проекте или в другом проект в составе 
мультипроекта). Если Вы выбрали нового партнера по соединению как 
партнера в "в неизвестном проекте", Вам будет предложено ввести имя 
для этого . соединения (ссылку). 

5. Подтвердите свой ввод щелчком на кнопке "OK". 

 
 Указания: 

Учтите, что при изменении партнера параметризованные свойства 
соединения сбрасываются на значения, устанавливаемые по умолчанию. 
Если Вы хотите изменить свойства соединения, используйте команду меню 
Edit > Object Properties [Редактировать > Свойства объекта]. 

Для соединений S7 действительно следующее: Начиная со STEP 7 версии 
V5, Вы можете изменить "неопределенного» партнера по соединению (напр. 
на станцию SIMATIC 300/400). Вы можете также изменить станцию-партнера 
SIMATIC на "неопределенного» партнера. 
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10.12.6 Резервирование соединения 

Если Вы резервируете коммуникационные ресурсы узла для последующего 
расширения своего проекта или пока не хотите указывать партнера по 
соединению, то внесите в качестве такого партнера "Unspecified 
[неопределенный]". Резервирование соединений в настоящее время 
возможно не для всех типов соединений. 

Предпосылка 
Вы находитесь в графическом представлении сети (NetPro). На экране 
отображается диалоговое окно для определения свойств соединения. 

Последовательность действий  
1. Выберите в поле «Station [Станция]» вариант "Unspecified 

[Неопределенный]".  
Результат: Содержимое поля "Module [Модуль]» деактивируется. 

2. Выберите в поле "Typ [Тип]» тип соединения. 

3. Активизируйте бокс выбора "Show Properties в диалоговом окне dialog box 
[Показать диалоговое окно свойств]", если после щелчка на «OK» или 
"Add [Добавить]» Вы хотите просмотреть или изменить свойства 
соединения. 

4. Подтвердите свой ввод щелчком на кнопке "OK". 
Результат: STEP 7 вносит соединение в таблицу соединений локального 
абонента и назначает для этого соединения локальный ID, который Вам 
нужен при программировании коммуникационных блоков. 

 
 Указание 

Примите во внимание, что для каждого соединения еще можно 
параметрировать специальные свойства. Для этого используйте команду 
меню Edit > Object Properties [Редактировать > Свойства объекта]. 
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10.12.7 Удаление одного или нескольких соединений 

Предпосылка: 
Вы находитесь в графическом представлении сети (NetPro). 

Последовательность действий 
1. Выделите соединения, которые Вы хотите удалить. 

2. Выберите команду меню Edit > Delete [Редактировать > Удалить].  
Если для этого соединения в таблицу соединений уже были внесены 
локальный ID и ID партнера, то STEP 7 удаляет также и соединение в 
таблице соединений партнера. 

14 Загрузите таблицу соединений с удаленными соединениями в 
соответствующий программируемый модуль (Чтобы удалить все 
соединения программируемого модуля, Вы должны загрузить пустую 
таблицу соединений) 

10.12.8 Копирование соединений 

Введение 
Соединения копируются не по отдельности, а всегда в контексте с проектом 
или со станцией. 

Вы можете копировать: 

• проекты целиком 

• одну или несколько станций внутри проекта или выходя за границы 
проекта  

Предпосылка 
Открыт SIMATIC Manager. 

Копирование проекта 
Когда Вы копируете проект, то вместе с ним копируются все 
спроектированные соединения. Для скопированных соединений не требуется 
настройка, так как соединения остаются непротиворечивыми. 
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Копирование станции 
Если Вы копируете одну или несколько станций в проекте или за его 
пределами, то Вы должны каждому локальному абоненту назначить нового 
партнера (изменение соединения).  

Если для некоторого соединения отсутствует партнер, то Вы узнаете это из 
таблицы соединений по тому, что строка партнера по соединению 
отображается жирно. 

Соединения между станциями, которые копируются за пределами проекта 
остаются согласованными, если соответствующие подсети между этими 
станциями копируются вместе с ними.  

10.12.9 Проектирование соединений для станции SIMATIC PC 

Вы можете сконфигурировать соединения для станций SIMATIC PC. В 
зависимости от интерфейса, имеющегося на Вашем PC (коммуникационный 
процессор, CP), Вы можете сконфигурировать соответствующие типы 
соединений.  

Если Вы хотите создать или изменить тип соединения кроме соединений S7 
(например, отказоустойчивых соединений S7), Вы должны убедиться, что 
установлен соответствующий опциональный пакет.  

Предпосылки 
Вы сконфигурировали станцию SIMATIC PC в графическом представлении 
сети со всеми конечными пунктами коммуникаций (приложения, сервер OPC, 
программные PLC или слот CPU) и коммуникационными платами РС. Кроме 
того, Вы сконфигурировали все станции, которые должны быть конечными 
коммуникационными пунктами соединений. 

Для конфигурирования соединений, Вы должны иметь в виду следующее, в 
зависимости используемых компонентов: 

• WinLC (V3.0): Эта версия не поддерживает конфигурируемых соединений . 

• Слот PLC (CPU 41x-2 PCI): Вы можете сконфигурировать соединения для 
этого CPU только для точно одного из сконфигурированных CP. 

• Приложения и серверы OPC: Пожалуйста смотрите документацию для 
используемых приложений или программных интерфейсов. 
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Как сконфигурировать соединение 
1. Выберите конечную точку соединения в станции SIMATIC PC в сетевом 

представлении, чтобы была видна таблица соединений. 

2. Дважды щелкните на пустой строке таблицы соединений или выделите 
строку и выберите команду меню Insert > Connection [Вставить > 
Соединение]. 

3. Выберите в диалоговом окне "New Connection [Новое соединение]» 
желаемого партнера для соединения. Помощь по выбору партнера Вы 
найдете в оперативной справке к этому диалоговому окну. 

4. Определите тип соединения.  
Особое свойство соединения: В отличие от станций S7 STEP 7 назначает 
не числовое значение для локального ID (идентификатора соединения), а 
имя. Это имя Вы можете изменить через свойства объекта для 
соединения. 
Кроме того, вновь созданное соединение всегда является двусторонним, 
т. е. STEP 7 автоматически вносит соединение для локальной станции в 
таблицу соединений партнера. 

5. Выберите команду меню Network > Save and Compile [Сеть > Сохранить и 
скомпилировать]. 

При компиляции генерируется конфигурационный файл для станции PC 
(файл "XDB file"). Он содержит имя станции PC, описание соединений, 
назначенные параметры и информацию подсети для коммуникационных 
карт PC. 
Вы вводите путь для файла конфигурации на закладке «Configuration 
[Конфигурация]» (свойства объекта для станции SIMATIC PC). 

6. Если станция PC сконфигурирована с использованием Station 
Configuration Editor [Редактора конфигурации станции], Вы можете 
загрузить станцию PC (смотри Загрузка станции PC).  
В другом случае продолжите с шага 7. 

7. Скопируйте конфигурационный файл в станцию PC (программируемый 
логический контроллер).  
Размещение конфигурационного файла на станции PC задается 
программой «Set PG/PC Interface [Установка интерфейса PG/PC]» 
(закладка «STEP 7 Configuration [Конфигурация STEP 7]»).  
Вы можете найти дополнительную информацию, включая установку на 
программаторе /PC в описании "SIMATIC NET, S7 Programming Interface» 
и в интерактивной справке для закладки «STEP 7 Configuration 
[Конфигурация STEP 7]»  
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10.12.10 Конфигурирование маршрутизации соединения S7 для 
станции SIMATIC PC  

Для серверов OPC (часть программного обеспечения CD SIMATIC NET PC 
начиная с версии 6.1) Вы можете сконфигурировать соединения S7 между 
станцией SIMATIC PC /SIMATIC HMI и станцией S7, которые подключены к 
различным подсетям. 

  

Предпосылки 
Обе подсети должны быть связаны через маршрутизатор, например, IE/PB 
Link. Функции маршрутизатора выполняются также станциями S7 или 
SIMATIC PC, которые подключены к обоим подсетям через CP или CPU.  

На станции  SIMATIC PC/HMI маршрутизацию должна поддерживать конечная 
точка(в настоящее время только сервер OPC).  

Партнер по соединению должен находиться  в том же проекте.  

Что делать, если могут быть сконфигурированы только односторонние 
соединения  S7  

Станции S7 могут работать только как коммуникационный сервер для 
сконфигурированных односторонних соединений S7 через подключенные 
подсети.  

В этом случае, используя NetPro для конфигурации односторонних 
соединений S7 для станции SIMATIC PC /HMI в другой подсети. Это 
обеспечивает Вам доступ к данным пользовательской программы станции S7 
из пользовательской программы станции SIMATIC PC, через функции PUT 
(доступ записи) и GET (доступ чтения). : 
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10.12.11 Программатор/PC как партнер по соединению 

Для проектирования соединений для конечного пункта на PG/PC у Вас 
имеется несколько возможностей. Выберите в графическом представлении 
сети или объект PG/PC, или станцию SIMATIC PC: 

• «SIMATIC PC Station [Станция SIMATIC PC]» для приложений 
использующих конфигурационные файлы (файлы *.xdb) для соединений 
со станцией SIMATIC S7, например:  

- Для резервированных соединений с дополнительным пакетом S7-
REDCONNECT (отказоустойчивые соединения S7) или 

- Для интерфейса SAPI-S7  

- Для сервера OPC  

Пожалуйста, проверьте информацию о продукте SIMATIC NET, чтобы 
убедиться, что конфигурация с использованием конфигурационного 
файла возможна.  

• «PG/PC» для приложений использующих файлы LDB для соединений со 
станциями SIMATIC S7 (интерфейс SAPI-S7)  

10.12.12 Соединение S7 c PG/PC 

Соединение S7 станции S7 с PG/PC возможно только тогда, когда PG/PC 
имеет программный интерфейс SAPI-S7 (программный интерфейс на языке С 
для доступа к компонентам SIMATIC S7). 
Информацию о заполнении диалогового окна Вы получите в online-помощи к 
этому диалогу. 

Для партнера по соединению "PG/PC" 
Одна из возможностей проектирования соединения состоит в создании 
локальной базы данных LDB (Lokale Datenbasis): 

1. Спроектируйте PG/PC в графическом представлении сети. 

2. Спроектируйте станцию, от которой должно идти соединение к PG/PC. 

3. Выберите при создании соединения S7 в качестве партнера "PG/PC". 

4. Выполните редактирование в диалоговом окне "Address Details 
[Подробный адрес]» (достижимо через свойства соединения). В этом 
диалоговом окне Вы должны внести имя соединения и имя VFD (virtual 
field device – виртуальное полевое устройство) для PG/PC. 
Дополнительную информацию Вы найдете в online-помощи к этому 
диалоговому окну. 

5. Дважды щелкните на спроектированном PG/PC и создайте локальную 
базу данных (LDB). 

6. Передайте базу данных в PG/PC. 

7. Загрузите соединение (-ия) в станцию 
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Для партнера по соединению "SIMATIC PC Station [Станция SIMATIC PC]" 
Для PG/PC создайте в отображении сети станцию SIMATIC PC. "Application 
[Приложение]» образует в этом типе станции конечный пункт соединения.  

10.12.13 Соединение S7 с PG/PC с WinCC  

Для партнера "Unspecified"... через " Unspecified» партнера 
Вы можете создавать соединения S7 с PG/PC с WinCC внутри проекта или с 
выходом за границы проекта. При создании соединения S7 Вы должны 
выбрать в качестве партнера "Unspecified [Неопределенный]". Специальную 
адресную информацию для WinCC введите в диалоговом окне "Address 
Details [Подробный адрес]". 

Для партнера "SIMATIC PC Station"... через станцию SIMATIC PC 
Создайте для программатора/PC в графическом представлении сети станцию 
SIMATIC PC. У этого типа станции WinCC образует конечный пункт 
соединения. 
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10.13 Проектирование соединений с партнерами в других 
проектах 

10.13.1 Типы соединений для партнеров из других проектов 

Выбор типа соединения с коммуникационными партнерами в других 
проектах  

Когда Вы устанавливаете мультипроект, Вы можете спроектировать 
межпроектные соединения . 

Типы соединений зависят от подсетей и транспортного соединения через 
который устанавливается соединение и от семейств автоматизации, которые 
являются партнерами по соединению.  

Вы можете использовать блоки (SFB, FB, или FC) в зависимости от типа 
соединения. 

Следующая таблица должна облегчить Вам выбор типа соединения для 
связи, которую Вы хотите установить. 

  
Тип соединения Тип подсети Соединения между SIMATIC ... SFB/FB/FC 

Соединение S7 MPI,  
PROFIBUS,  
Industrial Ethernet 

S7 - S7, S7 - PG/PC, 
S7 - PG/PC с WinCC 
для MPI также: M7 - M7, M7 - S7, 
M7 - PG/PC 

SFBs USEND, 
URCV, BSEND, 
BRCV, GET, 
PUT, START, 
STOP, RESUME, 
STATUS, 
USTATUS 

Соединение S7, 
отказоустойчивое  

PROFIBUS,  
Industrial Ethernet 

S7(H) - S7(H), S7(H)- Станция PC 
(H) 

SFBs USEND, 
URCV, BSEND, 
BRCV, START, 
STOP, RESUME, 
STATUS, 
USTATUS 

Соединение FDL  PROFIBUS S7 - S7, S7 - S5, S7 - PC/PG, S7 – 
устройства не Siemens, S7 – 
широковещательная со всеми 
узлами 

FBs READ, 
WRITE, 
IDENTIFY, 
OSTATUS, 
REPORT 

Транспортное 
соединение ISO 
 
 

Industrial Ethernet 
(транспортный 
протокол ISO) 

S7 - S7, S7 - S5, S7 - PC/PG, S7 – 
устройства не Siemens,  
S7 – незаданное 

FCs AG_SEND, 
AG_RECV, 
AG_LSEND,  
AG_LRECV 

Соединение  
ISO-on-TCP 
 

Industrial Ethernet 
(протокол TCP/IP) 

S7 - S7, S7 - S5,  
S7 - PC/PG,  
S7 – устройства не Siemens  
S7 – незаданное  
S7 – партнер в другом проекте 
(S7, S5, PG/PC, устройства не 
Siemens, незаданное) 

FCs AG_SEND, 
AG_RECV, 
AG_LSEND,  
AG_LRECV 
AG_LOCK 
AG_UNLOCK 
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Connection Type Subnet Type Connection Between SIMATIC ... SFB/FB/FC 

Соединение TCP  Industrial Ethernet 
(протокол TCP/IP) 

S7 - S7, S7 - S5,  
S7 - PC/PG,  
S7 - устройства не Siemens,  
S7 - незаданное  

FCs AG_SEND*, 
AG_RECV*, 
AG_LSEND**,  
AG_LRECV** 
AG_LOCK 
AG_UNLOCK 

Соединение UDP  
 

Industrial Ethernet 
(протокол TCP/IP) 

S7 - S7, S7 - S5, S7 - PC/PG, S7 – 
устройства не Siemens, S7 – 
незаданное  

FCs AG_SEND, 
AG_RECV, 
AG_LSEND,  
AG_LRECV 

* FC AG_SEND и AG_RECV здесь можно использовать только для S7-300 (это 
зависит от номера версии CP, см. документацию к CP). 

** FC AG_LSEND и AG_LRECV здесь могут обычно S7-400, и дополнительно 
для S7-300 (это зависит от номера версии CP, см. документацию к CP). 

Специальный случай: Создание широковещательных и групповых узлов  
Для специальных типов соединений есть возможность выбора не одного 
партнера по соединению, а нескольких (широковещательные и групповые 
узлы). Эта возможность описана в руководстве по SIMATIC NET (NCM S7). 
Партнеры по соединению «all broadcast nodes [все широковещательные 
узлы]» или «all multicast nodes [все групповые узлы]» появляются в 
диалоговом окне для выбора нового соединения.  

• Вы можете установить соединение с «all broadcast nodes [все 
широковещательные узлы]» (одновременная посылка ко всем 
широковещательным приемникам) для типов соединений FDL и UDP. 

• Вы можете установить соединение с «all multicast nodes [все групповые 
узлы]» (одновременная посылка к нескольким узлам) для типов 
соединений FDL и UDP. 
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10.13.2 Основная последовательность действий при 
проектировании соединений между проектами 

Конфигурирование соединений в мультипроекте 
Начиная со STEP 7 V5.2 Вы можете легко создать межпроектные соединения 
с помощью мультипроектов (смотри также раздел: “Что Вы должны знать о 
мультипроектах?”).  

Возможные партнеры в другом проекте (без мультипроекта) 
Для установления соединений с партнерами в других проектах STEP 7 
имеются 2 возможности (без мультипроекта): 

• Установление соединения с "Other Station [Иная станция]", с «PG/PC» или 
со станцией "SIMATIC S5" 

• Установление соединения с неопределенным партнером  

  
 Замечание 

Соединения с "Другими станциями", станциями "SIMATIC S5", «PG/PC» и 
"неопределенными» партнерами возможны также и внутри проекта STEP 7. С 
каким из этих партнеров можно устанавливать соединения, зависит, среди 
прочего, от типа соединения.  

Различия между двумя возможностями 
• "Other Station [Иная станция]", «PG/PC» или «SIMATIC S5-Station [Станция 

SIMATIC S5]» должны быть спроектированы Вами в качестве абонентов 
подсети в текущем проекте STEP 7. Ограничение: Для "Иных станций» и 
станций SIMATIC S5 Вы не можете проектировать соединения S7. Все 
другие типы соединений возможны. Рекомендация: Используйте эту 
возможность для подсетей PROFIBUS. 

• Для неопределенного партнера нет необходимости проектировать 
абонента подсети в текущем проекте STEP 7. С неопределенным 
партнером Вы можете устанавливать соединения S7, "точка-точка", 
транспортное соединение ISO, соединение ISO-on-TCP.  
Рекомендация: Используйте эту возможность для Industrial Ethernet. 

Особенность для соединений "точка-точка" 
В отличие от соединений S7 для проектирования соединений «точка-точка» с 
неопределенным партнером не предполагается соединение в сеть локальных 
узлов. Просто в своей реальной установке Вы должны обеспечить 
соединение коммуникационных партнеров, прежде чем Вы попытаетесь 
использовать это соединение. Вы только имеете коммуникационных 
партнеров  в сети в реальной установке до того, как Вы установили 
функционирование соединения.  
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10.13.3 Создание нового соединения с неопределенным партнером 

Соединения FMS, FDL, транспортное соединение ISO и соединение  
ISO-on-TCP 

Соединения FMS, FDL, транспортное соединение ISO и соединение  
ISO-on-TCP описаны в руководствах SIMATIC NET, NCM для PROFIBUS и 
NCM для Industrial Ethernet. 

Соединения S7  
Вы можете использовать незаданного партнера по соединению чтобы 
сконфигурировать соединения S7 с партнером  в другом проекте.  

Предпосылка 
Вы находитесь в отображении таблицы соединений (NetPro). 

Последовательность действий 
Соединение S7 или «точка-точка» с неопределенным партнером создается 
следующим образом: 

1. Выделите модуль, от которого Вы хотите провести соединение 
(локальный абонент). 

2. Дважды щелкните на пустой строке таблицы соединений или выберите 
команду меню Insert > Connection [Вставить > Соединение]. 

3. Выберите в диалоговом окне "New Connection [Новое соединение]» в 
качестве партнера "Unspecified [Неопределенный]". 

4. Установите свойства соединения: 

• Для соединений "точка-точка": Измените в диалоговом окне свойств 
соединения «точка-точка» имя партнера с "Unspecified 
[Неопределенный]» на какое-либо подходящее (имя вносится также в 
таблицу соединений). 

• Для соединений S7: Щелкните в диалоговом окне свойств на кнопке 
"Address Details [Подробный адрес]".  
В зависимости от партнера необходимы различные настройки в 
диалоговом окне "Address Details [Подробный адрес]". Информацию о 
заполнении диалогового окна Вы получите в online-помощи. 
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Диалоговое окно «Address Details [Детали адресации]» для соединений S7 с 
партнерами в других проектах 

В диалоговом окне для свойств соединения с незаданным партнером 
(диалоговое окно свойств соединения S7 и диалоговое окно детали 
адресации), Вы можете ввести или выбрать адрес (интерфейса), конечную 
точку соединения (стойка/слот), и ресурсы соединения для каждой "стороны» 
(то есть партнера по соединению). 

Пример: Рассматривается следующая конфигурация:  

Станции находятся в различных проектах. CPU как конечная точка 
соединения как центральный контроллер в обоих проектах расположен в 
стойке 0 и слоте 4. Обе станции подключены к сети PROFIBUS через CP.  

PROFIBUS

Проект 1 Проект 2

 
Следующая таблица показывает, какая дополнительная информация 
требуется при конфигурировании, чтобы разрешить создание соединения.  

 
Информация в диалоговом 
окне для незаданного 
партнера по соединению ... 

 ... для проекта 
1  

 ...для проекта  
2 

Комментарии 

Active connection setup 
[Установка активного 
соединения ] 

Да  Нет В диалоговом окне свойства 
соединения S7  

Address (interface) Local/Partner  
[Адрес (интерфейс) локального 
партнера] 

Локально: 2 
Партнер: 3 

Локально: 3 
Партнер: 2 

В диалоговом окне: свойства 
соединения S7, под 
Connection Path; адреса 
должны перекрестно 
сочетаться. 

Rack/slot [Стойка/Слот] Локально: 0/4 
Партнер: 0/4 

Локально: 0/4 
Партнер: 0/4 

В диалоговом окне: “Address 
Details [Детали адреса]»  

Connection resource (hex) 
(Local/Partner)  
[Ресурсы соединений (hex) 
(Локально/Партнер)] 

Локально: 10 
Партнер: 11 

Локально: 11 
Партнер: 10 

В диалоговом окне: Address 
Details [Детали адреса];  
Ресурсы соединения нельзя 
назначить дважды и должны 
“перекрестно” сочетаться.  

TSAP (Transport Service Access 
Point) [Точка доступа 
транспортного сервиса] 

отображение 
(нельзя 
изменить) 

отображение 
(нельзя 
изменить) 

В диалоговом окне: Address 
Details [Детали адреса]; 
Для внутристанционной  
адресации интерфейса, 
посредством исполнения 
соединения (состоит из 
деталей адреса)  
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10.13.4 Создание соединения с 'иной станцией', 'PG/PC', 'SIMATIC 
S5' 

Предпосылка 
Вы создали в двух проектах полную конфигурацию сети. 

Станции, которые были сконфигурированы в одном проекте, в другой проект 
вставлены как "Other Station [Иная станция]". 

Открыто графическое представление сети (NetPro). 

Последовательность действий 
Последовательность действий такая же, как и при создании соединений с 
партнером (PG/PC, "Other Station [Иная станция]» и SIMATIC S5) внутри 
проекта. 

10.14 Сохранение соединений 

10.14.1 Сохранение соединений 

NetPro сохраняет соединения (команда меню Network > Save [Сеть > 
Сохранить]) неявно со всеми данными сетей и станций, которые имеют 
значение для функционирования сетевой конфигурации. Для более 
детальной информации справьтесь в разделе "Сохранение и загрузка 
сетевых конфигураций и проверка согласованности ". 
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11 Проектирование связи через 
глобальные данные 

11.1 Обзор: связь через глобальные данные 

Введение 
Связь через глобальные данные (GD-связь) – это простой способ связи, 
встроенный в операционную систему CPU S7-300/S7-400. 

GD-связь дает возможность циклического обмена данными между CPU через 
интерфейс MPI. Циклический обмен данными имеет место с обычным 
отображением процесса. 

Связь через глобальные данные конфигурируется с помощью STEP 7; 
передача глобальных данных – это системная функция, поэтому она не 
программируется. 

В следующих разделах объясняется, как с помощью технических данных, 
заданных для каждого CPU (количество GD-контуров, величина и количество 
GD-пакетов и т. д.), можно оценить объемы данных, которыми можно 
обмениваться между CPU методом "GD-связи". 

Кроме того, приводятся: 

• условия передачи и приема, которые следует принять во внимание 

• формулы для приблизительной оценки времени реакции 

Что такое глобальные данные? 
Глобальные данные в том смысле, как они используются для GD-связи, - это 
следующие области операндов CPU: 

• входы, выходы (из отображения процесса!)  

• меркеры 

• области из блоков данных 

• таймеры, счетчики (не рекомендуется, так как эти значения у получателя 
не долго остаются актуальными; могут проектироваться только как 
области операндов для передачи!) 

Периферийные области (PI и PQ) и локальные данные не могут быть 
использованы для связи через глобальные данные. 
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Метод передачи данных 
Связь через глобальные данные функционирует по методу 
"широковещательной» передачи (Broadcast), т. е. прием глобальных данных 
не квитируется! Передатчик не получает никакой информации о том, получил 
ли посланные глобальные данные какой-нибудь приемник и, если получил, то 
какой именно. Если процесс требует надежной передачи данных, то 
используйте другой способ, напр., S7-функции. 

Подсети для связи через глобальные данные 
GD-связь возможна  

• или только через подсеть MPI (между различными станциями)  

• или только через заднюю шину (напр., между CPU S7 в одной стойке при 
использовании мультипроцессорного режима) 

Как область операндов становится областью передачи/приема? 
Области операндов, участвующие в связи через глобальные данные, 
конфигурируются с помощью STEP 7 таблице глобальных данных (GD-
таблице): 

• каждый столбец соответствует ровно одному CPU, т. е. столбцы 
представляют участвующие в обмене данными CPU (не более 15 CPU)  

• каждая строка (точнее: каждое редактируемое поле строки) представляет 
области операндов, через которые ровно один CPU передает, а один или 
несколько CPU принимают. 

После того, как Вы таблицу заполнили, скомпилировали и загрузили в 
участвующие в обмене CPU, эти CPU ведут циклическую передачу и прием 
через эти области операндов в контрольной точке цикла (т. е. в момент 
времени, когда имеет место актуализация отображения процесса). 

Особенность: У S7-400 спроектированные глобальные данные могут также 
передаваться под управлением событий через SFC 60 (GD_SND) и 
приниматься через SFC 61  (GD_RCV). 
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11.2 Определение производительности коммуникаций 
исходя из ресурсов GD 

11.2.1 Определение производительности коммуникаций исходя из  
ресурсов GD  

Определить, насколько велика производительность CPU S7 относительно 
GD-связи, Вы можете с помощью следующих технических данных ("GD-
ресурсов"): 

• количество GD-контуров (в которых может участвовать CPU) 

• макс. количество сетевых данных на GD-пакет 

• макс. количество принимаемых GD-пакетов на GD-контур 

• длина согласованных данных на пакет  

Остальные документированные GD-ресурсы одинаковы для всех CPU и 
поэтому не играют никакой роли при выборе CPU. 

Вышеназванные технические данные дают косвенную информацию о том, 
каким количеством данных могут циклически обмениваться между собой 
CPU, связанные друг с другом через подсеть MPI или через заднюю шину S7-
400. Сколько посылаемых данных может быть "пристегнуто» к GD-пакету и 
сколько GD-контуров для этого используется, показано в следующих 
разделах. 

Совет 
Если Вы хотите передавать небольшое количество данных (порядка 
нескольких байт) между небольшим количеством CPU, то просто внесите 
области операндов в таблицу глобальных данных и скомпилируйте таблицу. 

STEP 7 пакетирует данные и автоматически распределяет ресурсы. В целом 
"потребляемые» ресурсы (GD-контуры и GD-пакеты) Вы можете прочитать 
после компиляции в первом столбце (GD Identifier [Идентификатор GD]) 
таблицы глобальных данных. 

Ниже в общих чертах описывается принцип, в соответствии с которым 
используются GD-пакеты и GD-контуры. 
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11.2.2 Необходимое количество GD-пакетов 

GD-пакет – это кадр данных, который посылается ровно от одного CPU 
одному или нескольким CPU "за один прием". 

GD-пакет содержит максимум следующее количество нетто-данных (см. 
также технические данные CPU): 

• макс. 22 байта для S7-300 

• макс. 54 байта для S7-400 

Пример 1 
Вы хотите полностью исчерпать область передаваемых данных CPU S7-300 
для передачи из блока данных. Для принимающего CPU должна быть 
использована область меркеров. 

В качестве области для передачи внесите в таблицу глобальных данных для 
CPU S7-300: 

• DB8.DBB0:22 (т. е. область из 22 байтов данных в DB8, начиная с байта 
данных 0) 

В качестве области для приема другого CPU (всегда должна быть такой же 
величины, как и область для передачи) внесите в таблицу глобальных 
данных: 

• MW100:11 (т. е. 11 меркерных слов, начиная с MW 100) 

Правила 
• Если Вы хотите передавать данные более чем из одной области 

операндов, то для каждой дополнительно используемой области 
операндов Вы должны вычесть два байта из максимального количества 
нетто-данных. 

• Битовый операнд (напр., M 4.1) ”потребляет” один байт нетто-данных в 
GD-пакете. 

Пример 2 
Вы хотите передавать из блока данных и из отображения процесса на 
выходах. GD-пакет может иметь в этом случае величину только 20 байтов. 

В качестве областей для передачи внесите в таблицу глобальных данных для 
CPU S7-300: 

• DB8.DBB0:10 (т. е. область из 10 байтов данных в DB8, начиная с байта 
данных 0) 

• QW0:10 (т. е. область из 10 выходных слов, начиная с QW0) 

Области для приема других CPU вносите аналогично первому примеру; 
ширина области приема должна быть идентична ширине области передачи. 
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11.2.3 Необходимое количество GD-контуров 

Что такое GD-контур? 
Все CPU, участвующие в обмене общим пакетом данных в качестве 
передатчика или приемника, образуют GD-контур. 

  

CPU 1 CPU 2 CPU 3

GD-пакет GD-контур
 

Пример преобразования в таблицу глобальных данных (после 
компиляции): 

  
GD Identifier  
[Идентификатор GD] 

CPU 1 CPU 2 CPU 3 

GD 1.1.1 > MW0 IW0 IW0 

  

Пояснение к таблице глобальных данных: 

 ”>” означает передатчик 

Структура идентификатора  GD
GD 1.1.1

Текущ. № для области операндов
в GD-пакете

Номер GD-пакета

Номер GD-контура
  



Проектирование связи через глобальные данные 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
11-6 A5E00261404-01 

Когда требуется еще один GD-контур (случай 1) 
Если необходимо передать и принять больше данных, чем "входит» в один 
GD-пакет, то требуется дополнительный GD-контур. 

  

CPU 1 CPU 2 CPU 3

GD-пакеты
(сумма нетто-данных > 22 байт у S7-300, > 54 байт у S7-400)

  

Пример преобразования в таблицу глобальных данных (после 
компиляции): 

  
GD Identifier [Идентификатор GD] CPU 300 

(1) 
CPU 300 (2) CPU 300 (3) 

GD 1.1.1 >MW0:10 IW0:10 IW0:10 
GD 2.1.1 > MW100:4 IW30:4 IW20:4 

 

Когда требуется еще один GD-контур (случай 2) 
Дополнительный GD-контур нужен также и в том случае, если передающие и 
принимающие CPU не одни и те же (тогда должен быть "привязан» новый 
GD-пакет).  

CPU 1 CPU 2 CPU 3 CPU 4

GD-пакеты
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Пример преобразования в таблицу глобальных данных (после 
компиляции): 

  
GD Identifier 
[Идентификатор GD] 

CPU 300 (1) CPU 300 (2) CPU 300 (3) CPU 300 (4) 

GD 1.1.1 > MW0 IW0 IW0  
GD 2.1.1 > MW100:4 IW30:4 IW20:4 IW30:4 

Совет 
При определенных обстоятельствах может оказаться целесообразным 
определить CPU в качестве приемника GD-пакета, хотя этот пакет для 
данного CPU не нужен (как в вышеприведенном примере CPU 4). Если 
передающие и принимающие CPU одни и те же, то таким способом можно 
сократить количество GD-контуров, например, для передающего CPU. В 
вышеприведенном примере CPU 1, 2 и 3 в этом случае образовали бы только 
один GD-контур, так как оба GD-пакета были бы объединены в один пакет. 

Максимальное число GD-контуров  
число GD-контуров ограничено 16. CPU которые имеют число контуров GD 
больше чем 16 нельзя загрузить из конфигурации глобальных данных. 
Однако, STEP 7 не предотвращает сохранение и компиляцию таблицы GD с 
большим числом контуров GD. 

11.2.4 Исключения при расчете GD- контуров 

При определенных условиях баланс выглядит более благоприятно (т. е. 
требуется меньшее количество GD-контуров): 

Для S7-300: 
Если CPU S7-300 ("передающий CPU") посылает точно одному другому CPU 
S7-300 ("принимающий CPU") один GD-пакет, и этот принимающий CPU, в 
свою очередь, возвращает GD-пакет передающему CPU, то используется 
только один GD-контур. 

Это свойство отражает содержащееся в технических данных требование 
"макс. количество принимаемых GD-пакетов на GD-контур = 1". 

В следующем примере Вы увидите из идентификатора GD (номер GD-
пакета!), что используется только один GD-контур. 

Пример (таблица глобальных данных после компиляции): 
  

GD Identifier [Идентификатор GD] CPU 300 (1) CPU 300 (2) 

GD 1.1.1 > MW100 IW2 
GD 1.2.1 IW4:3 >MW10:3 
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Для S7-400: 
Если пакетами обмениваются не более 3 CPU, и каждый из 3 CPU посылает 
каждому из двух остальных CPU только один GD-пакет, то тоже используется 
только один GD-контур. 

Это свойство отражает содержащееся в технических данных требование 
"макс. количество принимаемых GD-пакетов на GD-контур = 2". 

В следующем примере Вы увидите из идентификатора GD (номер GD-
пакета), что используется только один GD-контур 

Пример (таблица глобальных данных после компиляции): 
  

GD Identifier 
[Идентифи-
катор GD] 

CPU 400 (1) CPU 400 (2) CPU 400 (3) 

GD 1.1.1 > MW0 IW0 IW0 
GD 1.2.1 IW2 IW2 > MW0 
GD 1.3.1 IW0 > MW0 IW2 
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11.3 Условия передачи и приема 

11.3.1 Условия передачи и приема 

С помощью коэффициента редукции Вы можете для каждого CPU, 
участвующего в обмене GD-пакетами, определить следующее: 

• через сколько циклов посылается GD-пакет (только для CPU, помеченного 
как передатчик) 

• через сколько циклов принимается GD-пакет 

Особый случай: Коэффициент редукции «0» означает, что GD-пакет 
передается под управлением событий (т. е. не циклически) (возможно только 
для S7-400 с использованием SFC 60/SFC 61). 

Пример: 
Коэффициент редукции 20, установленный для GD-пакета в передающем 
CPU, означает, что этот CPU передает GD-пакет в точке контроля цикла 
через каждые 20 циклов. 

Коэффициент редукции 8, установленный для GD-пакета в принимающем 
CPU, означает, что этот CPU принимает GD-пакет в точке контроля цикла 
через каждые 8 циклов (точнее: вводит принятый GD-пакет в область 
операндов). 

Коэффициент редукции у передатчика 
Вам следует соблюдать следующие условия, чтобы сохранять на низком 
уровне коммуникационную нагрузку CPU: 

CPU S7-300: коэффициент редукции × время цикла >= 60 мс  

CPU S7-400: коэффициент редукции × время цикла >= 10 мс 

Коэффициент редукции у приемника 
Чтобы воспрепятствовать потере GD-пакетов, они должны приниматься 
чаще, чем передаются. 

Чтобы это гарантировать, должно выполняться следующее: 

Коэффициент редукции (приемник) × время цикла (приемник) < Коэффициент 
редукции (передатчик) × время цикла (передатчик).  
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11.3.2 Соотношения между коэффициентом редукции и временем 
цикла  

Обоснованный коэффициент редукции 
Обоснованный коэффициент редукции для передачи, а также для приема  
может быть 0 или величина от 1 до 255. Помните, что слишком маленький 
коэффициент редукции перегружает CPU. 

Рекомендация: Примите установленный по умолчанию коэффициент 
редукции или убедитесь, что произведение коэффициента редукции на время 
цикла  больше 0.5 с. При более высоких требованиях к связи следует 
использовать другие механизмы связи, например соединения через 
PROFIBUS-DP. 

Коэффициент редукции 0 обозначает запускаемую событиями передачу с 
использованием в пользовательской программе системных функций (SFC) 
(возможно не для всех CPU). 

Если Вы не ввели коэффициент редукции, используется значение по 
умолчанию. 

Пример для коэффициента редукции 
Произведение время цикла x коэффициент редукции дает временной 
интервал глобального обмена данными.  

Допущение: Программа пользователя в CPU 412 имеет время цикла около 50 
мс. По умолчанию коэффициент редукции 22.  

50 мс x 22 = 1100 мс 

Глобальные данные посылаются или принимаются этим CPU каждые 1.1 с.  

Если время цикла в пользовательской программе возрастет, например, до 80 
мс, глобальные данные будут посылаться или приниматься каждые 80 мс x 
22 = 1760 мс. 

Чтобы снова получить величину 1100 мс, следует пересчитать коэффициент 
редукции.  

Коэффициент редукции (новый) = 1100 мс/80 мс = 13.75 

Таким образом, из-за увеличения времени цикла, следует установить 
коэффициент редукции, равным 14, чтобы сохранить временной интервал. 
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11.4 Время реакции 

Вы можете приблизительно рассчитать время реакции для двух станций, 
которые обмениваются GD-пакетами через подсеть MPI.. 

Предпосылка для расчета времени реакции 
• скорость передачи 187,5 Кбит/с  

• никаких других коммуникаций через MPI (напр., через подключенные 
PG/OP) 

Расчет 
Время реакции = коэффициент редукции (передатчик) × время цикла 
(передатчик)+ коэффициент редукции (приемник) × время цикла (приемник) + 
количество абонентов MPI × 10 мс 

При более высоких скоростях передачи коэффициент "× 10 мс» будет 
меньше; однако, уменьшается он не линейно с ростом скорости передачи. 

Совет 
Так как время реакции сильно зависит от времени цикла и прочей 
коммуникационной загрузки через MPI, требуется эмпирическое определение 
времени реакции и, в случае необходимости, подгонка коэффициента 
редукции в вашей установке.  

Ввод коэффициентов редукции  

Соотношения между коэффициентом редукции и временем цикла 
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11.5 Конфигурирование и сохранение GD-связи 

11.5.1 Последовательность действий при конфигурировании  
GD- связи 

Предпосылка 
Вы сконфигурировали подсеть MPI со всеми необходимыми станциями. 

Обзор: Последовательность действий 
  

Открытие GD-таблицы

Заполнение GD-таблицы

Первая компиляция GD-таблицы

Ввод строк состояния и коэффициента
редукции (не обязательно)

Вторая компиляция GD-таблицы

Загрузка GD-таблицы
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11.5.2 Открытие таблицы глобальных данных 

Имеются две возможности для открытия таблицы глобальных данных: 

• открытие таблицы глобальных данных для всей подсети 

• открытие таблицы глобальных данных для одного CPU  

Открытие таблицы глобальных данных для подсети (рекомендуется!) 
• Выделите в SIMATIC Manager подсеть MPI и выберите команду меню 

Options > Define Global Data [Возможности > Определение 
глобальных данных].  
Результат: Появляется таблица глобальных данных для выбранной 
подсети. 

Открытие таблицы глобальных данных для одного CPU  
Следующий вариант открытия таблицы глобальных данных рекомендуется 
тогда, когда Вы хотите прочитать эту таблицу из CPU, напр., при поиске 
неисправностей и обслуживании. 

1. Выберите команду меню GD-Table > Open > Global Data for CPU 
[Таблица глобальных данных > Открыть > Глобальные данные для 
CPU]. Появляется диалоговое окно ”Open [Открыть]”, в котором Вы 
можете выбрать проект и станцию, в которой находится желаемый CPU. 

2. Выберите одну из следующих опций: 

"Online", чтобы читать данные непосредственно из CPU, или 

"Offline", чтобы получить системные данные CPU из проекта в режиме 
offline. 

3. Выберите проект и откройте двойным щелчком станцию, в которой 
находится желаемый CPU. 

4. Выделите объект "Blocks [Блоки]» того CPU, для которого Вы хотите 
отобразить таблицу глобальных данных. 

5. Подтвердите свой выбор щелчком на кнопке ”OK”.  
Результат: Появляется таблица глобальных данных, в заголовке которой 
приведены все CPU, принимающие участие в GD-связи. Эта таблица 
содержит, однако, значения только для выбранного CPU.  

Чтобы заполнить пустые поля таблицы глобальных данных, Вы должны ее 
обновить. 

• Выберите команду меню View > Update [Вид > Обновить]. Выведенная 
таблица глобальных данных теперь отображается полностью. 
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11.5.3 Советы по работе с таблицами глобальных данных 

Вставка строк для глобальных данных 
• Выберите команду меню Insert > GD Row [Вставить > Строка 

глобальных данных].  

Удаление строк для глобальных данных 
• Выделите строку и выберите Edit > Delete [Редактировать > Удалить]. 

Вставка столбцов для CPU 
• Выберите команду меню Insert > CPU Column [Вставить > Столбец 

CPU].  

Удаление столбцов для CPU 
• Выделите столбец и выберите Edit > Delete [Редактировать > Удалить]. 

Замечание по удалению столбцов CPU 
Когда Вы удаляете столбец CPU из таблицы глобальных данных, то 
удаляются и соответствующие системные данные CPU (offline). Учтите, что 
для удаленного столбца CPU Вы должны также удалить и данные online в 
CPU. 

Предпосылка: PG связан с CPU через интерфейс MPI, и CPU находится в 
состоянии STOP. 

Используйте команду меню GD Table > Delete Global Data for CPU… 
[Таблица глобальных данных > Удалить глобальные данные для CPU…] 
и выберите в последующем диалоговом окне опцию "ONLINE". Выделите 
папку "Blocks [Блоки]» и подтвердите свои действия щелчком на "ОК". 

Изменение ширины столбца 
Ширина отдельного столбца CPU может быть изменена. Вы можете также 
уменьшать столбец до тех пор, пока он станет невидим. 

• Поместите указатель мыши в заголовке таблицы на правом краю поля 
CPU, держите нажатой левую клавишу мыши и перемещайте край столбца 
в желаемом направлении. 
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11.5.4 Заполнение таблицы глобальных данных 

Предпосылка 
В таблице глобальных данных выключено отображение коэффициента 
редукции и состояния глобальных данных. 

Ввод CPU в заголовок таблицы  
1. Щелкните в таблице глобальных данных на столбце в ее заголовке. 

После этого выбранный столбец будет выделен. 

2. Выберите команду меню Edit > Assign CPU [Редактировать > CPU]. 
После этого отображается диалоговое окно "Open [Открыть]". Вы можете 
открыть это диалоговое окно, также щелкнув на заголовке столбца. 

3. Выберите свой текущий проект и откройте двойным щелчком станцию, в 
которой находится желаемый CPU. 

4. Выделите этот CPU и подтвердите свой выбор щелчком на кнопке ”OK”.  
Результат: В заголовке таблицы отображается имя выбранного CPU. 

Ввод данных в GD-строки 
Предпосылка: Вы ввели участвующие CPU в заголовок таблицы (см. выше). 

1. Поместите курсор в поле таблицы и введите желаемый операнд. Вы 
можете вводить только абсолютные операнды (напр., IW0); символьный 
ввод невозможен. 
Совет: Непрерывно расположенные операнды, относящиеся к одному 
типу данных, требуют только одного ввода в таблицу глобальных данных. 
В этом случае вставьте после операнда двоеточие, а затем коэффициент 
повторения. Коэффициент повторения определяет размер области 
данных.  
Пример: IW4: 3 означает: 3 слова, начиная с IW4. 

2. Чтобы перейти из режима замены в режим вставки, нажмите клавишу F2. 

3. Редактируйте таблицу, как обычно. Для этого Вы можете использовать 
также команды меню Edit > Cut [Редактировать > Вырезать], Edit > Copy 
[Редактировать > Копировать] или Edit > Paste [Редактировать > 
Вставить]. 

4. Завершайте ввод нажатием клавиши RETURN. 

  
 Замечание 

Используйте в GD-контуре или только коммуникационную шину (т. е. внутри 
станции S7-400), или только подсеть MPI (вне станции). Смешанное 
функционирование невозможно! 



Проектирование связи через глобальные данные 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
11-16 A5E00261404-01 

Определение ячейки как передатчика или приемника 
Каждая строка глобальных данных содержит ровно один передатчик и один 
или несколько приемников. Передатчик помечается знаком ">". Все поля 
строки глобальных данных по умолчанию устанавливаются как поля 
приемника. 

• Чтобы пометить поле данных в качестве передатчика, выделите поле и 
выберите команду меню Edit > Sender [Редактировать > Передатчик]. 

Чтобы пометить поле данных в качестве приемника, выделите поле и 
выберите команду меню Edit > Receiver [Редактировать > Приемник]. 

  
 Указание 

Поля, в которых указывается таймер или счетчик, могут использоваться 
только как передатчики. 

11.5.5 Сохранение и первая компиляция таблицы глобальных 
данных 

Сохранение 
При сохранении данные, введенные в вашу таблицу глобальных данных, 
помещаются в исходный файл.  

• Выберите команду меню GD Table > Save [Таблица глобальных данных 
> Сохранить].  

Или: 

1. Выберите команду меню GD Table > Save as [Таблица глобальных данных 
> Сохранить как…] 

2. Перейдите в проект, в котором Вы хотите сохранить таблицу глобальных 
данных. 

3. Подтвердите щелчком на "OK". 

  
 Замечание 

Чтобы сохранить изменения, выполненные Вами в таблице глобальных 
данных, также и в системных данных, Вы должны таблицу скомпилировать 

Непосредственно после компиляции данные автоматически сохраняются в 
системных данных, относящихся к соответствующему CPU. 

Непротиворечивость между системными данными и исходным файлом 
гарантируется только тогда, когда каждое изменение в таблице глобальных 
данных сохраняется как в источнике (Save [Сохранить]), так и в системных 
данных (Compile [Компилировать]). 
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Компиляция 
Данные, введенные Вами в таблицу глобальных данных, должны быть 
переведены на язык, понятный для CPU. 

В результате из наглядной таблицы глобальных данных появляются 
системные данные, которые могут обрабатываться CPU.  

Для каждого столбца CPU при компиляции создаются именно те системные 
данные, которые требуются для коммуникации соответствующих CPU. По 
этой причине для каждого CPU имеется собственная конфигурация 
глобальных данных. 

• Щелкните на соответствующем символе в строке функций или выберите 
команду меню GD Table > Compile [Таблица глобальных данных > 
Компилировать]. Таблица глобальных данных теперь компилируется в 
соответствии с фазой 1. 
Результат: STEP 7 проверяет  

- те ли CPU указаны в заголовках столбцов CPU 

- синтаксис операндов, введенных Вами в поля  

- величину области данных для передатчика и приемника (области 
данных для передатчика и приемника должны быть одинаковой 
величины) 

- чтобы глобальные данные одной строки обменивались только через 
К-шину или подсеть MPI. Смешанное функционирование невозможно. 

После первой успешной компиляции таблица глобальных данных находится в 
фазе 1. В этой фазе Вы можете редактировать в таблице глобальных данных 
строки состояния и коэффициенты редукции. 
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11.5.6 Ввод коэффициентов редукции 

Введение 
Обмен глобальными данными происходит следующим образом: 

• Передающий CPU посылает глобальные данные в конце цикла. 

• Принимающий CPU читает эти данные в начале цикла. 

С помощью коэффициента редукции Вы можете установить, через сколько 
циклов должна происходить передача или прием данных. 

Последовательность действий 
1. Скомпилируйте таблицу глобальных данных, если она еще не находится 

в фазе 1 (это видно из записи в строке состояния на нижнем краю экрана). 

2. Если в таблице глобальных данных еще не отображаются коэффициенты 
редукции, выберите команду меню View > Scan Rates [Вид > 
Коэффициенты редукции]. 

3. Внесите желаемые коэффициенты редукции. Вы можете вводить данные 
только в тех столбцах, в которых соответствующий GD-пакет имеет 
записи. 
Замечание: Если Вы выводите на экран строки состояния и/или строки 
коэффициентов редукции, то Вы можете редактировать только эти строки 
и никакие другие. 

4. Скомпилируйте таблицу глобальных данных снова (фаза 2). 

Соотношения между коэффициентом редукции и временем цикла  

11.5.7 Ввод строк состояния 

Введение 
Для каждого GD-пакета Вы можете определить по одному двойному слову 
состояния на каждый участвующий в обмене CPU. Двойные слова состояния 
имеют в таблице идентификатор "GDS". Если Вы поставите слово состояния 
(GDS) в соответствие операнду CPU такого же формата, то Вы сможете 
анализировать состояние в программе пользователя или в строке состояния 
(GDS). 

Общее состояние 
STEP 7 создает для всех GD-пакетов общее состояние (GST). 

Общее состояние, тоже представляющее собой двойное слово такой же 
структуры, как и двойное слово состояния (GDS), появляется в результате 
выполнения поразрядного логического ИЛИ над всеми двойными словами 
состояния. 
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Последовательность действий 
1 Скомпилируйте таблицу глобальных данных, если она еще не находится 

в фазе 1 (это видно из записи в строке состояния на нижнем краю экрана). 

2 Если в таблице глобальных данных еще не отображаются строки 
состояния глобальных данных, выберите команду меню View > GD Status 
[Вид > Состояние глобальных данных]. 

3 Внесите в таблицу желаемое двойное слово состояния. Ввод можно 
выполнять только в столбцах, в которых соответствующий GD-пакет 
имеет записи. При вводе операндов придерживайтесь синтаксиса языков 
программирования STEP 7. 
Замечание: Если Вы выводите на экран строки состояния и/или строки 
коэффициентов редукции, то Вы можете редактировать только эти строки 
и никакие другие. 

4 Скомпилируйте таблицу глобальных данных снова (фаза 2). 

Структура двойного слова состояния 
На рисунке показана структура двойного слова состояния и значение 
установленных битов. 

Бит остается установленным до тех пор, пока он не будет сброшен 
программой пользователя или через PG.  

Непоказанные биты зарезервированы и в настоящее время не имеют 
значения. Состояние глобальных данных занимает двойное слово; для 
облегчения понимания на рисунке изображено MD 120.  

Ошибка длины
области в
передатчике

DB в передатчике
отсутствует

GD-пакет потерян

Синтаксическая ошибка в GD-
пакете

GD-объект отсутствует в GD-пакете

Длины GD-объектов в передатчике и
приемнике различны

Ошибка длины области в приемнике

DB в приемнике отсутствует

Передатчик выполняет новый/повторный пускПриемник получил новые данные

7 6 5 4 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0
MB 120 MB 121 MB 123MB 122

MD 120
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11.5.8 Вторая компиляция таблицы глобальных данных 

После редактирования строк состояния и коэффициентов редукции Вы 
компилируете таблицу глобальных данных снова, чтобы дополнительная 
информация попала в системные данные. 

Системные данные, созданные в фазе 1, достаточны для текущей GD-связи. 
Они могут быть загружены в CPU из устройства программирования. Фаза 2 
требуется только тогда, когда Вы хотите изменить значения по умолчанию, 
установленные для коэффициентов редукции, или выполнить ввод в строки 
состояния. 

Загрузка конфигурации глобальных данных  

11.6 Передача глобальных данных с помощью 
системных функций 

11.6.1 Передача глобальных данных с помощью системных 
функций 

Для центральных модулей S7-400 возможна также передача данных под 
управлением событий. Момент времени, в который производится обмен 
данными, определяется вызовом в программе пользователя системных 
функций (SFC). Для передачи глобальных данных в Вашем распоряжении 
имеется SFC 60 "GD_SND» (global data send = передача глобальных данных), 
а для приема - SFC 61 "GD_RCV» (global data receive = прием глобальных 
данных). Если передача данных должна происходить только под 
управлением событий, то в таблице глобальных данных Вы должны 
установить коэффициент редукции равным 0. Если внесено значение, 
большее 0, то глобальные данные передаются как циклически, так и под 
управлением событий. 
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12 Загрузка и выгрузка 

12.1 Загрузка конфигурации в программируемый 
контроллер 

Совет 
Перед загрузкой, используйте команду меню Station > Check Consistency 
[Станция > Проверить согласованность], чтобы убедиться, что в 
конфигурации станции нет ошибок. STEP 7 при этом проверяет могут ли 
создаться загружаемые системные данные из представленной конфигурации. 
Все ошибки, найденные при проверке согласованности, отображаются в окне.  

Предпосылки для загрузки 
• Программатор (PG) подключен к CPU через интерфейс MPI с помощью 

кабеля MPI.  

• В сетевой системе (программатор подключен к подсети): 
Все модули в подсети должны иметь разные сетевые адреса и 
действительная конфигурация должна соответствовать созданной Вами 
конфигурации. 

• Представленная конфигурация должна соответствовать реальной 
структуре станции. 
Конфигурация может быть загружена в станцию только при 
согласованности и отсутствии ошибок. Только в этом случае могут быть 
созданы системные блоки данных (SDB), которые в свою очередь 
загружаются в модули. 

• Если структура станции содержит модули, которые сконфигурированы и 
параметризованы с использованием дополнительных пакетов: 
дополнительные пакеты должны иметь авторизацию. 
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Последовательность действий 
• Выберите команду меню PLC > Download To Module [ПЛК > Загрузить в 

модуль]. 
STEP 7 ведет Вас к результату посредством диалоговых окон. 

Конфигурация для всего программируемого контроллера загружается в CPU. 
Параметры CPU непосредственно становятся активными. Параметры других 
модулей передаются в модули в процессе запуска. 

  
 Указание 

Частные конфигурации, например, конфигурации отдельных стоек, не могут 
быть загружены в станцию. В целях согласованности, STEP 7 всегда 
загружает в станцию полную конфигурацию. 

Изменение рабочего режима CPU при загрузке 
Когда Вы вызываете команду  PLC > Download [ПЛК > Загрузить], Вы 
можете выполнить с помощью программатора следующие действия, 
руководствуясь диалоговыми окнами:  

• Переключите CPU в STOP 
(если переключатель режимов установлен в RUN-P или подключение CPU 
защищено паролем) 

• Выполните сжатие памяти 
(если недостаточно непрерывной свободной памяти) 

• Снова переключите CPU в RUN 

Загрузка конфигурации в программируемый контроллер  

Загрузка конфигурации глобальных данных 

12.2 Первоначальная загрузка сетевой конфигурации 

Перед первой загрузкой модули, подключенные к сети, еще не имеют 
сконфигурированных узловых адресов, но имеют адреса по умолчанию. 
Чтобы Ваша сеть работала правильно, все узлы сети должны иметь 
различные сетевые адреса. 

• Подсеть MPI с соединением через CPU 
CPU поставляются с предустановленным адресом 2. Однако Вы можете 
использовать этот адрес в подсети только однократно, поэтому Вы 
должны изменить предустановленный адрес у всех других CPU. 

• Подсети PROFIBUS и Industrial Ethernet с CP 
CP станций, которые работают через эти подсети должны быть 
сконфигурированы и снабжены сетевым адресом. Например, Вы должны 
присвоить адрес CP, используя MPI, до того как Вы сможете загружать и 
работать через эти подсети (Вы можете найти больше информации 
руководствах SIMATIC NET и SIMATIC NCM).  
Существуют также CP Industrial Ethernet например, CP 443-1EX11) с 
предустановленным адресом MAC. Эти модули поддерживают прямую 
загрузку начальной конфигурации через Industrial Ethernet. Они не 
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нуждаются в инициализации через MPI. Все функции PG можно выполнить 
через Ethernet. 

Если сетевой узел не станция S7... 
Если сетевой узел не станция S7, свойства сети и узла должны быть 
назначены с использованием инструментария или переключателей 
предназначенных для этой цели. Это имеет место, например, в случае 
ведомых DP, на которых адрес PROFIBUS устанавливается 
переключателями. 

Убедитесь, что эти настройки настройкам объекта в сетевом представлении 
(PG/PC, Иная станция, Станция S5). 

Изменение адресов PROFIBUS на ведомых DP  
Ведомые DP, подключенные к подсети PROFIBUS, также должны иметь 
уникальный адрес PROFIBUS. Если ведомый DP, которого Вы хотите 
подключить, поддерживает функцию "Set_Slave_Add» (например, ET 200C), 
Вы можете установить адрес через STEP 7: 

В SIMATIC Manager и Configuring Hardware Вы можете назначить новый адрес 
PROFIBUS используя команду меню PLC Address [ПЛК > PROFIBUS > 
Назначить адрес PROFIBUS]. 

Совет: Если Вы не полностью определили текущую адресацию, Вы должны 
подключать ведомых DP к PG/PC по одному и переадресовать их. 

Изменение узловых адресов станций S7  
Для изменения предустановленных узловых адресов станций S7, действуйте 
так:  

1. Сконфигурируйте станцию; задайте сетевой адрес подключаемого модуля 
(например, CPU) на закладке «General [Общее]» кнопка «Properties 
[Свойства]» в поле "Interface [Интерфейс]". 

2. Переключите модуль в STOP и подключите программатор к интерфейсу 
модуля соединительным кабелем. 

3. Определите предустановленный сетевой адрес подключенного модуля 
(используя, например, в SIMATIC Manager команду меню PLC > Display 
Accessible Nodes [ПЛК > Показать доступные адреса]). 

4. Загрузите конфигурацию с новыми сетевыми адресами в 
программируемый контроллер (то есть, в подключенный модуль):  

- В представлении станции (Configuring Hardware) используя команду 
меню PLC > Download [ПЛК > Загрузить].  

- В сетевом представлении (NetPro) выберите станцию, которую Вы 
хотите загрузить, и выберите команду меню PLC > Download > In The 
Current Project >Selected Stations [ПЛК  Загрузить > В текущий 
проект]. Введите "старый» (пока еще действующий) 
предустановленный адрес.  
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12.3 Загрузка сетевой конфигурации в 
программируемый контроллер   

Предпосылка 
Здесь мы допускаем, что проект в целом уже сконфигурирован, то есть мы 
имеем: 

• Все станции сконфигурированы 

• Все подсети созданы и их свойства заданы  

• Соединения сконфигурированы (если требуется) 

• Интерфейс PG/PC установлен и коммуникация между PG/PC и 
программируемым контроллером возможна через подключенную подсеть. 

• Конфигурация проверена на согласованность 

Только в том случае, если конфигурация не имеет ошибок, значит когда все 
сетевые модули подсети имеют уникальные сетевые адреса, и когда 
действительная конфигурация соответствует созданной сетевой 
конфигурации, Вы можете загрузить конфигурацию в программируемые 
контроллеры через подсеть (PROFIBUS или MPI). 

12.4 Загрузка в станцию PC  

Начиная со STEP 7 V5.1, Service Pack 2, Вы можете полностью загружать 
станцию PC – также, как станции S7-300 или S7-400.  

Предпосылки 
• Чтобы STEP 7 полностью загрузил станцию PC, Вы должны 

сконфигурировать станцию PC как целевую систему через Component 
Configurator (Component Configurator - часть CD SIMATIC NET начиная с 
7/2001). Здесь компонентам PC назначается индекс. Эта процедура 
соответствуют вставке модулей в станцию S7-300/400.  
Как только Вы введете свою конфигурацию в станцию PC, Вы сможете 
использовать мастера (wizard) SIMATIC NCM PC, чтобы сохранить ее как 
проект для последующего использования в STEP 7 (например, Вы можете 
копировать их, перетаскивая в проект STEP 7 и конфигурируя затем 
соединения с другими станциями).  

• Станция PC должна быть доступна online: либо STEP 7 установлен на 
станции PC или станция PC доступна для создаваемой системы (PG/PC со 
STEP 7) через подсеть и соответствующие интерфейсы (CP или 
встроенные интерфейсы.  
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Загрузка при конфигурировании сети  
Вы можете выполнить все функции загрузки при конфигурации сети в STEP 7 
(например, Download > Selected and Partner Station, ... Subnet Stations 
[Загрузка >Выделенная и партнерские станции, … Станции подсети] и 
т.д..). Порядок действий тот же, что и при загрузке станций S7-300/400.  

Системные и конфигурационные файлы (файлы *.XDB) сгенерированы, когда 
компилировалась и сохранялась конфигурация SIMATIC PC. Однако, Вам не 
нужен этот файл конфигурации, когда Вы передаете конфигурацию 
коммуникации в станцию PC.  

Информация маршрутизации для Слот PLC и программного PLC (WinLC) 
автоматически загружается в станцию PC, если она представляет сетевой 
интерфейс.  

Прежде, загрузка в станцию PC была возможна только через встроенные 
интерфейсы Слот PLC или через индекс CP (слот) 9.  

Загрузка при выборе конфигурации аппаратуры  
Имейте в виду следующее, особенно когда Вы загружаете аппаратную 
конфигурацию:  

Индекс (строка) 125 в конфигурационной таблице станции PC содержит 
фиксированную запись 'Station Manager'. Station Manager представляет, на 
стороне проекта (STEP 7), конфигурацию в целом станции SIMATIC PC.  

Со стороны целевой системы (станция PC), функции компонента времени 
исполнения SIMATIC NCM интерпретируют загружаемые конфигурационные 
данные (SDB). Компонент времени исполнения создается Component 
Configurator [Конфигуратор компонента] (на CD SIMATIC NET начиная с 
7/2001). В этом случае станция PC может сравнить загружаемую 
конфигурацию с реальной и, например, в случае ошибки выдать сообщение о 
различиях между реальной конфигурацией и конфигурацией по умолчанию.  

12.5 Загрузка изменений сетевой конфигурации  

Предпосылки 
Все сетевые модули в подсети должны иметь уникальные сетевые адреса и 
реальная конфигурация должна соответствовать созданной сетевой 
конфигурации. 

Если Вы подключаете новую станцию к подсети и предустановленный 
сетевой адрес уже представлен в подсети, Вы должны действовать так, как 
описано в "Первоначальная загрузка сетевой конфигурации" 
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Что загружается? 
После компиляции сетевой конфигурации (команда меню Network > Save and 
Compile [Сеть >Сохранить и скомпилировать]) или после PLC > Download 
[ПЛК >Загрузить> ...] NetPro создает системные блоки данных (SDB) для 
модулей, которые могут интерпретировать информацию в SDB. SDB могут 
содержать таблицу соединений, адреса узлов, свойства подсети, адреса 
входов и выходов и параметры модулей. 

В зависимости от выбранной для загрузки команды меню, в различные 
системы программируемых логических контроллеров загружается различная 
информация. 

  
 Указание 

Если CPU включен в режим RUN-P, Вы можете загружать только используя 
вариант PLC > Download > Connections and Gateways [ПЛК >Загрузить> 
Соединения и шлюзы]. Для всех других вариантов CPU должен быть 
переключен в STOP.  

В CPU S7-300 соединения можно загрузить только при CPU в режиме STOP. 

  
Команда меню PLC > 
Download > 

Что загружается? Куда? 

... Selected Station(s)  
[…Выбранные станции] 

Таблицы соединений, 
адреса узлов, свойства 
подсетей, адреса входов и 
выходов, параметры 
модулей для выбранной 
станции  

В выбранные станции 

... Selected and Partner 
Stations 
[…Выбранные и 
партнерские станции] 

Таблицы соединений, 
адреса узлов, свойства 
подсетей, адреса входов и 
выходов, параметры 
модулей для выбранной 
станции и партнеров по 
соединениям выбранной 
станции 

В выбранные станции и все 
станции, которые являются 
партнерами выбранных 
станций по соединениям  

... Stations on Subnet 
[…Станции в подсети] 
 

Таблицы соединений, 
адреса узлов, свойства 
подсетей, адреса входов и 
выходов, параметры 
модулей  

Одна за другой во все 
станции выделенной 
подсети  

... Selected Connections 
[…Выбранные 
соединения] 
 

Выбранные соединения 
(возможно множественное 
выделение) 

В локальную станцию и (для 
двухсторонних соединений) 
в соответствующую 
партнерскую станцию  

... Connections and 
Network Gateways 
[…Соединения и 
сетевые шлюзы] 

Соединения (возможно и 
пустая таблица 
соединений) и информация 
сетевых шлюзов  

В выбранные модули  
(возможен режим RUN-P) 
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Последовательность действий 
1. Подключите устройство программирования к подсети, узлы которой Вы 

хотите загрузить. 

2. Откройте NetPro. 

3. Выберите в сетевом представлении станцию, которую Вы хотите 
загрузить или подсеть (для PLC > Download > Stations on Subnet [ПЛК > 
Загрузить > Станции в подсети]). 

4. Выберите один из приведенных выше вариантов для команды меню PLC 
> Download [ПЛК > Загрузить]. 

Дополнительная информация 
Дополнительная информация по командам меню, относящимся к загрузке 
можно найти в контекстной помощи (Выберите команду меню и нажмите F1).  

12.6 Загрузка конфигурации глобальных данных 

Во время компиляции данные таблицы глобальных данных преобразуются в 
системные данные. Если во время компиляции ошибки не возникают, Вы 
можете передавать системные данные в CPU: 

• Выберите команду меню PLC > Download [ПЛК > Загрузить]. 

Максимальное число циклов GD  
Число циклов GD ограничено 16. CPU, которые имеют число циклов GD 
больше 16, не могут быть загружены из конфигурации глобальных данных. 

12.7 Выгрузка конфигурации из станции 

Предпосылка 
Вы используете кабель MPI для подключения программатора (PG) к 
интерфейсу MPI CPU. 

Советы 
Выгрузка станции в новый пустой проект. 

Станции, которые определенным способом зависят от других станций 
(интеллектуальный ведомый и ведущий DP, приемник и передатчик в 
конфигурации с прямым обменом данных /связь через побочные 
коммуникации) должны всегда выгружаться вместе в один проект. Причина: 
Без партнера для станции этого типа, проект будет несогласованным. 
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Последовательность действий 
1. Выберите команду меню PLC > Upload [ПЛК > Выгрузить]. 

2. Возникает диалоговое окно для конфигурации. 

3. Выберите проект, в котором должна храниться позднее конфигурация и 
подтвердите, нажав "OK." 

4. В появившемся диалоговом окне, установите адрес узла, номер стойки, и 
слот, в котором расположен модуль который должен читать 
конфигурацию (обычно CPU). Подтвердите, нажав "OK." 

Вы можете использовать команду меню Station > Properties [Станция > 
Свойства] для назначения имени станции в этой конфигурации и затем 
сохранить это в проекте по умолчанию (команда меню Station > Save 
[Станция > Сохранить]). 

12.8 Выгрузка сетевой конфигурации 

Обзор 
Вы имеете возможность выгрузить реальную структуру сети в Ваш проект на 
программаторе станция за станцией. 

Во первых Вы можете выгрузить в программатор полную конфигурацию 
проекта станция за станцией в SIMATIC Manager (команда меню PLC > 
Upload [ПЛК > Выгрузить]). При этом STEP 7 создает в текущем проекте 
новую станцию для каждой выгружаемой станции.  

В другом варианте Вы можете выгрузить конфигурацию станции при 
конфигурировании аппаратуры (команда меню PLC > Upload [ПЛК > 
Выгрузить]). 

Ниже описано как Вы можете выгрузить полную сетевую конфигурацию 
станция за станцией в NetPro. 

Предпосылки 
PG/PC подключен к той же подсети, что и станции, которые Вы хотите 
выгрузить, или станции должны быть доступны через сетевые шлюзы. 
Сетевые адреса и стойки/слоты подключаемых к подсети модулей должны 
быть известны. 

Последовательность действий 
1. Подключите программатор к подсети, узлы которой Вы хотите выгрузить. 

2. Создайте новый проект для выгруженной сетевой конфигурации, если 
необходимо. 

3. Откройте NetPro через проект, в котором Вы хотите сохранить 
выгруженную сетевую конфигурацию на следующем шаге (например, 
через вновь созданный проект).  
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4. Выберите команду меню PLC > Upload Station [ПЛК > Выгрузить 
станцию]. 
Команда меню может быть выбрана, только когда открыт проект. 

5. В следующем диалоговом окне, определите станцию, которую Вы хотите 
выгрузить, задав адрес узла и стойку/слот. 
В сетевом представлении возникает объект «Station [Станция]» со всеми 
модулями, подключенными к сети. Отображается и подсеть, к которой 
подключена станция.  Вы можете изменить имя станции, назначенное 
системой, используя команду меню Edit > Object Properties 
[Редактировать > Свойства объекта]. 
Сконфигурированные соединения также выгружаются и видимы, когда Вы 
выбираете модуль, который является конечной точкой соединений.  

6. Вы можете изменить конфигурацию или соединений, а также загрузить 
изменения в станцию. Для соединений, которые созданы с 
использованием дополнительных пакетов, дополнительные пакеты 
должны быть установлены чтобы отредактировать и снова загрузить эти 
связи.  

7. Выполните описанное Выше пока Вы не выгрузите все требуемые 
станции.  

8. Если требуется, Вы можете сохранить сетевую конфигурацию в текущем 
проекте (команда меню Network > Save [Сеть > Сохранить] или Network 
> Save and Compile [Сеть > Сохранить и скомпилировать]). 

Особенности выгрузки соединений в программатор  
В таблице соединений, партнер по соединению сконфигурированный offline 
пропадает – партнер по соединению "unspecified [незаданный]». Однако, 
детали адреса доступны в диалоговом окне, которое следует за диалоговым 
окном свойств. 

Направление коммуникаций для соединений PTP не могут быть определены 
STEP 7 в каждом случае; но сообщение информирует Вас, какие направления 
коммуникаций возможны.  

Если оба партнера по соединению выгружены в программатор (PG), STEP 7 
затем попытается восстановить связи между этими партнерами. 
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13 Проекты, редактируемые несколькими 
пользователями  

13.1 Многопользовательская конфигурация в сети 

Обзор 
В STEP 7 Вы можете работать в многопользовательской конфигурации в 
рабочей группе Windows 2000/XP и сети NT/2000 Server/Novell. Вы можете 
или работать в мультипроекте или применить одну из следующих 
конфигураций: 

• Проект находится на локальном диске и может также использоваться 
другой рабочей станции. 
 
Пример: Рабочие станции 1 и 2 имеют доступ к проекту A на рабочей 
станции 1. 

• Проект расположен на сетевом сервере. 
 
Пример: Рабочие станции 1 и 2 имеют доступ к проекту C не сетевом 
сервере. 

• Проекты распределены по локальным дискам и одному или более 
сетевым серверам. 
 
Пример: Рабочие станции 1 и 2 имеют доступ к проектам A, B и C. 

  

Проект C

Сервер Windows NT

STEP 7
рабочая станция 1

Проект A Проект B

STEP 7
Сеть PC

рабочая станция 2

  



Проекты, редактируемые несколькими пользователями 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
13-2 A5E00261404-01 

Принципы хранения проекта на сетевом сервере 
• Начиная с версии 5.2 Вы можете использовать спецификацию UNC, когда 

Вы храните Ваши проекты на сетевом сервере, то есть больше не 
требуется назначать путь проекта к диску. 

• Когда Вы храните Ваши проекты на сетевом сервере или на разрешенных 
дисках других сетевых пользователей, операционная система Windows 
может выключить этот сервер или сетевой узел только тогда, когда все 
приложения STEP 7, имеющие доступ к проекту, закрыты. 

• Если Вы храните Ваши проекты на сетевом сервере или на разделяемых 
дисках других сетевых станций, убедитесь STEP 7 установлен на сетевом 
сервере или на сетевом компьютере. 

Принципы многопользовательского редактирования программ S7  
Вы должны помнить следующее: 

• Прежде чем более чем один пользователь сможет работать на одной S7 
программе, Вы должны установить конфигурацию рабочей станции 
(команда меню Start > Simatic > STEP 7 > Configure SIMATIC Workspace 
[Старт >  Simatic > STEP 7 > Конфигурировать рабочее пространство 
SIMATIC]). Смотрите соответствующую помощь в диалоговом окне.  

• Блоки и исходные файлы STL: 
Каждый пользователь должен программировать различные блоки или 
исходные файлы. Если два пользователя пытаются редактировать блок 
или исходный файл одновременно, отображается сообщение и доступ 
второго пользователя запрещен. 

• Таблица символов: 
Различные пользователи могут открыть таблицу символов одновременно, 
но только один пользователь может ее редактировать. Если два 
пользователя пытаются редактировать таблицу символов одновременно, 
отображается сообщение и доступ второго пользователя запрещен. 

• Таблицы переменных: 
Различные пользователи могут открыть таблицу переменных 
одновременно, но только один пользователь может ее редактировать. 
Если два пользователя пытаются редактировать таблицу переменных 
одновременно, отображается сообщение и доступ второго пользователя 
запрещен. Может быть ряд таблиц переменных в одной S7 программе. 
Они могут, конечно, редактироваться отдельно и независимо одна от 
другой. 

• Основные принципы многопользовательского редактирования станций 

Вы должны заметить следующее: 

Конфигурация оборудования и конфигурация сети должны редактироваться 
только централизованно одним пользователем  
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13.1.1 Установка конфигурации рабочей станции 

Чтобы работать над одним проектом с различных STEP 7 рабочих станций, 
Вы должны выполнить следующие установки на каждой рабочей станции.  

1. В стартовой панели Windows  выберите команду меню Start > Simatic > 
STEP 7 > Configure SIMATIC Workstation (Старт / Simatic / Step 7 / 
Конфигурировать рабочую станцию SIMATIC). 

Выберите опцию "Multi-terminal system” (Многотерминальная система) и 
сетевой протокол, который Вы хотите использовать. 

13.2 Конфигурация с одним узлом для несетевых 
рабочих станций  

13.2.1 Слияние нескольких S7 программ в одну 

STEP 7 не предлагает поддержку слияния S7 программ на несетевых рабочих 
станциях. Единственный способ соединить S7 программы в этом случае – 
копировать отдельные блоки или файлы источников. Разделяемые данные 
проекта, такие, как таблица символов или таблица переменных должны 
редактироваться вручную после копирования. 

1. Копируйте блоки и файлы источников в их соответственные папки в S7 
программе. 

2. Экспортируйте таблицы символов отдельных S7 программ в ASCII 
формат и импортируйте их в таблицу символов общей S7 программы. 

3. Проверьте, будут ли символы использоваться более чем один раз. 
 
Совет: Также Вы можете интегрировать короткие таблицы символов, 
используя буфер обмена (копирование и вставка). 

4. Копируйте таблицы переменных, которые Вы хотите использовать или 
интегрируйте различные таблицы переменных, используя буфер обмена 
(копирование и вставка), в новую таблицу переменных. 
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13.2.2 Копирование программ S7 с атрибутами сообщений  

Если Вам надо назначить атрибуты сообщения  блокам, учтите следующие 
ограничения, когда Вы копируете S7 программы: 

Назначение номеров сообщений для проектов 
Номера сообщений могут пересекаться. Чтобы избежать конфликта: 

• Используйте команду меню Edit > Special Object Properties > Message 
Numbers [Редактировать>Свойства специального объекта>Номера 
сообщений], чтобы выделить фиксированный диапазон номеров 
сообщений для каждой S7 программы.  

• Когда Вы копируете S7 программы, убедитесь, что они не перекрывают 
другие S7 программы. 

• Заметьте, что только шаблоны сообщений (FB) могут программироваться 
отдельно от S7 программы.  

Назначение номеров сообщений CPU  
• Программы могут копироваться из проекта в межпроектные соединения 

без изменения номера сообщений. 

• Номер сообщения изменится, когда Вы копируете одиночные блоки. 
Теперь необходимо перекомпилировать  блок с тем, чтобы изменить 
номер сообщения в программе. 

Копирование программы с назначением номеров сообщений проекту в 
проекте с назначением номеров сообщений CPU 

• Чтобы копировать программу, номера сообщений которой были назначены 
проекту в другой проект, который содержит программу, номера сообщений 
которой были назначены CPU, выберите нужную программу, вызовите 
команду меню File > Save As... [Файл > Сохранить как] и сделайте 
доступным "Reorganize» [Перестроить] в выпадающем диалоговом окне. 

• Свойства сообщения назначаются по умолчанию при копировании. 
Несогласованные назначения отображаются в выпадающем диалоговом 
окне. В этом окне Вы можете выбрать свое назначение. 
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Копирование программы с назначением номеров сообщений CPU в проекте 
с назначением номеров сообщений в проект 

Вы можете копировать только простые FB с сообщениями. 

  
 Предупреждение 

Назначение номеров сообщений n программе проекта должно быть  
единообразным. 

Когда Вы копируете блок типа сообщения, который содержит перекрестные 
ссылки на библиотеку текстов в другую программу, Вы должны включить 
соответствующие библиотеки текстов, или создать другую библиотеку 
текстов с тем же именем, или модифицировать перекрестные ссылки в тексте 
сообщения. 
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14 Работа с проектами в мультипроекте 

14.1 Что надо знать о мультипроектах? 

Что такое мультипроект?  
Термин мультипроект указывает на папку, содержащую все проекты и 
библиотеки для одного решения задачи автоматизации с одним или 
отдельными проектами STEP 7, а также возможно с библиотеками. Проекты 
мультипроекта могут содержать объекты, связанные с другими объектами  
(например, межпроектные соединения S7).  

Какие преимущества дает мультипроект? 
Проекты как часть мультипроекта могут быть разделены на более мелкие 
объекты,  более простые и обозримые. 

Вы можете, например, использовать мультипроект для создания проектов 
различными авторами и назначения для редактирования в offline каждому 
автору своих станций. 

Возможность связывания с другими проектами позволяет Вам разрабатывать 
мультипроект почти также как единый проект.  

Пример межпроектных функций 
Межпроектные функции STEP 7 (Стандартный пакет): 

• Сохранить как… (сохранение мультипроекта со всеми проектами в другом 
месте) 

• Архивирование (мультипроекта со всеми проектами) 

• Согласование межпроектной сети (например, слияние подсетей) 

• Обновление видов (все проекты мультипроекта) 

Дополнительные функции мультипроекта (с PCS 7, BATCH flexible) 

• Передача данных соединения AS-OS  

• Экспорт системных данных BATCH  
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Структура проекта без мультипроекта 
В обычной структуре проекта без мультипроекта доступ ко всем объектам 
централизован, например, чтобы обеспечить передачу данных соединения 
AS-OS. 

 

Станция PC 1 Станция PC 2

AS 1

Проект STEP 7

Конфигурация сетей и соединений

AS 3
AS 2 AS 4

DX

DX = Прямой обмен данных
 



 Работа с проектами в мультипроекте 

Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
A5E00261404-01 14-3 

Структура проекта в мультипроекте 
Проекты STEP 7 могут редактироваться с распределенным хранением и 
могут поэтому обеспечивать доступ различным авторам.  

Межпроектные функции позволяют пользователю разделить проекты 
мультипроекта на меньшие объекты, которые существенно проще и 
обозримее.  

Вы можете сконфигурировать для проекта одну или несколько отдельных 
систем автоматизации. 

  

Станция PC 1 Станция PC 2

AS 1

Мультипроект

Computer\Share\Path\STEP7 Project 1
Computer\Share\Path\STEP7 Project 2

STEP 7 Проект 3STEP 7 Проект 2

STEP 7 Project 1

STEP 7-Проект 4

Синхронизация сетей и
соединений

AS 3
AS 2 AS 4

DX

DX = Прямой обмен данных
(Перекрестный обмен)  
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14.2 Мультипроект – требования и рекомендации 

Различные методы работы с мультипроектами 
Мультипроекты позволяют Вам конфигурировать гибкие системы. На 
переднем плане сокращение сроков, параллельное создание проектов 
которые можно слить в систему.  

В сущности, Вы должны отличать два основных метода работы:  

• Отдельные участники группы пользователей разделяют мультипроект в 
сетевом окружении. Проекты мультипроекта хранятся в различных 
сетевых папках.  

- В этом случае все коммуникационные партнеры доступны online для 
конфигурации, например, соединений.  

- Только выполнение межпроектных функций сети требует 
согласования между партнерами, поскольку доступ для чтения и 
записи к проектам не разрешается, пока эти функции активны.  

• Администратор проекта управляет мультипроектом через базу данных 
мастера, определяя структуру проектов (локально, если требуется), 
управляя распределенными транзакциями внешних авторов, передавая   
поступающие проекты в мультипроект, согласовывает межпроектные 
данные через системные функции (синхронизация обновления файлов) и 
выполнение необходимых межпроектных функций.  

- В этом случае, например, Вы можете объявите имена соединений, 
поскольку при согласовании проектов соединения S7 с идентичными 
именами могут легко объединиться.  

- Пользователь может также комбинировать эти два метода работы. 
STEP 7 поддерживает распределение проектов через сети, например, 
простую вставку и удаление проектов из мультипроекта, независимо 
от используемого метода.  

Основные требования 
Предварительные условия для распространения проектов в другие сетевые 
папки: 

• Проекты должны храниться в папках с атрибутом чтение/запись. Это, в 
частности, подразумевает:  

- До создания мультипроекта должен быть предоставлен доступ для 
записи и чтения к дискам, на которых хранится мультипроект или 
проекты. 

- Имена версий должны быть уникальными в сети. Мы рекомендуем 
Вам выбирать имена версий, которые содержат имя компьютера и 
имя диска (например, PC52_D).  

- Права доступа и имена версий не должны изменяться для любых 
ресурсов (папок) участвующих в мультипроекте. Причина: когда 
проект вставляется в мультипроект, STEP 7 создает ссылку на 
расположение этого проекта. Эта ссылка определяется правами 
доступа, а именем версии соответствующих ресурсов.  
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- Проект может обнаруживаться только по имени версии, которое 
присваивается, когда он реализуется в мультипроекте.  

- Следует отвергнуть доступ ко всей иерархии дисков. Права доступа к 
папке могут предоставляться только одному уровню иерархии.  

Только один уровень разрешен одновременно!

Не может быть разрешено дополнительных папок более
высокого или низкого уровня

  
• На компьютерах, которые содержат папки проекта должен быть 

установлен STEP 7 или PCS 7. Причина: STEP 7 или PCS 7 
предусматривают функции базы данных сервера для доступа к проектам  .  

• Когда Вы реализуете проекты для которых Вы сконфигурировали 
сообщения в мультипроекте, помните следующее: 

- При назначении номеров сообщений для проекта, диапазоны номеров 
сообщений для различных CPU не должны перекрываться. Если Вы 
вставляете в мультипроект различные подпроекты с назначенными в 
них номерами сообщений, не выполняется автоматической проверки 
повторяемости номеров сообщений. Вы должны самостоятельно 
проверить и убедиться, что номера сообщений используются только 
однократно. 

Предпосылки для межпроектного функционирования 
Инициализируя межпроектные функции как совокупность, Вы должны 
убедиться, что:  

• Все компьютеры, содержащие проекты или мультипроект должны быть 
доступны online по сети во все время разработки проектов.  

• Разработка проектов, невозможна, пока выполняются межпроектные 
функции,  

Если это не может быть гарантировано, мы рекомендуем передать все 
проекты на один PG/PC, и затем выполнять межпроектные функции локально.  

Несколько пользователей редактируют один объект: 

Станция должна в один момент времени редактироваться только одним  
автором (не только для мультипроекта).  

Если Вы разделяете проект на проекты, которые содержат только одну 
станцию, Вы можете быть уверены, что только один автор получает доступ 
одновременно.  
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Рекомендации и правила для размера проекта  
Вообще говоря, не существует способа определить, сколько станций может 
содержаться в проекте. Тем не менее, есть несколько моментов, которые 
могут помочь Вам принять решение:  

• Чем сложнее станции, тем меньше станций должно быть в проекте.  

• Число проектировщиков системы является также критерием для 
распределения заданий. Каждый автор должен работать в параллельном 
проекте мультипроекта независимо от других. Вы должны оптимизировать 
размер каждого из проектов, с тем, чтобы обеспечить одновременное 
завершение всех проектов.  

• Станции, соединенные через прямой обмен ("перекрестный обмен 
данных") должны располагаться в одном проекте. Помните, что Вы не 
можете сконфигурировать прямой обмен данных через границы проекта.  

• Станции, которые участвуют в глобальном обмене данными через подсеть 
MPI, также должны находиться в одном проекте.  

• Станции, которые Вы хотите включить в Вашу сетевую визуализацию 
(NetPro), также должны располагаться в одном проекте.  

• Для ввода в эксплуатацию важно: Функции загрузки, доступные в NetPro, 
не зависят от межпроектного эффекта, но действуют только внутри. 
Поврежденными оказываются функции:  

- Download in the Current Project > Selected and Partner Stations 
[Загрузка в текущий проект > Выбранные и партнерские станции] 

- Download in the Current Project > Stations on the Subnet [Загрузка в 
текущий проект > Станции в подсети] 

- Download in the Current Project > Selected Connections[Загрузка в 
текущий проект > Выбранные связи] 

• Операции компиляции и сохранения также ограничиваются текущим 
активным проектом.  

Если соединения S7 -  межпроектные, например, сетевая конфигурация 
обоих частных проектов, должна скомпилирована.  
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14.3 Работа с мультипроектами 

Создание нового мультипроекта 
1. Выберите команду меню File > New [Файл > Новый]. 

2. В поле "Name [Имя]» диалогового окна "New [Новый]", назначьте имя 
мультипроекта и выберите тип "Multiproject [Мультипроект]".  
Нажмите "Find [Найти]» или отредактируйте путь, определяющий место 
хранения мультипроекта.  
 
Пример: 

  
3. Подтвердите настройки, нажав «OK».  

Замечания к определению пути 
По возможности Вы должны использовать соглашения UNC для определения 
пути. Это позволяет Вам обрабатывать проекты STEP 7 гибко и с учетом 
последующий изменений.  

Пример: Путь, определенный в Windows 2000 с учетом UNC:  

Путь UNC: \\Computer\Share\Path  
\\ двойная обратная наклонная (<Alt> <9><2>) 

Компьютер Имя сервера: макс. длина строки  = 15 символов 
Имя компьютера, который предоставляет ресурс (Файл, каталог, ..). 

Совместное 
использование 

Имя релиза: Под Windows доступ к ресурсам других Windows компью-
теров возможен только если предоставлены соответствующие права.

Путь Это дополнительная установка. 

Создание нового проекта в мультипроекте 
Когда Вы создаете новый проект, Вы может также связать новый проект с 
текущим мультипроектом на том же шаге.  

Мультипроект, для вставки нового проекта должен быть уже открыт.  

1. Выберите команду меню File > New [Файл > Новый]. 

2. В поле "Name [Имя]»  диалогового окна "New [Новый]» назначьте имя 
проекту и выберите тип "Project [Проект]".  
Активируйте бокс выбора "Insert project in current Multiproject [Вставьте 
проект в текущий мультипроект]".  
Нажмите кнопку "Browse [Браузер]»  чтобы определить путь к месту 
хранения проекта. Если Вы работаете в компьютерной сети, Вы можете 
сохранить файл проекта на сетевом диске, чтобы обеспечить доступ 
другим участникам проекта.  

3. Подтвердите настройки, нажав «OK». 

В качестве альтернативы Вы можете использовать команду меню File > 
Multiproject > Create in Multiproject [Файл > Мультипроект > Создать в 
мультипроекте] для генерации мультипроекта в текущем мультипроекте.  
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Как перенести проект из мультипроекта  
Для удаленной работы (например, для внешних авторов) Вы можете перенес-
ти проекты из мультипроекта и вставить их вторично после редактирования.  

Когда Вы перемещаете проект, взаимосвязи с другими проектами остаются 
(например, межпроектные соединения) и проекты остаются пригодными для 
компиляции.  

1. Выберите проект(ы), которые Вы хотите перенести из мультипроекта.  

2. Выберите команду меню File > Multiproject > Remove From Multiproject 
[Файл > Мультипроект > Перенести из мультипроекта]  

Теперь Вы можете сохранить проект на носителе информации посредством 
"Save As [Сохранить как ]» и передать его внешнему автору.  

Совет 
Другой способ подготовки проектов к внешнему редактированию:  

Создайте копию проекта для внешнего автора командой File > Save As [Файл 
> Сохранить как ] и сохраняйте эту «необрабатываемую» копию в мульти-
проекте, например, чтобы Вы все еще могли отлаживать межпроектные 
функции.  

Затем, после того как внешний проект будет завершен, Вы можете вызвать 
команду меню File > Add to Multiproject [Файл > Добавить к 
мультипроекту] и заменить оригинал отредактированным проектом.  

В этом случае, Вы должны убедиться, что редактируется только копия 
проекта, а не копия и оригинальный проект вместе!  

Как добавить проекты в мультипроект 
Любой созданный проект может быть добавлен в мультипроект. Для этой 
процедуры не уместно, когда рассматриваемый объект либо предварительно 
был перемещен, либо это «третья сторона», либо когда добавляется новый 
проект.  

1. Откройте мультипроект 

2. Выберите команду меню File > Multiproject > Add to Multiproject [Файл > 
Мультипроект > Добавить к мультипроекту] 

3. В следующем диалоге выберите проект, который Вы хотите добавить.  

4. Подтвердите настройки, нажав «OK».  

Теперь Вы можете вызвать мастера "Adjusting Projects in a Multiproject 
[Согласование проектов в мультипроекте]» для объединения межпроектных 
сетей и согласования конфигурации соединений.  
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 Указание 
SIMATIC Manager обозначает открытый проект, являющийся частью 
мультипроекта, подсвеченной серым открытой иконкой мультипроекта: 

  

Согласование проектов в мультипроекте 
Мастер "Adjusting Projects in a Multiproject [Согласование проектов в мульти-
проекте]» позволяет объединить подсети и согласовать межпроектные 
соединения.  

Запустите этого мастера в SIMATIC Manager командой меню File > 
Multiproject > Adjust Projects [Файл > Мультипроект > Согласовать 
проекты]. 

Согласование выполняется автоматически (насколько возможно) и шаг за 
шагом. Мастер регистрирует все несоответствия. Откройте NetPro для 
отладки ошибок, которые могли произойти.  

Копирование мультипроекта  ("Save As [Сохранить как ]") 
Независимо от того, были или нет проекты мультипроектов распределены по 
сети: всякий раз, когда Вы копируете мультипроект (используя для сохране-
ния мультипроекта команду меню File > Save As [Файл > Сохранить как ]), 
все объекты мультипроекта, то есть действительно мультипроект и все его 
проекты будут сохранены в этом месте. Здесь невозможно распределить 
проекты по нескольким различным целевым папкам!  

Копирование проекта в мультипроект ("Save As [Сохранить как]") 
В зависимости от текущего размещения в SIMATIC Manager, Вы имеете 
различные дополнительные возможности для копирования проекта, который 
является частью мультипроекта:  

Случай 1: Открыт мультипроект, в котором выделен проект: 

1. Выберите команду меню File > Save As [Файл > Сохранить как].  

2. В появившемся диалоговом окне, выберите из следующих возможностей: 

- "Add to multiproject [Добавить к мультипроекту]":  
По умолчанию копия вставляется в текущий мультипроект. Вы можете 
также вставить проект в другой мультипроект, выбранный из списка.  
Если этот вариант не выбран, то копия сохраняется как обычный 
проект не относящийся к мультипроекту. Оригинальный проект 
остается в мультипроекте.  

- "Replace current project [Заменить текущий проект]":  
Копия вставляется в текущий мультипроект. Оригинальный проект 
удаляется из мультипроекта и остается в базе данных STEP 7 как 
обычный проект, не относящийся к мультипроекту. 



Работа с проектами в мультипроекте 

 Конфигурирование аппаратуры и коммуникационных соединений STEP 7 V5.3 
14-10 A5E00261404-01 

3. Покиньте диалог, нажав «OK».  

Случай 2: Проект в мультипроекте отрыт:  

1. Выберите команду меню File > Save As [Файл > Сохранить как]. 

2. В появившемся диалоговом окне, выберите следующие настройки: 

- "Add to multiproject [Добавить к мультипроекту]": 
По умолчанию, копия вставляется в первый мультипроект из списка 
мультипроектов. Вы можете также вставить проект в другой мульти-
проект, выбранный из списка. Если этот вариант не выбран, копия 
сохраняется в обычном проекте не имеющем отношения к мультипро-
екту. Оригинальный проект остается в мультипроекте. Вариант 
"Replace current project [Заменить текущий проект]» не доступен. 

3. Покиньте диалог, нажав "OK". 

Копирование проектов мультипроекта в MMC 
Вы можете архивировать мультипроект со всеми его проектами (команда 
меню File > Archive [Файл > Архивировать]), а затем сохранять эти данные 
в Микро-карте памяти (MMC),  которая имеет достаточную емкость.  

Данные мультипроекта, которые Вы не архивировали, не могут быть 
записаны в единственную микро-карту памяти (MMC).  

Однако Вы имеете возможность сохранить все проекты мультипроекта через 
множество MMC. Когда Вы сохраняете данные в MMC, автоматически 
включается компонент мультипроекта, поэтому структура мультипроекта 
может быть полностью восстановлена из этих томов позже.  

Мы рекомендуем Вам создавать текстовый файл, чтобы протоколировать 
компоненты мультипроекта и их относительное положение в памяти (т.е. ID 
CPU), и включать этот файл протокола в данные, которые Вы передаете в 
MMC. Когда должны выполняться задачи обслуживания (PG без проектной 
информации), эта процедура избавляет Вас от утомительного поиска нужных 
CPUs, которые сохранили объекты мультипроекта в MMC. 

Как переместить проекты из одного мультипроекта в другой  
Вы можете переместить проект, который является частью мультипроекта в 
другой мультипроект. Для этого, сделайте так:  

1. Откройте мультипроект, в который Вы хотите переместить проект. 

2. Выберите команду меню File > Multiproject > Add to Multiproject [Файл > 
Мультипроект > Добавить к мультипроекту] 

3. В возникшем диалоговом окне, выберите проект для перемещения. 

4. Возникает сообщение, спрашивающее Вас, хотите ли Вы добавить этот 
проект к текущему мультипроекту.  
Выберите"Yes [Да]» для перемещения проекта в текущий мультипроект.  

Перемещение станций в пределах мультипроекта 
Вы можете переместить станцию (например, станции S7-400 или SIMATIC 
PC) в другое место мультипроекта.  
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Когда станция перемещается между проектами мультипроекта (например, 
перетаскиванием), поддерживаются соединения между проектами.  

Настройка библиотеки как библиотеки мастера данных   
Вы можете добавить к мультипроекту не только проекты, но и поддерживать 
библиотеки, одну из которых Вы можете определить как библиотеку мастера 
данных.  В этой библиотеке мастера данных Вы можете хранить блоки, 
используемые глобально во всех проектах. Эта функция особенно полезна, 
например, для проектирования в системе PCS 7.  

Библиотека мастера данных может содержать только одну программу 
каждого типа (S7, M7, и т.д.)  

1. Откройте библиотеку, которую Вы хотите установить как библиотеку 
мастера данных. 

2. Выберите команду меню File > Multiproject > Set as Master Data Library 
[Файл > Мультипроект > Установить библиотеку мастера данных].  
Следующая иконка для библиотеки мастера данных:  

 

14.4 Доступ Online к PLC в мультипроекте 

Межпроектный доступ с назначенным PG/PC 
Функция "Assign PG/PC [Назначить PG/PC]» для объектов «PG/PC» 
и»SIMATIC PC Station [Станция SIMATIC PC]» доступна и в мультипроекте.  

Вы можете назначить целевой модуль для доступа online в любом проекте 
мультипроекта. Эта процедура совпадает с той, которую Вы используете для 
работы с только одним проектом.  

Предпосылки 
• PG/PC или станции PC, которые Вы хотите использовать для доступа 

online к  PLC, должны быть включены в любые проекты мультипроекта  .  
Замечание: Назначенные PG/PC или станции PC, когда соответствующий 
проект открывается выделяются желтым цветом. Назначение PG/PC 
видимо только тогда, когда на PG открыт правильно назначенный проект.  

• Подсети всех проектов должны быть связаны. 

• Все проекты мультипроекта скомпилированы и конфигурационные данные 
загружены в участвующие станции; например, чтобы распространить 
информацию маршрутизации во все участвующие модули для того, чтобы 
установить соединение между PG/PC и целевым модулем.  

• Возможен доступ через сети к целевым модулям.  
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Возможные проблемы при работе с распределенными проектами 
Назначение PG/PC не видимо, если изменено размещения проектов и проект 
открывается на PG/PC, на котором он не был создан.  

Тем не менее, сконфигурированный объект PG/PC еще поддерживает 
состояние "назначенный» - но с «неправильным» PG/PC.  

В этом случае Вы должны очистить  назначение и переназначить объект 
PG/PC. Тогда доступ online к модулям станет возможен в пределах 
мультипроекта без проблем.  

Проект A

Пользователь A Пользователь B

1. Сохраните проект A на назначенном сетевом PG/PC
2. Откройте тот же проект на другом компьютере

  

Совет для работы с распределенными проектами  
Если более одного участника группы хотят иметь online доступ к PLC со своих 
PG, было бы полезным создать в мультипроекте один объект «PG/PC» или 
«SIMATIC PC Station [Станция SIMATIC PC]» и затем установить назначение 
для каждого PG. 

В зависимости от того, какой PG открыл проект, SIMATIC Manager показывает 
желтой стрелкой только объекты, назначенные этому PG.  
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14.5 Создание межпроектных подсетей 

Концепция межпроектных подсетей  
С использованием STEP 7 V5.2 Вы можете сконфигурировать межпроектные 
сети, которые можно использовать для создания соединений.  

Посети для межпроектной маршрутизации не создаются специальной 
операцией. Скорее объединяются уже сконфигурированные в различных 
проектах мультипроекта  подсети!  

Отдельные объединяемые подсети поддерживаются как обычно. При 
группировании, они назначаются в логическую "Subnet Group [Группу 
подсети]», которая представляет свойства общие для всех назначенных 
подсетей.  

Объединяемые подсети (то есть, межпроектные подсети) должны быть 
одного типа, с идентичным ID S7 подсети. Они обозначаются в NetPro 
суффиксом имени "(interproject)". 

В SIMATIC Manager объединяемые подсети представлены следующими 
специальными иконками.  

 
Маленькая иконка  
Большая иконка 

  

Подсети, которые можно объединить 
Могут быть объединены подсети Industrial Ethernet, PROFIBUS и MPI.  

Подсети, которые не могут быть объединены 
Подсети PtP не могут быть объединены.  

Подсети PROFIBUS с эквидистантным циклом также не могут быть 
объединены. Причина: Время эквидистантного цикла может быть 
сконфигурировано только для систем с одним ведущим, что означает, что 
соединения межпроектных коммуникаций не имеют смысла в этой 
конфигурации. 

По этой же причине подсети PROFIBUS, с H-системами подключенными к ним 
как ведущие DP также не могут быть объединены.  

Предпосылка 
Для слияния подсетей, должен иметься доступ для записи к частным 
проектам и их подсетям.  
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Как слить подсети в NetPro 
Чтобы слить или разъединить подсети, выполните следующее:  

1. Выберите команду меню Edit > Merge / Unmerge Subnets > 
...[Редактировать > Слить/Разъединить сети > …] 
В последней части этой команды меню выберите тип подсети. 

2. В следующем диалоге назначьте подсети мультипроекта объединенной 
подсети.  

- В правом поле ("Merged [Объединенная]"), выберите подсеть 
целиком. 

- В левом поле ("Subnets in the multiproject [Подсети в мультипроекте]”), 
выберите подсеть, которая будет частью объединенной подсети 

- Нажмите кнопку со стрелкой, указывающей вправо. 

Подсети группируются так, что Вы можете поддерживать обзор подсетей, 
которым Вы собираетесь назначать общие свойства (т.е. идентичные S7 
ID подсети).  
Все подсети объединяются в форму "Merged Subnet [Объединенная 
подсеть]» (Имя по умолчанию, например: PROFIBUS_merged(1)). Вы 
можете изменить имя по умолчанию объединенной подсети.  
Свойства первой подсети, которую Вы добавили в группу подсетей, 
определяют свойства всех подсетей, которые Вы последовательно 
добавляете в группу. Позже Вы можете определить другую ведущую 
подсеть, так, что одна подсеть будет определять свойства всех других, с 
помощью кнопки "Select [Выбор]». Значок ведущей подсети имеет 
зеленую рамку, чтобы его было легче опознать. 

3. Если Вам требуется больше объединенных сетей, нажмите кнопку 
"New[Новая]» и назначьте подсети из поля ("Subnets in the multiproject 
[Подсети в мультипроекте]") этой объединенной подсети, как описано 
выше. 

4. Если требуется, Вы можете изменить свойства подсети с помощью кнопки 
«Properties [Свойства]». Это может быть необходимо, например, для 
изменения параметров подсетей шины PROFIBUS, которые Вы 
собираетесь объединять.  

5. Примите установки с помощью кнопок «OK» или "Apply [Применить]". 
Переносимые свойства ведущей подсети применяются ко всем 
остальным подсетям группы.  
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Приведенный ниже рисунок поясняет контекст: 

Назначения в диалоговом поле
«Merge MPI» или «Merge
PROFIBUS»

  

Как разъединить подсети 
Чтобы разъединить подсети, действуйте так:  

1. Выберите команду меню Edit > Merge / Unmerge Subnets > 
...[Редактировать > Объединить/Разделить подсети >… ] 
Выберите тип подсети в последней части этой команды меню. 

2. В следующем диалоге, выберите подсеть в правом поле ("Merged 
[Объединенные]") которая должна быть удалена из слитых.  

3. Нажмите на кнопку со стрелкой, указывающей влево. 
Выделенная подсеть возникнет в левом поле ("Subnets in the multiproject 
[Подсети в мультипроекте]"). 
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Свойства объединяемых подсетей 
Когда Вы объединяете подсети, передаваемые свойства мастер-сети 
передаются другим подсетям этой группы.  

В дополнение к ID подсети S7 , эти свойства представляют (например, для 
подсети PROFIBUS) профиль, скорость передачи, наибольший адрес, и число 
узлов, которые надо принять в расчет.  

Следующие параметры подсети не настраиваются – то есть отдельные 
подсети группы могут иметь свои собственные свойства:  

• Name [Имя] 

• Author [Автор] 

• Comment [Комментарий] 

• Calculated parameters [Вычисленные параметры] 
(Исключение: Только сетевые параметры профиля 'User-defined 
[Определяемые пользователем]' должны согласовываться!) 
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14.6 Отображение объединяемых подсетей в сетевом 
виде  

Окно "Multiproject [Мультипроект]»  
NetPro отображает окно "Multiproject [Мультипроект]", когда Вы открываете 
проект , являющийся частью мультипроекта.  

Используйте команду меню View > Multiproject [Вид >Мультипроект], чтобы 
скрыть или показать это окно. Вы можете также управлять видом через 
иконку.  

 
  

Верхняя часть окна показывает проекты мультипроекта. Нижняя часть 
показывает все межпроектные подсети мультипроекта под их мастер-
системами.  

После того, как Вы выбрали проекты в верней части окна (возможно 
множественное выделение), нижняя часть этого окна отображает только те 
межпроектные подсети, которые маршрутизируются через все выбранные 
проекты.  

Совет: Вы можете быстро перемещаться между проектами мультипроекта 
двойным щелчком на соответствующем проекте в окне "Multiproject 
[Мультипроект]". STEP 7 откроет при этом сетевой вид соответствующего 
проекта в отдельном окне. 

Сетевой вид 
Сетевой вид, отображающий все межпроектные подсети с именем суффикс 
"...(interproject)".  
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14.7 Конфигурирование межпроектных соединений 

Введение 
После того, как Вы сконфигурировали межпроектные подсети, STEP 7 V5.2  
также позволяет Вам сконфигурировать соединения с подобными мастер- 
подсетями. Конечные точки этих соединений могут быть помещены в 
различные проекты. 

STEP 7 предлагает поддержку для создания межпроектных соединений в 
мультипроекте, также как  настройку соединений, сконфигурированных без 
мультипроектного контекста.  

Типы межпроектных соединений 
В STEP 7 Вы можете создать межпроектные соединения для 
резервированных соединений и соединений S7. 

С использованием SIMATIC NET Вы можете также сконфигурировать другие 
типы межпроектных соединений – за исключением соединений FMS. Для 
более детальной информации справьтесь с документацией по SIMATIC NET. 

Межпроектные соединения с заданным партнером 
Межпроектные соединения с заданным партнером (например, CPU) 
создаются также как внутренние соединения в проекте (идентичная 
процедура). Диалог для выбора партнера по соединению был расширен и 
теперь позволяет Вам выбрать – за исключением оконечной точки (например, 
модуля) – проект в мультипроекте, в котором расположена конечная точка 
соединения.  

  
Условием этого является то, что проекты являются составными частями 
мультипроекта (например, используя мастера SIMATIC Manager "Adjusting 
Projects in a Multiproject[Согласовать проекты в мультипроекте]»).  
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Свойства межпроектных соединений 
Согласованность межпроектных соединений обеспечивается, если проекты 
разрабатываются как части мультипроекта. Межпроектные соединения в 
пределах мультипроекта  полностью функциональны и могут быть 
скомпилированы, в случае если проект, содержащий партнеров по 
соединению перемещается из мультипроекта.  

Следующие применения соединений STEP 7: STEP 7 предлагает Вам 
разделить соединения прежде чем появится диалог свойств, когда Вы 
вызываете этот диалог для просмотра свойств соединения. Вы сможете 
модифицировать свойства соединения только подтверждения этого запроса 
"Yes [Да]". Вы можете настроить свойства соединения вручную, , например, 
задав для соединений S7 незаданного партнера по соединению. Всякий раз, 
когда Вы изменяете свойства соединения, есть риск сбоев в рабочем режиме.  

Только локальный ID соединения может быть изменен без нарушения 
соединения.  

Отказоустойчивые соединения STEP 7 не могут быть разорваны.  

Совет 
STEP 7 использует ID подсети S7 – в свойствах подсети – для согласования  
межпроектных соединений.  

Когда Вы пытаетесь сконфигурировать межпроектные соединения без 
объединения обоих связанных подсетей (которые должны сформировать путь 
соединения), например на другие, параллельно действующие проекты 
временно недоступны, Вы можете помочь себе следующим образом:  

Согласуйте ID S7 всех подсетей. Выберите соответствующие подсети и 
просмотрите их свойства через контекстное меню. Введите одинаковый ID S7 
подсети для обеих подсетей.  

Вы можете затем определить, что узлы настраиваемых вручную подсетей 
других проектов образуют конечные точки соединения. Однако, этот процесс 
оставляет не подтвержденным уникальность отдельных подсетей с точки 
зрения NetPro. Проверка консистентности должна сообщить об ошибке, если 
проекты связаны через общую, межпроектную подсеть. В этом случае, 
одинаковые ID подсетей в различных проектах должны обнаруживаться и 
определяться как ошибки.  

По этой причине, объединяйте подсети в NetPro. 
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Межпроектные соединения с партнером из другого проекта  
Если Вы не можете “положить свои руки” на партнера по соединению в 
мультипроекте, просто потому, что соответствующий проект создан в другой 
точке или редактируется в настоящий момент и поэтому блокирован, Вы 
можете выбрать соединение с "Partner In Unknown Project [Партнером в 
неизвестном проекте]". Повторите этот выбор в партнерском проекте.  

  
Эта процедура генерирует резервное соединение в обоих проектах. Вы 
можете использовать это соединение позднее для автоматического 
согласования партнерских проектов, после того как они будут включены в 
мультипроект.  

В этом случае Вам требуется сконфигурировать идентичные имена 
соединений (ссылки) в свойствах соединения обоих проектов. Используя 
имя соединения, Вы можете назначать партнера по соединению и 
согласовать таким образом свойства соединения (Команда меню Edit > 
Merge Connections [Редактировать > Объединить соединения]).  

Проект А Проект А

Локальный узел Удаленный узел

Конечная точкаКонечная точка

Имя соединения Имя соединения

 соединений Объединение

Удаленный узелЛокальный узел

Конечная точкаКонечная точка Имя соединения
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Специальные соображения для загрузки 
После того как Вы сконфигурировали межпроектные подсети и соединения, 
Вы  должны загрузить сетевую конфигурацию во все отдельные модули. Они 
представляют конечные точки соединений, а также участие в маршрутизации. 

Когда Вы загружаете эти данные в PG (Загрузка в PG) конфигурация сети и 
соединения соединяются автоматически, также как и все условия для  
функционирования (например, обе конечные точки были загружены).  

Функции загрузки, предусмотренные в NetPro, не влияют на межпроектные 
данными. Они, в основном, действуют в пределах проекта. Измененные 
функции: 

The download functions provided under NetPro do not affect interproject data. 
rather, they only have an effect within a project. Functions affected are: 

• Download in the Current Project > Selected and Partner Stations [Загрузка в 
текущий проект > Выбранные и партнерские станции] 

• Download in the Current Project > Stations on the Subnet [Загрузка в текущий 
проект > Станции в подсети] 

• Download in the Current Project > Selected Connections [Загрузка в текущий 
проект > Выбранные соединения] 

Функция Save and compile [Сохранить и скомпилировать] также 
ограничивается текущим активным проектом.  
Межпроектные соединения S7 требуют, чтобы Вы скомпилировали оба 
участвующих проекта. 
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14.8 Возможности слияния межпроектных соединений  

See also: 

Вы может слить межпроектные соединения, такие как соединения STEP 7. 

• Когда согласуете проекты в пределах мультипроекта в SIMATIC Manager 
(команда меню File > Multiproject > Adjust Projects [Файл > 
Мультипроект > Согласовать проекты]) 

• В NetPro командой меню Edit > Merge Connection [Редактировать > 
Слить соединения]  

Однако, между этими процедурами есть следующие: 

В SIMATIC Manager объединяются только те связи, которые 
сконфигурированы в составных проектах как "Connection partners in another 
project [Партнеры по соединению в другом проекте]» с одинаковыми 
именами соединения (ссылкой). Однако в NetPro Вы можете объединить 
друг с другом соединения, которые имеют похожие или разные имена 
соединений. 

При слиянии в SIMATIC Manager Вы не можете знать заранее, какой партнер 
по соединению имеет собственные свойства соединения, а какой партнер по 
соединению приспосабливает свои свойства соединения (например, 
активность партнера по соединению). Когда слияние выполняется в NetPro, 
партнер адаптирует свои свойства соединения к свойствам локальных 
модулей. Дополнительно, свойства соединения могут быть изменены в 
диалоге для слияния соединений. 

Соединения STEP 7 с незаданным партнером могут быть слиты только как 
межпроектные соединения в NetPro. Такие соединения не обрабатываются в 
SIMATIC Manager. 
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14.9 Соединения S7 с незаданным партнером 

Если Вы вставляете в мультипроект проект, который содержит незаданные 
соединения S7, Вы можете использовать простой метод объединения этих 
соединений S7 с межпроектными соединениями S7:  

1. Объедините подсети, через которые направлено незаданное соединение 
S7. 

2. Вызовите команду меню Edit > Merge Connections [Редактировать > 
Объединить соединения]. 
STEP 7 автоматически объединит сопоставленные незаданные 
соединения S7. 

14.10 Настройка проектов в мультипроекте  

После вставки проектов в мультипроект, проекты должны быть настроены в 
мультипроекте. Вы вызываете эту функцию также после того, как Вы 
изменили подсети соединения в мультипроекте. Всегда выполняйте эту 
функцию, когда Вы подготовили конфигурацию к вводу в эксплуатацию. 
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14.11 Архивация и разархивация мультипроектов 

Архивация данных мультипроекта 
Вы можете добавить мультипроекты, отдельные проекты и библиотеки в 
файл сжатого архива, который может храниться на винчестере или на 
мобильном средстве хранения (например, диске Zip).  

Если сегменты мультипроекта хранятся на сетевых дисках, Вы можете 
использовать только следующие инструменты сжатия для создания архива 
данных мультипроекта:  

• PKZip Commandline V4.0 (поставляется с пакетом STEP 7)  

• WinZip начиная с версии 6.0 

• JAR начиная с версии 1.02 

Предпосылка для архивации:  
Поскольку функция архивации влияет на все проекты мультипроекта, к 
соответствующим проектам не должно быть доступа от каких-либо других 
процессов.  

Последовательность действий 
1. Выделите мультипроект в SIMATIC Manager 

2. Выберите команду меню File > Archive [Файл > Архивировать] 

3. Подтвердите мультипроект в следующем диалоге и нажмите "OK". 

4. В следующем диалоге, выберите имя архива и путь, а также программу 
архивации (например, Kip 4.0)  

5. Подтвердите диалог, нажав "OK".  

Как разархивировать мультипроектный архив 
1. В SIMATIC Manager выберите команду меню File > Retrieve [Файл 

>Разархивировать] 

2. В следующем диалоге, выберите мультипроектный архив и нажмите 
"Open [Открыть]".  

3. В появившемся диалоге "Select destination directory [Выбор целевого 
каталога]", выберите целевой каталог для распаковки архивных файлов.  
В выбранном каталоге будет сгенерирован новый каталог. Полная 
структура каталогов распакованного мультипроекта появится на этом 
уровне ниже этого каталога.  
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15 Ввод в эксплуатацию и обслуживание  

15.1 Ввод в эксплуатацию и обслуживание 

Подготовка к вводу в эксплуатацию  
Для ввода в действие сетевых станций Вы должны вначале загрузить 
конфигурационные данные в каждый  PLC отдельно командой меню > 
Download [PLC > Загрузить] (SIMATIC Manager). Это обеспечивает PLC 
необходимой аппаратной конфигурацией, а также адресами сетевых узлов. 
После этого Вы имеете доступ к сети с использованием команды PLC > 
Compile And Download Objects [PLC > Скомпилировать и загрузить 
объекты]. 

Что надо сделать, если при вводе в эксплуатацию или при обслуживании 
были сделаны изменения  

Если используется мультипроект, мы рекомендуем согласовать проекты до 
загрузки в PLC (В SIMATIC Manager вызовите команду меню File > 
Multiproject > Adjust projects [Файл > Мультипроект > Согласовать 
проекты]). После этого Вы можете вызвать централизованную функцию  
"Compile and download objects [Скомпилировать и загрузить объекты]» для 
загрузки изменений в PLC. 

15.2 Как ввести в действие узлы PROFIBUS  

Начиная с  STEP 7 V5.2 Вы можете использовать Ваш программатор для 
online доступа к узлам PROFIBUS, даже если за исключением программатора 
к сети PROFIBUS подключены только ведомые DP.  

Для этих узлов Вы можете выполнить диагностику, наблюдать их входы 
изменять их выходы. Вы можете также переконфигурировать узлы и 
сохранить текущую отображаемую конфигурацию как новую конфигурацию 
(Выберите команду меню PLC > PROFIBUS > Save PROFIBUS Online 
Configuration as [PLC >Сохранить Online конфигурацию PROFIBUS как..]). 

Вы можете использовать конфигурацию, сохраняемую таким способом как 
основу для конфигурирования новой станции (в HW Config выберите команду 
меню Station > Open [Станция > Открыть]). 
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Как включить доступ в online  
В SIMATIC Manager эта функция запускается командой меню PLC > 
PROFIBUS > Operator Control/Monitoring And Diagnosis Of Nodes [PLC > 
PROFIBUS > Операторский контроль, управление и диагностика узлов], 
или, если Вы сконфигурировали оборудование для станции, открытой offline, 
командой меню PLC > Operator Control/Monitoring And Diagnosis Of Nodes 
[PLC > Операторский контроль, управление и диагностика узлов].  

Вам будет представлен вид, подобный HW Config (Station > Open Online 
[Станция >Отрыть Online]). Разница в том, что здесь определить узлы 
(например, через контекстное меню Specify Module [Задать модули]), 
изменить параметры и сохранить новую конфигурацию, как новую станцию.  

Виды offline и online  
После того как Вы сохранили конфигурацию ("Offline view [Вид Offline]") и 
затем запустили "Online view [Вид Online]» командой меню PLC > Operator 
Control/Monitoring And Diagnosis Of Nodes [PLC > Операторский 
контроль, управление и диагностика узлов], применимо следующее:  

• Вид Online показывает все найденные узлы, независимо от числа узлов в 
конфигурации offline.  

• STEP 7 использует идентификатор производителя и данные конфигурации 
как основу для попытки найти для каждого узла вида online 
соответствующий узел вида offline. Если успешно, (то есть все узлы 
идентичны), параметры  вида offline применимы к виду online.  

Этот метод гарантирует, что изменения, сделанные и сохраненные в 
процессе отладки непосредственно  доступны при открытии вида online.  

Операторское наблюдение и управление 

В представлении online Вы можете читать входы и управлять выходами. При 
этом программатор (PG) работает как ведущее DP. 

1. Выберите необходимый узел.  

2. Вызовите команду меню PLC > Operator Control/Monitoring.  

Появляется диалоговое окно операторского контроля и наблюдения. Path 
definition [Определение пути] показывает, как выполняется доступ online через 
службы PROFIBUS.  

Отличие вызова этой функции через аппаратную конфигурацию (online через 
назначенные службы CPU) по отношению к прямому доступу через службы 
PROFIBUS в том, что условия запуска не могут быть применены к ведомым 
DP.  

Диалог показывает все входы и выходы модулей в одной строке.  
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Использование сохраненной конфигурации как основы для 
конфигурирования новой станции 

Узлы PROFIBUS определенные online могут сохранить как конфигурацию 
станций (команда меню PLC > PROFIBUS > Save PROFIBUS Online 
Configuration As...[PLC > PROFIBUS > Сохранить Online конфигурацию 
PROFIBUS как... ]). Любые сделанные изменения (в "Specify Module 
[Определить модуль]» или "Change Properties [Изменить свойства]") также 
сохраняются. 

Эта вновь сохраненная конфигурация однако не может содержать некоторых 
специфических конфигурационных данных ведущего, подключенного к  
PROFIBUS. По этой причине ведущие DP будут показаны только символьно, 
подобно ведомым DP. 

Вы имеете возможность сконфигурировать DP позднее и тогда заменить 
ведущего, полученного через online (и представленного символьно), вновь 
сконфигурированным.  

Последовательность действий:  

1. Откройте сохраненную online конфигурацию PROFIBUS. 

2. Сконфигурируйте столько ведущих DP, сколько мастер-систем было 
определено online (полностью стойку с CPU и PROFIBUS CP или CPU с 
встроенным интерфейсом DP). 

3. Выберите одного из ведущих DP, определенных online, которого Вы 
желаете заменить вновь сконфигурированным ведущим. 

4. Выберите команду меню Options > Assign Master [Возможности > 
Назначить ведущего].  

5. В появившемся диалоге назначьте сконфигурированного ведущего 
ведущему, который был получен через online.  

6. Повторите шаги 3 .. 5 для всех ведущих DP, полученных online заменяя их 
вновь сконфигурированными. 
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